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1.1 Welcome to Leica Infinity

1.1.1 What is Infinity

Infinity, the intuitive office software solution from Leica Geosystems. Infinity
is the ideal place for managing data to and from field instruments, the bridge
between field and office:
• Bring together different kinds of data on a field project. TPS, GNSS,

images, scans and so much more.
• Numerous data formats can be edited, archived and exported to CAD

applications easily, without data loss and without the hassles involved in
conversion. It is not only for data from different instrument types, but
also from multiple sites and survey teams.

• Infinity structures and processes surveying data for simplified, automated
and logically expanded workflows, for a faster overview of the project as a
whole.

More efficiency, greater transparency, quicker decision making and
simply better.

The aim of Infinity is to support the user throughout a survey project by
fulfilling the following five principles:
• Visualise - Become familiar with the data and see visually how it is

related to each other.
• Prepare - Extract and prepare data for the field.
• Confirm - Process data, perform quality checks and view results.
• Report - Generate and store, proof of quality and completed task reports.
• Archive - Know where exported data and reports are stored.

Watch the Infinity overview video which gives you a broad understanding
about what modules exist in the software https://www.youtube.com/watch?
v=un5WH-sF6I8&list=PL0td7rOVk_IV_al3ziSKuAYA1VVu6W0rM&index=11&t=0s

☞ Some of the features used in the video are licence protected.

To find help, refer to the following:
• Use the Contents tab to browse to a topic.
• Use the Search tab to search for key words.
• Select a link from a topic to go to the related topics.

 

1.1.2 Training Materials

For training purposes refer to the following training materials:

What is Infinity

Training Materials
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• Video tutorials.
• Tutorials, downloadable in the Infinity software.

Video tutorials
Video tutorials are available on the Infinity YouTube channel:
https://bit.ly/3sZaIIK

Tutorial downloads
Tutorials are available for download in the Localisation Tool.

 

1.2 License Options

1.2.1 Basic Modules

Basic modules include the core data in and out modules: File, Home, Features
and External Services. These modules make for easy field to office or office to
field data preparation.

File
• Manage and archive all your Projects.
• Set up local and global settings.
• Send and receive data to and from the field using external services: Leica

Exchange, Leica ConX, Autodesk BIM 360.
• Download reference station data from predefined reference stations or by

connecting to SmartNet.
• Connect to Map Services: WMS, WMTS, XYZ and WFS.
• Manage and edit coordinate systems.
• Apply styles using the Layer Manager and CodeTables.
• Get Help & Support as well as the access to the Localisation Tool.

Basic Modules
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Home
• Import and export all supported data formats.
• Generate extensive reports including data source and stakeout.
• View or share data using Google Earth.
• View base maps: With an active CCP use the HxIP accurate orthorectified

imagery.
• Check the quality and correcting field errors.
• Use COGO to calculate distance, compute points and shift/rotate/scale.
• Link/unlink images to features, clip base map and georeference image.

Features
• Create and edit thematic code information.
• Automated feature code processing (blocks and layer).
• Create and manage points, lines and areas.
• Copy of entities from CAD, IFC, Shape files and WFS to the project.
• Solve name conflicts using the Rename Tool.

External Services
• Send and receive data to cloud services Leica ConX and Leica JetStream.

1.2.2 Optional Modules

Optional modules in Infinity, are designed to support the user by grouping
product features to workflows. These workflows are grouped to modules,
and most modules are optional, allowing you choose what work you perform
in Infinity. The optional modules are: TPS-Processing, GNSS-Processing, Level-
Processing, Surfaces, Point Clouds (including surfaces), Imaging, Point Clouds
from Images (including imaging), Infrastructure and Adjustments.

TPS-Processing
• Create or edit TPS setups to update orientation or positions.
• Support of further point calculations: Sets of angles, measure foresights.
• Build or edit traverses.
• Update stations.

GNSS-Processing
• Process single or multi-frequency GNSS raw static and kinematic data for

determining the most reliable and accurate solution.
• View cycle slips, SNR and residual plots with statistics using advanced

GNSS data analysis tools.
• Process multiple frequencies of GPS, GLONASS, BeiDou, Galileo and QZSS.
• Use Autoprocessing to build up automatically all possible combination of

baselines and process your data within one click.

Level-Processing
• Manage level lines - Edit start/end points, join or split lines.
• Process level lines - Edit staff corrections, reprocess and generate reports.
• Level network adjustment (1D) - Complete levelled height networks.

Optional Modules
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Surfaces
• Compute 3D or 2.5D surface using individual points and point clouds.
• Add break lines, boundaries or exclusion areas, to edit a mesh.
• Calculate volumes.
• Create contours.
• Cut fill maps and compute tolerance lines.
• Comparison maps.

Point Clouds (including surfaces)
• Measure within point clouds for comparison and checks.
• Visualise scan data in different colour modes - SNR, Intensity, RGB.
• Automatic and manual point cloud cleaning tools.

Imaging
• Manage image data using integrated image group viewer. Sort and organ-

ise by groups and features and compute points from images taken from
total stations and GNSS sensors.

Point Clouds from Images (including imaging)
• Orientate images.
• Create dense point clouds.
• Generate digital surface models and orthophotos.

Infrastructure
• Import, visualise and organise road design data.
• Repair road data before sending it to the field, for example live edits to

road geometry or fixing string line connections.
• Document and report field applications, including stakeout and checks

with tolerance flags.
• Manually input a road and compute daylight stringlines.

Adjustments
• Combine TPS, GNSS and level data.
• Full 3D, 2D and 1D computation.
• Compute loops and display of error ellipse and reliability.

1.3 Getting Started

1.3.1 Working with the User Interface

1.3.1.1 Overview

When we open a project we see the layout of the user interface. The layout of
the user interface can be split into several parts which are highlighted in the
following graphic.

Working with the
User Interface
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No. Name Description

1. Ribbon Bar Explore functions and tools grouped into
modules.

2. Graphical View View the project content graphically in 2D or
3D.

3. Navigator Navigate through the project content.

4. Data Inspector View project content in table format.

5. Property Grid View the properties of a selected data item.

6. Quick Access Bar Get quick access to some important func-
tions.

7. Status Bar See current settings.

8. Layer Manager Change the layer status and their graphical
settings.

9. BIM Explorer Inspect the structure of IFC files.

10. Flythrough Creator Create video with defined flythrough meth-
ods.

See also:
Window Behaviour
Objects, Point Roles and Symbols

1.3.1.2 Ribbon Bar

The ribbon bar is at the top of the screen and allows access to all the func-
tions and tools.
It is used to group the functions and tools of particular operations together
into modules. Each module has its own tab in the main menu at the top.
Different tabs allow access to different ribbon bars.

Ribbon Bar
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Under the File tab it is possible:
• To perform project management-related operations, such as creating and

deleting projects.
• To edit all global settings and global objects.

The Home tab is the core of every project, as that is where the Import, Export
and Reports functionalities are located.
For more information, refer to Basic Modules.
Under the Processing, Surfaces, Scanning, Imaging, Infrastructure, Adjustments
and Features tabs, operations can be run to work with data and perform edits.

☞ Most of these operations are licence protected and must be ordered
separately.

For more information, refer to Basic Modules and Optional Modules.
Under the External Services tab, Infinity manages cloud services such as the
Leica ConX and the Publish to Leica JetStream.

1.3.1.3 Graphical View

The graphical view displays the project content graphically in 2D or 3D. It is
the main representation of project content and is always visible in the back-
ground. It cannot be switched off or hidden.

 

Zooming/Panning/Rotating the view:
When you open a project, the graphical view is zoomed to the full extent. The
whole project content is shown.

To zoom into inspect the data in detail:
Scroll the mouse wheel back and forth to zoom in and out.

Alternatively select Ctrl+ or Ctrl- on the keyboard.

When you have zoomed in and you want to shift the view to neighbour-
ing areas (pan the view):
Press the mouse wheel and move the mouse into any direction until the
displayed area suits your needs.

Graphical View
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Alternatively press the Right, Left, Up or Down arrows on the keyboard.

To rotate the view:
Click into the view with the left mouse button and move the mouse.
The axis in the bottom left corner of the view follows your rotations and
indicate the current view direction.

To look around:
By default, the rotation in the graphical view is around the centre of the
graphical view, marked by a little white cross. Look around, allows reverse
rotation around the current camera position.

Select the  Look Around option on the status bar to rotate around the
camera position. Click into the view with the left mouse button and move the
mouse.

Use Ctrl+R to turn on/off the look around.

To lock zooming to the pivot point:
By default, the pivot point is identified by your mouse pointer. When you start
zooming the view is zoomed into the area that your mouse points at. But you
can also lock the pivot point to the centre of the graphical view marked by the
little white cross.

Select the  Lock the Pivot Point option at the bottom of the graphical
view to lock the direction of view to its centre.
Alternatively, press and hold Alt while zooming.

To zoom into the insides of an object:

Switch to  Perspective View and zoom until you break through the surface
of the object. Once inside you can rotate the view to look at the insides of the
object.

Switching between Standard Views:
You can switch between the following standard view options:

Icon Description

2D Plane View:
Select 2D Plane View to enforce a 2D view from the top
down onto the data. The data is displayed as in a map
only showing the position information. You cannot rotate
the view when it is set to 2D.
3D:
Select 3D to see your data including its position and height
information.
3D Clamped:
Select 3D Clamped to enforce a projection of the data to
the height level of the lowest point in your project.
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Icon Description

Parallel:
Select Parallel to enforce a parallel projection of the data in
the 3D view.
Perspective:
Select Perspective to allow for a perspective view.
☞ Zooming into the insides of an object is only pos-

sible in perspective view.

☞ The overview window is only available when the
view is set to Parallel projection. When you switch
to perspective the overview window disappears.

Select how you want to look at the data, that means select
your Camera position. In the 3D view, you can freely rotate
the view. But if you want to orientate the view such that
you can look at your data exactly from, for example, the
front or back or from the left or right then you have a
choice here.
☞ The 2D view is set to be a top-down view.

Select whether you want to see the entities shaded (with
or without edges) or whether you want to see just the wire-
frame.

Select the intensity of shading.

 Enable the 3D terrain in order to view base maps, orthopho-
tos or georeferenced images in 3D.
The default DEM (SRTM) has a resolution of approximately
one arcsecond.
☞ Due to the low accuracy, the DEM is only intended

for visualisation purposes.

 Select whether you want the coordinate grid to be shown or
hidden.

Select the Look Around feature.

Turn on Google Earth View Synchronisation:

When you turn on  Google Earth View Synchronisation, then Google
Earth follows all zoom, pan and rotation operations you make in Infinity.

Reset the View:
To reset the view to the initial camera position right-click into the background
of the graphical view and select Zoom All from the background menu.

Alternatively press Ctrl+Shift+R on the keyboard.
The zoom status is reset, which means that the view is zoomed to the full
extent. Any panning and/or rotation operation is reset, too, so that you have a
look at the data as if you had just opened the project.

Managing Layers:
How your data is represented in the graphical view can be modified in the
layer manager, which allows you to switch layers on and off, lock them so that
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they cannot be modified and change the colour and style of their appearance.
For more information, refer to Layer Manager.

Hiding Elements from View:
When the data structure of your project is complex you can filter the view by
switching elements or whole groups of elements off. This way the graphical
view can be reduced to show the jobs and elements that you currently work
on or that need revision.

To Switch Elements On or Off:

Select the Eye  in the navigator to hide points and objects or even whole
jobs from view. When the eye is shown in the navigator then the element or
all elements in a job are visible in the graphical view.

Selecting Elements:

Action Result

Single left mouse click
onto an element

Selects the element.

Ctrl
+single left mouse clicks
onto elements

Selects a series of elements.

Shift (↑)
+single left mouse clicks
into background

Draws a polygon and selects all elements
inside.

Shift (↑)+left mouse but-
ton
+dragging the mouse

Draws window and selects all elements
inside.

Shift (↑)+Ctrl
+dragging window/drawing
polygon

Selects all elements outside the win-
dow/polygon.

The properties of the selected element are loaded to and shown in the prop-
erty grid.
In the graphical view, selected elements change their colour as specified in the
layer manager.

Centring Elements:
To centre the view on a selected element select an element in the navigator
or in theiInspector, right-click onto it and select Centre To from the context
menu.
The view shifts to show the selected element in the centre.

1.3.1.4 Navigator

The navigator allows you to navigate through the project content. It shows the
whole project content for searching for and locating single data items.

☞ Search has got a filter effect. You can filter the points and other
objects by their ID or date and time. All other points and objects are
hidden from view.

Navigator
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The project content is structured into three main parts:
In the Library section, all objects are
grouped by the type of object they belong to
and all points and objects are listed by their
ID.
In the Source section, all imported jobs
are listed by date and time. All setups are
grouped by the jobs they belong to. Inside
each job, all points are grouped by the
setups they belong to and listed by their ID.
In the Archive section, all reports and
exported files are listed in chronological
order by their creation date and time.

☞ If you have closed the navigator you can make it reappear by select-

ing the  Navigator option in the status bar.

Functions

Showing/hiding items:
To hide points and other objects or even whole jobs from view in the graphical
view select the  icon. This way the graphical view can be reduced to show
the jobs and elements that you currently work on or that need revision.

Recovering points/observations:

Files/objects indicated by the  icon, have been deleted externally and can-
not be accessed.

Points and/or observations deleted in the field can be restored by selecting 
Recover from the context menu.

1.3.1.5 Data Inspector

The data inspector shows module-specific project content grouped thematic-
ally for detailed investigation. It is designed to focus completely on one type
of data object.
The availability of the module-specific tabs depends on which of the modules
you have decided to purchase.

Data Inspector
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See also:
License Options
With the options on the left side, you can switch between subcategories.

 

☞ If you have closed the inspector you can make it reappear by select-

ing the  Inspector option in the status bar.

Functions

Drilling down:
To get one step further into your data select the arrow  next to a group of
data items.

Navigation to parent:
To navigate back to a higher category of data items, select the breadcrumbs.
Example:

Filtering:
To filter points and other objects by their ID or date and time, use the search
function.

To filter columns, select the  option in the column header. To undo the filter
effect, click the option again and clear your selection.

Editing:
To edit the properties of an item, select it and make your edits in the property
grid.

Where ever the  option is available a separate tool for editing can be
invoked.

☞ Multi-Edit is possible for points and observations. For further inform-
ation, refer to the following topics:
Observation Properties
 Multi-Editing of Point Code Information
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Recovering Points/Observations:

Points and/or observations deleted in the field can be restored by selecting 
Recover from the context menu.

Selecting Columns/Changing Column Order:
Right-click onto a column header or any item in the inspector view and select

 Select columns... from the context menu.

Select the columns to be visible and change the column order if desired.
You can also change the column order by dragging and dropping the column
header.

Sorting by Column Heading:
Click onto the header of a column to sort its items in an ascending or des-
cending order.
By default, the items in the inspector view are sorted by the first column.

☞ If tilt compensation was applied to a measurement using the Leica
AP20 sensor, tilt compensated measurement values are shown in the
data inspector.

1.3.1.6 Property Grid

The property grid shows the properties of a selected data item. Data items
can be selected in the graphical view, in the navigator and in the inspector. By
default, the property grid is open and stays open unless you close it. It is filled
dynamically depending on the selected data item.

☞ If multiple items are selected, select one from the drop-down list at
the top to make its properties be displayed in the property grid.

Property Grid
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Functions
All properties are arranged in subgroups that
can be collapsed or expanded.
All properties with a white background can
be edited.

The  icon and the  icon indicate that
these properties can be edited or recalcu-
lated in a fly-out or separate tool. Fly-outs
have to be confirmed by OK or Cancel
before you can continue working.
All changes in the properties have to be con-
firmed by selecting the Apply at the bottom
of the property grid.

☞ If you have closed the property grid window you can make it

reappear by selecting the  Properties option in the status bar.

☞ If tilt compensation was applied to a measurement using the Leica
AP20 sensor, tilt compensated measurement values are shown in the
Property Grid.

1.3.1.7 Quick Access Bar

The quick access bar is at the top left corner of the Infinity window and
is active with an open project. It enables quick access to some important
functions:

Icon Description

Undo an operation. It is possible to undo multiple times.

Redo an operation. It is possible to redo multiple times.

Quick Access Bar
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Icon Description

Delete any selected item from the navigator, the data
inspector or the graphical view.

Refresh to refresh all windows and reset the graphical view.

Open the coordinate system manager.

Open the code table manager.

Open the GNSS manager.

Open the task manager to monitor the image-processing
tasks.

1.3.1.8 Status Bar

The status bar at the bottom of the Infinity workspace, indicates current set-
tings.

Connectivity Status
You can see information about services that Infinity is connected with (Leica
Exchange or Leica ConX).

Icon Description

Not logged in.
It is not possible to send or receive data
using Leica Exchange. You are not notified of
incoming messages.

Indicates being logged in.
It is possible to import and export data from
the open project.

New messages are available for download.

Selection Status
The status bar indicates the number of selected items.

Window Status
The status bar indicates whether the navigator, the inspector and/or the prop-
erty grid are visible or hidden.

Select the  to open/close them.

Status Bar
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Tools

Open the  Layer Manager or the  BIM Explorer or the  Flythrough
Creator from here.

Unit Settings
The status bar indicates the units you have chosen for distances and angles.
To change the units and the available decimal places in the current project

open the drop-down lists: .

☞ You can also change the unit settings through File > Info & Settings
> Coordinates & Units.

Master Coordinate System Settings
The status bar indicates the coordinate system which is currently used for dis-
playing the project data. The selected coordinate system is called the master.
To select another coordinate system open the drop-down list:

☞ You can also select a different master coordinate system through
File > Info & Settings > Coordinates & Units.

Conditions:

• If you import raw data coming with a coordinate system then this
coordinate system is automatically stored to the project and is made
available in the drop-down list.
To make it be used, select it from the list.

☞ If you want a coordinate system from the global coordinate
system management to become available for selection, then go
to File > Tools > Coordinate Systems and copy the required
coordinate system to the current project.

• If you select None then the data of each job is displayed using its own
coordinate system.

• If you export project data to DBX, LandXML or HeXML, always the mas-
ter coordinate system are exported with your data.
If none is used then your data is exported without any coordinate sys-
tem information.

☞ If you want to export all coordinate systems from the current
project choose to export coordinate systems in the data export
dialog.
All coordinate systems are saved to the same TRFSET.DAT file.

1.3.1.9 Layer Manager

When you import data into an Infinity project, it is automatically organised into
layers. Each layer is given a name in relation to its status and a pre-defined
graphical representation. Each layer consists of a pre-defined colour, line style
and shading style of the elements that belong to a layer. In the layer man-
ager, you can change the status (on/off, locked/unlocked) and the graphical
settings.

Layer Manager
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To open the layer manager:

Select the  icon in the home tab or in the Infinity status bar.

☞ The layer manager can stay open while working within Infinity, be
shifted to another screen or docked in a preferred window position
within the Infinity frame.

Survey data layers:
All surveyed data is organised in layers. On the survey layers, you can find
all the Infinity objects that are imported as field data from SmartWorx (DBX)
jobs or HeXML files. Survey layers can be exported to *.dxf, *.dwg, *.xml or
*.HeXML files.

See also:
Objects, Point Roles and Symbols

Labels and selection layers:
On these layers, elements are grouped so that label survey data entities like
point ID and point code ID, line/area ID or position and height labels.

☞ Labels can be switched on and off, but they cannot be locked or
unlocked.

Survey data layers:
On these layers, the survey data is grouped by object type.

Thematic layers
All feature codes are organised in layers. On a thematic layer, the thematic
information of feature objects like points, lines or areas are grouped. The
thematic layers can be exported to *.dxf or *.dwg.
Thematic layers can either be edited directly in the code manager or in the
layer manager. You can also create new thematic layers from inside the layer
manager. In both cases, the code table is updated accordingly.
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To create new layers in the layer manager:

Select the  New Layer option in the top right corner and define the new
layer through inline editing and selecting features from the drop-down list in
each column. The layer name can also be changed through inline editing.

To delete selected layers:

Select one or more layers and select the  Delete option to delete layers.
The layers are deleted without any further warning message.

Reference layers
Under Reference Layers you can find all the layers as defined in referenced
files like imported *.dxf or *.dwg files or *.ifc files. For those layers, you can
also change the appearance, switch layers on/off or lock/unlock them, without
having to modify the source files themselves.

See also:
Data Import

Settings

Switching layers on or off:
If the data in your project is organised in many different layers you can reduce
the view to just the layers you are currently working on by switching others
off:

Select the  option to switch off a layer, select the  option to switch on a
layer.
Switched off layers are not visible in the graphical view.

Locking or unlocking layers:
If you want to make sure that elements in a specific layer cannot be selected
then you can lock that specific layer.

Select the  option to unlock a layer and the  option to lock a layer.

The properties of data in locked layers cannot be edited.

☞ The graphical settings can always be changed for all layers, even if a
layer is locked.

Defining the graphical settings:
To redefine the graphical appearance of a layer (for example, the colour of the
point symbols or the line style of an area boundary) you can modify the line
colour, its width and style as well as shading colour and style of area objects.

Excluding layers from export:
Most of the layers can separately be excluded from export.

In the Export column, select the  option to exclude a layer from being
exported.

To visualise the new status the option is crossed out, .
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1.3.1.10 BIM Explorer

Use the BIM Explorer to inspect the structure of *.ifc files and list its entities
by types.

 

To open the BIM Explorer:

Select  BIM Explorer from the status bar.

☞ The BIM Explorer can stay open next to working within Infinity, be
shifted to another screen or docked in a preferred window position
within the Infinity frame.

Available functionality

Switching between Structure view and Types view:
View the elements/entities either by file structure or sorted by type.

 

Selecting elements/entities:
When you select an element in the BIM Explorer it is simultaneously selected in
the graphical view and its properties are displayed in the property grid.
You can select single elements as well as whole entities.

Viewing/Hiding elements/entities:
Select the eye to hide an element or a whole entity from view.

Deleting elements:
Selected elements can be deleted.

BIM Explorer
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Searching for elements/entities:
Search for single elements or entities.
The Search functionality filters the elements. All other elements are hidden
from view.

1.3.1.11 Flythrough Creator

The flythrough creator allows the creation of video with defined flythrough
methods like fly along view points, orbit, look around or fly along feature.

To open the flythrough creator, select the  icon in the status bar.

☞ The flythrough creator can stay open while working with Infinity, be
shifted to another screen or docked in a preferred window position
within the Infinity frame.

Terminology Definition

View Point: Defined from the camera and look at point position.

Camera Pos-
ition:

Is a place in the space from which you look at the data,
for example when rotating around an object, you move the
camera position. The camera position is changed by modify-
ing the distance and angle between the camera and look at
position.

Look at
Position:

Defined by the current view (indicated by the rotation pivot
point in the centre of the screen), by the current selection
(for example a feature like road, line or area) or by a tech-
nical point.

Camera
Angle:

Is the vertical angle of the camera to the data being
viewed. Looking straight on is 90°/100 gon, 0° is up and
180°/200 gon is down.

To store the Flythrough:
1. Enter the name for the flythrough and then select Save, the fly-

through is now active. Save all changes manually.

2. To create a new flythrough, select New… from the Template drop-
down list, enter the name and select Save.

3. To use an existing flythrough, select it from the available list of
templates.

Flythrough using Fly Along View Points:
Fly along view points create flythrough based on the view point positions
defined by navigating in the 3D graphical view. To set a new view point
navigate to the desired location and select Create a new View Point from
current view.
1. Select the  icon in the status bar to open the Flythrough Creator

and select the Fly Along View Points method.

2. Navigate in the 3D view (by panning, zooming and rotating) to set
the desired position and orientation.

Flythrough Creator
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3. Select create New View icon point to store the current position.
A temporary indication for the camera position and the look at posi-
tion appears in the graphical view.

4. The camera position and the look at position are modified by select-
ing a new technical point from the list or by manually changing the
current view point coordinates.

5. Repeat steps 2 and 3 until all desired fly along view points are
added.

6. Use play and stop to preview the flythrough.

7. Modify the available settings to change the flythrough duration,
number of frames or to change the direction.

8. To save the flythrough, define the video format and resolution then
select Create. In the export window, select the destination of the
flythrough and select Save.

Flythrough using Orbit:
Orbit rotates the camera position 360° around the look at position at the
specified distance and vertical angle. The look at position is a current view,
selection or technical point.
1. Select the  icon in the status bar to open the Flythrough Creator

and select the Orbit method.

2. Select the Look at Position by defining the current view icon,
selection icon or choose a technical point from the list.

3. Define the distance between the look at point and camera position
and the angle. The vertical angle range is between 0 - 180°. For
example, an angle of 30° makes the camera look up and an angle of
170° makes the camera look down.

4. Modify the available settings to change the flythrough duration,
number of frames or to change the direction.

5. To save the flythrough, define the video format and resolution then
select Create. In the export window, select the destination of the
flythrough and select Save.

Flythrough using Look Around:
Look around fixes the camera position and rotates the view 360° at a specified
vertical angle. The camera position is a current view, selection or technical
point.
1. Select the  icon in the status bar to open the Flythrough Creator

and select the Look Around method.

2. Select the Camera Position by defining the current view icon, selec-
tion icon or choose a technical point from the list.

3. Define the angle for the look at position. The vertical angle range is
between 0 - 180°. For example, an angle of 30° makes the camera
look up and an angle of 170° makes the camera look down.

4. Modify the available settings to change the flythrough duration,
number of frames or to change the direction.
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5. To save the flythrough, define the video format and resolution then
select Create. In the export window, select the destination of the
flythrough and select Save.

Flythrough using Fly Along Feature:
The fly along feature creates flythrough by moving along a feature such as a
line or alignment. The camera position comes from the offset to the look at
position feature or the trajectory along a secondary feature.
1. Select the  icon in the status bar to open the Flythrough Creator

and select the Fly Along Feature method.

2. Choose between the Offset and Trajectory method to create the
flythrough.

3. To create a flythrough with the offset method, choose the pen
option to select a feature and define the offset for the camera
position. The offset for the camera position works similar as the
offset for the technical point.
• The Length offset - The negative value (-) moves the position

back and the positive value (+) moves the position forward.
• The Cross offset - The negative value (-) moves the position

to the left and the positive value (+) moves the position to the
right.

• The Up offset - The negative value (-) moves the position down
and the positive value (+) moves the position up.

4. To create a flythrough with the trajectory method, select the pen
option and select a feature for the look at trajectory and the camera
trajectory.

5. Modify the available settings to change the flythrough duration,
number of frames or to change the direction.

6. To save the flythrough, define the video format and resolution then
select Create. In the export window, select the destination of the
flythrough and select Save.

1.3.2 Local and Global Data Objects

In Infinity, we distinguish between objects and settings from the File global
and within the Project-Local.
A project holds all objects that allow it to be opened on a machine, and some
of these objects are global. We have global objects so that they can be reused
for single projects.

Global Objects:
• All objects which are stored in Infinity under the Tools within the File tab.
• Use Copy to Project to use them inside your active project.

Global Settings:
• All settings that are listed under Preferences within the File tab.
• Project templates that are used when creating a new project.

Local Objects:
• The data object is imported or found only in your project.
• Use Export to global to copy data from the project to the global objects.

Local and Global Data
Objects
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Local Settings:
• Settings that are only valid within a single project.
• Are available only when an individual project is opened.
• Found under Info & Settings.

Working with Local and Global Data Objects:
 

No. Name Description

1. Code Tables Feature codes can be imported from Leica
field software jobs into a global code table.
The global code table can then be made
available to any Infinity project.

2. Targets TPS target definitions are automatically
imported into Infinity projects from Leica
field software jobs (along with the survey
data they relate to).
New TPS target definitions can be manually
entered globally and from there they can be
copied to projects.

3. Antennas GNSS antenna definitions can be imported
into the GNSS manager from a dedicated
antenna file (not from a Captivate job). You
can do it globally, or inside a project. Anten-
nas are automatically mapped during import
of GNSS data to the project. When the GNSS
antenna is found in the global antenna list,
then all antenna calibration definitions are
copied into the project automatically.

4.  Coordinate Systems Coordinate systems are often imported into
Infinity projects (along with survey data), in
jobs from Leica field software.
They can then be saved to the global librar-
ies and from there they can be copied into
any other project.
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No. Name Description

5.  Georeferenced 
Images

Background map images can be georefer-
enced backstage (using the points from a
project) or inside an Infinity project, then
saved to the global library.

☞ Any editing we do in Tools is on the global objects. Changes to
these global objects do not affect any existing projects. But any new
project that we create uses the updated global objects.

☞ When having to work with different coordinate systems, projects
units and code tables use project templates Save as Template.

See also:
Tools
Save as Template

1.3.3 Objects, Point Roles and Symbols

Infinity is an object-oriented software. The objects are the basic entities for
performing operations. All objects are intelligent objects which means that
they are interrelated with each other.

Sym-
bol

Object Description

Points A point is a named object that represents a
location with either local or global latitude and
longitude coordinates, and possibly a height or
elevation.

Lines A line is used to describe feature objects by
drawing a line between two or more points.

Areas An area is a closed line object.

Setups A setup is the source of any measurement
observation.

Observations An observation is the measurement that defines
the source of a point.

GNSS Tracks A GNSS track is an object resulting from pro-
cessing moving or mixed data.

Traverses A traverse is a series of intervisible points at
which angles are measured and also distances
can be measured, to determine the station
setups.

Sets of Angles A set of angles are a series of observations that
are reduced to an angular value. The angular
value is then coordinated from the source of the
observations.

Surfaces A surface is a triangulation network representing
points, cloud points, lines and areas.

Point Cloud
Groups

A point cloud group is a defined group of point
clouds that represents a single object, used for
cleaning or surface creation.

Objects, Point Roles
and Symbols
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Sym-
bol

Object Description

Point Clouds A point cloud is a measurement object from the
data source.

Image Groups An image group is a defined group of images
that you can measure image points from.

Images An image is a picture captured that is represen-
ted by its position or object it is assigned to.

Georeferenced
Images

An image that has been ortho-rectified and can
be placed in the project coordinate reference
frame.

Alignments The alignment is a linear object made of mul-
tiple segments geometrically defined and joined
together.
It defines the route of a road construction, gen-
erally its centreline or axis.

Roads A road is made of several objects including a
centreline and a material layer. The material
layer describes the stringlines assigned to it.

Material Layers Are the layers constituting a road. A material
layer groups a set of stringlines that belong to
the same level, material or phase of construc-
tion.

Cross Sections A cross section is a slice or cut at a certain
chainage of the road, displaying the position of
different linear features connected together in a
cross section view.

Cross Section
Assignments

Result from cross sections templates being
assigned to a road. Stringlines result from inter-
connecting cross section assignments.

Stringlines Are special line objects that can either be impor-
ted from CAD or defined through cross section
assignment.

Scan Setup A setup belonging to a BLK360, RTC360 or
RTC360LT.

Scan Group A group of scan setups that have been joined
together by links.

Registration Link A line shown between two scan setups to sym-
bolise that they have been joined by visual align-
ment or target matching.

Used Registra-
tion Target

A target that has been used to join setups by
target matching.

Unused Registra-
tion Target

A target that has not been used to join setups
by target matching.
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Interval Icons for GNSS Tracks:

Sym-
bol

Object Description

Static Interval This icon indicates that GNSS raw data is
acquired with static mode.

Moving Interval This icon indicates that GNSS raw data is
acquired with kinematic mode.

Mixed Interval This icon indicates that GNSS raw data is
acquired with alternating static and kinematic
modes.

Point Roles and Point Symbols:

Sym-
bol

Point Role Description

Control Point
(not fixed in
adjustment)

Is a control point that is not considered for
adjustment and not fixed.

1D Control Point
(fixed in height)

Is a 1D control point that is considered for
adjustment, fixed only in height.

2D Control Point
(fixed in position)

Is a 2D control point that is considered for
adjustment, fixed only in position.

3D Control Point
(fixed in position
and height)

Is a 3D control point that is considered for
adjustment and fixed in position and height.

Adjusted Meas-
ured Point

Is a measured point adjusted by the least
squares method or in a traverse computation.
The adjusted least squares point role, include
the adjustment method 3D, 2D or 1D.

Station Setup Is a point on which a station setup exists after
import of field data.

Averaged Point This point is derived by averaging two or more
measured points.

TPS Reduced
Measurement

This point is generated from the reduced obser-
vation computed from sets of angles, reduced
foresights or a traverse.

TPS Measured
with Reflector

Is a point that has been measured using a
reflector.

TPS Measured
Reflectorless

Is a reflectorless measured point.

TPS Measured
with Reflector
(compensated)

Is a tilt compensated point that has been meas-
ured using a reflector and the Leica AP20 sensor.

TPS Measured Is a point that has been measured without
instrument EDM information.
Typically, such points are imported from XML.

TPS Measured
Setup Point (with
reflector)

Is a control point used in a Setup application and
a measurement has been taken with reflector
EDM.
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Sym-
bol

Point Role Description

TPS Measured
Setup Point
(reflectorless)

Is a control point used in a Setup application
and a measurement has been taken with reflect-
orless EDM.

Fixed Real-Time
Kinematic (RTK)/
Fixed PP

Is a GNSS RTK measured or post-processed
phase fixed point (most accurate).

xRTK/Widelane
PP

Is GNSS xRTK measured or a widelane post-pro-
cessed phase fixed point.

PPP Converged Is a GNSS point measured with precise point
positioning, final position converged.

Float RTK/Float
PP

Is a GNSS RTK measured or post-processed point
with float solution (less accurate).

PPP Converging Is a GNSS point being measured with precise
point positioning, final position not yet con-
verged.

Code RTK/Code
PP

Is a GNSS RTK measured or post-processed point
with code solution (least accurate).

Navigated RTK/
Navigated PP

Is a GNSS RTK measured or post-processed point
with lower accuracy. It is measured without
using a reference station.

 ☞ When the GNSS point roles have got a green background,
this indicates a tilted measurement.

GNSS Measured Is a measured GNSS point with unknown solution
type.
Typically, such points are imported from XML or
SKI ASCII.

GNSS Track Post-
Processed

Is a post-processed GNSS track (using a refer-
ence station).

GNSS Track Nav-
igated

Is a post-processed GNSS track computed by
applying the SPP technique (without using a ref-
erence station).

GNSS Track Aver-
aged

Is a GNSS track derived by averaging two or
more post-processed tracks.

Level Measured Is a point measured by level staff.

Offset Point Is a point for which an offset observation has
been measured or entered.

Auto Point Is a point measured with the auto points applic-
ation.
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Sym-
bol

Point Role Description

Computed Point Is a point calculated by an application and not
measured with an instrument.

User-entered
Point

Is a manually entered point.

Point (unknown) Is a point for which no point role can be defined
on import.
Typically, such points are imported from XML.

Point (deleted) Is a point which has been deleted on the instru-
ment and could be recovered.

1.3.4 Shortcut Keys in Infinity

Graphical view:

Action Result

Ctrl+/Ctrl-
or move mouse wheel

Zooms in/out.

Alt+Ctrl+/Ctrl-
or Alt+move mouse wheel

Locks zooming to the pivot point.

Right, left, up or down arrow
or press the mouse wheel and move
it

Shifts the view (pan the view).

Click into the view with the left
mouse button
+dragging the mouse

Rotates the view.

Ctrl+R Turn on/off look around.

Selecting elements:

Action Result

Single left mouse click onto an ele-
ment

Selects the element.

Ctrl
+single left mouse clicks onto ele-
ments

Selects a series of elements.

Shift (↑)
+single left mouse clicks into back-
ground

Draws a polygon and selects all ele-
ments inside.

Shift (↑)+left mouse button
+dragging the mouse

Draws window and selects all ele-
ments inside.

Shift (↑)+Ctrl
+dragging window/drawing polygon

Selects all elements outside the win-
dow/polygon.

Lighting of shaded objects:

Action Result

I+moving the mouse wheel Adjusts the overall intensity.

K+moving the mouse wheel Adjusts the key light intensity.

Shortcut Keys in
Infinity
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Action Result

F+moving the mouse wheel Adjusts the fill light intensity.

B+moving the mouse wheel Adjusts the back light intensity.

A+moving the mouse wheel Adjusts the ambient light intensity.

1.3.5 Window Behaviour

The overall Infinity user interface is designed such that the graphical 2D/3D
view is always available in the background. The other three main windows (the
navigator, the inspector and the property grid) can individually be made to be:

Floating:
Select the window with a left mouse-click onto its title bar and drag it out of
its place. It is undocked from its place and becomes a floating window.
To dock it again, select the floating window with a left mouse-click onto its
title bar and drag it to one of the docking places that appear when you start
moving the window. Drop it with the mouse pointer onto the desired docking
area and the window is docked in the frame of the opaque yellow area.

Illustration of docking places:

☞ To enlarge the available space for the graphical view, floating win-
dows can comfortably be moved to a second monitor.

Hidden:

Hide the window by either selecting  in its title bar or by selecting its

option  in the status bar. The option frame disappears to indicate

that the window is hidden: 

To make the hidden window visible again select the option again in the status
bar.

1.3.6 Customising Colours

Code and layer colours can be customised.

Window Behaviour

Customising Colours
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To customise a colour:
 

1. Select Home, then Layer Manager and select the object to be cus-
tomised.

2. From the drop-down menu, select Show Customise Colour.

3. You can choose between RGB (Red-Green-Blue) colour definitions or
HSB (Hue-Saturation-Brightness) from the drop-down list.

4. Drag the inner circle to the area of the desired colour spectrum.
☞ You can also enter the ID of a specific colour or its

RGB/HSB parts.

5. Move the circle in the bar at the bottom to change the brightness.

6. Set the selected colour by selecting the square in the top left corner
of the customisation area.

1.3.7 Working with Coordinate Systems

1.3.7.1 Overview

Each Infinity project can support many coordinate systems. These coordinate
systems can be imported from data sources such as SmartWorx jobs or copied
into the project from the global objects list. Since multiple coordinate systems
can exist in the project, the project has settings to define how the coordinate
systems are used. The project can have a single coordinate system which is
used to project all project data to the same grid positions or each data source
can use its own coordinate system to project the data that belongs to that
imported data source.

☞ Coordinate systems are global objects.

Master Coordinate System
The master coordinate system is what the project is defined to use.
If a coordinate system is chosen when creating a new project, then this is
called the master coordinate system. This master is used to project all data
to the common grid reference frame. All WGS84 data is projected to local grid
values and all local grid values can be converted to WGS84. You see this when
working with the project, from the status bar.

Working with
Coordinate Systems
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☞ When you are exporting data to various formats, it is important to
have a master coordinate system set for your project data so all the
data is on the same reference frame.

Data Source Coordinate Systems
For many data sources, it is possible that they include their own coordinate
system. Importing a SmartWorx job could have a coordinate system as used on
the field instrument. You see this in the data source properties if a coordinate
system is included.
It is possible to view each coordinate system as was used on the field sensors
by choosing None in the status bar. This can be useful to identify potential
problems between different data sources.

Using the Coordinate Systems

Master Coordinate
System

What you see with project data when a master
coordinate system is in use:
• WGS84 entered points are convertible to local

grid unless they fall outside the projection limits
of the selected coordinate system.

Data source Coordin-
ate Systems

What you see with project data when no master
coordinate system is in use and if no coordinate
system is assigned to the data source:
• WGS84 entered points are not convertible to

local grid. They are not displayed in the graphic
view and are indicated with this icon: .

• Point averaging results only include the local grid
values if available:
• When only WGS84 coordinates exist for that

point ID, then the average is computed in
WGS84.

• When one or more local coordinates exist
for that point ID, then the average only con-
siders the local grid points.

• Exporting data might not include the coordin-
ates as expected.

See also:
Coordinate System Properties

1.3.7.2 Coordinate Systems inside a Project

You can import one or more coordinate systems to your current project either
together with SmartWorx DBX jobs or independently of raw data as transform-
ation sets stored in TRFSET.dat files or from LandXML.

Coordinate Systems
inside a Project
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All imported coordinate systems are automatically:
• Stored to the project.
• Available for selection in the job properties, the ASCII file properties, the

project settings (Info & Settings) and the status bar.
• Listed in the Coordinate Systems tab of the Inspector.

Job Coordinate Systems and ASCII/SKI ASCII file Coordinate Systems
In the job property grid you can choose a different coordinate system to be
attached to the source data of a job.
In the ASCII/SKI ASCII file property grid, you can choose a coordinate system to
be attached to the source data of an imported ASCII/SKI ASCII file.
All coordinate systems stored with the current project are available for selec-
tion.
1. In the navigator, go to the Source section and select the job/ASCII

or SKI ASCII file to which you want to attach a different coordinate
system.

2. In the property grid, select a different coordinate system from the
drop-down list.

☞ If you select None no coordinate system is used with the selected
job/ASCII/SKI ASCII file.

☞ Directly after import ASCII/SKI ASCII files always have the coordinate
system None. Attach a coordinate system to be able to use individual
coordinate systems with each set of imported raw data, be that jobs
or ASCII files, in your project.

If you want to make the coordinate system of the selected job globally avail-
able under File > Tools > Coordinate Systems:

Select the  Export to global option.

Inspecting Coordinate Systems
In the Coordinate Systems tab of the inspector all coordinate systems that
are stored with the current project are listed.

You can:

• Remove coordinate systems from the project.
Select one or more than one coordinate system, right-click into the
selection and select  Delete from the context menu.

Alternatively, select the  option in the top left corner of the main
window.

☞ You can only delete, for example coordinate systems which are
not in use.

☞ Removed coordinate systems are still available in the global
coordinate system management under File > Tools > Coordinate
Systems.
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• Export coordinate systems to the global coordinate system manage-
ment under File > Tools > Coordinate Systems.
Select one or more than one Coordinate System, right-click into the
selection and select  Export to Global from the context menu.

• Inspect the properties for each coordinate system including geoid and
CSCS models.

• See whether a coordinate system is In Use  and/or in use as a Mas-

ter .
Coordinate systems are in use when they are attached to one of the
jobs that have been imported to the project.
A Coordinate system is the master when it is selected either in the info
& settings or from the status bar to be used with all data in the project.

☞ The master coordinate system may not be in use with one of the
jobs.

☞ If no master is selected (for example, None is chosen in the
status bar) then the data of each job/ASCII file is displayed using
its own coordinate system.

Coordinate systems can be modified in the property grid.

Exporting Coordinate Systems:
If you export a project to DBX, LandXML or HeXML always the master coordin-
ate system is exported with your data. If None is used then your data is
exported without any coordinate system information.

To Export all Coordinate Systems from a Project:
Select to export coordinate systems in the data export dialog to export all
coordinate systems that are available with the current project and save them
to the same TRFSET.DAT file.

See also:
Data Export

1.3.7.3 Coordinate System Properties

To view and edit the coordinate system properties:
Go to the Coordinate Systems tab of the inspector and select a coordinate
system from the list.

Coordinate System
Properties
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In the property grid:

• Select the  Export to Global option if you want to make the selected
coordinate system be globally available under File > Tools > Coordin-
ate Systems.

☞ The option is inactive if the selected coordinate system is already
available under File > Tools > Coordinate Systems.

• Select the  icon to get detailed information on the transformation,
ellipsoid and projection used with the coordinate system in a fly-out.

• Select the  icon to get detailed information on the geoid model or
the CSCS model used with the coordinate system. Import a geoid or
CSCS model if required or select a different one from the drop down-
list.

☞ Only Geoid/CSCS models that are valid for the selected coordinate
system are available for selection. Their names can be modified if
required.

• Leave the Property Grid with Apply to take over your changes.

To import Geoid/CSCS Model:

In the Geoid/CSCS Model fly-out:
1. Select the  option to browse for and select a geoid field file

(*.gem) or a CSCS model (*.csc). Their names can be modified.

2. Leave the fly-out with OK to add the geoid/CSCS model to the drop-
down list.

3. The newly imported model is selected automatically. Select None if
you want no geoid or CSCS model to be used with the coordinate
system.

4. Leave the fly-out with OK to apply your modifications. The inspector
view is updated accordingly.

☞ Only Geoid/CSCS models that are valid for the selected coordinate
system can be imported.
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2 Basic Modules
2.1 File

2.1.1 Overview

The file tab includes all the backstage functionality.

Here you can do the following:
 

Name Description

Save as Template Save the current project as a template.

Data Import Import many different data formats.

Data Export Export all or selected data to many different
formats.

Info & Settings Adapt the settings for the Infinity project.

Welcome See all your recent projects and read Leica news.

New Project Create a new Infinity project.

Project Manager See and manage all your projects in one place.

Tools Manage or create Infinity global objects.

Services Access services from Leica, Hexagon and third
parties.

Preferences Under preferences, you can configure global applica-
tion settings.

Help & Support Access Infinity training materials as well as the local-
isation tool.

About Get Information about your licence and installed
Infinity version.

2.1.2 Save as Template

Save the current project as a template. When you save a project as a template,
all project settings as well any data in the project are saved in the new tem-
plate file (.iprjt). The new name is added to the template list, to select when
creating a new project.

File

Save as Template
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☞ Good practice is to create a project template when having to work
with different coordinate systems, project units and code tables you
commonly use.

☞ The default project template is from the user settings which were set
using the Save as Project defaults option in an older version of
Infinity.

 

Project templates can be deleted from the selection list, when creating a new
project.

 

2.1.3 Info & Settings

In this section of the file tab, you can find information on the settings for the
Infinity project that you are currently working on. You can adapt the settings
to your personal requirements.

Project Details and Project Customer & Details
View and/or edit the project details and project customer details as set when
you created a project under File > New Project.

See also:
New Project

Feature Coding
Choose a different Code Table to be used with the current project. Select
Apply to make your changes become effective in the current project.

Info & Settings

Project Information
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Units
Decide on your preferred distance, area, volume and angle units and the
decimal places to be available.
Decide on your preferred temperature and pressure units and the decimal
places to be available.
Choose the coordinate order you prefer. Available are easting/northing or
northing/easting.

☞ Your choice is applied to the listing of coordinates in, for example,
the wizards or the property grid. It does not apply to the content
views, though, where a change in the column order can be achieved
by drag and drop of columns.

Coordinate Systems
Choose one of the coordinate systems that are stored with the project to
be used as the master. Coordinate systems are either stored to a project
automatically by being imported together with raw data or can be  copied
to a project manually from inside the global coordinate system management
under File > Tools > Coordinate Systems.
The coordinate system you choose is used for converting between WGS84 and
local coordinates.

See also:
Coordinate Systems inside a Project
Coordinate Systems
Choose None if you want each job to be converted using its own coordinate
system.

☞ If you want a different coordinate system to be attached to a job
then change the job properties accordingly in the property grid.

View information on the transformation and residual distribution, on the
ellipsoid and projection as well as on the geoid and CSCS model used with the
selected coordinate system. A different geoid or CSCS model can be selected
in the coordinate system properties.

See also:
Coordinate System Properties

Coordinate Display
Choose local if you want Infinity to hide WGS84 coordinate representations in
the inspector, the property grid and the graphical view. Only WGS84 observa-
tions which can be converted to local grid shows up in the graphical view.
Choose Local and WGS84 if you want Infinity to output local grid and WGS84
coordinates. To display local grid coordinates is by default always selected.
You can additionally select geodetic and/or cartesian coordinate representa-
tions to be output in either local and/or WGS84 if available or convertible. The
inspector shows the additional columns. In the property grid switch between
representations by selecting a different output.

☞ To be able to convert coordinates from one format to another, a
coordinate system must be selected to be used with the project data.

Coordinates & Units
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Coordinate Direction
Choose to switch the northing and/or easting.

Point Averaging Settings
Define the maximum distance allowed between an average and the measure-
ments from which it has been computed.
Define whether weighted averages shall be computed for the current project.
The setting is applied to points and GNSS tracks.

☞ For GNSS tracks the average is computed with respect to the solution
type.
Meaning that if a phase fixed solution and a code solution shall be
averaged automatically, the phase fixed solution is taken into account
while the code solution is ignored.

Angle Reduction Parameters
Define the angle residuals and slope distance residuals to be allowed when
computing sets of angles.

☞ The tolerance settings can also be changed for single computation
runs in the sets of angles wizard or for single targets once a sets of
angles computation is completed. To change the tolerances for single
targets select the  option in the Observation section of the Sets
of Angles Target properties. The tolerances shown correspond to
the last used, but can be changed for single targets if necessary.

Define the maximum face differences to be allowed when computing sets of
angles.

Image Point Tolerances
Defines the maximum 3D accuracy allowed for the computed image points. If
the 3D accuracy is outside of this value, no point is computed.
You can always reset your changes to the factory defaults.

Define the stakeout tolerances.

☞ Defaults are available.

When you import stakeout data to Infinity then the delta values that exceed
the defined tolerances are marked in red bold in the stakeout report.

See also:
Reports

Define the checked tolerances.
Δ Azimuth - Is the difference between the calculated azimuth and the current
orientation.
Δ Hz Distance - Is the difference between the calculated and the current
horizontal distance.
Height Difference - Is the difference between the calculated and the current
height.

☞ Defaults are available.

Points & Angles

Staked Points

Checked Points
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When you import checked points data to Infinity then the delta values that
exceed the defined tolerances are marked in red bold in the checked points
report, as well as the TPS inspector.

See also:
Reports

Default Traverse Adjustment Parameters
Define the default parameters for adjusting traverses like method and balan-
cing.
Decide whether you want to apply scale to observations.

Tolerance Checks in Traverse Wizard
Define which tolerance checks shall be used in the traverse wizard and enter
different values for the limits.

Station Difference before and after Adjustment
Define the maximum allowed difference between stations before and after the
adjustment computation.
The changes you make here are used as defaults in the traverse wizard. You
can always reset your changes to the factory defaults.

☞ For entering different values for tolerance checks, the available
decimal places should be set to at least five positions after the
decimal point for angles and three for distances.

For detailed information on single parameters, see:
Traverse Processing Parameters

The sections data and processing strategy, correspond to dialogs in the GNSS
processing module.

See also:
Settings: Data
Settings: Strategy
Settings: Advanced

☞ The defaults used in the advanced settings are suffice in most cases.
Only modify them if you are an advanced user and have special data
to be processed.

The section time, sets the time format used in the Inspector > Intervals
View.

See also:
GNSS Intervals
The section Computation, steers automated behaviour that follows a compu-
tation.
You can also decide whether navigated tracks are processed on import. Only
when this setting is active are GNSS tracks automatically recognised as data
objects on import.

Data Processing: TPS

Data Processing:
GNSS

Basic Modules 39



Level Line
Define the default level line adjustment method - By distance or equally.
Set the default tolerance values to flag the line information before applying
adjustment.

Observations
Set the default tolerance values to flag the observation information to help
identify data issues.

Point Heights
Set the default tolerance values to flag the height differences to be applied to
the points.

Staff Corrections
Set the default staff correction values that could be applied in a level line
adjustment.

Cloud-to-Cloud
Define default parameters for the cloud-to-cloud routine including max. itera-
tions and search radius. The max. points density and normal threshold can
also be set in this section.

Targets
Define default parameters for the match targets routine including max. target
error and prioritise targets.

Unified Point Cloud
Define the default parameter for the max. number points.

Registration Tolerances
Define the flagging tolerances for a number of registration metrics in the
application and scan registration report.

☞ See Point Cloud Registration Settings for descriptions on individual
settings.

General
Set the general parameters for adjustment computations and iterations.

Test Criteria
Define the Test Criteria to be used in adjustment computations.

Advanced Terrestrial Parameters
Decide whether reduced observations and/or refraction coefficients and scale
factor corrections shall be used.
Define the values for the refraction coefficients and scale factor corrections.

Coordinate System
Decide on the coordinate system and the height mode in which your observa-
tions shall be adjusted.
Define rotations about the axis and a scale if necessary.

Data Processing:
Level

Registration

Network Adjust-
ments: General
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The changes you make here are used as defaults in the adjustments module
of your project. You can always reset your changes to the factory defaults.

☞ For entering different values, the available decimal places should be
set to at least five positions after the decimal point for angles and
three for distances.

For detailed information on single parameters see:
General Adjustment Settings
Test Criteria
Advanced Terrestrial Parameters
Coordinate System Settings

TPS
Define standard deviations and centering and height errors for TPS observa-
tions.

GNSS
Define standard deviations and centering and height errors for GNSS observa-
tions.

Level
Define standard deviations and centering and height errors relative to the level
data.

Meshing
Define the Max. Triangle Size and the Min. Triangle Size for the surfaces
created with the refined, regular and 2.5D method.

☞ Occasionally, triangles can exceed the maximum and minimum
defined size. This may occur when the surface must be continuous,
for example while creating a watertight mesh. Like for example on
surface boundaries, the triangle size may exceed the defined max-
imum and minimum size to produce a more reasonable and realistic
shape of the surface.

Fill Holes
Fill Interpolation - Define the method. The level of interpolation uses sur-
rounding surface geometry to determine the number of extra triangles to
create between hole edges.

Contours
Minor Interval - Define the distance between contour lines that are drawn.
Major Frequency - Define when a major contour is drawn. Usually this setting
is set at five or ten.
Min. Length - Define the minimum contour length. Contours shorter than this
value are not created.
Smoothing - Define the degree of smoothing applied to the contour lines.

Cut Fill
Cut Definition - Define if the cut positive values are referring to the material
Above Reference or Below Reference.

Network Adjust-
ments: Accuracy

Surfaces & Contours
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Cut Fill/Comparison Map
Define the Type of cut fill and comparison map. Should only differences in the
height be calculated (Height Difference) or if a value above and below the
reference should be used for calculation and visualisation (Tolerance).

☞ If Tolerance is selected for the Type, then define the Upper Toler-
ance, Lower Tolerance values and the Min. Segment Distance.

Then define the Colour Mode, Colour Ramp and the Colour Transition.

The copy from CAD settings can be set separately for points, lines, areas,
surfaces, alignments and roads.
Define the point role that points copied from CAD shall have. Choose between
User-entered or Control.
Define a naming scheme (a prefix or a suffix) that entities copied from CAD
shall have.
Separate prefixes and/or suffixes can be defined for points, lines, areas, sur-
faces, alignments and roads.
Decide if/how the imported entities shall be coded.
A code table needs to be defined.

☞ Surfaces and roads cannot be coded.

Decide on which layer the imported entities shall be:
• By default the layer structure is taken over from the source file.
• If the source file does not have layer information, then the entities are

imported to a default layer.

☞ If a code table is defined and codes are assigned to layers, then layer
selection is blocked.

Define how heights shall be managed for points copied from CAD.
Define a default height that 2D objects shall get.
You can also specify a height to be excluded. Entities with that height are
copied either as 2D objects (with no height) or they get the specified default.

☞ Defaults can be restored separately for points, lines, areas and sur-
faces.

General
Choose the way and with which precision chainages are displayed in the
graphical view, inspector and the property grid.
Choose major interval and minor frequency to define how the alignment shall
be segmented visually.
Define your own abbreviations for horizontal and vertical points of interest.

Road
Set the tolerance thresholds for the maximum deflection angle that two con-
secutive elements are allowed to have in a horizontal or vertical alignment.
Exceeding values are flagged in the application and reports.
The stringline chord tolerance defines the spacing used for digitizing
stringlines.

Copy CAD to Library

Infrastructure
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Curves need to be digitised as a sequence of straight segments and the toler-
ance defined here is used for it.

☞ Angular and metric units can be changed under Coordinates & Units.

2.1.4 Welcome

In welcome you see:
 

No. Name Description

1. Shortcuts Shortcuts allow you to create, for example,
new projects, code tables, coordinate sys-
tems or to access help & support or about
pages.

2. Projects Open recent or pinned projects.
☞ There is a preview for a project if

it has been opened once.

3. News Information about various Leica product
releases including hardware and software, as
well as blog posts, new videos on YouTube
and new tutorials.

2.1.5 New Project

New projects can only be created from inside the file tab.

Welcome

New Project
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To create a new project:
 

1. Go to the File tab and select New Project from the menu on the
left.

2. Define the Project Template.

☞ The default project template is from the user settings which were
set using the save as project defaults option in an older version of
Infinity. For more information, refer to Save as Template.

3. Define the Project Details:
• Give the project a unique Project Name.
• Optionally, fill in the details on the Surveyor.
• Optionally, add Comments and Tags.

4. Optionally, fill in Customer Details.

5. Define the Storage information, for example where to store the
project and if you want to create project subfolders.
Project subfolders provide a clear folder structure to organise the
following data:
• Data sent and received through ConX.
• Data sent and received through Leica Exchange.
• Exported data from Infinity.
• Imported data to Infinity.
• Reports generated within Infinity.

6. Optionally, choose a Code Table to be used with the project. To be
able to do so, at least one code table has to be globally available
from the File > Tools > Code Table Management.
It is copied to the project. If there are no global objects yet, leave as
None.

7. Define Units for various measurement types.

8. Optionally, choose a Coordinate System to be used with the
project. To be able to do so at least one has to be globally available
from inside the File > Tools > Coordinate Systems.
It is copied to the project. If there are no global objects yet, leave as
None.

9. Choose from the Coordinate Display which coordinate format you
want to see in the project.
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10. Set the Coordinate Direction which switches the coordinate sys-
tem axes for the northing, easting or both. For example, used in
South Africa.

11. Select the  Create option to create and open the new project in
the home module.

2.1.6 Project Manager

The whole data and object management in Infinity is done in working units
called projects. Each project uses its own database. The same data and objects
may belong to and can be handled in different projects. Start the project
manager from the file tab.

In the project manager you can do the following:
 

No. Name Description

1. Load Open an existing project in Infinity so you
can carry on working on it. A single click on a
project selects it and a double-click loads it.

2. Delete Delete the selected project and all the data
within it. There is no undo option!

3. Unregister Remove an existing project from the project
manager list. Does not delete the project.

4. Register Browse to an existing Infinity project file
(.iprj) to add it to your list of projects.

5. Order by The list of Infinity projects can be ordered
by:
• Project name (alphabetical order).
• Date the project was last used.
• Date the project was created.

6. Search box Search for any part of a project name.

7. Pin project Pin the project to have it always available on
top of the project list. Pinned projects also
appear on the Welcome page.

See also:
Save as Template

Project Manager
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2.1.7 Tools

2.1.7.1 Overview

Tools are available to manage the following global objects:
 

No. Name Description

1. Code Tables Has a collection of codes and attributes.
New Infinity code tables can be created here.

2. Targets Manage prism constant values.

3. Antennas Manage antennas.

4. Coordinate Systems Manage coordinate systems.

5. Georeferenced 
Images

Manage georeferenced images.

☞ Any edit we do in tools is on the global objects. Changes to these
global objects do not affect any existing projects. But any new
project that we create uses the updated global objects.

See also:
Local and Global Data Objects

2.1.7.2 Code Tables

The code table is to manage the list of code groups, codes, attributes and
styling information including layers, blocks and custom line styles.
A codelist can be generated in the code table and transferred to the field soft-
ware. When measurements are made, the details of the features like codes
and attributes, are recorded and stored with the measured point. Everything
can be considered a feature, a building, a fence, a road, a bench, or even a
tree.
The code table applies automatically the correct style to the imported field
data.

Use feature coding to help increase productivity both in the field and
the office by:
• Having features described.
• Visualising the data in the software.
• Simplified CAD export.

Tools

Code Tables
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In code tables you can do the following:
 

No. Name Description

1. New Create a new code table.

2. Delete Delete an existing code table, including
existing codes and attributes.
☞ There is no undo function.

3. Import Import an Infinity code table from an *.lic
file.
☞ To import a codelist from Leica

field software, a new Infinity code
table must first be created and
edited it in the Code Manager.

4. Export Export an Infinity code table to an *. lic file.
☞ A code table, can be exported as

a codelist to Leica field software,
from inside the Code Manager.

5. Localise Open the Localisation Tool and download
code tables from the available global or
national list.

6. Edit Open the Code Manager to add/edit codes
and its attributes as well as layers, line styles
and blocks.

See also:
Code Manager
The video "Leica Infinity – Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity – Feature Coding Part 2 - How to use blocks and
layers" https://www.youtube.com/watch?v=REYP8JzmaSs
The video "Leica Infinity – Feature Coding Part 3 - How to use custom
line styles" https://www.youtube.com/watch?v=ze9ganVf6AU
The video "Leica Infinity – Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ
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2.1.7.3 Code Manager

2.1.7.3.1 Overview

The code manager allows you to manage all feature coding information
included in code tables:
• Coding information (code groups, codes and attributes).
• Coding style information (blocks and layers), which are extended code

properties used for visualisation.

To open code manager :
1. Go to File, then select Tools and then Code Tables.

2. Select one or create new and select Edit.

In code manager you can do the following:
 

No. Group
Name

Name Description

1. Data Import Import codes from available format files.

Export Export a codelist to various format files
or a code table.

Reports Open either code report or code table
report.

2. New Code Group Create a new code group.

Code Create a new code.

Code Attrib-
ute

Create a new code attribute.

Layer Create a new layer.

3. Edit Delete Delete selected objects.

Convert to 
Line/
Area Code

Convert a point code with linework to a
line/area.

Convert to 
Point Code

Convert a line/area code to point code
with linework.

4.  Layers and 
Blocks

Import layers and blocks from DXF/DWG
CAD files.

5.  Line Styles Import custom line styles from LIN files.

Code Manager
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See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity - Feature Coding Part 2 - How to use blocks and
layers" https://www.youtube.com/watch?v=REYP8JzmaSs
The video "Leica Infinity - Feature Coding Part 3 - How to use custom
line styles" https://www.youtube.com/watch?v=ze9ganVf6AU
The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.2 Import

The code table content can be built by importing:
• Code Tables (*.lic) or (*.xcf).
• SmartWorx Viva, Captivate Job -DBX.
• HeXML/LandXML- XML.
• ESRI Geodatabase.
• Trimble -FXL.
• FlexLine - CLS.

To import codes from existing sources:
 

1. Open the Code Table and select Import.

2. Navigate to the file you want to import and select it.

3. Select Import.

4. Select OK to save the changes and to close the Code Manager.

☞ After importing a codelist, you may add coding style properties to the
imported codes.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA

2.1.7.3.3 Export

Import
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The code table content can be exported to:
• SmartWorx Viva, Captivate Job - DBX.
• SmartWorx, System1200, GPS 900 - DBX.
• HeXML- XML.
• Zeno Data Model -ZDM.
• Trimble -FXL.
• FlexLine - CLS.
• Infinity Code Table - (*.lict).

To export a code table or codelist:
 

1. Open the Code Table that you want to export.

2. Select Export and select the format.

3. In the Select Folder window, select the location to save the file.

4. Select OK.

5. Select OK to save the changes and to close the Code Manager.

See also:
Code Manager
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA

2.1.7.3.4 Code Group

Code groups are the primary building blocks of a code table and describe
groups of objects, which have a common theme. For example, utilities, veget-
ation, buildings or roads. Grouping helps to manage codes by activating or
deactivating groups on board the instrument.
A code table may have as many code groups as you define. Each code group
then has subcomponents known as codes and attributes.
Code group names may be up to 16 characters long and may consist of alpha-
numeric characters.
You can add new code groups, modify existing code groups and Delete code
groups.

Export

Code Group
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To add a new code group:
 

1. Select the Code Table in the Code Manager.

2. Select Code Group.

3. In the content area, a new group is created with default settings
that you can modify.
☞ A Code Group Name must be unique and may be up to 16

characters long.

☞ A description is optional.

4. Select OK to save the changes and to close the Code Manager

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.5 Code

Codes are parts of code groups and are used to describe objects. A set of
codes with a common theme is grouped into a code group. For example,
the codes tree, hedge and grass, may be attached to a code group entitled
vegetation.

There are two methods for feature coding:

Name Description

Thematical
codes

Can be assigned to points, lines and areas.

Free codes Purely time-related information recorded in-between meas-
urements in the field. A timestamp is recorded with each
free code allowing a chronological order of export points
and free codes to be used for third-party mapping software.

Code
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To add a new code to the code group:
 

1. In the Code Manager, select the Code Table tab.

2. Select the code group to which you want to add a new code in the
navigator view.

3. Select Code from the ribbon bar

4. In the content area, a new code line is created with default settings
that you can modify.
☞ In the Attributes, you can see how many attributes the

code has.

5. Select OK to save the changes and to close the Code Manager.

A code consists of:

Group Name Name Description

Coding
Information

Code Name May be up to 16 characters long and may
consist of numbers or alphanumeric charac-
ters (for example tree).

Code
Description

May be up to 16 characters long and may
consist of alphanumerical characters (for
example outstanding tree).
☞ The description of a code is

optional.

☞ For Leica Captivate V2.30 and
higher, the allowed length is 48
characters when ASCII characters
are used. If other than ASCII char-
acters are used, then it depends
on the character set whether
longer names are truncated on
export.
Codelists and jobs with names
longer than 16 characters cannot
be imported to any Infinity version
lower than 2.4.

Type Can either be point, line, area or free.
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Group Name Name Description

Quick Code Must be unique within a code table and
up to three alphanumeric characters are
allowed.
☞ To define a quick code is optional.

Linework Is only available for codes type point and it
can be either none, start line or start area.

Coding Style
Information

Layer Enables grouping of codes by theme. For
example, the codes kerb, canter line and
pavement can be grouped in the same layer
called road.

Style Option Can be either by layer or by code. This
option allows you to set if the code uses
its own style in the project or uses the style
from the layer.
For example, the codes kerb and pavement
(type line) can use different colours. Both
can be assigned to the same layer called
road. When you select the by code option,
they are presented in the project with their
own colour. When you select the by layer
option they are presented with the same
colour defined for layer road.
☞ This option is not available for free

codes.

☞ By code is not available for the
point code if linework is set to
none.

Block Geometry objects used to represent fea-
tures. For example, a CAD block represents
a tree or a signpost.

Line Colour Is available for code types point/linework
(start line/start area), line, area.

Line Width Is available for code types point/linework
(start line/start area), line, area.

Line Style Is available for code types point/linework
(start line/start area), line, area.

Shading Col-
our

Is available for code types point/linework
(start area), area layer.

There is no limitation for the number of codes. You can add new codes,
modify existing codes and delete codes within a code group.
Each code may have attributes attached to it. Attributes prompt you to enter
further information about the code.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
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The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.6 Code Attribute

Attributes are the tertiary building block of a code table. Attributes prompt
you to enter information describing a code. You can add new attributes,
modify or delete existing attributes of a code.
For example, attributes for the code tree could be species, diameter and
remark.
Each code may have one or more attributes attached to it. Attributes are
the tertiary building block of a code table. Attributes prompt you to enter
information describing a code.
For example, the code tree could have the attributes diameter, species, height,
and remark attached to it. You may then define an attribute value for an
attribute. It may be chosen from a predefined choice list or a predefined
range. For example, possible values for the attribute diameter could be from
a range from 1 to 25 metres and the attribute species from a choice list that
has the values pine, fir and oak.

☞ You do not have to define an attribute value within code manage-
ment. If no value is defined for an attribute you may enter a value or
description in the field.

To add new attribute:
 

1. In the Code Manager, select the Code Table tab.

2. Select the code to which you want to add a new attribute in the
navigator.

3. Select Code Attribute from the ribbon bar.

4. In the content area, a new attribute is created with default settings
that you can modify.
☞ To copy attributes between codes use Ctrl C and Ctrl V.

5. Select OK to save the changes and to close the Code Manager.

Code Attribute
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An attribute consists of:

Name Type Description

Attribute
Name

 The Attribute Name may consist of alphanu-
meric characters and may be maximum 13
characters long.
☞ For Leica Captivate V2.30 and

higher, the allowed length is 48
characters when ASCII characters
are used. If other than ASCII char-
acters are used, then it depends
on the character set whether
longer names are truncated on
export.
Codelists and jobs with names
longer than 16 characters cannot
be imported to any Infinity version
lower than 2.4.

Attribute
Type

Normal The attribute value can be edited in the field.

Mandatory The attribute value can be edited in the field.

Fixed No value is shown on the instrument and
the default value is automatically attached
to the attribute.

Value Type Text Possible values may only be entered in a
choice list. For example, for the attribute
species choose text as the value type.

Real You have the possibility of entering a choice
list or a range of possible values.

Integer You have the possibility of entering a choice
list or a range of possible values. For
example, for the attribute diameter choose
integer as the value type.

Value
Region

None For example, for the remark attribute choose
none.

Range Enter or modify the interval (range from/to).
For example, for the attribute diameter a
range from 1 to 5 metres could be defined.

Choice List Enter or modify a list of possible attribute
values. For example oak, pine and fir could
be possible choice list entries for the attrib-
ute species.
• To add new values to the choice list

select Add.
• To remove values from the choice list

select Delete.
• To modify the sequence of the values

in the choice list select Move Up/Move
Down.

Default
Value

 Optional.
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Name Type Description

 Enter default value, for value region choice
list or range.

 If the attribute type is fixed, enter a default
value otherwise no attribute value is set.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.7 Layer

A layer is used to group thematic information within a project. The layer
includes style information that can apply to all the coded features that are
using this layer.
Use the style option to decide if the feature is presented with its individual by
code style or with the common by layer style.

To add a new layer:
 

1. In the Code Manager, select Layer from the ribbon bar.

2. The view is switched to the Layers tab and in the content area a
new layer is created with default settings that can be modified.

3. Select OK to save the changes and to close the Code Manager.

See also:
Code Tables
The video "Leica Infinity – Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity – Feature Coding Part 2 - How to use blocks and
layers" https://www.youtube.com/watch?v=REYP8JzmaSs

2.1.7.3.8 Delete

Layer
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In the Code Manager It is possible to delete the following objects:
• Code Groups
• Codes
• Attributes
• Layers
• Blocks
• Line Styles

To delete an object from code manager:
 

1. In the Code Manager, select the objects from either the Code Table,
Layers, Blocks or the Line Styles tabs

2. Select Delete.

3. Select OK to save the changes and to close the Code Manager.

☞ If you delete a code group, all codes and attributes in that code
group are deleted.

☞ If you delete a code, all attributes of that code are deleted.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA
The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.9 Convert to Line/Area Code

The convert to line/area code option is useful when data has to be exported
to GIS, CAD or VIVA where the point linework is not supported.

Delete

Convert to Line/
Area Code

Basic Modules 57

https://www.youtube.com/watch?v=9Mf8E0trTXA
https://www.youtube.com/watch?v=ASLoVHHAYGQ


To convert to line/area code:
 

1. In the Code Manager, select one or more point codes with linework.
☞ You can also select the whole code group.

2. Select Convert to Line/Area Code.
☞ Points with linework, start line convert to lines and the

start area convert to area.

3. Select OK to save the changes and to close the Code Manager.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA

2.1.7.3.10 Convert to Point Code

The convert to point code option is useful when you want to use your exist-
ing line/area codes in Captivate where only the point linework is supported.

To convert to point code:
 

1. In the Code Manager, select one or more codes of type line or area.
☞ You can also select the whole code group.

Convert to Point Code
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2. Select Convert to Point Code.
☞ All selected codes are converted to the type point with

linework start line or start area.

3. Select OK to save the changes and to close the Code Manager.

See also:
Code Tables
The video "Leica Infinity - Feature Coding Part 1 - How to create a Code
Table & Codelist" https://www.youtube.com/watch?v=9Mf8E0trTXA

2.1.7.3.11 Layers and Blocks

Blocks are the collection of geometry objects that act as a single object and
can be used in a drawing repetitively to represent features. For example, a
block can be used to represents a tree or a signpost.
Blocks can have attributes and can only be used for the codes, type point.
Layers are used to define a common style.
Blocks, block attributes and layers can be imported into the code table from
DXF/DWG CAD files.

To import blocks and layers:
 

1. In the Code Manager, select the Layers or the Blocks tab

2. Select Import and then Blocks or Blocks & Layers from the ribbon
bar.

3. Navigate to the file you want to import and select it.

4. Select Import.

5. In the content area, the newly imported blocks are seen.
☞ The block preview is only shown if it is imported from the

CAD file. Blocks preview can be created in AutoCAD with
the ‘BLOCKICON’ command.

6. Select OK to store changes and to close the Code Manager.

☞ To see the imported block attributes, select a block in the blocks tab.

☞ To see imported layers, go to the layers tab.

See also:
Code Tables

Layers and Blocks
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The video "Leica Infinity - Feature Coding Part 2 - How to use blocks and
layers" https://www.youtube.com/watch?v=REYP8JzmaSs
The video "Leica Infinity - Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.3.12 Line Styles

Line style is a visual property that can be assigned to geometric objects. Line
styles can be for example a pattern of dashes, dots or text.
Line styles are defined in a line style definition LIN file. You can import the line
styles from the LIN file and use them with your codes.
The line style functionality is not supported in SmartWorx Viva or Captivate.
Therefore, line styles are not exported to the codelist. Collect your data as
normal and assign the code table to the project for the correct style repres-
entation.

☞ Line style names are case-sensitive. During an import, line styles with
the same name are overwritten.

To import line styles from a LIN file to a code table:
 

1. In the Code Manager, select the Line Styles tab.

2. Select Import and select Line styles from the drop-down menu.

3. Select the LIN file to import.

4. Select Import.

5. Select OK to save the changes and to close the Code Manager.

☞ Line styles combo box is only available for the code type line or point
with linework set to start line or start area.

See also:
Code Manager
The video "Leica Infinity – Feature Coding Part 3 - How to use custom
line styles" https://www.youtube.com/watch?v=ze9ganVf6AU
The video "Leica Infinity – Feature Coding Part 4 - How to process fea-
tures and export to CAD" https://www.youtube.com/watch?v=ASLoVHHAYGQ

2.1.7.4 Targets

Prism constants for TPS targets are defined here. Infinity provides a default list
of targets.

Line Styles

Targets
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In targets you can do the following:
 

No. Name Description

1. New Create a new user-defined target and enter
the prism constant values.
☞ If a user-defined target was cre-

ated in the field software, it is
imported with the TPS data and
therefore is not necessary to be
created again.

2. Delete Delete selected target. Only user-defined
targets can be deleted.
☞ There is no undo function.

3. Copy to Project Copy user-defined targets to the currently
open project. The project must already be
open before this option is available.

See also:
Local and Global Data Objects

2.1.7.5 Antennas

2.1.7.5.1 Overview

Antennas can be managed in the antennas list. Infinity provides a default list
of antennas and calibration sets.

By default, the following calibration sets are available:
• GEO++ GmbH Absolute and GEO++ GmbH Relative: Include elevation

and azimuth calibration values for Leica antennas.
• Leica Absolute and Leica Relative: Include elevation and azimuth calib-

ration values for Leica antennas.
• NGS 14 Absolute and NGS Absolute: Include elevation and azimuth

calibration values for Leica and third-party antennas.

☞ NGS calibration set, provides the antenna calibration values published
by NGS at the following link: https://www.ngs.noaa.gov/ANTCAL/.

Antennas
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In antennas you can do the following:
 

No. Name Description

1. GNSS Manager Manage antenna calibration sets, RINEX data
from permanent reference stations, precise
ephemeris, ionospheric models and predict
the satellite availability.

2. Delete Delete user defined or imported antennas.

3. Import Import antennas.

4. Export Export antennas.

5. Copy to Project Copy antennas from global list into open
project.

See also:
Local and Global Data Objects
Antennas/Calibration Sets
The tutorial "How to Manage an Antenna Calibration Set" https://leica-
geosystems.com/-/media/a633447d1f3f4afc8c7abf4a1685be6a.ashx

☞ The tutorial can be downloaded in the Localisation Tool.

2.1.7.5.2 Delete

User-defined or imported antennas/calibration sets can be deleted.

☞ The following actions can also be done from within the GNSS Man-
ager.

Delete
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To delete antennas:
 

1. Select File, then Tools and then Antennas from the menu.

2. Select the antenna file you want to delete.

3. Select Delete.

4. Select OK.

2.1.7.5.3 Import

Except for the predefined antennas, it is possible to import new antennas and
add them to the list.

☞ The following actions can also be done from within the GNSS Man-
ager.

To import a new antenna:
 

1. Select File, then Tools and then Antennas from the menu.

2. Select Import.

3. Select the antenna file you want to import.

4. Select the file type from the drop-down menu.

5. Select the checkbox Create Calibration Set in the import settings,
to add all the antennas in the file, under a new calibration set.

6. Specify the name of the new calibration set.

Import
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7. Select Import.

2.1.7.5.4 Export

☞ The following actions can also be done from within the GNSS Man-
ager.

To export an antenna:
 

1. Select File, then Tools and then Antennas from the menu.

2. Select the antennas/calibration sets you want to export.

3. Select Export.

4. Select the folder location to export the antennas to.

5. Specify the name.

6. Select the file type from the drop-down menu.

7. Select Save.

2.1.7.5.5 Copy to Project

Antennas are automatically mapped during import of GNSS data to the project.
When the GNSS antenna is found in the global tools antenna list, then all
antenna calibration definitions are copied into the project automatically.
Antennas can be copied from the global tools into single projects to make
them available in calibration sets for processing.

Export

Copy to Project
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To copy antennas to a project:
 

1. Select File , then Tools and then Antennas from the menu.

2. Select the antennas you want to copy.

3. Select Copy to Project.

See also:
Local and Global Data Objects

2.1.7.6 Coordinate Systems

The globally available coordinate systems are listed by name together with
their source and information on the transformation and residual distribution,
the ellipsoid and projection and the geoid and CSCS model used with each
coordinate system.

Here you can do the following:
 

No. Name Description

1. Manager Opens the Coordinate System Manager,
where geoid field files, CACS field files and
the whole coordinate systems can be impor-
ted, created and managed.

Coordinate Systems
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No. Name Description

2. Delete Permanently delete the selected coordinate
system.
☞ There is no undo function.

3. Import Import existing coordinate systems from:
• SmartWorx DBX (*.xcf).
• *.dat files.
• iCON/SBG Geo *.lok.
• Infinity Coordinate System file*.CSYS.
• HeXML/LandXML.
• LGO CSys *.dbd.
• Trimble *.DC/*.CAL/*.JXL.

4. Export Export coordinates systems as Infinity
coordinate system files in:
• *.csys.
• Global Transformation Sets TRFSET.dat

files.
• iCON/SBG Geo *.lok.
• Trimble *.DC/*.CAL/*.JXL.

5. Copy to Project Copy selected coordinate system to the cur-
rently open project.
☞ You can only copy coordinate sys-

tems to the project which are not
attached already.

6. Localise Open the Localisation Tool and download
coordinate systems from the available
global or national list.

See also:
Coordinate System Manager
Local and Global Data Objects

2.1.7.7 Coordinate System Manager

2.1.7.7.1 Overview

In the coordinate system manager, you can create and manage all the com-
ponents that constitute a coordinate system, for example Transformations,
Ellipsoids and Projections as well as Geoid Models and CSCS Models.

To open the coordinate system manager:
1. Select File > Tools > Coordinate Systems.

2. Select the Manager option to open the Coordinate System Man-
ager.

Coordinate System
Manager
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The ribbon bar gives access to the following actions:
Data Import existing coordinate systems from:

• SmartWorx DBX (*.xcf).
• *.dat files.
• HeXML/LandXML.
• LGO CSYS.
• Trimble *.DC/*.CAL/*.JXL.
• iCON/SBG Geo *.lok.
• Infinity Coordinate System file*.csys.

 Export coordinates systems as:
• Infinity Coordinate System files in *.csys.
• Global Transformation Sets TRFSET.dat files.
• iCON/SBG Geo *.lok.

 Copy to Project, to copy selected coordinate systems to
the current project.

 Report, to get a coordinate system report.

 Create Geoid Field File, to create a new geoid field file.

 Create CSCS Field File, to create a new CSCS field file.

New Coordinate System, to create a new coordinate system.

 Transformation, to create a new transformation.

 Ellipsoid, to create a new ellipsoid.

 Projection, to create a new projection.

 Geoid Model, to create a new geoid model.

 CSCS Model, to create a new CSCS model.

 Determine Transformation, to determine a new trans-
formation.

Edit Delete coordinate systems from the list.

☞ To be able to copy a coordinate system to a project, the project has
to be open. You can only copy coordinate systems to the project
which are not attached already.

In the Properties window you are shown the properties of any selected item,
be that a coordinate system, a transformation, an ellipsoid, a projection, a
geoid model or a CSCS model.
Some properties are editable. Confirm any changes with Apply.
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In the status bar at the bottom:
• Select the  option to hide or show the Properties window.
• Change the  linear and  angular units and the available decimal

places if necessary.
• Change the way latitude and longitude are displayed if necessary.

The functionality is similar to the status bar in the main frame.

See also:
Status Bar

☞ If you have long lists use the  Search functionality to find an item.

2.1.7.7.2 Create Geoid Field File

Geoid models may also be used on the receiver in the field. This command
enables you to create a geoid field file.
Geoid models usually consist of a geoid height grid where a geoid separation
is defined for each grid point. Depending on the extent and the grid spacing
of the geoid model, it may require considerable disk space. In order to use the
geoid model on a GPS sensor the disk space has to be reduced and a special
field file has to be created which allows the field system to interpolate geoid
separations.

From geoid model:
This command enables you to extract a geoid height grid from an existing
geoid model for a particular area. The area boundary can be defined by a
rectangle or circle and a grid spacing in metres can be selected. The file can
then be uploaded to the receiver.

 

1. From the Coordinate System Manager, select Create Geoid Field
File/From File.

Create Geoid Field
File
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2. Select an existing geoid model from the list.
If Select source file is selected from the list, browse to the exist-
ing .exe file.
☞ If the tool has been started from a project, the list with all

geoids found in the project are shown.

☞ If the tool has been started from the File tab, all available
geoids are shown.

3. Define all needed settings.

4. From the file browser, select the path where the file shall be created
(enter a file name without extension).

5. Select Create to finish the process.

From File:
You can create a geoid GEM file from locally provided geoid model data usually
in ASCII format.

 

1. From the Coordinate System Manager, select Create Geoid Field
File/From File.

2. Browse for an ASCII grid file.

3. Select the Format.
Select between User Defined or some Predefined formats.

4. Define all needed settings.
☞ When a predefined format is selected, the settings are

filled in automatically.

5. From the file browser, select the path where the file shall be cre-
ated.
Enter a file name without extension.
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6. In the preview, identify the data type in each column by selecting a
type from each drop-down menu.
Select Create to finish the process.

☞ Once created, the geoid model is automatically added to the list of
geoids in the Coordinate System Manager.

2.1.7.7.3 Create CSCS Field File

CSCS models may also be used on the receiver in the field. This command
enables you to create a CSCS model field file.
1. From the Coordinate System Manager, select Create CSCS Field

File.

2. Select a CSCS model from the list and add a new CSCS model.

3. Select the Interpolation Type, which is used when interpolating
in the CSCS field file. Select between Bi-quadratic, Bi-linear and
Spline interpolation methods.

4. Select the method to define the limits of the CSCS model field file.
Select between Centre & radius and Extents.

5. Enter the coordinates of the centre point and the radius or enter
the coordinates of the South-west and North-east corner.

6. From the file browser, select the path where the file shall be cre-
ated.

7. Enter a File name without extension. (Extension "csc" is added auto-
matically).

8. Select the Create option to confirm.

☞ Depending on the file size, this may take a while.

☞ Check the file size. If you want to use the file on the system RAM, it
must not exceed a certain size.
The maximum file size may vary depending on the free memory in
the receivers system RAM. Refer to the technical reference manual
on how to free system RAM of the receiver.

2.1.7.7.4 Coordinate Systems

A coordinate system provides the information necessary to convert coordin-
ates between different representations (cartesian, geodetic, grid) and to
transform coordinates between the WGS84 and a local system.
Coordinate systems can be imported, exported and copied to project.

See also:
Coordinate System Manager

☞ To be able to copy a coordinate system to a project, the project has
to be open. You can only copy coordinate systems to the project
which are not attached already.

☞ Coordinate systems can always be deleted from the list of globally
available coordinate systems.

Create CSCS Field File

Coordinate Systems
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Coordinate System Properties
The properties window is filled dynamically depending on the selected coordin-
ate system. It shows you information on all the components which constitute
a coordinate system.
Different constituting components can be chosen. Basically all transforma-
tions, ellipsoids, projections, geoid models and CSCS models that are avail-
able from within the global coordinate system management are available for
selection, too. But which ones are available for a specific coordinate system,
depends on validity.

The dependencies are as follows:
• When you select a coordinate system of with a projection of type custom-

ised, then the connected ellipsoid is predefined and cannot be edited.
You cannot choose another. Customised projections are country-specific,
predefined projections.

• If you select a projection then an ellipsoid must be selected too.
• When you select a coordinate system with a transformation that does

not have common points stored with it, then there are no residuals to
be distributed. This is typically the case with manually entered classic
3D transformations. Residual Distribution are set to None and cannot be
edited.

• When you select a coordinate system with a transformation of type
onestep, then Ellipsoid and Projection are set to None and cannot be
edited because knowledge of the local map projection and the local ellips-
oid is not needed with onestep transformations.

• When you select a coordinate system with a transformation of type
twostep, then Ellipsoid and Projection must be read from the transforma-
tion and cannot be edited.

Geoid and CSCS models can be selected or imported.
• To import a geoid or a CSCS model select the  option and then the 

Select Field File option from within the fly-out.
• Only valid models are available for selection. For further information on

validity, see topics:
Geoid Models
CSCS Models

☞ The properties of a coordinate system can only be edited from within
the properties window.

2.1.7.7.5 Geoid Models

A Geoid Model can be defined for geodetic or grid coordinates and refers to a
particular ellipsoid. With a Geoid Model attached to a coordinate system, geoid
separations can be computed for the points in your project.
If geoid separations are available you can switch between viewing ellipsoidal
and orthometric heights.

☞ Geoid Models are always an approximation of the actual geoid. In
terms of accuracy, they may vary considerably and in particular global
models should be used with care. If the accuracy of the Geoid Model
is not known it might be safer to use local control points with ortho-
metric heights and apply a transformation to approximate the local
geoid. The classic 3D transformation can be used in areas where the
geoid has a regular shape.

Geoid Models
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To import a Geoid Model:
1. In the Coordinate System Manager, select the Geoid Models tab

and then  Import from the ribbon bar.

2. Browse for the *.gem file to be imported and open it.

Create a new Geoid Model:
1. In the Coordinate System Manager, select the Geoid Models tab

and then  New from the ribbon bar.

2. In the Properties window, give the Geoid Model a unique Name.

3. Select the  option to browse for and select a Geoid Model Field
file (*.gem).

4. Select Create to create the new Geoid Model or Cancel to exit the
function.

See also:
Coordinate System Manager

Types of Geoid Models

WGS84 Geodetic Models
Geoid Models of this type are of Coordinate Type Geodetic based on the
WGS84 ellipsoid. To obtain local orthometric heights the geoid separations
are applied to the ellipsoidal heights on the WGS84 coordinate side, that is,
models of this type are never flagged to be applied on local side and they
are only valid and can only be used with coordinate systems that either have
transformation none or a transformation with height mode ellipsoidal, that is
a transformation which flags the local heights as ellipsoidal.

Local Geodetic Models
Geoid Models of this type are of Coordinate Type Geodetic based on either a
local ellipsoid or the WGS84 ellipsoid but flagged to be applied on local side.
To obtain local orthometric heights the geoid separations are applied to the
ellipsoidal heights on the local coordinate side. Models of this type are valid
and can be used with coordinate systems that either have transformation
none or classic 3D. The ellipsoid of the coordinate system must be the same
as the ellipsoid used with the Geoid Model.

Local Grid Models
Geoid Models of this type are of Coordinate Type Grid based on Ellipsoid
None. To obtain local orthometric heights the geoid separations are applied
to the ellipsoidal heights on the local coordinate side. Models of this type are
valid and can be used with coordinate systems which either have a projection
defined or which are of transformation type onestep or twostep.

☞ If a local grid model is imported that is based on an ellipsoid other
than none then the ellipsoid of the coordinate system with which the
model shall be used must match the ellipsoid of the Geoid Model.
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Geoid Model Properties
The Properties window is filled dynamically depending on the selected Geoid
Model. It shows you the Path to the imported *.gem file, the Ellipsoid upon
which the model is based, its Extents and Spacing.
For geodetic Geoid Models which are based on the WGS84 ellipsoid you can
see if they are flagged to be Applied on Local Side. Valid WGS84 geodetic
models never have this flag set. They are always applied on the WGS84
coordinate side. Valid local geodetic models must have the flag set if they
are based on the WGS84 ellipsoid. Local grid models are always applied on the
local side.
The Name of a Geoid Model can always be modified even if it is in use with a
coordinate system.

☞ To be able to delete a Geoid Model it must not be in use with any
coordinate system.

2.1.7.7.6 CSCS Models

Several countries have produced tables of conversion factors to directly con-
vert between GPS measured coordinates given in WGS84 and the correspond-
ing local mapping coordinates, taking the distortions of the mapping system
into account. Using these tables it is possible to directly convert into the local
grid system without having to calculate your own transformation parameters.
A Country Specific Coordinate System Model (CSCS Model) is an addition to an
already defined coordinate system, which interpolates corrections in a grid file
and applies the interpolated corrections. The extra step of applying these cor-
rections can be made at different points in the coordinate conversion process.
Therefore, different methods of CSCS Models are supported.

To import a CSCS Model:
1. In the Coordinate System Manager, select the CSCS Models tab

and then  Import from the ribbon bar.

2. Browse for the *.csc file to be imported and open it.

Create a new CSCS Model:
1. In the Coordinate System Manager, select the CSCS Models tab

and then  New from the ribbon bar.

2. In the Properties window give the geoid model unique Name.

3. Select the  option to browse for and select a CSCS Model Field file
(*.csc).

4. Select Create to create the new CSCS Model or Cancel to exit the
function.

See also:
Coordinate System Manager

CSCS Models
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Conversion Methods

Grid conversion method (grid shifts):
The grid file is usually based upon local grid coordinates and can only be
applied to coordinate systems for which a projection is defined.
1. Step: Applying the specified transformation, map projection and

ellipsoid to get preliminary grid coordinates.

2. Step: Interpolation of a shift in Easting and Northing in the grid file
of the CSCS Model to get the final local Eastings and Northings.

Cartesian conversion method (cartesian shifts):
The grid file can be based upon WGS84 geodetic or upon local geodetic
coordinates and can only be applied to coordinate systems for which either
a classic 3D transformation is defined or for which the transformation is none.
1. Step: Applying the specified transformation.

2. Step: Interpolation of a 3D shift in the grid file of the CSCS Model
resulting in local cartesian coordinates.

3. Step: Applying the specified local ellipsoid and map projection to get
the final local Eastings and Northings.

Geodetic conversion method (geodetic shifts):
The grid file can be based upon WGS84 geodetic or upon local geodetic
coordinates and can only be applied to coordinate systems for which the
transformation is none.
1. Step: Interpolation of a shift in geodetic latitude and longitude

in the grid file of the CSCS Model resulting in final local geodetic
coordinates.

2. Step: Applying the map projection to get the final local Eastings and
Northings.

Ellipsoidal conversion method (ellipsoidal shifts):
The grid file can be based upon WGS84 geodetic or upon local geodetic
coordinates and can only be applied to coordinate systems for which an ellips-
oid is defined.
1. Step: Applying the specified transformation and the ellipsoid to get

preliminary local geodetic coordinates.

2. Step: Interpolation of a shift in geodetic latitude and longitude
in the grid file of the CSCS Model resulting in final local geodetic
coordinates.

3. Step: Applying the map projection to get the final local Eastings and
Northings.

CSCS Model Properties:
The Properties window is filled dynamically depending on the selected CSCS
Model. It shows you the Path to the imported *.csc file, the Kind of conversion
method it uses, its Geodetic Datum Kind (either WGS84 or Local) and its
Coordinate Type (either Grid or Geodetic) as well as the Extents and Spacing
of the model.
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The Interpolation Type can be either Bi-linear, Bi-quadratic or Spline and is
pre-defined by the imported grid file, too.
The Name of a CSCS Model can always be modified even if it is in use with a
coordinate system.

☞ To be able to delete a CSCS model it must not be in use with any
coordinate system.

2.1.7.7.7 Determine Transformation

2.1.7.7.7.1 Overview

In many surveying jobs it is necessary to transform the WGS84 coordinates
into a local coordinate system or vice versa.
Using the Determine Transformation wizard, you can determine transforma-
tion parameters necessary to perform datum transformations between two
sets of coordinates.
To determine a transformation it is necessary to have common control points
whose positions are known in both WGS 1984 coordinates and local coordin-
ates. The more points that are common between datum, the more accurately
the transformation parameters can be calculated. Depending on the type of
transformation used, details about the map projection, the local ellipsoid and
a local geoid model can also be needed.
With one common control point, it is still possible to calculate a transforma-
tion.
The one point localisation method, allows you to fix specific parameters of the
transformation. It requires only one point for the calculation. The method is
valid for classic 3D, onestep and twostep transformations.
To use the one point localisation method, select the Use one point localisa-
tion method option in the Settings page of the Determine Transformation
wizard.

Create a new transformation:
1. Select the Coordinate System Manager (either from the File tab or

inside the project) and then Determine Transformation from the
ribbon bar.

2. The Determine Transformation wizard consists of three steps:
1. Determine Transformation Wizard: Settings.
2. Determine Transformation Wizard: Match Points.
3. Determine Transformation Wizard: Results.

Calculated transformations can be accessed and managed using the Coordin-
ate System Manager.
Depending on the purpose of determining transformation parameters, there
are four different transformation types supported in Infinity.
Quick Ground allows the transformation from local grid to ground coordinates,
based on the selected coordinate system and the base point. The coordinates
of the base point can be kept fixed during the transformation. More shifts in
Northing and Easting can be applied, if necessary.

See also:
Classic 3D
Onestep

Determine Trans-
formation
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Twostep
Which Approach to Use
Minimum Requirements for Coordinates

2.1.7.7.7.2 Determine Transformation: Settings

To define the settings:
 

1. Enter the transformation Name.

2. Select the transformation Type from the drop-down list: Classic 3D,
Onestep or Twostep.

3. If you want to use a one point localisation, check the option Use
one point localisation method.

4. Depending on the selected Type, choose the Parameters.
☞ You can enter the parameters for shift, rotation and scale

manually or allow Infinity to compute them using common
points.

5. Select Next to proceed with Step 2: Determine Transformation: 
Match Points.

2.1.7.7.7.3 Determine Transformation: Match Points

To match common points:
 

1. Select a project to load the list of points for System A (WGS84).
☞ Only points stored in the project as WGS84 are shown.

Determine Trans-
formation: Settings

Determine Trans-
formation: Match
Points
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2. Select a project to load the list of points for System B (Local).
☞ Only points stored in the project as local grid are shown.

 ☞ Points can be loaded into the list for System A (WGS84)
and System B (Local) separately by selecting an Infinity
project. These can be two different projects, but you can
also select the same project for A and B.

3. Match points:

 Match the points manually:
Available only for the single selection.
Select a point in System A (WGS84) then select a point in System B
(Local).
Select the option to make a pair.

 Match the points automatically:
Available if nothing is selected or if at least one point which has a
match is selected.
The match looks for the same point ID from selected points and
makes pairs automatically.
Pairs always use the highest point roles.

 To unselect a point press Ctrl+click.

4. : When selected, the pair is removed from the list. The calculation
is updated based on remaining pairs.

5. Select the Use: Position & Height, Position, Height or None.
☞ None removes matched common points from the trans-

formation calculation but does not delete them from the
list. This option can be used to help improve residuals.

☞ For classic 3D, only Position & Height or None are avail-
able.

6. Select Next to proceed with Step 3: Determine Transformation: 
Results.

2.1.7.7.7.4 Determine Transformation: Results

To finalise the calculation:
 

1. Review the calculated transformation Parameters.

Determine Trans-
formation: Results
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2. Select the Create Coordinate System checkbox to create a new
coordinate system with the newly calculated transformation. The
new coordinate system is available for further usage in the coordin-
ate system manager.
Decide on a Residual Distribution.

3. Deselect the Show Transformation Calculation Report checkbox
to hide the report.
☞ A report is created by default and opens when you select

Finish.

4. Select Finish to perform the operation.

2.1.7.7.7.5 Classic 3D

The classic 3D transformation approach creates transformation parameters
using a rigorous classic 3D method.
Basically, the method works by taking the cartesian coordinates of the GNSS
measured points (WGS84 ellipsoid) and comparing them with the cartesian
coordinates of the local coordinates. Shifts, rotations and a scale factor are
calculated, to transform from one system to another.
The classic 3D transformation approach allows you to determine a maximum
of seven transformation parameters (three shifts, three rotations, and one
scale factor). However you can select the parameters to be determined.
The classic 3D transformation allows the choice of two different transforma-
tion models: Bursa-Wolf or Molodensky-Badekas.
For the classic 3D transformation method, we recommend that you have at
least three points for which the coordinates are known in the local system
and in WGS84. It is possible to compute transformation parameters using only
three common points but using four produces more redundancy and allows for
residuals to be calculated.

The advantage:
• The advantages of this method of calculating transformation parameters,

are that it maintains the accuracy of the GNSS measurements and may
be used over virtually any area as long as the local coordinates (including
height) are accurate.

The disadvantage:
• The disadvantage is, that if local grid coordinates are desired, the local

ellipsoid and map projections must be known. In addition, if the local
coordinates are not themselves accurate, any new points measured using
GNSS, may not fit into this existing local system once transformed.

• In order to obtain accurate ellipsoidal heights, the geoid separation at the
measured points must be known. This may be determined from a geoid
model, but many countries do not have access to an accurate local geoid
model. See also Geoid Models.

Other transformation approaches:
Onestep
Twostep
Which Approach to Use

Classic 3D
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2.1.7.7.7.6 Onestep

This transformation approach works by treating the height and position trans-
formations separately. For the position transformation, the WGS84 coordin-
ates are projected onto a temporary transverse mercator projection and then
the shifts, rotation and scale from the temporary projection to the real projec-
tion are calculated.
The height transformation is a single dimension height approximation.
Because of how the position transformation approach works it is possible to
define a transformation without any knowledge of the local map projection or
local ellipsoid.
The height and position transformations are separate and therefore errors in
height do not propagate into errors in position. Additionally, if knowledge of
local heights is not good or non-existent you can still create a transformation
for position only. Also, the height points and position points do not have to be
the same points.
Because of how the transformation works it is possible to compute transform-
ation parameters with just one point in the local and WGS84 system.
The combinations of the number of points in position and the position trans-
formation parameters that can be calculated from them are as follows:

No. of position points Transformation parameters computed

1 Classic 2D with shift in X and Y only.

2 Classic 2D with shift in X and Y, rotation
about Z and scale.

More than 2 Classic 2D with shift in X and Y, rotation
about Z, scale and residuals.

The number of points with height included in the transformation directly
affects the type of height transformation produced.

No. of height points Height transformation based on

0 No height transformation.

1 Constant height transformation.

2 Average constant between the two height
points.

3 Plane through the three height points.

More than 3 Average plane.

The advantage:
• The advantages of this method are that transformation parameters may

be computed using little information. No knowledge is needed of the local
ellipsoid and map projection and parameters may be computed with the
minimum of points. Care should be taken however when computing para-
meters using just one or two local points as the parameters calculated are
only valid in the vicinity of the points used for the transformation.

The disadvantage:
• The area of the transformation is restricted to about 10 km2 (using four

common points).

Onestep
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Other transformation approaches:
Classic 3D
Twostep
Which Approach to Use

2.1.7.7.7.7 Twostep

This transformation approach works by treating the height and position trans-
formation separately. For the position transformation, the WGS 84 coordin-
ates are first transformed using a classic 3D pre-transformation to obtain
preliminary local cartesian coordinates. These are projected onto a preliminary
grid using the specified ellipsoid and map projection. Then the two shifts, the
rotation and the scale factor of a classic 2D transformation are calculated to
transform the preliminary to the “real” local coordinates.
The position transformation requires knowledge of the local map projection
and the local ellipsoid. However, as the distortions of the map projection are
taken into account, twostep transformations can be used for larger areas than
onestep transformations.
The height transformation is a single dimension height approximation.
The height and position transformations are separate and, therefore, errors in
height do not propagate into errors in position. Additionally, if knowledge of
local heights is not good or non-existent you can still create a transformation
for position only. Also, the height points and position points do not have to be
the same points.
Because of how the transformation works it is possible to compute transform-
ation parameters with just one point in the local and WGS84 system.
The combinations of the number of points in position and the position trans-
formation parameters that can be calculated from them are as follows:

No. of position points Transformation parameters computed

1 Classic 2D with shift in X and Y only.

2 Classic 2D with shift in X and Y, rotation
about Z and scale.

More than 2 Classic 2D with shift in X and Y, rotation
about Z, scale and residuals.

The number of points with height included in the transformation directly
affects the type of height transformation produced.

No. of height points Height transformation based on

0 No height transformation.

1 Constant height transformation.

2 Average constant between the two height
points.

3 Plane through the three height points.

More than 3 Average plane.

Twostep
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The advantage:
• Errors in local heights do not affect the position transformation.
• The points used for determining the position and height transformation

do not necessarily have to be the same points.
• The distortions of the map projection are taken into account which

enables you to use the transformation for larger areas.

The disadvantage:
• Knowledge of the local projection and local ellipsoid are required.

Other transformation approaches:
Classic 3D
Onestep
Which Approach to Use
Minimum Requirements for Coordinates

2.1.7.7.7.8 Which Approach to Use

This question is almost impossible to answer since the approach used depends
totally on local conditions and information.
If you want to keep the GNSS measurements totally homogenous and
the information about the local map projection is available, the Classic 3D
approach would be the most suitable.
For cases where there is no information regarding the ellipsoid and/or map
projection and/or you want to force the GNSS measurements to tie in with
local existing control, then the Onestep approach may be the most suitable.
The Twostep approach treats position and height information separately which
allows for position only control points to be used as well. Compared to the
onestep approach, information regarding the ellipsoid and map projection has
to be known. The advantage is that this approach can be used for larger areas
than the onestep.

2.1.7.7.7.9 Minimum Requirements for Coordinates

The following list provides you with the minimum requirements for coordinate
system A and B, necessary to calculate transformation parameters using the
different transformation types. The coordinates either have to comply with
the minimum requirements or the coordinate system attached must allow the
conversion of the coordinates to the type required. For example, if coordin-
ates are required in cartesian format but are available in geodetic format only,
an ellipsoid must be defined allowing the system to convert to the appropriate
format.

System Classic 3D Onestep Twostep

System A Cartesian +
Ellipsoid

Cartesian Cartesian

System B Cartesian Grid Grid + Ellipsoid + Projection

☞ Cartesian + Ellipsoid means that the coordinates have to be available
in cartesian or geodetic format plus an ellipsoid must be defined in
the attached coordinate system.

Which Approach to
Use

Minimum Require-
ments for Coordin-
ates
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The onestep and the twostep transformations require that the geoid model is
of type grid. This means that geoids of type geodetic or geoids created from
WGS84 or another ellipsoid cannot be used.
Additionally, when a transformation is determined it is important to state
whether ellipsoidal or orthometric heights are intended to be used in the
target system B. With this information being stored as part of the transforma-
tion definition (Height mode), the system knows in which direction the geoid
separations have to be applied.

Type Minimum requirements

Classic 3D
7 parameters

3 points with position + height

Classic 3D
3 shifts

1 point with position + height

Classic 3D
3 shifts + scale factor

2 points with position + height

Classic 3D
3 shifts + rotation about Z

2 points with position + height

Classic 3D
3 shifts + scale factor + rota-
tion about Z

2 points with position + height

Classic 3D
Other combinations

If 3 unknowns or less
1 point with position + height
If 4,5 or 6 unknowns
2 points with position + height

Onestep 1 point with position only
1 point with height is required for the height
part of the transformation to be determined.

Twostep 1 point with position only
1 point with height is required for the height
part of the transformation to be determined.

Only if these requirements are met it is possible to see the points loaded in
the lists and to move to the Result page with the Next option of the Match
Points.

☞ Since a onestep transformation may be calculated without any given
height information on the local side, the system takes the WGS84
ellipsoidal height as the local height in that case. This height is also
displayed as ellipsoidal then.

☞ If a twostep transformation is calculated without any given height
information on the local side, the system displays the height after
applying only the pre-transformation as a local height.

2.1.7.8 Georeferenced Images

2.1.7.8.1 Overview

Infinity supports the display of georeferenced images as a background. The
use of these images is a nice way to help visualise, reference and relate your
project data.
Georeferenced images are shown as objects in the library and can be set to
visible or not visible. It is possible to use many georeferenced images. An

Georeferenced
Images
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existing georeferenced Image can be edited and updated with a new trans-
formation.

In georeferenced images you can do the following:
 

No. Name Description

1. Delete Delete a georeferenced image from the
global library.

2. Import Import georeferenced images or images you
want to georeference.

3. Export Export georeferenced images.

4. Copy to Project Copy georeferenced images to be used in
the project.

5. Georeference Images Open georeference image wizard to edit an
existing or to calculate a new transforma-
tion.

See also:
Local and Global Data Objects
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

2.1.7.8.2 Delete

User-defined or imported georeferenced images can be deleted.Delete
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To delete images:
 

1. Select File, then Tools and then Georeferenced Images from the
menu.

2. Select the image you want to delete.

3. Select Delete.

4. Select OK.

2.1.7.8.3 Import

Images can be imported from PNG, JPG, TIFF or PDF.
When the images include a matching world file TIFF+TFW, PNG+PNW or
JPG+JPW, then they are imported and translated as a georeferenced image.
Otherwise it is possible to reference these images using the Georeference 
Images.

To import images:
 

1. Select File, then Tools and then Georeferenced Images from the
menu.

2. Select Import.

3. Select the image you want to import.

4. Select the unit settings.
☞ You now see the image preview.

5. Select Import.

Import
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See also:
Local and Global Data Objects
Georeference Images
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

2.1.7.8.4 Export

Georeferenced images can be exported in JPG format with the matching JPW
world file.
Requirements:
• The image must be georeferenced.

To export an image:
 

1. Select File, then Tools and then Georeferenced Images from the
menu.

2. Select the image you want to export.

3. Select Export.

4. Select the file location.

5. Select the unit settings.

6. Select OK.

☞ To export a georeferenced image to Captivate simply attach it to a
project and export the project to Captivate.

See also:
Local and Global Data Objects
Georeference Images
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

2.1.7.8.5 Copy to Project

Georeferenced images can be copied to the currently open project.
Requirements:
• The image must be georeferenced.
• The project must be opened before this option is available.

Export

Copy to Project
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To copy to a project:
 

1. Select File, then Tools and then Georeferenced Images from the
menu.

2. Select the image you want to copy.

3. Select Copy to Project.

See also:
Local and Global Data Objects
Georeference Images
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

2.1.8 Services

2.1.8.1 Overview

With data services by Leica, Hexagon and third parties are integrated with
Infinity, access to data is seamless and effective.
Under services, there is a collection of external services which Infinity can
communicate to and from.

 

Service Description

Leica Exchange Transfer data easily between the field and the office.

Leica ConX Manage and share construction and survey data
when working with iCON.

Services
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Service Description

Leica JetStream Allows you to publish point clouds to an existing
storage location.

 HxGN SmartNet Access HxGN SmartNet to download reference sta-
tion data for GNSS post-processing within Infinity.

X-pos Access X-pos to download reference station data for
GNSS post-processing within Infinity.

Earth Data Allows you to log in to the data provider used by
Infinity to download precise ephemeris and elevation
data.

Hexagon Imagery 
Program

Access and use high-quality aerial imagery informa-
tion for base maps.

OpenStreetMap Access and use the open source map service.

Map Services Define map services (WMS; WMTS; XYZ; Arc GIS Map
Server) to use as base maps and feature services
(WFS; Arc GIS Feature Server) to get data.

ArcGIS Online Access feature servers to get data and upload data
as web maps.

Portal for ArcGIS Access feature servers to get data.

Bricsys 24/7 Share project data connecting to the Bricsys 24/7
service.

AUTODESK BIM 360 Access, download and upload field data.

Bentley ProjectWise Transfer data between Infinity and the Bentley Pro-
jectWise server.

Procore Transfer data between Infinity and the Procore ser-
vice.

vGIS Transfer digital surface model data to the vGIS ser-
vice.

☞ The Hexagon Imagery Program and OpenStreetMap services are only
available within Infinity, if the computer has a valid maintenance end
date/current Customer Care Package (CCP). All other services require
subscriptions to be able to access them.

2.1.8.2 Leica Exchange

Infinity supports the Leica Exchange service.
Transfer objects easily between the field and the office with Leica Exchange.
Requirements:
• Valid subscription.

☞ The yearly Leica Exchange service allows an unlimited number of
exchanges to an unlimited number of users.

Leica Exchange
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To connect to the Leica Exchange service:
 

1. Select File, then Services and then Leica Exchange from the menu.

2. Enter your User Name and Password.

3. Select Connect.
To make it as easy as possible:
• Select remember credentials.
• Connect on start-up.

To import data:
 

1. Select Import from the Home tab.

2. In the Import window, select Leica Exchange. View the available
files from the Bricsys 24/7 window.

3. Highlight the file to import to the project.

4. Select Download.
☞ The selected file is imported to Infinity and downloaded to

the Leica Exchange directory, in the current Infinity project
directory.

5. Select the data and if necessary specify import settings.

6. Select Import.
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To export data:
 

1. Select Export from the Home tab.

2. In the Export window, select Leica Exchange.

3. In the Leica Exchange window, select the user or users to send data
to.

4. Select the output type and export settings.

5. Select Export.

☞ The Leica Exchange data is always copied to your computer. From the
archive, you can always access the location from the computer the
data is stored on.

See also:
https://leica-geosystems.com/services-and-support/workflow-services/leica-
exchange
The tutorial "How to send and receive the data to and from the
field - Working with Leica Exchange" https://leica-geosystems.com/-/media/
279c6f19b6ce49479aa9942529c85994.ashx

☞ The tutorial can be downloaded in the Localisation Tool.

2.1.8.3 Leica ConX

Infinity supports the Leica ConX service. With the Leica ConX service, you
can log in to iCON Build/iCON Site projects and assign data to the project or
directly to the units, that are the machines working on building sites.
Requirements:
• Valid subscription.

Leica ConX
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To connect to the Leica ConX service:
 

1. Select File, then Services and then Leica ConX from the menu.

2. Enter your User Name and Password.
☞ You can enter a default user name and password. If you

do so, the user name and the password are automatically
populated when you select login from within the external
services module.

3. Select Connect.
☞ You are connected until you log out from within the

external services module.

See also:
Leica ConX
Export to Leica ConX

2.1.8.4 Leica JetStream

Infinity supports the Leica JetStream service.
You can publish point clouds to existing storage locations.
Requirements:
• Cyclon Publisher or Cyclon Publisher Pro licence (from Infinity 3.4.2).

To connect to the Leica JetStream service:
 

Leica JetStream
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1. Select File, then Services and then Leica JetStream from the
menu.

2. Define the host name and the port.

3. Select Connect.

See also:
Publish to Leica JetStream
https://leica-geosystems.com/products/laser-scanners/software/leica-jet-
stream

2.1.8.5 HxGN SmartNet

Infinity supports the HxGN SmartNet service.

The HxGN SmartNet service allows:
• The download of post-processing data from GNSS reference station ser-

vice providers directly to a project.
• The creation of Virtual Reference Stations (VRS) directly in a project.
• Valid subscription.
Requirements:
• Valid subscription.

To connect to the HxGN SmartNet service:
 

1. Select File, then Services and then Leica ConX from the menu.

2. Select a Provider in your region from the drop-down menu. The list
is updated regularly online.
Or select to enter the host manually and type the providers
Address in the following field.
☞ If there is no HxGN SmartNet service provider listed for

your region, contact your local Leica Geosystems sales
representative to find out more.

3. Log in with your User Name and Password.
☞ If you do not have a subscription, select the hyperlink to

go to the providers webpage.

4. Select Connect.

HxGN SmartNet
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When logged in, you see all HxGN SmartNet reference stations in the GNSS
Manager > Reference Stations tab. HxGN SmartNet reference stations are
indicated with blue station icons in the map view and have got HxGN SmartNet
listed as the provider in the Inspector view. Download works in the same way
as for all other stations.

 

With the HxGN SmartNet licence, you can create VRS from the GNSS ribbon
bar by selecting Create VRS after having highlighted a GNSS interval. The
VRS is created automatically and imported into the project, starting from the
coordinates of the highlighted GNSS interval.

See also:
GNSS Manager
Create a Virtual Reference Station (VRS)
The tutorial "How to download reference data" https://leica-geosys-
tems.com/-/media/817c1f0ca2634823b2da45a5359cefec.ashx

☞ The tutorial data can be downloaded in the Localisation Tool.

2.1.8.6 X-pos

Infinity supports the X-pos service.

The X-pos service allows:
• The download of post-processing data from GNSS reference station ser-

vice providers directly to a project.
• The creation of Virtual Reference Stations (VRS) directly in a project.
• Valid subscription.
Requirements:
• Valid subscription.

X-pos
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To connect to the X-pos service:
 

1. Select File, then Services and then X-pos from the menu.

2. Select a Provider in your region from the drop-down menu. The list
is updated regularly online.
Or select to enter the host manually and type the providers address
in the following field.
☞ If there is no X-pos service provider listed for your region,

contact your local Leica Geosystems sales representative
to find out more.

3. Log in with your User Name and Password.
☞ If you do not have a subscription, select the hyperlink to

go to the providers webpage.

4. Select Connect.

When logged in, you see all X-pos reference stations in the GNSS Manager
> Reference Stations tab. X-pos reference stations are indicated with red
station icons in the map view and have got X-pos listed as the provider in the
Inspector view. Download works in the same way as for all other stations.

 

With the X-pos licence, you can create VRS from the GNSS ribbon bar by
selecting Create VRS after having highlighted a GNSS interval. The VRS is cre-
ated automatically and imported into the project, starting from the coordin-
ates of the highlighted GNSS interval.
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See also:
GNSS Manager
Create a Virtual Reference Station (VRS)
The tutorial "How to download reference data" https://leica-geosys-
tems.com/-/media/817c1f0ca2634823b2da45a5359cefec.ashx

☞ The tutorial data can be downloaded in the Localisation Tool.

2.1.8.7 Earth Data

Infinity supports the download of several GNSS data, such as reference sta-
tions, precise ephemeris or navigation files.

☞ To access the data, some providers require you to register and log in.
Under File > Services, you can log in to the Earth Data provider.

Log in to Earth Data
Earth Data is used by Infinity to download precise and rapid ephemeris
from the Crustal Dynamics Data Information System (CDDIS) archive https://
cddis.nasa.gov/archive/gps/products/mgex/
If you do not have an account yet, visit the web page Earth Data Login https://
urs.earthdata.nasa.gov/

To log in with your credentials:
 

1. Select File, then Services and then Earth Data from the menu.

2. Enter your User Name and Password.

3. Select Connect.

When logged in you can download precise ephemeris from the GNSS Man-
ager > Precise Ephemeris tab by enabling the Precise Ephemeris checkbox.

Earth Data
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See also:
4.

2.1.8.8 Hexagon Imagery Program

Infinity supports the Hexagon Imagery Program service. Also referred to as
HxIP.
Requirements:
• Valid Infinity maintenance Customer Care Package (CCP).

This service is a cached basemap imagery service consisting of up to 30 cm of
true colour imagery that is updated on an ongoing basis. This service provides
a backdrop to your Infinity projects which is a nice way to help visualise,
reference and relate your project data. It can be loaded and displayed in a
project and with the Clip Base Map function, downloaded as a georeferenced
image and available for export to the field software. This service is provided
free of charge for Infinity customers having an active CCP. The software reads
from the Infinity Electronic Identification (EID) licence, the information about
the maintenance period. When the maintenance period has expired, no access
is available to the imagery.

See also:
Base Map
https://hxgncontent.com/imagery
The video "Leica Infinity - Home Module - Using Base Maps" https://
www.youtube.com/watch?v=ZPXJSI3WWVM

2.1.8.9 OpenStreetMap

Infinity supports the OpenStreetMap service. Also referred to as OSM.
Requirements:
• Valid Infinity maintenance Customer Care Package (CCP).

This service provides a backdrop to your Infinity projects which is a nice way to
help visualise, reference and relate your project data. It provides open source
maps that can be loaded, displayed in a project and with the Clip Base Map
function, downloaded as a georeferenced image and available for export to
the field software. This service is provided free of charge for Infinity customers
having an active CCP. The software reads from the Infinity Electronic Identific-
ation (EID) licence the information about the maintenance period. When the

Hexagon Imagery Pro-
gram

OpenStreetMap
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maintenance period has expired, no access is available to the OpenStreetMap
service.

See also:
Base Map
https://www.openstreetmap.org/copyright
The video "Leica Infinity - Home Module - Using Base Maps" https://
www.youtube.com/watch?v=ZPXJSI3WWVM

2.1.8.10 Map Services

2.1.8.10.1 Overview

Infinity supports the following map services:

Map Service Description

WMS (Web Map
Service)

A WMS delivers georeferenced map images. A WMS
service provides various layers that can be turned
on and off. WMS focuses on rendering custom maps
and is an ideal solution for dynamic data or custom
styled maps.

WMTS (Web Map
Tile Service)

A WMTS delivers pre-generated georeferenced map
images. A WMTS service can have one or more
styles, dimensions, or tiling schemes to specify how
the WMTS layer is displayed. WMTS trades the flexib-
ility of custom map rendering for the scalability pos-
sible by serving of static data where the bounding
box and scales have been constrained to discrete
tiles.

WFS (Web Feature
Service)

A WFS serves, queries, and updates feature geo-
metry and attributes using a Geography Markup Lan-
guage (GML) profile.

XYZ Tiles (Tile Map
Service)

Known as TMS. This service provides tiled images. X,
Y, Z are tile numbers corresponding to a particular
area.

ArcGIS Map Server Map service (tile layer, map image layer) hosted by
ArcGIS Online or ArcGIS Server, can be used as a  
Base Map.

ArcGIS Feature
Server

A feature service (feature layer) hosted by ArcGIS
Online or ArcGIS Server. Used in Get Feature to
download feature geometry and attributes.

Map Services
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In map services you can do the following:
 

No. Name Description

1. New Add a new map service.

2. Edit Edit an existing map service.

3. Delete Delete selected map service.

4. Import Import a list of configured WMS/WMTS/WFS
services from the Captivate web services list
format.

5. Export Export selected services to Captivate web
services list format.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.10.2 New

To add a new map service:
 

1. Select File, then Services and then Map Services from the menu.

2. Select New and choose the service type.

New
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3. Insert all necessary login information in the Configuration table.
• Name: The name of map service.
• URL: The web address of map service.
• User Name: Your user name.
• Password: A valid password.

4. Select Get Capabilities to connect to the map service.
☞ Information about the map service appears in the Detail

table after connection.

☞ Activate the checkbox Remember Credentials to save
the login information.

5. For WMTS only:
In the Data table, you can select various Layers and Styles. Click the
arrow in the table field to open a drop-down menu of options.
In the drop-down menu, select the layer/style to define a default
layer/style for your project.

 For WMS only:
In the Data table, various layers are displayed. Select the  eye
icon, to turn the layers on and off.
☞ To switch all the layers on/off in one go, press shift and

select the first and last layer.

6. Select Apply.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.10.3 Edit

To edit the map service:
 

1. Select File, then Services and then Map Services from the menu.

2. Select the map service you want to modify from the list.

3. Select Edit from the ribbon bar or the context menu.

4. Do the changes.

Edit
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5. Select Apply.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.10.4 Delete

To delete a map service:
 

1. Select File, then Services and then Map Services from the menu.

2. Select the map service you want to delete from the list.

3. Select Delete from the ribbon bar or context menu.

4. Select OK.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.10.5 Import

The entire list of configured WMS/WMTS/WFS services (including connection
name, URL, user name) can be imported from Captivate or from another Infin-
ity user using the webServiceList.fil format.

Delete

Import
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To import web service list:
 

1. Select File, then Services and then Map Services from the menu.

2. Select Import.

3. Navigate to the location.

4. Select Open.

☞ To save the web service list in Captivate use transfer user objects.

☞ Passwords are not exported, add them manually in Captivate or
another Infinity instance.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.10.6 Export

Existing WMS/WMTS/WFS services (including connection name, URL, user name)
can be exported to webServiceList.fil format and then used in Captivate or by
another Infinity instance.

To export selected WMS/WMTS/WFS to web service list:
 

1. Select File, then Services and then Map Services from the menu.

Export
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2. Select the WMS//WMTS/WFS services you want to export.

3. Select Export.

4. Select the folder location to export to.

5. Select Save.

☞ To load the web service list in Captivate use transfer user objects.

☞ Passwords are not exported, add them manually in Captivate or
another Infinity instance.

See also:
Get Feature
Base Map
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.11 ArcGIS Online

Infinity supports the ArcGIS Online service. ArcGIS Online is a cloud-based
mapping and analysis solution from ESRI.
You can get access to the feature servers to get data as well as upload
existing projects as web maps.
Requirements:
• Existing account and valid subscription.

To connect to the ArcGIS Online service:
 

1. Select File, then Services and then ArcGIS Online from the menu.

2. Select ArcGIS Online.

3. Enter your User Name and Password.

4. Select Sign In.
☞ You are connected until you select to Sign Out.

When logged in, you can see all supported feature servers grouped as in
ArcGIS Online into: My Content > My Favourites > My Groups > My Organ-
isation.

☞ Living Atlas from ArcGIS Online is not seen, however selected data
can easily be copied to My Favourites or My Groups.

ArcGIS Online
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See also:
Get Feature
Save as an ArcGIS Online Web Map
Map Services
The video "Leica Infinity - Services - How to use the ArcGIS Online ser-
vice" https://www.youtube.com/watch?v=QgFY17R990o

2.1.8.12 Portal for ArcGIS

Infinity supports the Portal for ArcGIS, user-defined ArcGIS on premises server.
You can get access to the feature servers to get data.
Requirements:
• ArcGIS Online account hosted on the customers own premises.

To connect to the Portal for ArcGIS service:
 

1. Select File, then Services and then Portal for ArcGIS from the
menu.

2. Enter the URL, User Name and Password.

3. Select Connect.
☞ You are connected until you select to Sign Out.

When connected, you can see all supported feature servers grouped as in
Portal for ArcGIS: My Content > My Favourites > My Groups > My Organ-
isation.

See also:
Get Feature
Save as Portal for ArcGIS Web Map
https://enterprise.arcgis.com/en/portal/10.4/use/what-is-portal-for-arcgis-.htm

2.1.8.13 Bricsys 24/7

Infinity supports the Bricsys 24/7 cloud service for sharing project data.
It gives users easy access to their projects and to the data required to prepare
for field campaigns.

Portal for ArcGIS

Bricsys 24/7
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Being connected also simplifies providing processed data and data deliverables
to the project by uploading directly from Infinity.
Requirements:
• Valid subscription.

To connect to the Bricsys 24/7 service:
 

1. Select File, then Services and then Bricsys 24/7 from the menu.

2. Enter your User Name and Password.

3. Select Connect.

To import data:
 

1. Select Import from the Home tab.

2. In the Import window, select Bricsys 24/7.

3. View the available files in the Bricsys 24/7 window.

4. Highlight the file to import to the project.

5. Select Download.
☞ The selected file is imported to Infinity and downloaded to

the Bricsys 24/7 directory, in the current Infinity project
directory.

6. Select the data and if necessary specify import settings.

7. Select Import.
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To export data:
 

1. Select Export from the Home tab.

2. In the Export window, select Bricsys 24/7.

3. From the Bricsys 24/7 window, select the directory to export the
data to.

4. Select the data format and export settings.

5. Select Export.

☞ The Bricsys 24/7 data is always copied to the current Infinity project
directory.

2.1.8.14 AUTODESK BIM 360

Infinity supports the AUTODESK BIM 360 service, for an easy and direct collab-
oration with construction projects.
Log in directly to your project services to access, download and upload field
data.
Requirements:
• AUTODESK BIM 360 account and subscription.

You are guided through the steps to log in and authorise Infinity to connect to
the AUTODESK BIM 360 service.

See also:
The video "Leica Infinity with Autodesk BIM 360
service" https://www.youtube.com/watch?v=QMMPzShF2UA&t=0s&list=PL0t-
d7rOVk_IV_al3ziSKuAYA1VVu6W0rM&index=2

2.1.8.15 Bentley ProjectWise

Infinity supports the Bentley ProjectWise service.
Transfer objects easily between Infinity and the ProjectWise server.
Infinity currently supports version 2.0 and above of the ProjectWise Application
Program Interface (API).
Requirements:
• Valid subscription.

AUTODESK BIM 360

Bentley ProjectWise
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To connect to the Bentley ProjectWise service:
 

1. Select File, then Services and then Bentley ProjectWise from the
menu.

2. Enter the URL.
To use the Bentley Projectwise service, enter the full URL, of the
Web Service Gateway instance.
• For example: https://myserver.com/ws/v2.5 (where "v2.5" rep-

resents the Projectwise API version).
• Contact your organisation Projectwise administrator to obtain

the URL.

3. Select the Authentication method from the drop-down list.
Choose to authenticate through:
• Bentley IMS (Federated Identity) - Choose this option when

the Bentley Connection Client is required for the ProjectWise
connection.

• ProjectWise (Non-Federated Identity) - Choose this option
when the Bentley Connection Client is not required for the Pro-
jectWise connection.

4. Enter the User Name and the Password.

5. Select Connect.
To make it as easy as possible:
• Select remember credentials.
• Connect on start-up.

To import data:
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1. Select Import from the Home tab.

2. In the Import window, select Bentley ProjectWise from the drive
list.

3. View the available files in the Bentley ProjectWise window.

4. Highlight the file to import to the project and if necessary specify
the import settings.
☞ The selected file is imported to Infinity and downloaded

to the Bentley ProjectWise directory, in the current Infinity
project directory.

5. Select Download.

To export data:
 

1. Select Export from the Home tab.

2. In the Export window, select Bentley ProjectWise from the drive
list.

3. In the Bentley ProjectWise window, select the location to export the
data to.

4. Enter a File Name and select the Output Type.

5. Select Export.

☞ The Bentley ProjectWise data is always copied to the current Infinity
project directory.

See also:
The video "Leica Infinity - Services - How to use Bentley ProjectWise"
https://www.youtube.com/watch?v=0DEvgPXL4Mg

2.1.8.16 Procore

Infinity supports the Procore service.
Easily transfer data between Infinity and the Procore service.
Requirements:
• Valid subscription.

Procore
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To connect to the Procore service:
 

1. Select File, then Services and then Procore from the menu.

2. Select Procore.

3. Enter your User Name and Password.

4. Select Log In.
☞ Login is controlled with Internet Explorer autocomplete

settings. Selecting the Procore icon logs the current user
out of the Procore service.

To import data:
 

1. Select Import from the Home tab.

2. In the Import window, select Procore.

3. View the available files in the Procore window.

4. Highlight the file to import to the project.

5. Select Download.
☞ The selected file is imported to Infinity and downloaded to

the Procore directory, in the current Infinity project direct-
ory.

6. Select the data and if necessary specify import settings.

7. Select Import.
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To export data:
 

1. Select Export from the Home tab.

2. In the Export window, select Procore.

3. From the Procore window, select the directory to export the data to.

4. Select the data format and export settings.

5. Select Export.

☞ Depending on the project settings, Procore data is either copied to
the current Infinity project directory or the downloads folder.

☞ If the file name already exists, it is uploaded as a new version in the
Procore directory.

☞ Folders cannot be updated if the folder name already exists in the
Procore directory.

See also:
The video "Leica Infinity - Services - How to use the Procore service"
https://www.youtube.com/watch?v=ZtmIA7XlQ0M

2.1.8.17 vGIS

Infinity supports sending data to vGIS. vGIS is a leading extended reality (XR)
visualisation platform that transforms traditional BIM, GIS, reality capture and
other types of data, into practical augmented reality overlays.
Creating digital surface models from images acquired by UAV or GS18 I, you
can share and visualise the models in the vGIS augmented reality field applica-
tion.
Requirements:
• A token provided by vGIS or your customer is required to access the

required service location.

vGIS
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To connect to the vGIS service:
 

1. Select File, then Services and then vGIS from the menu.

2. Enter the Company, then the Token and then press enter.

See also:
Publish to vGIS
https://www.vgis.io/

2.1.9 Preferences

2.1.9.1 Overview

Under preferences you can configure global application settings which apply to
all projects.

 

No. Name Description

1. Display Configure the graphical view.

2. Proxy Define the proxy server.

3. Imaging Define the host for imaging tasks.

4. Window Layout Reset window layout to default position.

Preferences
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2.1.9.2 Display

Under display, you can configure the graphical view. The settings you make
here apply to all projects.

 

No. Name Description

1. Graphics Adapter Change the graphics adapter if automatic
selection is not suitable for you.

2. Background Colour Choose a different background colour for
the graphical view.

3. Show Rotation
Pivot-Point

Show or hide the pivot-point in the centre of
the graphical view.

4. Defaults Reset all the settings to the defaults values.

2.1.9.3 Proxy

Under Proxy you can configure a Proxy server. Only needed if your company
establishes Internet connections through a Proxy.
By default, this option is disabled.

2.1.9.4 Imaging

Under imaging, you can configure the preferences for image rendering, image
processing assets and host configuration.
The settings you configure here apply to all projects.

Display

Proxy

Imaging
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Image import creates a directory to store temporary image-related data
objects for large georeferenced images.
The default path for this folder is: C:\Users\[USER]\AppData\Local\Leica Geo-
systems\Infinity\dzi\.
The default Max. Cache Size for this folder is 20 GB.
The default life length for this folder is seven days.
In File > Preferences > Imaging > Image Rendering, these defaults can be
modified.

 

When Use Image Tiles is checked, temporary image-related data are created
when images are imported or created (for example, when an orthophoto is
created during image processing). The use of image tiles improves image ren-
dering in the graphical view for large georeferenced images.
The Files Location is the location of the folder that has the image tiles.
Using the folder icon, a different folder can be selected. The selected folder
contains the automatically generated dzi folder. Inside the dzi folder, a sub-
folder for each project is generated.
Consider the free disk space, when setting the Files Location.

☞ To improve the processing time, use a fast read-write disk to store
the folder containing the image tiles.

The Max. Cache Size defines the max. size of the folder that has the image
tiles. Older data is deleted once the Max. Cache Size is reached. This process
reduces the size of files on the computer used for image rendering. If deleted,
image tiles are created again when images are requested to be shown in the
graphical view. Increase this number if there is enough free space in the image
tiles location.
The Max. Duration is the life length of the folder that has the image tiles.
When the defined threshold is passed, the image tiles are deleted. This pro-
cess reduces the size of the files on the computer used for image render-
ing. If deleted, image tiles are created again when images are requested to
be shown in the graphical view. Increase this number if there is enough free
space at the image tiles location.

Image Rendering
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☞ Image tiles are anyway deleted when the project is deleted.

Image-processing tasks create an asset directory to store temporary image-
processing related data objects.
The default path for this folder is: C:\Users\[USER]\AppData\Local\Leica Geo-
systems\Infinity\mvs\assets\.
The default life length for this folder is 28 days.
In File > Preferences > Imaging > Image Processing Assets, these defaults
can be modified.

 

The Files Location is the location for the folder containing the Image Pro-
cessing Assets. Using the folder icon, a different folder can be selected.
The selected folder has the automatically generated assets folder. Inside the
assets folder, a subfolder for each project is generated.
When the path is modified, the change applies to projects created from that
moment on, and to old projects where results are not yet generated. If a
project already has a result from image processing: a change in the Files
Location does not apply to it, even if new processes are started in this project.
For each project, all the asset folders are stored in the same parent folder.
When the assets folder directory for a project differs from the one set in
Files Location, an already generated result in that project cannot be stored.
The Open Containing Folder is greyed out when opening the context menu for
such a result.

 

Once the same path is set again in the Files Location: the result can be stored
again and results can be accessed using Open Containing Folder from context
menu.

☞ Another option to make the old results and the old asset folder path
available again, is to run a new task for each project.

If Files Location is modified while a task is running, the change is applied to
the next task, as soon as the processing engine is idle.
When the local computer is connected to a host computer for processing:
the Image Processing Assets is greyed out since the assets folder is created
on the host computer. To modify the settings, go to File > Preferences >

Image Processing
Assets
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Imaging > Image Processing Assets on the host computer and modify the
Files Location.

☞ To improve the processing time, use a fast read-write disk to store
the assets folder.

The Max. Duration is the life length of the folder containing the Image Pro-
cessing Assets. When the defined threshold is passed, the assets are deleted.
Time is computed from the most recently created files in the assets folder.
When the time passed from the creation of the most recent file is longer
than the Max. Duration, the assets are deleted for that project. This process
reduces the size of the files on the computer used for image processing.
Objects created like for example dense point clouds or orthophotos are still
accessible in the project, but a not stored result, cannot be stored anymore.
Set a bigger value if results should be set to stored after more than 28 days.
Set a smaller value if once the process is done and stored there is no need to
store other results eventually present in the project.
The Max. Duration applies to all the assets folders on the computer used for
processing, so a change in this value also impacts previous generated folders.
If Max. Duration is modified while a task is running, the change is applied as
soon as the processing engine is idle.
When the local computer is connected to a host computer for processing:
the Image Processing Assets is greyed out since the assets folder is created
on the host computer. To modify the settings, go to File > Preferences >
Imaging > Image Processing Assets on the host computer and modify the
Max. Duration.

☞ When you delete a result from the Inspector > Imaging > Imaging
Results, the correspondent assets folder is also deleted.

☞ The asset folder is anyway deleted when the project is deleted.

Imaging tasks can be sent to a different computer (host) for processing, as
long as the following requirements are met:
• Both computers have an Infinity licence with the point clouds from images

option.
• Both computers have the same version of Infinity.
• The Infinity image-processing worker host is already running on the com-

puter that is used for processing.
• Infinity is running on the computer that sends the processing task.
• The computers are working within the same network.

By default, the host for image-processing tasks is the local computer, that is
the computer where the project is already running.

Host Configuration
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2.1.10 Help & Support

2.1.10.1 Overview

In help & support you get access to:
 

No. Name Description

1. Localisation Tool Download data predefined for your region.

2. Infinity Help Open the Infinity Help and search for a topic.

3. Tutorials Download tutorials to learn about and how
to use Infinity.

4. Videos Watch videos from the Infinity YouTube
channel.

See also:
Welcome
About

2.1.10.2 Localisation Tool

The localisation tool allows you to download and/or import data that are
pre-defined for your region.
Requirements:
• Latest version of Infinity available.

The following objects are supported:
• Coordinate Systems
• Geoid Models
• Stylesheets
• Training Materials
• Documents
• ASCII Import and Export Templates
• Code Tables

Help & Support

Localisation Tool
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To download/import data:
 

1. Select File, then Help & Support and then Localise your Infinity.

2. Select your Location.

3. Select the check box of the data category you want to down-
load/import. Drill into the category by clicking the little arrow 
to select single files.

4. Select the folder icon to define a download location.

5. The Select Folder window appears and you can change the default
download path.

6. Select Start to start the download/import.

Pre-defined data:

Coordinate Sys-
tems

Downloaded coordinate systems are automatically
imported and available for use under Coordinate 
Systems.
In the coordinate system manager, select Copy to
Project, to make the selected coordinate system
available for use in the currently active project.

Geoid Models Geoid models and CSCS models can be downloaded
and imported separately. After download, they
are automatically available for further use in the
coordinate system manager.

Stylesheets Downloaded stylesheets are automatically imported
and available to select in the settings for exporting
data using stylesheets.

Training Materials Downloaded training materials, for example tutorials,
are saved in the selected download location.

Documents Downloaded documents, for example readme files,
are saved in the selected download location.

ASCII Import/Export
Templates

Downloaded templates are automatically imported
and available to select in Import ASCII Data or
Export ASCII Data.

Code Tables Downloaded code tables are automatically imported
and available for use under Code Tables.

☞ Only data provided by your local Leica distributor is available for
download.

Basic Modules 115



See also:
Coordinate Systems
Training Materials
Import ASCII Data
Export ASCII Data

2.1.11 About

2.1.11.1 Overview

In about you get information on:
 

No. Name Description

1. About Leica Infinity Check your Infinity version as well as the
maintenance information.

2. Check for Updates Check for the latest updates available for
Infinity.

3. Licence Information The purchased product options are listed
together with your licence model.

☞ Under the Improvement program, you are asked to contribute
towards the improvement of the quality and performance of Infinity.
Leica Geosystems AG collects anonymous information about hard-
ware configuration and application usage.

☞ Under Legal Trademarks, you are informed that and how Leica Infinity
is protected by copyright.

☞ Under Remarks, you are informed on the legal and licensing notices
on third party software components that Infinity uses.

2.1.11.2 Check for Updates

Periodically, Infinity updates are made available for download and installation.
These updates can include new releases with new modules or new features.
Updates can also include maintenance releases with software patches.
You can check for updates from the About menu under the File tab, or have
the checks made automatically on start-up. Updates can be downloaded from

About

Check for Updates
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myWorld@leica-geosystems.com, the Leica Geosystems customer information
portal.
To get the most from any new updates for Infinity, it is recommended to have
a current Leica Geosystems Customer Care Package (CCP). With an active CCP,
access to all software updates including new releases is available.

☞ For users who do not have administrator rights on their computer,
the Check for Update message only informs of available updates. The
files required for any update must be downloaded and installed by
your IT department or a person with administrative rights for that
computer.

2.1.11.3 Licence Information

The purchased product options are listed together with your licence model.
You can also see when your licence expires and your maintenance should be
renewed.

If you are using a floating licence you can:
• If necessary, connect to a different licence server.
• See whether an option is momentarily available.
• See the borrowed licence options and expiration data.

2.2 Home

2.2.1 Overview

The home tab is the core data flow working module. You can visualise, quality
control, perform basic edits and generate reports from this module.
The home tab bundles some general functionality for data handling and data
creation.

In the home tab you can do the following:

No. Group
Name

Name Description

1. Data Data Import Import all supported data formats using
import dialog or drag and drop.

Data Export Export all or selected data to many dif-
ferent formats.

Reports Create detailed reports on your project
data.

2. New New Point Create new points.

New Station Create new stations.

New Obser-
vation

Create new observations.

3. Layers Layer Man-
ager

Open layer manager and set the colour,
style and export settings for the library
data.

Licence Information

Home
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No. Group
Name

Name Description

Survey Data Explore the imported survey data: Switch
them on/off or lock/unlock them.

Thematic
Codes

All feature codes are organised in layers:
Switch them on/off or lock/unlock them.

Referenced
Files

All the layers as defined in referenced
files: Switch them on/off or lock/unlock
them.

4. Map
Services

Base Map Turn on or off one of the available base
maps.

Clip Base 
Map

Clip a base map as a georeference image
stored to the project.

Feature Info Get information about objects at the
mouse position.

Get Feature Download data from a Web Feature Ser-
vice (WFS).

Google Earth Visualise the project data in Google
Earth.

5. Images Link Images Select an image and link it to a point,
line or area.

Unlink 
Images

Remove an image linked to a feature.

Georefer-
ence Images

Select an image to ortho rectify.

6. COGO Measure 
Point to 
Point

Measure point to point.

Compute 
Point

Compute point.

Shift, 
Rotate, Scale

Shift, rotate, scale.

7. Coordin-
ates

Compute 
Project 
Coordinates

Compute project coordinates.

Coordinate 
System Man-
ager

Open the coordinate system manager.

Transform 
Local Grid to 
Local Grid

Transform local grid coordinates from
coordinate system A to another local
grid coordinate system B.

2.2.2 Data Import

2.2.2.1 Overview

Data can be imported to the current project from different sources. Based on
the type of data you can define and apply specific settings and filters. The

Data Import
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import functionality is available either from inside the File tab or from inside
the Home tab.

☞ It is only possible to import data into a project if the project is open
in the application. Check if the Import menu is active. If not then
open a project first either by creating a new project or by opening an
existing project from inside the File > Project Manager.

☞ Imported data files are listed in the Navigator under Source. Select
any file to view its properties in the property grid.

To import data:
1. Go to the File tab and select Import from the menu on the left side

or go to the Home tab and select Import from the ribbon bar.

In the Import dialog:

2. Select the Type of the source file to be imported.

3. Browse to the location where the source file is stored.
All source files of the selected file type that are available in the
selected location are listed in the content area of the dialog under
Files.
☞ Select the Show subfolders option to list all files that are

of the selected type, but contained in subfolders.

4. Select the Source files to be imported.
☞ Only files of the same type can be multi-selected.

☞ Selecting a file and pressing Ctrl+A, selects all files that are
of the same type.

5. Select the Import option.

To import data by drag and drop:
1. On your computing device: Open the file explorer and browse to the

location where the file is stored.

2. In the Infinity software: Select the Home tab in the ribbon bar and
activate View within an open project.

3. Go to the file explorer and drag and drop the file into the View area
to import the file.

Import Formats

ASCII A template must to be defined. See also Import ASCII 
Data.

SKI ASCII SKI ASCII files are written in a specific ASCII format
to exchange information on baseline vectors. See also
Importing SKI ASCII Files.

Captivate/Smart-
Worx DBX

Imports all data belonging to a job measured in the field.
Points that were deleted in the field are by default also
imported. Under Settings, de-select this option if you
do not want deleted points to be imported.
☞ Points that were deleted in the field can

be recovered in the Navigator or in the
Inspector.

Basic Modules 119



GNSS Raw Data *.MDB only - Imports only the raw GNSS data from Cap-
tivate/SmartWorx jobs.
RINEX 2.10, 2.11, 3.02 and 3.04 supported.
Hatanaka supported (for example, RINEX observations
files in a compressed format preferably used when
observations are downloaded online from permanent
reference station sites).

Level Data Import *.LEV format level data from the DNA levels.

Coordinate Sys-
tems

Coordinate systems can be imported from:
*.dat files from Leica.
*.lok files from iCON and SBG Geo.
*.dc, *.cal and *.jxl coordinate system files from Trimble.

XML Supported are LandXML and HeXML files.

Scan Data Point Clouds can be imported from:
*.pts or *.ptx, both of which are ASCII based formats.
*.xyz.
*.sdb, the Leica specific format.
*.las/ *.laz.
☞ Importing to *.las/ *.laz: Data has to be in the

local grid coordinate system.

☞ Importing to *.las/ *.laz: If the data includes
classification, a point cloud group is created.
Each classification is written as a point cloud
that belongs to the point cloud group.

Images - JPG,
PNG, TIFF

Imports images from *.JPEG, *.PNG and *.TIFF.

Georeferenced
Images

Imports georeferenced images from *.JPEG, *.PNG and
*.TIFF with respective world files in *.JGW,*.PGW,*.TFW.

CAD Imports CAD data from *.dxf, *.dwg and *.dgn.

ICM Import the Bentley ICM file with the alignment and sur-
face.

BIM Import building information modelling data from *.ifc or
*.ifczip files.
Data structure (structure, types, layers) is preserved.

ESRI Shape files Imports points, lines and areas information from ESRI
Shape files (*.shp).
☞ The attribute information from the (*.dbf) is

imported as well and is listed in the Attribute
table available from the Data Source context
menu.

ESRI Geodata-
base

Imports points, lines, areas and codes definition from
ESRI file geodatabase (.gdb) and mobile geodatabase
(.geodatabase).
☞ Data can be imported from .zip files.

GeoJSON Imports points, lines and areas information from
GeoJSON GIS file format (*.geojson).
☞ The attribute information is imported as well

and is listed in the Attribute table available
from the Data Source context menu.
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GEO Viewer -
KML, KMZ

Import points, lines and areas information from *.KML,
*.KMZ.
☞ The attribute information is imported as well

and listed in properties.

Zeno Mobile Import Zeno mobile projects as zip files. The zip file
has shape files, GNSS observations, linked images and
defined coordinate systems.

Observation Data
GSI

Import *.GSI format for level data, points and TPS obser-
vations.
For TPS observations:
From the Import Settings table, you can select how the
feature codes shall be processed during the import.
In the Interpret Features field, you can choose if fea-
ture coding is interpreted as Thematic, Free or None.
Thematic: A point-related code is created. Decide on
which point or points the code shall be related to.
Free: The result is a time stamp code. Time stamp codes
are not point-related.
None: Codes are ignored. Points are created without
codes.
Thematic codes may belong to either previous or follow-
ing points. In theApply Code to field you can decide on
which points the feature code shall be applied to:
Previous point or Following point.
All previous points until different code or All fol-
lowing points until different code is encountered
while reading the raw data file.
All previous and following points is encountered
while reading the raw data file.
☞ Codes registered as WI 71 are imported as

thematical codes independent of the coding
import setting.

Aibot Data The Aibot data include image, GNSS and sensor informa-
tion.

LGO Project/CSYS Import LGO projects or LGO global coordinate systems.
The coordinate systems and georeferenced images
attached to a project are imported when the path to the
database ODB folder is defined.
To import all global coordinate systems navigate to the
CSysDb dbd file, default path: C:\ProgramData\Leica Geo-
systems\LGO\ODB\Fixed\CSysDb\.
For more information, see Import LGO Project.

ZIP Various compressed file formats (*.zip) are supported
and show in the import dialog, if import is possible.
Infinity attempts to preview the file contents to determ-
ine the correct import format.
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Navigation features in the Import dialog
Two special folders support better navigation between locations:
• Under  Recent, the last used locations are listed.
• Under  Favourites, the locations are listed that you marked as a

favourite by selecting the  Set/Reset favourite folder option.

Favourites can be removed from the list by selecting  Remove from the
context menu.

To  Refresh the navigation pane,  Rename or  Delete a folder or to

create a  New Directory:

Right-click onto the folder and select the desired function from the context
menu.
It is also possible to copy and paste a location. Double-click the breadcrumbs
in the files pane to make the field become editable and copy the desired path
to it.

2.2.2.2 Import ASCII Data

To import ASCII files into your project you have to use the ASCII import. A
template must be defined to identify user-specific data structures which are
typical of ASCII files.

☞ Without a suitable and correctly defined template, it is not possible
to read the data structure in the ASCII file nor to import the data.

To import ASCII data:
1. Go to the file tab and select Import from the menu on the left side

or go to the Home tab and select Import from the ribbon bar.

In the Import dialog:

2. Select ASCII as the type of source file to be imported.

3. Browse to the file to be imported and select the file.

4. Under ASCII Settings select an existing Template that fits the file
format or select New... to define a new one.
Confirm a newly defined template with OK.

5. Select the Import option.

Defining an ASCII Import template:
 

Import ASCII Data
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Settings:
• Define at which row the import shall be started.

If the ASCII files have a header in row 1 then start the import at row 2 (for
example, at the row that has the first data set).

• Identify the Column Separator.
Select Treat Consecutive Delimiters as One if necessary. See the fol-
lowing for further information.

• Identify the Decimal Separators that are used in the ASCII file.
• Identify the correct Coordinate Format and Height Mode of the data to be

imported.
• Select the Point Role that shall be assigned to the imported points.
• Identify the Linear Unit.
• If you intend to import geodetic coordinates identify the Coordinate

Format.
For more information, refer to:

Attributes:

• Identify the Attribute and Value Separators that are used in the ASCII
file.

• A preview shows you which structure is expected based on your set-
tings.

☞ Preview and ASCII file must correspond to each other.

Preview:

• Identify the data type in each column by selecting a type from the
drop-down menus.
To identify the column point ID is mandatory. All other data types can
optionally be set.

☞ Columns of type Unused are ignored during import.

☞ For the height, only the previously selected mode is available for
selection.

☞ If a column only has attribute values (without the attribute name)
then select Attribute Value from the drop-down menu.
If the name is given in the file header then it is taken from there.
I
If the header is empty a default name is assigned.

Treat consecutive delimiters as one
It may happen that your ASCII file looks like this:

Using two tabs following each other in the first row but only one as separator
in the following rows. ASCII Import would interpret this as:
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Making it impossible to identify the columns.
Select Treat consecutive delimiters as one to achieve a correct interpreta-
tion of the columns.
The resulting columns in the Preview are inline and you are able to identify
each by its header.

Geodetic Coordinate Formats
If you intend to import geodetic coordinates from a text file the coordinates
have to be in one of the following formats:

DD.DDDD

Or

With the "-" sign indicating West and South.

DD MM SS

Or

With the "-" sign indicating West and South.

DD.MMSS

Or
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With the "-" sign indicating West and South.

2.2.2.3 Importing SKI ASCII Files

When you want to import post-processed GNSS baselines as observations into
Infinity, for example as input to an adjustments computation, then you can do
so though the SKI ASCII Import.
SKI ASCII files are written in a specific ASCII format to exchange information on
baseline vectors.
In the import dialog:

1. Select SKI ASCII files (*.asc) as file type.

2. Browse to the location where the SKI ASCII file is stored and select
the file to be imported.

3. Select the Import option.

In the Infinity project:

4. Select a coordinate system to be used for displaying the imported
GNSS observations.

SKI ASCII files that have baseline vector information always hold this inform-
ation in WGS84. But Leica Infinity only displays data that is either stored
as local grid or can be converted to local grid. Thus a coordinate system is
required to convert the GNSS observations to local grid and make them visible
in the graphical view. On how to assign a coordinate system to a project, see
Coordinate Systems.

2.2.2.4 Import Aibot Data

To import Aibot data:
 

1. Select the .uav file in the import dialog.

2. Specify the exact path where the images can be found at Image
Location.

Importing SKI ASCII
Files

Importing Aibot Data
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3. Select whether to import images or not. If the Import Images
checkbox is not selected, images are linked to the project from the
import folder.

4. Select the Import option.

Once the Aibot file is imported, a points group, an image group and a GNSS
tracks group are automatically created. The image group holds the flight object
and the images acquired during the flight.

Depending on the type of Aibot licence, at import you can have:

• Autonomous flight (no GNSS correction received during the flight).

• RTK flight (GNSS correction are received during the flight to get very
accurate image positions).

The default name of the image group is the name of the flight.

☞ The position of the images is updated automatically with respect to
the flight track. No additional synchronisation is required.
If the position of the RTK base station is updated either by manually
updating the station coordinates or by processing it from another
reference station, then the flight track is automatically updated.
Therefore also the position of the images is updated.
If GNSS raw data have been logged, they can be post-processed in
Infinity using a reference station. Once the processing results are
stored, the flight track is automatically updated. Therefore also the
position of the images is updated.

Information about the flight can be found in the flight report as well as the
data source report.

To create a flight report:
1. Select the image group that contains the Aibot data.

2. Select Flight Report from Reports in the Home ribbon bar or use
the context menu.

The flight report includes information about:
• The flight: Start and end time and number of events.
• The sensor: Model, serial number and firmware version.
• The GNSS track: Start and end time, length, receiver name and serial

number, sampling rate and so on.
• The GNSS intervals and the reference station (if any).
• The image group: Number of images, size, sensor and camera model.
• The interior orientation of the camera.

The image data from Aibot can be processed using the Imaging Point Clouds
module.
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2.2.2.5 Import DJI GNSS Flight Data

To import DJI flight data:
 

1. Select the .dji file in the import dialog.

2. Specify the exact path where the images can be found at Image
Location. Default is the current folder.

3. Select whether to import images or not. If the Import Images
checkbox is not selected, images are linked to the project from the
import folder.

4. Select Import.

Once the DJI file is imported, an image group is created in the library; it has
the images and the track.
A GNSS tracks node with the imported track is also created.
The default name of the image group is the name of the flight. It can be
modified at any time.

 

Import DJI GNSS Flight
Data

Basic Modules 127



☞ When the images are not located in the same folder as the Flight
Data, the image location can be set accordingly using the import
dialog.
If multiple DJI flights are copied in the same folder, they can be
imported together selecting them in the import dialog at the same
time.
If multiple DJI flights are in the same folder, and only one is needed,
only the images connected to the selected DJI file are imported.
You can drag and drop data into the application using the
events .MRK file.
If the GNSS data is not of interest, only the images are imported by
selecting them instead of the DJI file.
The GNSS track can be post-processed in Infinity using a reference
station. Once the processing results are stored, the positions of the
images are automatically updated, and can be used for a standard
image-processing workflow.

To create a flight report:
1. Select the image group that has the DJI data.

2. Select Flight Report from Reports in the Home ribbon bar or use
the context menu.

The flight report includes information about:
• The flight: Start and end time and number of events.
• The sensor: Model, serial number and firmware version.
• The GNSS track: Start and end time, length, receiver name and serial

number, sampling rate and so on.
• The GNSS intervals and the reference station (if any).
• The image group: Number of images, size, sensor and camera model.
• The interior orientation of the camera.

The image data from DJI can be processed using the Imaging Point Clouds
module.

See also:
The tutorial "How to work with DJI drones - GNSS and image processing
workflow"

☞ The tutorial can be downloaded in the Localisation Tool.

2.2.2.6 Import LGO Project

With this function, it is possible to import data from LGO projects into Infinity.

To import an LGO Project:
Drag and drop:

1. Navigate to the LGO project folder in Windows File Explorer or sim-
ilar.

2. Select, then drag the LGO project folder and drop it into Infinity.

☞ Default import settings are used.

Or

Import LGO Project
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Import dialog:
 

1. Navigate to LGO project folder and select the project to import data
from.

2. Choose the data format for import to LGO Project/CSYS to filter the
import view.

3. Specify the path of the LGO database (ODB).
☞ If LGO is installed on the computer the path is recognised

automatically. If LGO is not installed, copy the ODB direct-
ory from another computer and the path to it is defined
here.

4. Select whether to Show Data Source Report.

5. Select Import.

The list of supported LGO objects and the data that can be imported is
explained in the following table:

Object What is supported or not supported

Features Supported: Points, lines, areas with codes and assigned
Images.
Not supported: Shading styles for areas.

Coordinate Sys-
tem CSYS

Supported: Coordinate systems from the CSYS manager
or a project.
Not supported: If the coordinate system has a
geoid.exe file or a stepwise/interpolation transformation,
the CSYS is skipped on import.

TPS Supported: Stations, observations, setups, traverse,
Sets of Angles.
☞ Set orientation with known azimuth option

from LGO is transferred to known backsight
method.

GNSS Supported: Stations, observations with QC values,
tracks and interval events, antennas.
Not supported: Raw data is not imported.
☞ Use the RINEX format to export from LGO and

import to Infinity if reprocessing is required.

GNSS Hidden
Points

Supported: Offset information.
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Object What is supported or not supported

Level Supported: Observations and level lines.
☞ To view misclosure and height errors, repro-

cess the level line.

Codelists Supported: Project codelist imported to Infinity as field
codes.
Not supported: Global codelists.

Images Supported: Images linked to points, lines, areas, TPS
stations as well as not linked images.

Georeferenced
Images

Supported: If LGO is installed on the same computer
as Infinity and the path to the database folder (ODB) is
defined.

Free Codes Supported: LGO free codes are imported as with the
option Apply leap seconds set in LGO.

Surfaces Supported: Surfaces with boundaries and breaklines.
☞ If the surface vertices are stored in WGS84,

the created surface is not editable.
Not supported: Importing contours.

DXF Background
Maps

Not supported: Imported separately using the
DXF/DWG import.

2.2.3 Data Export

2.2.3.1 Overview

From your current project either all data can be exported or just a selection
of objects or sources. You can choose from different file formats. When you
export a selection make sure that the selected object fits to and can be
exported in the chosen format.

☞ Exported files are listed in the Navigator under Archive. Select any
file to view its properties in the property grid.

To export data:
1. Select the Export option in the ribbon bar. If elements are selected

either graphically or in the Navigator or in the Inspector choose
between exporting All or Selection from the drop-down menu.

2. In the Export dialog:
Select the Destination where the exported data shall be stored to.

3. Give the file to be exported a Name without extension.
The file extension is given automatically according to the selected
file type.

4. Select the Type of the file to be exported.

5. Choose whether a subdirectory shall be created. If you select the
checkbox a subdirectory of the same name as the file is created and
the file is written to it.

6. Select the Export option.

Data Export

130 Basic Modules



Export Formats

ASCII A template must be defined. See also:
Export ASCII Data

SmartWorx DBX You can export points and/or lines and areas and/or sur-
faces as DTM and/or alignments and/or infrastructures
and/or GEM files.
For points, select the Roles to be exported. Choose
between:
Highest: To export only the highest role for each point.
All: To export all available roles for each point.
Selection: To export only the selected roles.
For lines/areas, the points that define the line/area are
automatically exported, too.
For alignments, you can select the export To Road Job ,
To Rail Job or To Tunnel Job.
☞ If you export a selection, make sure that you

select the correct object type under Settings
to avoid empty files to be written.

Select the checkbox to Create .zip file.
☞ The suffix _dbx is added to the end of the file

name for example " [file name]_dbx.zip".

☞ This option is not available when using Leica
Exchange service.

ESRI - SHP You can export points and/or lines and areas. For points
and for lines and areas, you can select various Addi-
tional Attributes.
You can select the Dimension: 2D or 3D.
You can select if the images should be exported as Indi-
vidual or Combined.
Combined image files are exported as a jpg and html. If
the images checkbox is selected in Additional Attributes,
only one attribute with multiple images is created.
Individual image files are exported as a jpg. If the
Images checkbox is selected in Additional Attributes, a
separate attribute is created per image.

ESRI File
Geodatabase -
GDB

Export project data with thematic information as an ESRI
GDB File Geodatabase. points, lines and areas are expor-
ted with their assigned code and code attributes.
You can select the Dimension: 2D or 3D.
☞ All data is written with WGS84.

Coordinate Sys-
tems

All coordinate systems available with the current project
are exported and saved to the same TRFSET.DAT file or
separate iCON/SBG Geo LOK, Trimble JXL files.
☞ If you export to DBX, LandXML or HeXML

always the master coordinate system is expor-
ted with your data. If None is used then your
data is exported without any coordinate sys-
tem information.
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XML Supported are HeXML and LandXML.
You have the option to use an XSL Stylesheet to format
the output. You can use the same stylesheets as avail-
able with SmartWorx Viva or define your own.

KML/KMZ All library objects are exported except for cloud points.

Images Images are exported in JPG, PNG and TIFF format.

Georeferenced
Images

Georeferenced images can be exported in JPG, PNG and
TIFF format with the respective world file (JGW, PGW,
TFW), and in geoTIFF format. JPG and PNG format can be
used by onboard software.

Georeferenced
DEM - TIFF,
geoTIFF

Surfaces are exported as raster in TIFF (with the respect-
ive TFW world file) and geoTIFF format.

GNSS raw data -
RINEX

You can select the following Export Settings:
RINEX version: Select whether you want to save files as
RINEX files (version 2.11) or as RINEX files (version 3.04).
Apply Interval Windows: Select the checkbox if you
want to apply the interval windows to the exported
RINEX files.
Separate files for different tracks: Select the check-
box if you want to write a separate file for each track.
☞ The files are named according to the point ID,

day of year and session number.
Satellite Systems: Select the GNSS constellation to be
exported.

Point Cloud Point Clouds can be exported to:
*.e57.
*.las/*.laz.
*.ply.
*.pts, which is an ASCII based format.
*.Igs
☞ When exporting to *.las/*.laz note that Infinity

does not support any classification of points.

☞ When exporting to *.Igs, a valid Cyclone Pub-
lisher or Cyclone Publisher Pro (from Infinity
3.4 on) licence is required.

☞ When exporting in .lgs format, point cloud
includes:
MSxx/TLS data - Point cloud arrived from
instruments and panoramas.
UAV/GS18 I data - Dense point cloud
and images which were used for point cloud
reconstruction.

AutoCAD You can export your project data as well as BIM entities
to *.dxf or *.dwg.
There is no necessity to first create library objects from
BIM entities.

Aibotix AiProF-
light

Kinematic tracks can be exported for use onboard
Aibotix AiProFlight devices. See also:
Export UAV Track and Import to AiProFlight Software
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GeoMoS Now For points, select the Point Roles to be exported.
Choose between:
Highest: To export only the highest role for each point.
All: To export all available roles for each point.
Selection: To export only the selected roles.

Bentley - FWD Project data can be exported to the Bentley FWD format.

Navigation features in the export dialog
Two special folders support better navigation between locations:
• Under  Recent, the last used locations are listed.
• Under  Favourites, the locations are listed that you marked as a

favourite by pressing the  Set/Reset favourite folder option.

Favourites can be removed from the list by selecting  Remove from the
context menu.

To  Refresh the navigation pane,  Rename or  Delete a folder or to

create a  New Directory:

Right-click onto the folder and select the desired function from the context
menu.
It is also possible to copy & paste a location. Double-click onto the bread-
crumbs in the files pane to make the field become editable and copy the
desired path to it.

2.2.3.2 Export ASCII Data

The ASCII export allows you to extract point information from your project to
an ASCII file. The export format must be defined in a template. In the template
you specify and store information like:
• A template name.
• ASCII specific settings.
• File content settings.

To export data to an ASCII file:
1. Go to the File tab and select Export from the menu on the left side

or go to the Home tab and select Export from the ribbon bar.

In the export dialog:

2. Select ASCII as the Type of source file to be exported.

3. Browse to a location where the exported file shall be written to (for
example, to the drive, folder).

4. Give the file a Name. You can choose a file extension from the
drop-down list or give the name any file extension you want.

5. Choose whether a subdirectory shall be created. If you tick the
checkbox a subdirectory of the same name as the file is created and
the file is written to it.

6. Under Settings select an existing Template that fits the file format
or select New... to define a new one.
Confirm a newly defined template with OK.

7. Select the Export option.

Export ASCII Data
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Defining a new ASCII Export template
 

Settings:

• Select to Export Column Headers if desired.
• Select the Column Separator to be used in the exported ASCII file.
• Select the Point Roles to be exported.

Choose between Highest to export only the highest role for each point,
All to export all available roles for each point or Selection to export
only the selected roles.

• Select the type of Coordinates to be exported.
☞ Only available coordinates or coordinates that can be derived

from a transformation calculation are exported.
• Select the Height Mode to be exported.
☞ Only the available height mode is exported or the geoid separa-

tions must be known.
• Set the Units for exported distances.
• If you intend to export geodetic coordinates, identify the coordinate

format.
For more information, refer to:

• Choose the precision for Rounding.
• Select whether the exported data shall be sorted by Point ID, Date/

Time or Feature.
Sort by Feature: It is possible to export ASCII data sorted by Feature to
better support moving field collected data to third party software.

• If you select Sort by Date/Time, you can activate Export Free Codes
by selecting the checkbox.
Free codes are purely time-related information. They are recorded in
between of measurements in the field. A time stamp is recorded with
each free code allowing to export points and free codes in a chronolo-
gical order to be used for third-party mapping software.

• Select the File Extension to specify the file type of the export file.

Special Code:
Define the output for the Code Expression, that sets how the code, attribute,
code information and feature name is written in the ASCII export, including the
Field Separator.
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To define the code expression, do the following:
 

1. In the Export ASCII Template Editor, select Sort by Feature.

2. In the Code Expression field, select the  Edit icon to open the
Edit Code Expression dialog.

3. In the Edit Code Expression dialog, define the Code Expression by
selecting or entering the patterns to be part of the export.

☞ You can write special characters in between patterns, for example
[C]/[N]*[L]*[V1], then they get exported in all cases.
You can write one special character before or after the pattern, then
the special character only gets exported, if the pattern itself exists,
for example [C][/N][*L][*V1].

Attributes:

• Select the Attribute and the Value Separator that shall be used in the
ASCII file.

• A preview shows you how the attribute columns are structured in the
ASCII file based on your settings.

Preview:

• The Preview shows you how the data is written to the ASCII file.
Select the columns to be exported. Unchecked columns are not expor-
ted.

☞ Only data that is available according to the given ASCII settings
are available for selection.

• To change the sequence of columns in the ASCII file, shift them (by click-
ing and dragging them) in the Preview.
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Geodetic Coordinate Formats
If you intend, to export geodetic coordinates to a text file, the coordinates can
be exported in one of the following formats:
DD.DDDD.

With the "-" sign indicating West and South.
DD MM SS.

With the "-" sign indicating West and South.
DD.MMSS.

With the "-" sign indicating West and South.

2.2.3.3 Export UAV Track and Import to AiProFlight Software

UAV data coming from the Aibot can be processed by Infinity.
Process the track and then export an updated coordinate file that is used to
update the geotags of the images in the AiProFlight software.

In Infinity:
1. Select the track from the graphical view.

2. Select Export to Aibotix AiProFlight from the context menu.

3. In the Export dialog, enter all the necessary information.

4. Select Export to create a txt file which can be used in AiProFlight.

In AiProFLight:
1. Go to the Log Manager tab.

Export UAV Track and
Import to AiProFlight
Software
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2. Right-click on the white tab and select Import Log File.

3. Select your log file. The log file is provided to you together with the
flight data and the photos.

4. Select the imported Log File. Right-click and select Geotag the
selected log.

5. A question might pop up in case the log file contains high precision
GPS data:

6. Select Yes to continue using high precision GPS data.

7. In the Photo Selection tab, select the folder that contains the
photos of the specific flight. Import your photos.
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8. In the Coordinates tab, import the output file from Infinity.

9. Once the file is imported, activate Use Coordinates from file.

10. On how to update the image geotags and the steps that are neces-
sary to do so, refer to the Aibot Help.

2.2.4 Reports

An important part of any project is the documentation of the data import, field
work and project processing results. Run and store the reports and be aware
of all the reports from the navigator archive.

Reports
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To run a report:
 

1. Select the objects that you want to have the report of. You can
also select the results of processing or adjustment runs or of single
volume calculations.
☞ In some cases, you can run reports on all the data of the

project, such as points, TPS setups, TPS and GNSS obser-
vations.

2. Select the Foresights Report option in the Home tab or select
Report from the context menu.

3. Report opens in Report Manager.
☞ Values exceeding limits are marked in bold red.

Go to File > Info & Settings to set the tolerances as
required.

For each report, the following operations are possible:

Icon Description

Save the report as a PDF or HTML file.

Print the report.

Open the report in an Internet Browser.

Add an image/HTML file as a Report Header.

Reset the Report Header to the Leica default.

Saved reports are seen in the Project Archive in the Navigator.

For a selected report from within the context menu, the following oper-
ations are possible:

Icon Description

Open the report.

Open the report in containing folder.

Remove the report.

Basic Modules 139



Icon Description

Open properties.

Reports on Data Sources
After importing a Captivate/SmartWorx DBX job, it is possible to run a report to
document the imported state of the data source. In some cases editing of the
imported data is necessary to fix various field errors or to shift the data from
local to grid coordinates. You can run again the Data Source Report to store
the edited state of the data source.
1. Run report after import to document the field data as measured.

2. After edits have been made run a second report to document the
current or final state of the field data.

2.2.5 Map Services

2.2.5.1 Base Map

It is possible to use a base map in your project. The base map function is a
nice way to help visualise, reference and relate your project data.
We distinguish between predefined and user-defined base maps.

The following predefined base maps are available:
• HxIP (Hexagon Imagery Program).
• OSM (OpenStreetMap).
• ESRI.
• NGS Topo.
• A coordinate system defined in the project.
• At least one point in the local grid value available in the project.
• Internet access to stream the image tiles or maps.
• Valid CCP is required to use Leica predefined base maps.
• Manually added services do not require a valid CCP.
Requirements:
• A coordinate system defined in the project.
• At least one point in the local grid value available in the project.
• Internet access to stream the image tiles or maps.
• Valid CCP is required to use Leica predefined base maps.
• Manually added services do not require a valid CCP.

The base map is drawn below all project data, regardless of height values.

To enable or disable base map:
 

Base Map
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1. Go to the Home tab and select Toggle Base Map.

2. From the drop-down list, select between the available services.

3. Define the Max Zoom Level.
☞ The default Max Zoom Level is 19 and in normal circum-

stances should stay in this setting.

☞ Higher-quality map services can be viewed in a higher
zoom level. The larger the values of the Max Zoom Level,
the better the resolution.

4. The base map is drawn below all project data, regardless of the
height values.

5. Enable the 3D terrain from the graphical view tool bar to view base
maps in 3D.

To add a new map service, see Map Services.

☞ All base maps can be viewed in 3D. Enable the 3D terrain from the
graphical view tool bar. The default DEM has a resolution of approx-
imately one arcsecond.

☞ Log in to Earth Data from Services in order to enable the 3D Terrain
model option on the view tool bar.
Elevation data is downloaded and shown once the login is estab-
lished and the 3D Terrain model option is active.
The downloaded elevation data is stored by Infinity in the folder:
C:\ProgramData\Leica Geosystems\Infinity\dems\SRTM\version3_0 to
be also used in offline mode.
It is possible to add elevation data to the folder manually, to work
with the 3D Terrain model offline.

See also:
Hexagon Imagery Program
OpenStreetMap
Map Services
Get Feature
Google Earth
Feature Info
The video "Leica Infinity - Home Module - Using Base Maps" https://
www.youtube.com/watch?v=ZPXJSI3WWVM
Once the login is done, and the 3D Terrain model is active,

2.2.5.2 Clip Base Map

With clip base map, it is possible to clip the base map and store it to the
project as a georeferenced image.
When you clip the base map, the image or map that is downloaded is what
you see as displayed in the graphical view.
Requirements:
• Active base map.

Clip Base Map
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To clip base map:
 

1. Navigate to the map area you want to download.

2. Select Clip Base Map from the ribbon bar.

3. The clip base map window opens.

4. Enter a Name for the georeferenced image to download.

5. Select the level of detail.
☞ Available depending on the service set as the active base

map.

☞ Base map image services, use tiles of images to cover the
area of display. When you download an image, it is there-
fore downloading tiles, the detail level of the tiles starts
from the display in the graphical view. You can increase
the level of detail for the image tiles to download. The
detail level is normally indicated by a number between the
range of 1 - 20, where 20 is the highest level of detail.
Keep in mind that the more detail you want to download,
the larger the size of image tiles being downloaded. The
maximum number of tiles possible to download is 1200,
regardless of the level of detail.

6. Select Create.

7. Georeferenced images are shown as objects in the library and can
be set to visible or not visible.

8. Enable the 3D terrain from the graphical view tool bar.
☞ All clipped base maps can be viewed in 3D.

☞ The default DEM has a resolution of approximately one
arcsecond.

☞ When exporting a project with georeferenced images to Captivate,
the georeferenced images are also exported. To export a georefer-
enced image to Captivate simply attach it to a project and export the
project to Captivate.

See also:
Base Map
The video "Leica Infinity - Home Module - Using Base Maps" https://
www.youtube.com/watch?v=ZPXJSI3WWVM
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2.2.5.3 Feature Info

With the feature info it is possible to discover data directly from the base map
view.

To get the basic feature info from predefined base maps:
 

1. Enable any of the predefined base maps.

2. From the Home tab, select the Feature Info option.

3. Click into the desired area of the displayed map.

4. Available position information, including street view images from
mapillary service is displayed in the property grid.

5. Copy the active image to the library and show its position in graph-
ical view.

To download feature info like attributes or geometry from user-defined
web map service:

☞ Identifying features is done on visible web map service layers.

 

Feature Info
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1. In File, define the web map service which supports querying of the
features.
For more information, refer to File > Services > Map services.

2. In File, turn the layers on or off.
☞ If too many layers are on, the performance is affected.

3. In the project, select the defined Web Map Service as a base map.

4. Select the Feature Info option.

5. Click into the desired area of the displayed map.

6. Available position information, including images, feature geometry
and attributes is displayed in the property grid.

7. Download the single feature or only the code with attributes.

2.2.5.4 Get Feature

With the get feature it is possible to download features like points, lines,
areas, together with their codes and attributes from user-defined Web Feature
Service (WFS) or ArcGIS Online feature servers.

☞ When logged in to ArcGIS Online the feature servers are added auto-
matically to the list.

☞ To visualise the data in Infinity, it is necessary to create/download a
coordinate system.

Get Feature
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To get features:
 

1. Define a WFS or ArcGIS feature server in from the File tab. Refer
to Map Services.

2. To access the service within an open project, go to the Home tab >
Map Services and select the Get Feature icon.
The Get Feature dialog opens.
☞ The map is located around your project data by default.

If the project is empty, the map is located around Heer-
brugg, Switzerland by default.

3. In the Settings table, you can select the Service and the Max. No.
of Features.
To select the Service, select the arrow of the Name field to open a
drop-down menu of available services.
To select Max. No. of Features, click into the Max. No. of Fea-
tures field and enter a number to limit the maximum number of
features in one single download.
☞ By default, the Max. No. of Features are set to 10000.

4. To download the data, select the Download all icon or the Down-
load current view icon.
Download all: For downloading all features from the selected layer.
Download current view: For downloading features from current
map view only.
☞ It might happen that some services do not support the

Download current view option. If no data can be down-
loaded, use the Download all option.

5. After starting the download, follow the download in the status sec-
tion.
In the status section, you can view the progress, the number of
downloaded features and download errors.

6. After the download, you can see the features in your project. For
selected features, you can see single attributes. From the Navig-
ator>Source, you can open an attribute table from the context
menu for all features.

It is possible to select an object and run Copy from CAD. Refer to How to 
Copy from CAD?.
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2.2.5.5 Google Earth

Infinity offers the possibility to view and inspect your project data in Google
Earth.
Requirements:
• Google Earth is installed.
• Project data has either WGS84 coordinates or a coordinate system

attached.

To visualise the data in Google Earth:
 

1. Go to the Home tab and select the Google Earth option from
inside the ribbon bar.

2. Google Earth is started and the data is displayed as a Temporary
Place.

3. Under Library, click the links to get information on the properties of
single points, lines, areas or surfaces in a Google Earth flyout.

4. Under Source, click the links to get information on the properties of
single data sources in a Google Earth flyout.

By default you see all GNSS and TPS observations as well as the point symbols
and point ID, each on a separate layer:
To switch off a layer in Google Earth deselect it in the tree structure on the
left.

To synchronise Google Earth with Infinity:
1. Turn on  the Google Earth view synchronisation.

2. Google Earth then follows all zoom, pan and rotation operations you
make in Infinity.

2.2.6 COGO Calculations

2.2.6.1 Measure Point to Point

Measure point to point is a COGO function and can be used to determine hori-
zontal and vertical angle differences as well as horizontal and slope distance
differences between two points in your project. The coordinate differences in
Easting, Northing and height are also computed and displayed in the Measure:
Point to Point window.

Google Earth

Measure Point to
Point
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To start the measure point to point function:

Select the  Measure Point to Point option in the Home tab to open
the Measure: Point to Point window and switch to the Measure Point to Point
COGO mode.

The cursor changes to  and you are able to pick start and end points
graphically.

Overall behaviour:
Apart from the changed appearance of the cursor in the graphical view, a
green line indicates that you are in the measure point to point mode once you
have selected a start point. When you select the Cancel option in the right
bottom corner of the window:
• The cursor returns to its standard appearance.
• The green line disappears.
• The Cancel option becomes a measure option.

You can leave the Measure Point to Point window open next to the Propertiy
Grid and by selecting the Measure option, you can always pick up the COGO
calculation again. By default, the Measure Point to Point window is docked to
the Propertiy Grid and opened in its own tab. When you close the Measure
Point to Point window, the Propertiy Grid remains.

Input options:

Field Option Description

Mode  There are two input modes of determining
angles and distances between two points.
You can switch the mode without having to
re-invoke the function.

Radial In the Radial mode you can select a cent-
ral point from which angles and distances
to other points shall be determined in a
star-like manner around the selected point.
Select the Finish option to:
• Complete a measuring loop.
• Stop the COGO function.
• Return to the standard mode.

Sequential In the Sequential mode you can select a
start point and an end point for your cal-
culations and after that another start and
another end point. Select the Finish option
in the right bottom corner of the window to:
• Stop the COGO function.
• Return to the standard mode.

☞ In the Sequential mode a measuring loop is automatically finished
when the end point has been selected. In the Radial mode the meas-
uring loop is kept open (graphically this is visualised by the green line
sticking to the cursor) until you manually select to finish it.
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Field Option Description

Distance type  The type of distances displayed in the res-
ults.

Grid Distances are calculated as the trigonometric
distance between the position of two points.
The distance field is horizontal distance.

Ground Distances are horizontal distances between
two points at the mean elevation parallel
to the ellipsoid of the active coordinate sys-
tem. The distance field is horizontal distance
(ground).

Ellipsoid Distances are reduced to the ellipsoid. They
are calculated as the shortest distance
between the two points on the ellipsoid. A
scale factor is applied. The distance field is
horizontal distance (ellipsoid).
☞ In the attached coordinate sys-

tem, a projection, an ellipsoid
and a transformation have to be
defined to calculate grid, ground
and ellipsoid coordinates.

P1

a

d1

d2

d3

P2

SYS13_001

a Ellipsoid
Known
P1 First known point
P2 Second known point

Unknown
d1 Ground distance
d2 Ellipsoid distance
d3 Grid distance

How to measure point to point?
When you are in the Measure Point to Point mode and the cursor appears as

:

1. In the graphical view, click on the start point from which you want
to determine angles and distances to one or more end points.
The Point ID is automatically entered into the 1st Point field at the
top of the window.

2. Click on the end point. The Point ID is automatically entered into the
2nd Point field at the top of the window.

 ☞ If there exists more than one point role for the selected
points, pick the required one from the point selection
menu that automatically appears if for a point more than
one point role is available.

☞ Select the  option in the 1st Point/2nd Point fields to
select the start and end points for the calculation non-
graphically from a flyout.
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3. Inspect the results in the Measure: Point to Point window. The
results are listed one below the other. Each result section can be
collapsed or closed individually.

Create a report:
You can create a report of the measured points by selecting the Report
option at the bottom of the Measure Point to Point window.
The Report Manager opens and shows the generated report.

2.2.6.2 Compute Point

Compute point is one of the COGO functions and can be used:
• To determine point positions relative to existing geometry objects, like

base points and offset points.
• To determine point positions by intersection or segmentation of existing

geometry objects.
• To determine point positions by defining a direction and distance from a

known point.

The following methods are supported:

Icon Method Illustration Description

Bearing Bear-
ing

Calculates the intersection
point between two selected
points using defined bear-
ings.

Bearing Dis-
tance

Calculates the intersection
points between two selected
points using a defined bear-
ing from one point and a
defined distance from the
other.

Distance Dis-
tance

Calculates the intersection
points between two selec-
ted points using defined dis-
tances.

Point in Dir-
ection

 Calculates a point using a
defined direction and dis-
tance from a known point.

Compute Point
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Icon Method Illustration Description

Two Obser-
vations

Calculates the intersection
point between two selected
TPS observations.

Line Base
Point

Calculates the position of
a base point on a defined
line where the offset to a
defined point is perpendicu-
lar to the line.

Line Intersec-
tion

Calculates the intersection
point between two defined
lines.

Line Offset
Point

Calculates the position of an
offset point using an entered
distance along and a perpen-
dicular offset from a defined
line.

Line Seg-
mentation

Splits a line into multiple
segments. The segment
length is derived from either
a given number of seg-
ments or a specified segment
length.

Arc Base
Point

Calculates the position of
a base point on a defined
arc where the offset to a
defined point is perpendicu-
lar to the arc.
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Icon Method Illustration Description

Arc Offset
Point

Calculates the position of an
offset point using an entered
distance along and a perpen-
dicular offset from a defined
arc.

Arc Segment-
ation

Splits an arc into multiple
segments. The segment
length is derived from either
a required number of seg-
ments or a specified segment
length.

1. Go to COGO > Compute Point in the Home tab and select a
method from the drop-down menu.
The Compute Point Property Grid opens up next to the regular Prop-
erty Grid.
☞ You can still change the method here.

☞ For some methods, it is necessary to select how the geo-
metry shall be defined.
Select a Mode from the drop-down box.

2. Select  the points and/or observations based on which the com-
putation shall be performed. You can only select existing Infinity
objects as input to the computation.
Objects can also be selected graphically in the graphical view.
To select observations, TPS observations have to visible in the
graphical view. See also Layer Manager.
☞ If you cancel the operation or if you have already run a

computation and want to run another, then select Meas-
ure at the bottom of the Property Grid to activate point
selection again in the graphical view.

3. Depending on the calculation method, you may need or want to
define azimuths, distances or offsets.
Enter the values or select the  option to calculate the values.
☞ For methods Bearing Bearing, Bearing Distance and Dis-

tance Distance the values can also be derived from select-
ing points graphically for computation.

How to compute
points?
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4. Select the Height at which the computed points shall be calculated.
You have the choice between:
None
No height is computed.
Max
The point is computed at the same height as the point with the
maximum height, that has been used for computation.
Min
The point is computed at the same height as the point with the
minimum height, that has been used for computation.
Average
The point is computed at an average height of all points that have
been used for computation.

5. Check the box for Show report, when you need a report of the
COGO computation.

6. The Result of the computation is shown in the Property Grid once all
necessary input is available.
In the Results panel, you can change the Point Role and Coding
information of the computed point.
☞ If more than one point results from the computation (for

example in the case of Distance Distance computations)
select which of the points shall be saved.

7. Select Create to save the computed points as objects to the project
database.
If selected before, the COGO report opens automatically.
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8. Computed COGO points are selectable.
A flyout displays the method and values used to compute the COGO
point. In the properties, select  in Local Position.

2.2.6.3 GNSS Hidden Points

Hidden points are points that cannot be directly accessed with the GS. For
example, if a point physically cannot be reached or because no satellites can
be tracked in the point to be measured due to obstructions.
The hidden points can be measured in the field using Leica Captivate, Leica
SmartWorx or Leica Viva.
Infinity supports importing, editing and updating these points.
The lines between the points which are used for the calculation are visualised
on the hidden point survey layer.

Importing GNSS Hidden Points

The following methods are supported:

Icon Method Illustration Description

Bearing Bear-
ing

Calculates the intersection
point between two selected
points using defined bear-
ings.

GNSS Hidden Points
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Icon Method Illustration Description

Distance Dis-
tance

Calculates the intersection
points between two selec-
ted points using defined dis-
tances.

Point in Dir-
ection

 Calculates a point using a
defined direction and dis-
tance from a known point.

Line Offset
Point

Calculates the position of an
offset point using an entered
distance along and a perpen-
dicular offset from a defined
line.

Hidden points are included in the COGO report and in the data source report.

Editing GNSS hidden points:
1. Select a computed hidden point.

2. In Local Position, select .
A flyout displays the method and values used to compute the point.
The parameters available in the flyout are the same available in the
COGO report for that specific point.

3. Change the values.
☞ New coordinates of the hidden point are computed as

soon as some values are changed. The new coordinates
are shown in the flyout.
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4. Select OK.
☞ The Property Grid is updated and new coordinates are

stored.

Updating GNSS Hidden Points
The coordinates of a hidden point are automatically recomputed when the
coordinates of a point which has been previously used in hidden point meas-
urements are changed.

2.2.6.4 Shift, Rotate, Scale

Shift, rotate, scale is a COGO function and can be used to match a set of
preliminary points with a set of control points.
You can also shift, rotate, scale point clouds, CAD geometries, BIM objects and
TPS setups.

☞ All BIM entities in a file are transformed even if only a single element
has been selected.
The BIM entities used as common points, must be copied to the
Infinity library first. This can be done by using the New Point option
or Copy from CAD.

See also:
How to Create New Points from CAD Entities?
How to Copy from CAD?

To start the shift, rotate, scale wizard:
1. Select the entity to be transformed in the graphical view or in the

Inspector.
Setups can also be selected in the Source section of the Navigator.

2.
Go to the Home tab and select Shift, Rotate, Scale in the
COGO group.

In the shift, rotate, scale wizard:
1. Select the type and the method.

You can enter the parameters for shift, rotate, scale manually or
allow Infinity to compute them using common points.

When you select the method: Enter manually or compute separately,
you must:
2. Enter the Shift in Easting, Northing and Height. Select the  option

to compute the shift:
Under 'From', select a point in the preliminary system. Under 'To,'
select the Control point in the target system.

Shift, Rotate, Scale
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3. Enter the Rotation angle. Select the  option to compute the rota-
tion angle.
Under From, select a pair of points in the preliminary system. Under
To, select the same pair of control points in the target system.
Select the  to select a point as the origin for the rotation. This
can be either in the preliminary system or in the target system.

4. Enter the Scale Factor. Select the  option to compute the scale
using points or known distances.
Under From, select a pair of points in the preliminary system. Under
To, select the same pair of control points in the target system.

5. Select Next to inspect the results.

6. Select Finish to perform the operation.

When you select the method: Compute using common points, the trans-
formation parameters are computed automatically in the background
using the common points:
2. Select whether you want to compute a Rotation and a Scale using

common points or None.

3. Select Next to match points.

4. Under System A, select the preliminary measured points.
Under System B, select the corresponding control points.

5. Select  to match the pair of points.
It is listed in the following view:
☞ If you match two pairs of points height residuals are cal-

culated. If you match three or more pairs residuals are
calculated for position and height. Errors are distributed.

☞ To delete a mismatched pair select .

6. Select Next to inspect the results.

7. Select Finish to perform the operation.

By default, a report is created and opened when you select Finish. You can
Save and/or Print the report from within the report window.
Saved reports are written as PDF to the archive. You can reopen them from
there.

☞ Unsaved shift, rotate, scale reports are lost when you close them.

☞ Only coordinates stored as local grid can be transformed.

☞ The following two types of transformations are supported:
The 5 - Parameter transformation, is ideal for shifting, rotating and
scaling TPS data to fit to GNSS data. The main assumption here is
that the source and the target data have parallel height axes. The
scale is applied in Easting and Northing.
The 7 - Parameter transformation is a 3D Helmert transformation. It
can be used to shift, rotate and scale a BIM object to fit to a point
cloud. The scale is uniform in all three dimensions. The additional
parameters are the rotations around the East and North axes.
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2.2.7 Compute Project Coordinates

Allows you to apply a combined scale factor and additional shifts in East-
ing and Northing in order to compute project coordinates from existing grid
coordinates.

In the Home tab, select the  Compute Project Coordinates option.

The Project Coordinates tool opens up next to the Property Grid.
1. Select a method.

The following methods are available:
User entered
Enter the required combined scale factor manually, and optionally a
shift in Easting and Northing.
Base Point
Select the  Edit icon and select a base point from the flyout.
The grid scale, the height scale and the combined scale factors are
computed based on the selected point.
Additional shifts in Easting and Northing can be entered manually.
If the option Hold Base Point Coordinates is selected and no addi-
tional shifts are applied, the grid coordinates of the selected Base
Point are equal to its project coordinates.
Selection
The average grid scale, height scale and combined scale factors are
computed based on the values that are computed for each of the
selected points individually.
Additional shifts in Easting and Northing can be entered manually.

2. Select Apply at the bottom of the tool window.

Project coordinates are computed for all points that are either stored as local
grid or can be converted to local grid using the attached coordinate system.

☞ The project coordinate system must have a map projection of type
transverse mercator, UTM, Lambert two or double stereographic.
Check the attached coordinate system in the coordinate system
manager.

Inspect the results in the Inspector > Features tab under  Points. If not
switched on already right-click on the column headers and select the columns
Project Easting and Project Northing to be displayed in addition to the
regular Easting and Northing columns. There are also columns for the three
scale factors for each point.

☞ The project coordinates including scale factors can be exported to an
ASCII file using the ASCII export.

2.2.8 Transform Local Grid to Local Grid

Allows you to transform the points stored with local grid coordinates of initial
system A to local grid coordinates in the target system B.

Compute Project
Coordinates

Transform Local Grid
to Local Grid
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To transform local grid coordinates:
 

1. Open the Transform Local Grid to Local Grid tool.

2. Select the points you want to transform from the left pane.

3. Move the points to the right pane; a preview of the transformed
coordinates is available.
☞ Infinity uses the parameters of coordinate system A to

convert the Easting, Northing and Orthometric Height of
each selected point to WGS84 coordinates.
It then uses the parameters of coordinate system B to
convert the WGS84 coordinates of each selected point to
the new local Easting, Northing, Orthometric Height.
Along with each TPS setup, the sideshots are also trans-
formed.
Points with no horizontal position are not transformed.

4. Enable the option to Keep Heights.
☞ If the option Keep Heights is enabled, the point heights

are not transformed in system B, even though the new
heights are displayed in the preview.

5. Enable the option to generate the report.
☞ You can create a report that has the transformed points.

In the Results section of the report, the WGS84 coordin-
ates of the points are also displayed.

6. Select OK.
☞ The coordinate system B is automatically set as the Mas-

ter, to ensure that the projects GNSS data (if any) fits into
the transformed points.

2.3 Features

2.3.1 Overview

In the features module, you can manage the thematic information of imported
or created data within the current project. Points, lines and areas are features
and can have thematic data assigned to them.
Feature coding is used to describe topographical details of features in the
field. The code table holds all the thematic and style information that is applic-
able to the field data in Infinity. Code tables can be created or registered from
within the File > Code Table Management.

Features
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See also:
Code Tables
To apply coding style information to the field data, you can assign a code table
to the project while creating a new project or later from within the File > Info
& Settings.

See also:
New Project
Info & Settings
After importing data to the project, use the inspector to view all features
collected with or without codes. This is also where you can see if a code was
created in the field and is not in the code table.
You can edit a feature code for a single point in the properties.
Feature codes can be managed locally inside a project by the project code
manager, which allows you to edit or apply styling. Features in the project,
can be edited to have an individual style. All feature code edits made with the
project code manager are project-specific.

See also:
Project Code Manager

Features in the Inspector

In the  Feature Coding tab of the Inspector, all the thematic codes
attached to your current project are displayed. You can sort the view by code
groups or layer or code name.

The coding information is grouped into two groups:

• Code Table
Lists the codes that belong to the projects code table.

• Field Codes
Lists imported new codes that are not part of the code table.

☞ You cannot modify any information in this view.

Features in the Properties window
In the Properties window, you can find also coding information for the selec-
ted object (point, line and area). The information is divided into Feature, Styl-
ing and Code sections. These properties can be changed individually:
• In the Feature section, the Layer can be selected or modified to which

the object belongs to.
• In the Styling section, the line colour, line width and shading colour for

lines and areas can be modified.
• In Code section, you can assign another code to the object within a code

group.

Feature coding workflow

General steps to follow:
1. Create a Code Table with codes, coding style and layer information

including blocks in Infinity. You can also register an existing Code
Table.
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2. Export a Code Table to a codelist for a specific instrument and use it
during data collection in the field.

3. Assign a Code Table to your project while creating it. You can assign
a Code Table also later on when you miss this step.

4. Import data to the project. The data is processed based on the
assigned Code Table.

5. Check field data to be correct with the thematic information.
If needed then manage codes using the Project Code Manager and
export the modified Code Table to the instrument.

6. Export the data to a DXF/DWG file.

2.3.2 How to Create New Features?

Functionality to create new features is available through the ribbon bar in the
Features tab. Alternatively, you can access the same functions from within the
context menu in the graphical view.

☞ New points can also be created through the ribbon bar of the Home
tab or the Processing tab.

To indicate that feature creation is on, the cursor appears as a crosshair
during all create operations.

New point:
New points can be defined:
• Through the Property Grid. Enter the point details and select Create at

the bottom.
• By picking points from CAD, BIM, ESRI Shape files entities as well as base

maps.

See also:
How to Create New Points from CAD Entities?

New line, arc, spline and area:
New lines, arcs, splines or areas are drawn in the graphical view. Their proper-
ties can be modified through the property grid.
1. Select the first point by clicking onto it in the graphical view.

2. Click the next point and continue until you come to the last point.

3. Right-click and select:
End, to finalise the feature. Alternatively, select Create in the Prop-
erty Grid.
The feature is created as specified in the Property Grid. The cursor
changes back to normal.
Remove last point, to remove the point that you last selected.
Through this function, you undo your operations step-by-step.
Cancel, to cancel the operation. Alternatively, select Cancel in the
Property Grid.
Close, to end a line feature on its start point.
Continue..., to continue a feature using a different type of geo-
metry.

See also:
How to Edit the Feature Geometry?

How to Create New
Features?
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☞ Lines have to consist of two points minimum. Arcs can always only
consist of three points maximum.

☞ Areas and closed lines have to consist of three points minimum.

2.3.3 How to Create New Points from CAD Entities?

1.
Click on  New Point in the ribbon bar.

☞ To indicate that feature creation is on, the cursor appears
as a cross hair during all Create operations.

2. In the graphical view pick a point. This can be the vertex point of
CAD/BIM entities, ESRI Shape files or of a point cloud (surface).
The new point snaps to the existing point/vertex and adopts its
coordinates.
☞ The coordinates and other point properties can be viewed

and edited in the New Point tool.
Change the Point ID, Code and Layer information if neces-
sary.

3. Pick the next point.
Every time you pick a point it is added to the list in the Property
Grid. The grid always displays the properties of the point that has
been picked last.
☞ To view/edit the properties of a previously picked point

open the drop-down list at the top of the Property Grid
and select it from the list.

4. When you have picked all points that shall be created press the
Create button in the Property Grid.
Only then are the points created and added to the Infinity library.

2.3.4 How to Edit the Feature Geometry?

The functionality to edit features is available from within the context menu in
the graphical view.
To edit features through the ribbon bar go to the Features tab. Activate the
feature to be edited by selecting it.
To indicate that feature editing is on, the cursor appears as a cross hair during
all edit operations.

Icon Function Description

 Add point at
Start/End of a
Line

You can choose to add points either at the
start or the end of a line or spline. Click
the points to be added. When you are done,
right-click and select End from the context
menu or select Create in the property grid.

How to Create New
Points from CAD
Entities?

How to Edit the Fea-
ture Geometry?
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Icon Function Description

Add point in
Between

You can choose to add points in between.
Right-click the segment where additional
points shall be inserted and select Add
Point, then in Between. The existing seg-
ment is removed. When you are done, right-
click and select End from the context menu
or select Create in the property grid.
☞ In Between is only available

through the context menu.

Remove You can remove points from a feature.
Select the feature and click the point to be
removed.
☞ In order to remove a point through

the context menu, select the point
and not the feature.

 Continue You can continue features with the same or
another feature type. Follow the Add Point
workflow. The feature is continued at its
end.
☞ You cannot use continue with

closed lines or area features to
continue a closed line or an area,
go and add points in between (see
previous).

 Convert You can convert lines to splines or splines to
lines.

Convert to Arc
(Midpoint)

You can also convert a feature to an arc.
Right-click on a point and select Convert to
Arc from the context menu. The arc is cre-
ated from the previous to the next point.
☞ Features consisting of less than

three points cannot be converted.

Join You can join line features that share their
start and/or end points.

Split You can split features. Click the point on
which you want to split the feature.
☞ When you split an area it is con-

verted into lines.

Reverse You can reverse the direction of a feature,
which means that the start point becomes
the end point and vice versa.
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2.3.5 Multi-Editing of Point Code Information

To edit the coding information for more than one point at a time:
1. Select the points for which you want to edit the code information

either from inside the Library section of the Navigator or from inside
the Points and Lines & Areas subtabs of the Inspector.
In the Points and Lines & Areas subtabs of the Inspector, go to
the  Points subtab and select the points.

2. Right-click into the selection and select  Edit Code from the
context menu.

The edit code operation is done for all selected points.

☞ For observations, you can multi-edit the target point codes. For fur-
ther information, see Observation Properties.

2.3.6 How to Copy from CAD?

Functionality to copy from CAD is available through the ribbon bar in the
features tab. Alternatively, you can access the same functions from within the
context menu in the graphical view.
You can import entities from *.dxf files (CAD data), from *.shp files (GIS data)
as well as from *.ifc files (BIM data).
1. In the graphical view, select the entities that you want to import.

To select more than one element at a time keep the Ctrl-key
pressed while clicking onto each element or keep the Shift-key
pressed while dragging a rectangle around the group of elements
to be selected.
See also:
Graphical View

2. Modify the Copy Settings if necessary.
See also:
Copy from CAD: Settings

3. Select one of the following options:
All, to import the selected entities and their points.
☞ If you select a block this option is not available.

☞ You can also copy from CAD through the property grid. In
the feature tab, select the  option next to Source. This
always imports all.

☞ If you select a surface, points are not included.
Points, to import only the points belonging to the selected entities.
All from Layer, to import all features and points that are on the
same layer as the selected entity.
All Points from Layer, to import only the points that are on the
same layer as the selected entity.
☞ If you have selected more than one entity then this func-

tion is only available if both entities are on the same
layer.

To Alignment, to import all selected entities to the project as align-
ment objects.
To Road, to import all selected entities to the project as a road
object.

Multi-Editing of Point
Code Information

How to Copy from
CAD?
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The entities and/or points are copied to the Infinity library.
The reference layer is copied to the thematical layers and the imported fea-
ture belongs to it.

☞ On how to manage layers, see Project Code Manager.

☞ Go to File > Info & Settings to define defaults for how CAD entities
shall be written to the Infinity library.

2.3.7 Copy from CAD: Settings

To open the copy CAD settings:
Select Copy Settings in the Features ribbon bar.
By default the Copy CAD Setting window opens up as an extra pane next to
the property grid.
The copy CAD Settings can be set separately for points, lines, areas, surfaces,
alignments and roads.

☞ For roading features (alignments, stringlines, roads and material lay-
ers), the default naming is done by using the CAD layer name. If
manual input is desired, you can activate the checkbox and specify
a different ID. When there are multiple features in one layer, the
features are incremented accordingly.

☞ In the File tab under Info & Settings, you can pre-define which set-
tings are assumed as default in each tab.
To restore the Infinity defaults go to the File > Info & Settings >
Copy CAD to library and select the Default option.
Defaults can be restored separately for points, lines, areas, surfaces,
alignments and roads.

See also:
Info & Settings

2.3.8 Project Code Manager

The project code manager allows you to manage all the thematic codes and
layers attached to your current project. Including the structured code table
that you may have attached to your project and unassigned field codes that
have been imported with your data.
When importing data into the project codes that are related to data are
checked against the projects code table. If an imported code is not included
in the projects code table or it has more attributes than the same code in
the code table then the imported code is shown in the field codes part of the
navigator.

To launch the project code manager:

In the Features module, select  Code Manager from within the ribbon bar.

The Project Code Manager opens in a separate window.
The assigned Code Table and the Field Codes are shown even if they are
empty.

Copy from CAD: Set-
tings

Project Code Manager
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To manage coding and coding style information:

In the Project Code Manager, select the project Code Table and go to the 
Code Table tab.
Choose from the following possibilities:
• Add a new code group/code/attribute.
• Edit a code group/code/attribute.
• Delete a code group/code/attribute.

☞ Field codes cannot be edited within the project. To manage field
codes within the project add them to the project code table.

To add imported field codes to the project code table:
1. Under Field Codes, navigate to the Code Group that has the code

that you want to add to the project Code Table.

2. Select the code in the Content View and cut it off from Field Codes
by pressing Ctrl+X on the keyboard.

3. Navigate to the Code Group where you want to insert the code in
your Code Table and press Ctrl+V.

4. Edit the code properties if needed.

5. To save your changes select Apply and OK.

☞ You can select and move not only one code but more codes, a whole
code group or a single attribute from field codes to the code table.

☞ Conflicts between the project code table content and the newly
dropped in content is highlighted. Resolve conflicts before applying
changes.

To manage thematic layers:

In the Project Code Manager, select the Code Table and go to the  Layers
tab.
Choose from the following possibilities:
• Add a new Layer to extend thematic grouping for the project features.
• Edit a layer to edit the style of all features on this layer.
• Delete a layer to remove the thematic grouping and style from the

project.

To manage blocks:

In the Project Code Manager, select the Code Table and go to the  Blocks
tab.
Choose from the following possibilities:
• Edit a Block Name.
• Delete a Block to remove it from the project.

Export a project Code Table:
The project Code Table can be exported to:
• A Infinity Code Table file for use by another Infinity user.
• A SmartWorx DBX to be used on an instrument.
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2.3.9 Rename

The rename tool, allows you to rename a selection of point ID, and likewise
line, area, image and point cloud ID.

You can rename the selected items:
• Using search & replace to replace (or remove) some characters.
• Using rename by renumbering starting from a specific value using a

counter.
• Using rename by adding fixed characters to the current ID.

Search & Replace

To search:
You may search for parts of the current ID that shall be renamed and replace
these parts with a new combination of alphanumeric characters.
You may also search for spaces, dashes, dots and underscores to be replaced.

To replace:
Define a replacement for the search string. Spaces, dashes, dots and under-
scores may also serve or be included as part of the replace string. If you want
to remove a fixed part of the current ID leave the replace string empty.

Rename

To rename points, lines, areas, images or point clouds:
 

1. In the Inspector, go to the Points, Lines & Areas tab or to the
Observations tab and select the items you want to rename.
In the Navigator, items can be selected from the Library section.
Points can also be selected from inside the Source section by
selecting the job.
Alternatively, you can also select items in the graphical view.

2. Select the Rename option in the Features ribbon bar or select
Rename from the context menu to open the Rename Tool.

3. Define a new ID.

4. Check the Show Report checkbox to show the Rename Report.

5. Select Apply.

☞ When changing the selection, the items to rename are updated in the
preview.

☞ To remove a selected item from the list, so it is not renamed, select
the items and select the Remove option.

Rename
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To define a new ID:
Enter any combination of alphanumeric characters and/or add the expressions
by selecting the Add option.

☞ Alternatively type [C], [ID] or [ID#-#].

To add an expression:
Select an expression and select the Add option.

Three expressions are available:
Numeric Counter [C]: Numeric Counter for renumbering the ID. The

following selection fields become active to define
the counter:
Start Counter at:
Define the number to start counting with.
Increment Counter by:
Define how the counter shall be incremented.
Counter-Digits:
Define the digits that shall be reserved for
inserting the counter.

Current ID [ID]: The ID which the selected items currently have.
To modify the current ID, you can enter any
combination of alphanumeric characters or add
a counter before or after.

Part of Current ID [ID
#-#]:

A part of the ID which the selected items cur-
rently have.
To modify a part of current ID, you can enter any
combination of alphanumeric characters or add a
counter before or after.

2.3.10 Time Series

The time series feature, allows you to analyse how coordinates of a point vary
over a period, by creating plots over the time.
The plots are created choosing one point as a reference, the highest point
role or first measured point in time and computing the differences from that
point.
The pre-condition to use the option is the availability of measurements of the
same point (same point ID) at different dates and times.
Once the time series plots have been created, it is possible to edit the refer-
ence points, see To edit time series reference points:.
The time series results are always available in the application and are access-
ible from the Inspector > Features > Time Series.

Time Series
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To create a time series plot:

From Points
It is possible to create time series for a point measured over a time, independ-
ently from how it has been measured (TPS, GNSS, Level).

 

1. In the Inspector, select Features, then Points and then the point
to be plotted.

2. Right-click to open the context menu and select Time Series.

☞ To plot all the points for the highest point role, select only the
highest point role. In the example, all the contributors are plotted
with the average coordinates of PT3.

To plot a subset of points for the first measured points:
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1. In the Inspector, select Features, then Points and then the points
of interest.

2. Right-click to open the context menu and select Time Series.

After the process, the Points Time Series Report with the results opens auto-
matically.

 

Results are stored and are always accessible from the Inspector > Features >
Time Series.

From TPS Observations:
With TPS measurements, it can be convenient to start the process from TPS
observations, to select only the ones coming from the same setup.
In the following picture, the TPS reduced measurement is taken as the refer-
ence.

 

1. In the Inspector, select TPS, then TPS Observations by Station
Source and then drill into the station source.

2. Select the observations to plot.

3. Select Time Series from the context menu to create the point time
series plot.

☞ If all the observations have the same point role, the first measure-
ment is taken as the reference.

☞ If available, the highest post role is taken as the reference.

The Points Time Series Report opens automatically, and the results are always
accessible from the Inspector > Features > Time Series.
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From GNSS Observations:
The time series option can also be started from GNSS observations, so that
the relative measured points are plotted.

To do that:
1. In the Inspector, select GNSS, then GNSS Observations by Sta-

tion Source and drill into station source.

2. Select the observations to plot.

3. Select Time Series from the context menu to create the point time
series plot starting from the selected observations.

The Points Time Series Report opens automatically, and the results are always
available from the Inspector > Features > Time Series.
To edit time series reference points:
Once time series have been created, it is possible to change the reference
points used to compute the residuals, by choosing another existing point in
the project. Plots and statistics are automatically updated.

 

1. In the Inspector, select Features, then Time Series and then the
Edit Pencil option, to select the results you want to edit.

2. Select a point from the project, that you want to use as a new
reference point.

3. Select OK.

2.3.11 Staked Points in Infinity

Make use of Infinity to:
• Prepare data for use with stakeout applications in the field. Such data can

come from imported files including CAD files.
• Import field stakeout application data to a project and view the details

in the inspector and the property grid; as well as within specific stakeout
reports.

☞ To see the differences in the graphical view the view needs to be
zoomed in on single points.

Staked Points in
Infinity
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Supported is the import of job data collected with the applications:
• Stake points
• Stake DTM
• Stake points & DTM
• Stake to line (line, line with slope, grid, segment, segment with slope,

quick line)
• Stake road/check road

In Infinity staked points are written to the points library as well as to a library
of their own called staked points.
• Staked points are grouped for easy viewing in the Inspector > Features

tab.
• Stake road/check road results are grouped for easy viewing in the

Inspector > Infrastructure tab.
• Run a report on selected results either by selecting the Reports option in

the Home tab or by selecting Report > Staked Points from the context
menu.
There are additional reports for staked infrastructure and checked infra-
structure. You can run them from general list of reports but also from the
Infrastructure ribbon bar.

Define the stakeout tolerances in File > Info & Settings. Stakeout results
exceeding the tolerances are marked in bold red in the report.

See also:
Reports

Stakeout Workflows

Make design points coming from CAD available for use with stakeout
field applications:
1. Import of the CAD job into Infinity.

2. Copy the CAD entities to be staked out from CAD into a project.

3. Export the project for use within the stakeout application in the
field.

See also:
How to Copy from CAD?
To check and document stakeout results import the stakeout job into Infinity.

The aim is to check the stakeout results. The differences between
design coordinates and stakeout results can be:
• Seen in the graphical view.
• Checked in the Inspector > Features tab or in the Infrastructure tab

under Checks and Stakes.
• Saved in a report.

2.3.12 Points Measured to Reference

Import measured to line data from the field application to an Infinity project.
View the details in the inspector and the property grid, and document the
results with a specific points measured to reference report.

Points Measured to
Reference
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In Infinity measured to reference points are written to the points library as
well as to a library of their own called points measured to reference.
• Measured to Reference points are grouped for easy viewing in the

Inspector > Features tab.
• Run a report on selected results by selecting the Reports option in the

Home tab or by selecting Report > Measured to Reference Points from
the context menu.

See also:
Reports

2.4 External Services

2.4.1 Leica ConX

With the Leica ConX service, you can log in to iCON Build/iCON Site projects
and assign data to the project or directly to the units (that are the machines
working on building sites).
Requirements:
• Valid subscription.

To connect to the service:
 

1. Select the ConX Login from the External Services tab.

2. Enter the User and the Password.
☞ A default user can be set in Leica ConX.

3. Select Login.
☞ The New Project option becomes active.

Leica ConX
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To assign/unassign Leica ConX data:
 

1. Create a new project or select one of the available projects.
☞ The ConX user ID requires administrator rights to create

new projects.

2. Select Leica ConX Data to open the Leica ConX project viewer.

3. Select the project data you want to assign or the units you want to
reassign.

4. Select the unit to which you want to assign.

5. Select assign or reassign.

See also:
Leica ConX
Export to Leica ConX

2.4.2 Export to Leica ConX

Requirements:
• Valid subscription.

To export data to an iCON project:
 

1. In the Infinity project, select the data to export, for example the
centreline of the road.

Export to Leica ConX
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2. Create a new project or select one of the available projects.
☞ The ConX user ID requires administrator rights to create

new projects.

3. Select Export and then Selection from the External Services tab.
☞ Alternatively you can select Export from the Home tab.

4. In the Export dialog, select Leica ConX in the tree view.

5. Optionally select a unit.

6. Define the File Name and Output Type.
☞ HeXML is the default.

7. Define the Export Settings.

8. Select Export .
☞ If selected, the HeXML file is written to the iCON project

on the server and to the unit.

☞ See the data being assigned to the iCON project in the
Leica ConX project viewer.

☞ The exported file is written to the Leica Infinity Archive >
Exported Files.

See also:
Leica ConX
Leica ConX

2.4.3 Publish to Leica JetStream

Infinity supports the Leica JetStream service and allows you to publish point
clouds to an existing storage location.

☞ When exporting in .lgs format, point cloud includes:
MSxx/TLS data - Point cloud arrived from instruments and panoramas.
UAV/GS18 I data - Dense point cloud and images which were used for
point cloud reconstruction.

To publish data:
 

1. In the Infinity project, select the point clouds for publication.
☞ If no point cloud is selected, all point clouds are exported.

Publish to Leica Jet-
Stream
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2. Select Publish and then Selection from the External Services tab.
☞ Alternatively, select Export and then Selection from the

Home tab.

3. In the Export dialog, select Leica JetStream in the tree view and go
to the required storage location.

4. Select Export.
☞ The point clouds are stored in the defined storage loca-

tion on the server.

☞ The exported file is written to the Leica Infinity Archive >
Exported Files.

See also:
Leica JetStream
https://leica-geosystems.com/products/laser-scanners/software/leica-jet-
stream

2.4.4 Publish to vGIS

Infinity supports the vGIS service and allows you to publish digital surface
models in the vGIS augmented reality field application.
Requirements:
• Connection to  vGIS.
• Project with digital surface model.

To publish data to vGIS:
 

1. In the Infinity project, select the digital surface model DSM that you
want to publish.

2. Select Publish from under vGIS in the External Services tab.
☞ Alternatively you can choose Publish all.

See also:
 vGIS
https://www.vgis.io/

Publish to vGIS
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2.4.5 Save as an ArcGIS Online Web Map

With the save as an ArcGIS Online web map, it is possible to upload Infinity
project data to ArcGIS Online.

☞ Either all library data or selected objects or reference files as .shp
or .dxf/dwg can be exported.

Requirements:
• Logged in with ArcGIS Online.
• Subscription with rights to publish feature.
• Project data must have either WGS84 coordinates or coordinate systems

attached.

To save the Infinity project as an ArcGIS Online web map:
 

1. From within the open project, select the Save as ArcGIS Online
Web Map option.

2. Sign in to your ArcGIS Online account.

3. The project data opens as a ArcGIS Online web map, with objects
ordered by the code.

☞ A new web map is created, each time the icon is selected.

☞ Created web maps are accessible in ArcGIS Online/My Content for
further edits/sharing.

See also:
Get Feature
Save as Portal for ArcGIS Web Map
Map Services

2.4.6 Save as Portal for ArcGIS Web Map

With the save as portal for ArcGIS, it is possible to upload Infinity project data
to the ArcGIS portal.

☞ Either all library data or selected objects or reference files as .shp
or .dxf/dwg can be exported.

Requirements:
• Logged in with Portal for ArcGIS.
• Subscription with rights to publish feature.
• Project data must have either WGS84 coordinates or coordinate systems

attached.

Save as an ArcGIS
Online Web Map

Save as Portal for
ArcGIS Web Map
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To save the Infinity project as a new portal for the ArcGIS Web Map:
 

1. From within the open project, select the Save as Portal for ArcGIS
option.

2. Sign in to your Portal for ArcGIS Online account.

3. The project data opens as a Portal for ArcGIS Online web map, with
objects ordered by the code.

☞ A new web map is created, each time the icon is selected.

☞ Created web maps are accessible in Portal for ArcGIS Online/My Con-
tent for further edits/sharing.

See also:
Get Feature
Save as an ArcGIS Online Web Map
Map Services
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3 Optional Modules
3.1 TPS-Processing

3.1.1 Overview

The processing module allows you to:

Create new Points. New points can also be created in the
home module.

Create a new Station on any point in your project. New
stations can also be created in the Home module.
Stations for which new observations have been entered, are
identified as setups in the TPS tab of the Inspector.

Create new Observations on any station in your project.
New observations can also be created in the Home module.

Create new Traverses. Only setups can serve as points in a
traverse.

Create new Sets of Angles on any setup in the project.

You can also:
•  Edit setups, see Edit Setup Wizard.
•  Edit traverses, see Traverse Wizard.
•  Edit sets of angles, see Sets of Angles Wizard.

From inside the TPS tab in the Inspector.

3.1.2 New Point

In Infinity you can create points manually. By default, manually created points
get the point role  user-entered.

Creating points:
1.

Select the  New Point option in the ribbon bar of the Home
tab or the Processing tab.

2. New points have to be defined in the point properties window. Enter
a Point ID for the new point.

3. Choose whether the new point shall get the Point Role User-entered
or whether it shall become a Control point.
☞ You can always create control points from existing points

from inside the point properties, too, by selecting the 
Create Control option next to the current point role.

4. Enter the coordinates either Local or WGS84. If you have a coordin-
ate system attached to the project, then the coordinates are auto-
matically available in both systems.

TPS-Processing

New Point
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5. Optionally, enter the local Position Quality and select a Code.
codes can only be selected if a code table is defined within or has
been assigned to the project before.

6. Select the Create option to create the point.

The new point is automatically added to the survey layer points.

See also:
Layer Manager

3.1.3 New Station

In Infinity you can create stations manually. When you define observations on
a manually created station, the station becomes a setup with the orientation
unknown.

Creating a station:
1.

Select  New Station from the Home tab or the Processing tab.

2. The new station has to be defined in the Property Grid: In the Sta-
tion section, select the Position Source. Select the  option on
the right to search for and select a point from the fly-out list.

3. Optionally, change the coordinates and/or attach a code.

4. Select Create to create the station.

When you create a new station its orientation is unknown. It does not have
any observations attached to it yet.

The new, manually entered station is added to:
• The  Points section in the Navigator > Library.
• The  Points section of the Inspector > Points, Lines & Areas.

Results:

You see that:
• With creating the first observation on a newly defined station, its point

role changes to be a TPS setup with a still unknown orientation.

The new, manually created setup is added to:
• The navigator as  manually entered in the source section.
• The inspector as a  setup in the TPS tab.

3.1.4 New Observation

In Infinity you can create stations manually. When you define observations on
a manually created station, the station becomes a setup with the orientation
unknown.

New Station

New Observation
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Creating observations on a new, manually entered station:
1.

Select  New observation from the Home tab or the Processing
tab.

2. New observations have to be defined in the Property Grid: Enter an
ID for the new point that is to be defined by the New Observation.

3. Select the station ID from which the New Observation aims at the
new point. Select the  option on the right to search for and select
a station from the fly-out list.

4. Enter the observation details: Horizontal angle (Hz raw), Vertical
angle (V), Slope Distance (SD) as well as the target height and type.
☞ Optionally, you can also enter offsets, if necessary,

atmospheric and geometric corrections (ppm values) and
codes.

5. Select Create to create the observation.

6. Repeat steps 1 to 5 until you have entered all observations for a
station.

Results:

You see that:
• With creating the first observation on a newly defined station, its point

role changes to be a TPS setup with a still unknown orientation.

The new, manually created setup is added to:
• The navigator as  manually entered in the source section.
• The inspector as a  setup in the TPS tab.

3.1.5 Checked Points

The checked points subtab lists all the points measured in the field with Cap-
tivate using the checked point application.
Points with at least one of the checked values out of tolerance, are indicated
with an exclamation mark. You can find out more information about the out
of tolerance values, by hovering the mouse over the icon with the exclamation
mark.
Infinity can create Reports for the checked points application results.

Checked Points
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The out of tolerance limits are defined in Checked Points.

☞ Currently, the checked point application results are not updated
when the setup is updated and these observations cannot be modi-
fied.

See also:
Reports

3.1.6 Observation Properties

In the property grid you can change the properties for single observations.

You can:
1. Edit the Target Point ID.

2. Select the  option and select a different Station ID.

3. Edit the Target Height and select a different Target Type.

4. Edit the Target Offsets.

5.
Select the  option to re-calculate the Atmospheric and/or Geo-
metric PPM.

6. Select a different Target Point Code from the drop-down list.

7. Set how the Local Position Quality shall be defined (choose between
Standard Deviations and Coordinate Quality).

☞ To re-calculate a setup with another orientation method and using
different setup observations make use of the edit setup wizard. To
invoke the wizard from inside the Property Grid select the  Open
Setup Wizard option in the Orientation section.

Observation Proper-
ties
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Multi-edit

To edit the properties for one or more observations:
1. Select the observations to be edited either from inside the Source

section of the Navigator or from inside the TPS tab or the Adjust-
ments tab of the Inspector.
In the TPS tab of the Inspector drill into Setups by selecting the
little arrow . Drill further into a Station to see all connected
observations and select the observations to be edited.

In the Adjustments tab of the Inspector go to the  Observa-
tions section and select the observations to be edited.

2. Right-click into the selection and select the  Edit operation you
want to perform from the context menu.

You can select more than one observation at a time. The edit operation is
executed for all selected observations/target points.

3.1.7 Setup Properties

Some setup properties can be edited in the property grid.

Depending on the setup method you can:
1. Select the  option and select a different Station Source.

2. Edit the Instrument Height.

3. Edit the Station Coordinates.

4. Edit or select the  option to compute an Azimuth.

5. Select the  option and select a different Target Point.

6. Edit the Target Height.

7. If a station scale has been applied, select the  option to remove
the Station Scale from all observations to which it has been applied
before.

☞ To re-calculate the setup with another orientation method and using
different setup observations make use of the edit setup wizard. To
invoke the wizard from inside the Property Grid select the  Open
Setup Wizard option in the Orientation section.

☞ When TPS setups are edited in Infinity then all scan data connected
to that setup is shifted and/or rotated accordingly.

3.1.8 Setup Methods

There are several methods how a setup can be calculated.

Setup Properties

Setup Methods
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These are:

Set Orientation:
Instrument was set up on a known point and
oriented to a known azimuth.

Known Backsight:
Instrument was set up on a known point and
oriented to a known backsight point.

Resection/Resection Helmert:
Instrument was set up on an unknown point.
Station coordinates and the orientation were
calculated by measuring to known target
points.

Multiple Backsights:
Instrument was set up on a known point.
The Orientation and/or height were calcu-
lated by measuring to known target points.
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Local Resection:
Station coordinates and Orientation were
derived from measuring to two points which
define a local coordinate system.

 

Height Transfer:
Instrument was set up on a known point.
The height was calculated by measuring to
known target points.

3.1.9 Edit Station Setup

3.1.9.1 Overview

The edit setup wizard allows you to recalculate setups defined in a project.
It automatically detects the setup method that has been used in the field and
suggests a station point source.

See also:
Setup Methods

To edit setups:
Select the setup to be edited either from the Source section of the Navigator
or from inside the TPS tab of the Inspector.
In the Navigator, right-click on the setup to be edited and select Open Setup
Wizard from the context menu.
In the Inspector, drill down  into the Setups, select the setup to be edited

and select the  option.

Once selected you can also select the  Open Setup Wizard option in the
Orientation section of the Setup Property Grid.
The edit setup wizard starts with, Edit Setup Wizard: Station and Method.

See also:
The tutorial "How to manage TPS setups and data edits" https://leica-geo-
systems.com/-/media/6d5180b3d45d4102ace367b9dc6309ad.ashx

Edit Setup Wizard
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☞ Tutorial data can be downloaded in the Localisation Tool.

3.1.9.2 Edit Setup Wizard: Station and Method

A common use for the edit setup wizard is to update station coordinates
and/or the orientation.
1. Check whether the setup method itself can be left as set in the field

data or whether it needs to be changed.

2. For Orientation methods that use a known station point, check the
source of your station point.

3. Select the  icon to select another Station Point Source from the
flyout list and then OK to confirm your selection.

4. Adapt the instrument height if necessary.

5. Select Next to proceed with, Edit Setup Wizard: Setup Observations.

Orientation methods using known station points are:
• Set Orientation
• Known/Multiple Backsights
• Height Transfer

Stations to be calculated in a Resection are always set up on unknown points.
For resections the station ID can be changed but you cannot select a different
station source. You can only choose to re-calculate the resection by using
different target points in the next wizard step.

3.1.9.3 Edit Setup Wizard: Setup Observations

1. On the selected station point  select the observations that shall
be used for recalculating the orientation.
For method Set orientation:
Select an observation that shall serve as the known orientation. All
measurements on this station point are recalculated with reference
to the selected orientation.
For method Known/Multiple Backsight:
Select a point/points that shall serve as a known/multiple backsight
points. The orientation to the selected points is taken for recalcula-
tion.
For method Resection/Resection Helmert:
Select the observations to points that shall serve as targets in the
resection calculation.
For method Local Resection:
Select the observations to two points that shall define the line to
which your station shall be oriented.
For method Height Transfer:
Select the observations to known target points from which the
height shall be transferred to the station point.

2. Select Next to proceed with, Edit Setup Wizard: Compute Setup.

Edit Setup Wizard:
Station and Method

Edit Setup Wizard:
Setup Observations

Optional Modules 185



☞ It is important to differentiate between the selection of target points
and the selection of observations to the target points. The target
points are identified in Step 3. In this step of the wizard (Step 2), you
choose the observation information. If there exists, for example res-
ulting from a sets of angles calculation, more than one observation
to a point, select only the one observation to be used. In the case
of a sets of angles existing on a station point, this would be the 
reduced measurement to the target point.

3.1.9.4 Edit Setup Wizard: Compute Setup

For all target observations, selected in the Step 2: Setup Observations, the
target points are listed in the target info content view. But, if a target point
disposes of more than one point role, then by default always the role from
the top of the hierarchy is selected.

Thus:
1. Select the  option to select the target point role needed for recal-

culating the setup from a flyout list. Leave the flyout with OK to
take over your selection.

2. When you are recalculating a Resection choose from the Parameters
section:
• The Adjustment Method: Least Squares or Robust.
• Whether Easting, Northing, Height and Orientation shall be cal-

culated or just the position and the orientation or just the sta-
tion coordinates.

• Whether a Scale shall be computed.
If you decide to compute the scale factor then you can decide
further down under Station Point whether the scale shall be 
Applied to all observations that have possibly been measured on
the station point of the resection.
☞ To remove the scale, select the  option under Station

Scale in the Setup Properties window.

In the station point section you can review:
• The azimuth, calculated with respect to the chosen target points and

observations.
• The calculated orientation correction.
• The station coordinates.

For resections, the standard deviations for the Azimuth and the station
coordinates are given as well.

In the tolerances section:
3. Define the limits for how much the measured target point position

and height are allowed to differ from the target point position and
height after recalculation.

4. For resections also define an orientation limit, as in a limit for how
much the Hz observations to each target point are allowed to differ
from the calculated values.

Edit Setup Wizard:
Compute Setup
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5. Decide whether you want to  run a tolerance check for the
position and/or height and/or orientation of the target points using
the given limits.

When you decide to check whether the target points calculated from the
recomputed station point lie within the defined tolerances you see that out-
liers are marked by  and the Δ values are written in red in the Target Info
content view.
6. Exclude outliers from use in the setup computation by double-click-

ing slowly onto a target points Use field and selecting None or use
just Position or just Height from the drop-down list. All computation
results are recalculated and shown to you instantly.

7. Select Finish.

Before the computation results are taken over into your project you get a
 warning message that the coordinates and orientation of the recalculated

setup are to change by the given Δ values.
8. Select OK to update the setup in your project.

3.1.10 Create or Edit Traverse

3.1.10.1 Overview

The traverse wizard allows you to build up a traverse from the setups defined
in a project. You can also edit existing traverses. It automatically detects which
setups are connected by back and foresights and suggests a sequence once
you have selected the start point.
It also detects the traverse technique from the selected combination of setups
and suggests the start and end point as well as the initial backsight and final
foresight.

☞ Not all kinds of traverses are defined by the classic setup of a start
and an end point and an initial backsight and final foresight.

To create a new traverse:
Go to the Processing tab and select Traverse from the ribbon bar.

The Create new traverse wizard starts with:
Traverse Wizard: Extract Traverse
Go through the wizard to create a new traverse.

To edit an existing traverse:
Select the traverse to be edited either from the Library section of the Navig-
ator or from inside the TPS tab of the Inspector.
In the Navigator, right-click on the traverse to be edited and select Open
Traverse Wizard from the context menu.
In the Inspector, move down  into the traverse applications, select the tra-

verse to be edited and select the  option.

Once selected you can also select the  Open Traverse Wizard option in
the Results section of the Property Grid.

Traverse Wizard
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The edit traverse wizard starts with:
Traverse Wizard: Extract Traverse
Go through the wizard to edit an existing traverse.

See also:
The tutorial "How to process a traverse" https://leica-geosys-
tems.com/-/media/d70cbaceb3ea49988bbdf75a92ac0ef3.ashx

☞ The tutorial data can be downloaded in the Localisation Tool.

3.1.10.2 Traverse Wizard: Extract Traverse

1. Identify the new traverse by a unique ID (name).

2. Choose the traverse start point from the available setups and 
add it to the new traverse. The next possible setups in the traverse
are detected automatically and suggested for selection.

3. If the next setup in the traverse can be identified uniquely press 
add again to add the next point.
If there is a choice select the next traverse point manually and
press  add.

4. Repeat step 3 until the traverse is complete.

5. Under Traverse Technique check that the start and end point
coordinates are identified correctly. If  Control coordinates are
available these coordinates should be taken. If there is a choice
for the initial backsight and/or the final foresight, then choose the
correct coordinates to be used.

6. Optional: If reduced measurements are available for one or more of
the traverse points from the Sets of Angles or Measure Foresight
applications. And if you want the reduced measurements to be
taken for the traverse calculation then  check this option at the
bottom of the traverse wizard page.

7. Select Next to proceed with:
Traverse Wizard: Observation Review

3.1.10.3 Traverse Wizard: Observation Review

1. Review the angle observations and measured distances. If you
decide to  Use tolerances outliers will be marked by: 
You can adjust the tolerances to your needs either for the current
computation run in the same wizard page or globally under Info and
Settings > Traverse Processing Parameters.
See also:
Traverse Wizard: Processing Parameters

2. You can de-select single observations which you do not want to
take part in the computation. But at least one backsight and one
foresight observation must remain on each setup, otherwise the
traverse gets broken up and cannot be calculated. The Next button
becomes inactive.

Traverse Wizard:
Extract Traverse

Traverse Wizard:
Observation Review
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3. Select Next to proceed with:
Traverse Wizard: Processing Parameters

3.1.10.4 Traverse Wizard: Processing Parameters

Configure the traverse processing parameters for the current processing run.

☞ On how to configure the default parameters, refer to Traverse Pro-
cessing Parameters.

Methods: Compass Rule, Transit Rule:
1. Select the Adjustment Method by which the traverse shall be adjus-

ted. By default the Compass Rule is selected.

2. Define the Standard Error per Angle and Distance that shall be
used as the coefficients to calculate the Max. Angular and the Max.
Length Errors. By default these values are set to 15'' and 0.01m.

3. Depending on the required level of accuracy adapt the Min. 2D
Accuracy, as in, the minimum required position accuracy. By default
this value is set to be 1/10'000.

4. Define the Max. allowed Height Error per Traverse Point. By default
this value is set to be 0.01m.

5. Depending on the required level of accuracy adapt the Min. 1D
Accuracy, as in, the minimum required height accuracy. By default
this value is set to be 1/10'000.

6. Define the maximum allowed Station Difference before and after
Adjustment. By default these values are set to be 0.01m for Easting,
Northing and Height.

7. Select to compute the misclosure, traverse length and accuracies to
the end FS.
Select the desired point to compute the misclosure to. An angular
misclosure cannot be computed or distributed when this option is
selected. The misclosure is computed to the end station, if this
option is unselected.

8. Select to apply curvature and refraction correction to the observa-
tions.

9. Select to use forward only observations. Forward and backward
observations are mesured for each traverse leg, if this option is
unselected.

10. Select Next to proceed with Test Criteria.

☞ If you deselect any of the tolerance checks or the maximum station
difference check, then these checks are not applied in the traverse
calculation. By default all checks are switched on.

Method: Least Squares:
1. Select the Adjustment Method by which the traverse shall be adjus-

ted. In this case, select Least Squares.

2. Define the Adjustment Dimension. By default this is set to 3D.

Traverse Wizard: Pro-
cessing Parameters
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3. To define the settings refer to the adjustment help topics:
• General Adjustment Settings
• Test Criteria
• Advanced Terrestrial Parameters

4. Select Next to proceed with Traverse Wizard: Traverse Result.

☞ GNSS settings and level settings in the adjustment help are not
applicable to the traverse wizard.

3.1.10.5 Traverse Wizard: Calculate Traverse

Before the traverse is adjusted you are shown its accuracy before adjustment.
If you select to distribute the angular misclosure (equally or by distance), the
angle distributed misclosure is shown.

You see:
• Its computed total length.
• Its computed 1D and 2D accuracies. If the tolerance values defined in step

3 are exceeded a warning  is issued.
• Its length and direction of error. This corresponds to the vector resulting

from the computed length and cross errors.
• Its computed start azimuth. You can force a different value to be taken

when you select Use Start Azimuth and enter a different azimuth value.
By default this setting is switched off.

• Its computed scale.
• The misclosure point.
• Its computed coordinate misclosures. In the components where the max.

allowed station differences as defined in Step 3 are exceeded a warning
 is issued.

• Its computed end azimuth. You can force a different value to be taken
when you select Use End Azimuth and enter a different azimuth value.
By default this setting is switched off.

Select a method for misclosure distribution:
Angular misclosure:

1. The maximum allowed angular error, as computed according to the
number of stations and the standard error per angle defined in Step
3, is compared with the calculated angular error. If the maximum
allowed error is exceeded a warning  is issued.

2. Choose the method how the angular misclosure shall be distributed.
• If you select Equally, the angular misclosure is divided by the

number of traverse angles and the same correction is applied to
each setup.

• If you select By Distance, the angular misclosure is distributed
with respect to the length of the traverse legs. The shorter a
traverse leg is, the bigger the correction is.

• If you select No Distribution, the angular misclosure is not
distributed to the traverse angles.

3. The misclosure values that are shown on this page are determined
with the angular misclosure method that is selected. Any coordin-
ate misclosure distribution performed through the compass rule or
transit rule are based on these values.

Traverse Wizard: Cal-
culate Traverse
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Length misclosure:

4. The maximum allowed length error, as computed according to the
total traverse length and the standard error per distance defined in
Step 3, is compared with the calculated length error. If the maximum
allowed error is exceeded a warning  is issued.

Height misclosure:

5. The maximum allowed height error per traverse point, as defined in
Step 3, is compared with the calculated height error. If the maximum
allowed error is exceeded a warning  is issued.

6. Choose the method how the height misclosure shall be distributed.
• If you select Equally the height misclosure is divided by the

number of stations and the same correction is applied to each
station height.

• If you select By Distance the height misclosure is distributed
with respect to the length of the traverse legs. The longer a
traverse leg is, the bigger the correction is.

• If you select No Distribution the height misclosure is not dis-
tributed to the station heights.

7. Select Next to proceed with the Traverse Wizard: Traverse Result.

☞ The calculate traverse section of the traverse wizard is skipped when
adjusting using the least squares method.

3.1.10.6 Traverse Wizard: Traverse Result

Before you take over the computation results to your project, the calculation
results are listed.

Method: Compass Rule, Transit Rule

You see:
• The total traverse length.
• The number of stations included.
• The achieved 1D and 2D accuracy (if the misclosure is zero these fields

are dashed).
• The misclosure point.
• The misclosure values after adjustment.
• The calculated scale.

Select Apply scale to observations if you want to apply the scale factor
resulting from the traverse computation to all setups that make up the
traverse. For each setup, all observations are scaled with this value.

• The kind of error distribution (balancing) you have chosen for angles and
height.

• Transformation values applied as a result of point resourcing (based on
start station and initial azimuth).

• The adjusted results calculated for the traverse point coordinates using
the control coordinates at the start (and the end) of the traverse plus
the Δ values in position and height relative to the coordinates resulting
internally from the measurements.
How large the Δ values are depends on how you choose to distribute the
errors in Step 4: Calculate Traverse.

Traverse Wizard: Tra-
verse Result
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To apply the results and update the traverse point coordinates in your
project:
Select Finish.

The traverse points get the  adjusted coordinates added as another point
role.

Method: Least Squares

You see:
• Least squares results:

- F-test results and associated critical values.
- W-test results and associated critical values.
- Chi-Square test results and associated critical values.
- 2D and 1D confidence levels.
- Adjustment dimension.

• Adjusted Points tab.
• Absolute Error Ellipses tab.
• Relative Error Ellipses tab.
• Adjusted Observations tab.

To apply the results and update the traverse point coordinates in your
project:
Select Finish.

The traverse points get the  adjusted coordinates added as another point
role.

Least squares method - Additional considerations
• Flagged W-test observations can be removed from the observation review

section of the traverse wizard.
• Refer to the following help articles for the least squares result interpreta-

tion:
- Statistical Testing
- F-Test
- Chi-Square Test
- W-Test
- T-Test
- Interpreting Test Results

☞ The  adjusted coordinates should be taken as target coordinates
when recalculating setups on sideshot points of the traverse.

3.1.10.7 Traverse Processing Parameters

In the file tab, under info & settings you can define the traverse processing
parameters that shall be used by default when a new traverse is calculated in
Infinity.

See also:
Info & Settings

Traverse Processing
Parameters
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Default Traverse Adjustment Parameters

Adjustment method:
Choose the method of how the coordinate misclosure (Easting, Northing) shall
be distributed.
• If you select Compass Rule, the coordinate misclosure is distributed

relating to the length of the traverse legs. The Compass Rule assumes
that the biggest error comes from the longest traverse observations. This
method is suitable when the precision of the angles and distances are
approximately equal.

• If you select Transit Rule, the coordinate misclosure is distributed relat-
ing to the coordinate changes in Easting and Northing. Use this method if
the angles were measured with a higher precision than the distances.

• If you select No Adjustment, the coordinate misclosures are not distrib-
uted to the station coordinates.

• If you select 2D Helmert, the traverse is adjusted with a 2D Helmert
transformation. Shift, rotation and scale factor is computed and applied to
the traverse.

• If you select Least Squares, the traverse is adjusted with a constrained
2D or 3D least squares adjustment.

☞ The compass rule is also known as the Bowditch method.

☞ Control coordinates have to be stored for the start and end point in
the traverse if you want to calculate and distribute the coordinate
misclosure by either the compass rule or the transit rule.

Methods: Compass Rule, Transit Rule

Angle Balance
Choose the method of how the angular misclosure shall be distributed.
• If you select Equally, the angular misclosure is divided by the number of

traverse angles and the same correction is applied to each setup.
• If you select By Distance, the angular misclosure is distributed relating to

the length of the traverse legs. The shorter a traverse leg is, the bigger
the correction is.

• If you select No Distribution, the angular misclosure is not distributed to
the traverse angles.

• The misclosure values that are computed are determined with the angular
misclosure method that is selected. Any coordinate misclosure distribution
performed through the compass rule or transit rule are based on these
values.

Height Balance
Choose the method of how the height misclosure shall be distributed.
• If you select Equally, the height misclosure is divided by the number of

stations and the same correction is applied to each station height.
• If you select By Distance, the height misclosure is distributed relating to

the length of the traverse legs. The longer a traverse leg is, the bigger the
correction is.

• If you select No Distribution, the height misclosure is not distributed to
the station heights.
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Apply scale to observations
Select this setting, if you want to apply the scale factor resulting from the
traverse computation to all setups that make up the traverse. For each setup,
all observations are scaled with this value.

☞ When you recompute the same traverse then the scale is 1.0 or very
close to it.

☞ To remove the scale select the  option, under Station Scale in the
Traverse Properties window.
If you delete the traverse the scale is also deleted from the setups
and observations to which it has been applied.

Tolerance Checks in Traverse Wizard

Observation Review

Residuals Hz/V
Specify a limit for the value that the residuals of your angular observations are
allowed to take. When the residuals exceed this limit then the observations
are marked with a  in the Observation Review of the New Traverse wizard.

Residuals Slope Distance
Specify a limit for the value that the residuals of your slope distance meas-
urements are allowed to take. When the residuals exceed this limit then the
measurements are marked with a  in the Observation Review of the New
Traverse wizard.

Distance Difference
Specify a limit for the difference that shall be allowed between distances
measured as a foresight and a backsight between two traverse stations.

Δ Height Difference
Specify a limit for the difference that shall be allowed between height differ-
ences measured as a foresight and a backsight between two traverse stations.

Processing Parameters - Compass Rule, Transit Rule

Use max. 2D error

Max. Angular Error:
The tolerance for the angular error is defined as F = k*sqrt(n), with k being
the constant value that you have to enter as the Standard Error per Angle (the
default value is 15'') and n being the number of traverse points (angles). If the
calculated angular error exceeds the Max. Angular Error, the angular misclosure
is marked with a  in the calculate traverse step of the traverse wizard.

Max. Length Error:
The tolerance for the length error is defined as F = k*sqrt(L), with k being
the constant value that you have to enter as the Standard Error per Distance
(the default value is 0.010m) and L being the total length of the traverse. If
the calculated length error exceeds the Max. Length Error, the length misclos-
ure is marked with a  in the calculate traverse step of the traverse wizard.
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☞ If you choose to adjust the traverse by a 2D Helmert transformation
it is not necessary to define a maximum length error and a maximum
cross error. The corresponding functionality is not available. The scale
factor is automatically applied as part of the transformation.

Min. 2D Accuracy:
The accuracy in position is achieved by dividing the calculated length of error
by the total traverse length, with the length of error being the length of the
vector resulting from taking the length and the cross error into account. The
minimum position accuracy that should be achieved is defined as 1 divided by
a user-defined value. By default this value is set to be 10'000. If the achieved
accuracy is bigger than the defined fraction value then the Min. 2D Accuracy is
marked with a  as exceeded.

Use max. 1D error

Max. Height Error per Traverse Point:
Define the tolerance for the height misclosure. If the calculated height mis-
closure divided by the number of stations exceeds the Max. Height Error per
Station, the height misclosure is marked with a  in the calculate traverse
step of the traverse wizard.

Min. 1D Accuracy:
The accuracy in height is achieved by dividing the calculated height error
by the total traverse length. The minimum height accuracy that should be
achieved is defined as 1 divided by a user-defined value. By default this value
is set to be 10'000. If the achieved accuracy is bigger than the defined fraction
value then the Min. 1D Accuracy is marked with a  as exceeded.

Station Difference before and after Adjustment

Use station difference

Max. Station Difference before and after Adjustment:
Define the maximum difference that shall be allowed between measured
and adjusted station coordinates. If the adjusted station coordinates differ
by more than the defined values from the measured coordinates then the
coordinate misclosure is marked with a  in the calculate traverse step of the
traverse wizard.

☞ If you deselect any of the tolerance checks or the max. station dif-
ference check, then these checks are by default not applied in the
new traverse wizard. But you can always select or deselect single
checks while calculating a traverse in the wizard independent of the
default settings.

Processing Parameters - Least squares method

Refer to the following adjustment help topics:
• General Adjustment Settings
• Test Criteria
• Advanced Terrestrial Parameters
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Least squares method - Processing considerations:
• GNSS settings and Level settings in the adjustment help topics are not

applicable to the traverse wizard.
• The least squares method does not perform a transformation. If this is

required, you can apply a transformation through the Shift, Rotate, Scale
wizard.

• Flagged observations in the observation review section of the traverse
wizard are a good early indicator of a failing F-test.

• Flagged W-test observations can be removed from the observation review.

3.1.11 Create or edit Sets of Angles

3.1.11.1 Overview

The sets of angles wizard reduces a sequence of TPS observations from a
common TPS setup.
The result also includes a reduced observation available to use for a traverse
application.
The sets of angles are reduced to the first target, which can be different than
the backsight target of the selected station setup.
The reduction to the station setup results in an orientation correction applied
from the backsight to the first target used in the sets of angles. Only one
orientation correction can exist per station setup.

To create new sets of angles:
Go to the Processing tab and select Sets from the ribbon bar.
The new sets of angles wizard starts with:
Sets of Angles Wizard: Select Setup and Points
Go through the wizard to create a new sets of angles.

To edit existing sets of angles:
Select the sets of angles to be edited from inside the TPS tab of the Inspector.
Drill down  into the Sets of Angles Applications, select the station on which

the sets to be edited is defined and select the  option.

Once selected you can also select the  Open Sets of Angles option in the
Results section of the Sets of Angles Property Grid.
The edit sets of angles wizard starts with:
Sets of Angles Wizard: Select Setup and Points
Go through the wizard to edit an existing sets of angles.

3.1.11.2 Sets of Angles Wizard: Select Setup and Points

1. On the left side select the Setup upon which the measurements
have been taken, that shall be used for the sets of angles computa-
tion.

Sets of Angles Wizard

Sets of Angles Wiz-
ard: Select Setup and
Points

196 Optional Modules



2. Choose whether you want to compute the maximum number of
sets or the maximum number of points.
☞ When you choose to compute the maximum number of

sets, then the maximum number of sets that have been
measured on the selected setup for either Face I or for
Face I & II are detected, but only those points are offered
for selection as available targets which have been meas-
ured in all sets.
Points that have been skipped in one of the sets, are
not offered for selection. Thus, the calculation method is
called without skipped points.

☞ When you choose to compute the maximum number of
points, then all points that have been measured on the
selected setup for either Face I or for Face I & II are
detected and offered for selection as available targets,
independent of how many sets can be computed in rela-
tion to the current selection.
Sets that have been measured excluding one or more
of the selected target points are incomplete and thus
ignored. The calculation method is called without incom-
plete sets.

3. Select either observation type Face I & II or Face I.

4. Select the Available Targets and select the  option to add all
related measurements to the right side.

5. Select Next to proceed with the Sets of Angles Wizard: Sets Review.

3.1.11.3 Sets of Angles Wizard: Sets Review

In the sets review all used target points are listed.
1. Review the angle observations and measured distances for each

target point.
☞ When in Step 2 you chose to compute the maximum

number of points without using incomplete sets, all those
instances of a point, are unavailable for selection that are
part of incomplete sets.

2. Depending on the Tolerance settings, outliers are marked by .
You can adjust the tolerances to your needs either for the current
computation run in the same wizard page or globally under Info &
Settings > Averaging & Reduction.
☞ The tolerance settings can also be changed for single tar-

gets once the sets of angles computation is finished. To
do so select the  option in the Observation section of
the Sets of Angles Target Properties window. The toler-
ances shown correspond to those last used but can be
changed for single targets if necessary.

Sets of Angles Wiz-
ard: Sets Review
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3. Exclude outliers from the computation by de-selecting them.
☞ When you de-select a target point from one of the sets

then the set becomes incomplete and thus be de-acti-
vated for all points. At least one set has to remain active
to be able to compute reduced measurements.

4. Select Next to proceed with, Sets of Angles Wizard: Sets of Angles 
Results.

3.1.11.4 Sets of Angles Wizard: Sets of Angles Results

In the errors section the resulting standard deviations are listed for:
• A single Hz direction in a single set.
• A single V angle in a single set.
• A single slope distance in a single set.

and for:
• The reduced Hz direction.
• The reduced vertical angle.
• The reduced slope distance.

With the standard deviations for the reduced observations being the standard
deviation for a single observation divided by the square root of the number of
sets.
In the targets section each target point is listed with:
• Its reduced values for Hz, V, slope and horizontal distances.
• Its local grid coordinates resulting from the sets of angles computation.
• The standard deviation calculated from the correction values for each

point in all sets.

3.1.12 Reduce Foresights

3.1.12.1 Overview

The reduce foresights wizard reduces a sequence of TPS observations from a
common TPS setup.
Each foresights application is using the station setup backsight target point as
the starting reference to compute the foresight targets. This is different to
the sets of angles application which references the first target to reference
the reduced angles.
The reduced foresights also result with a reduced observation.

☞ Reduced Foresights reduced measurements are not available to use
for the traverse application.
Delete the reduce foresights applications from the Inspector > Pro-
cessing > TPS application list and then create a traverse.

To create new reduced foresight:
Go to the Processing tab and select Foresights from the ribbon bar.
The wizard starts with:
Reduce Foresights Wizard: Select Setup and Points
Finish the wizard to create a new reduced foresight app that you can run a
report on.

Sets of Angles Wiz-
ard: Sets of Angles
Results

Reduce Foresights
Wizard
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To edit existing reduced foresights:
Select the target to be edited from inside the TPS tab of the Inspector.
Drill down  into the Foresights Applications, select the station on which the

sets to be edited is defined and select the  option.

Once selected you can also select the  Open Reduced Foresights option
in the Results section of the Foresights Property Grid.
The edit reduced foresights wizard starts with:
Reduce Foresights Wizard: Select Setup and Points
Go through the wizard to edit existing foresights.

3.1.12.2 Reduce Foresights Wizard: Select Setup and Points

1. On the left side, select Setup upon which the measurements that
have been taken, shall be used for the foresights computation.

2. Select either observation type Face I & II or just Face I.

3. Select Available Foresights and select the  option to add all
related measurements to the right side.

4. Select Next to proceed with, Reduce Foresights Wizard: Foresights 
Review.

3.1.12.3 Reduce Foresights Wizard: Foresights Review

In the foresights review, all used target points are listed.
1. Review the angle observations and measured distances for each

target point.
☞ When in Step 2 you chose to compute the maximum

number of points without using incomplete sets, all those
instances of a point, are unavailable for selection, that are
part of incomplete sets.

2. Depending on the tolerance settings, outliers are marked by .
You can adjust the tolerances to your needs either for the current
computation run in the same wizard page or globally under Info &
Settings > Averaging & Reduction.
☞ The tolerance settings can also be changed for single tar-

gets once the foresights computation is finished. To do
so select the  option in the Observation section of
the Foresights Target Properties window. The tolerances
shown correspond to those last used, but can be changed
for single targets if necessary.

3. Exclude outliers from the computation by de-selecting them.
☞ When you de-select a target point from one of the sets

then the set becomes incomplete and thus be de-acti-
vated for all points. At least one set has to remain active
to be able to compute reduced measurements.

Reduce Foresights
Wizard: Select Setup
and Points

Reduce Foresights
Wizard: Foresights
Review
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4. Select Next to proceed with the Reduce Foresights Wizard: Results.

3.1.12.4 Reduce Foresights Wizard: Results

In the errors section the resulting standard deviations are listed for:
• A single Hz direction in a single set.
• A single V angle in a single set.
• A single slope distance in a single set.

and for
• The reduced Hz direction.
• The reduced vertical angle.
• The reduced slope distance.

With the standard deviations for the reduced observations being the standard
deviation for a single observation divided by the square root of the number of
sets.
In the targets section each target point is listed with:
• Its reduced values for Hz, V, slope and horizontal distances.
• Its local grid coordinates resulting from the foresights computation.
• The standard deviation calculated from the correction values for each

point in all sets.

3.1.13 Update Stations

3.1.13.1 Overview

The update stations wizard enables you to recalculate multiple setups when
new coordinates are available for your stations and target points.
For setup method unknown, local resection, height transfer, orient to object
and adjusted traverse the update stations is not available. All computations
are run with the current individual setup settings.
To update stations, go to the Processing tab and select Update Stations
from the ribbon bar.
The Update Stations wizard opens.

3.1.13.2 Update Stations Wizard

In the Select Stations tab, all available or selected stations are displayed on
the left side.

☞ By default, stations are sorted by time and date. You can use filters
and search to find required stations.

1. Select the  option to add across selected stations or select the 
option to add all stations.

2. Select the  option to remove a selected station from the list of
setups. Select the  option to remove all stations from the list of
setups.

3. Select Next to progress to the Update Stations Wizard: Review & 
Update Stations.

Reduce Foresights
Wizard: Results

Update Stations

Update Stations Wiz-
ard: Select Stations
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The Review & Update Stations tab shows computed setups with the highest
class for the station and targets available in the project.
1. Review suggested point source for stations.

2. Review suggested point source for targets by selecting the 
Expander option next to the station.

3. Select the  Edit option to select different point sources for the
computation.

4. Disable the  Update checkbox if the station should not be
updated.

5. Select the  Apply scale to observations checkbox to apply pre-
computed scale to the observations.

6. By default, a report runs and opens when you select Finish.
☞ Deselect the  Show Report checkbox to hide the

report .

7. Select Finish to start the operation.

3.2 GNSS-Processing

3.2.1 Overview

GNSS post-processing considers the three influences of baseline processing to
arrive at the most reliable and accurate coordinates.

These three influences are:
• Defining what data the processing engine should consider.
• Selecting the antenna calibration set to minimise errors in the position

solution.
• Setting the processing strategy to be applied to the data.

You can define the baseline to process in two ways:
• Manually: Setting the reference and rover station.
• Automatically: Allowing the application to find the possible baseline com-

bination, according to the constrains defined in the auto settings.

In both configurations, the graphical view helps you to visualise (to have a pre-
view) of the possible baselines through the GNSS Suggested Baselines layer.

 

The data processing and the automatic baselines selection are defined
by the following project settings:

Data:
Allow you to filter or set which data is sent to the processing engine.

Update Stations Wiz-
ard: Review & Update
Stations

GNSS-Processing
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This can be:
• Choosing which constellations the processing should include to the eleva-

tion angle of observation data.
• The ephemeris type or even the observation rate.
• A key data setting is the antenna calibration set, that is considered dur-

ing processing. Ensuring that both the reference and the rover stations
are referring to the same calibration model of determining POC and PCV
values ensures minimising the physical error sources to achieve the most
reliable solution.

Strategy:

Allows you to set parameters to influence the baseline computation
based on:
• The length of baseline.
• Common observation times.
• The atmospheric influences.

Auto Settings:
The automatic processing settings define the logic to identify intelligently
pairs of reference and rover stations, building up all possible combinations
of baselines.
The rules to create a baseline consider the baselines duration (amount of
time of simultaneous measurement at reference and rover station) and the
baseline length.
The baseline processing order is defined according to the points role, for
example if control points are available, they are used as a starting point for
the baselines automatic processing, and the automatic processing settings
defined by you.

Advanced:
Allows you to tune the processing through specific settings, such as the fre-
quency to use in the computation.
It is recommended to leave these settings at system defaults in order that the
processing engine determines the highest reliability of the solution.

See also:
The tutorial "How to process GNSS Baselines" https://leica-geosys-
tems.com/-/media/c614b534942141c8952e7fa8973bc7e2.ashx
The tutorial "Advanced GNSS Processing" https://leica-geosys-
tems.com/-/media/539597242bfa46b99d1366acae90d133.ashx
The tutorial "Ambiguity Statistics Interpretation" https://leica-geosys-
tems.com/-/media/41ee41837f7442bfa42d4b746ed088c0.ashx

☞ The tutorial data can be downloaded in the Localisation Tool.

3.2.2 How to Post-Process GNSS Data?

Setting up your project
Setting up your project to post-process GNSS data. Import data to a project
and adapt the processing parameters if necessary.

How to Post-Process
GNSS Data?
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1. Import the GNSS raw data to your project.
See also:
New Project
Data Import
☞ GNSS raw data is only supported in the DBX (SmartWorx)

or RINEX format.

2. Import and select a local grid coordinate system.
☞ Infinity can process pure WGS84 data, but it can only dis-

play local grid coordinates in the graphical view. This is
the reason why you cannot view the points. The navigator
shows you the following icon: .
Once you have selected a coordinate system the icon in
the navigator changes to  and you can see the points in
the graphical view.
On how to import or define a coordinate system, see
Coordinate Systems.
On how to select a coordinate system within a project,
see Coordinate Systems inside a Project.

3. Adapt the processing parameters. In the main menu, go to the Pro-
cessing tab. Its ribbon bar offers you all GNSS relevant functionality.
Select  to open the Data settings dialog.
See also:
Settings: Data
Select  to open the Processing Strategy dialog.
See also:
Settings: Strategy
☞ You can also define the data settings and the processing

strategy through File > Info & Settings > Data Pro-
cessing > GNSS.

Select  to open the GNSS Manager.
For further details on different processing strategies, see GNSS 
Manager.

Manual processing
To post-process the imported raw data manually, proceed as follows. You see
that directly after import the role of each point is navigated. When you have
successfully processed the data, it is GNSS post-processed.
1. Go to the Inspector GNSS tab.

Select the  Intervals to display the list of all imported intervals.
SelectStart Time in the header to sort the intervals by time.
Select the  option next to the Search field to see a graphical
representation.

2. Be sure to have assigned the correct point roles that you use as a
reference. To assign as control, right-click on the interval and select
Assign Control Point.
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3. Specify the  reference and the  rover intervals. To do so right-
click on an interval in the Inspector and select either Reference or
Rover from the context menu.

☞ After setting your reference and rover station, the
enabled baselines are listed in the GNSS > Inspector
> Enabled Suggested Baselines. If there is a coordin-
ate system attached to the project, the manually enabled
baselines are also visible in the graphical view (before pro-
cessing). The line colour of the manually enabled baseline
is taken from the GNSS observation layer. Line width and
line style of the manually enabled baselines are taken
from the GNSS suggested baseline layer.

☞ You can also enable a baseline by selecting it from the
graphical view (GNSS suggested baseline layer) and setting
the direction from the context menu. After this action, the
interval view is updated to reflect the changes.
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☞ Intervals multi-selection is possible.

☞ Reference station data can also be downloaded from the
Internet.
See also:
GNSS Manager

4. When you have selected a reference and all its rover intervals select

 in the ribbon bar to process the data.

☞ Short-cut functionality is available here to change the
antenna calibration set before starting the processing run.

5. Highlight the rover and its intervals again in the Inspector and select
Reset from the context menu to remove the reference and rover
flags.
Specify the next reference and its rovers.
Select the Processing option again in the ribbon bar.

6. Repeat Step 4 until all baselines are processed.

7. In the Inspector, the Results tab has become active. Drill into each
processing run by selecting the little arrow  right next to it and
inspect the results for each baseline.
☞

Select  in the ribbon bar to generate a report on
the currently selected element. You can generate reports
on single baselines, single tracks as well as on whole pro-
cessing runs.
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8. Select the results to be stored and select  in the ribbon bar.
You can store single baselines, single tracks as well as whole pro-
cessing runs.
☞ When you store points that have been computed with

two or more different reference stations, then the point
average is computed regardless of the solution type. This
means that if a phase fixed solution and a code solution
shall be averaged then the average is computed in any
case and it is left to the user to decide whether the code
solution shall be ignored or not.
When you store tracks that have been computed with two
or more different reference stations, then the track aver-
age is computed to the solution type. This means that if a
phase fixed solution and a code solution shall be averaged
then automatically the phase fixed solution is taken into
account while the code solution is ignored.

☞ Only stored results are displayed in the graphical view.

Automatic processing
To find the possible baselines automatically and post-process the imported
raw data, proceed as follows.
1. Go to the Inspector GNSS tab.

2. Be sure to have assigned the correct point roles for your control
stations. To assign as control, right-click on the interval and select
Assign Control Point.
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3. Highlight all the intervals you want to consider for the baselines
creation. Set the intervals to automatic from the GNSS ribbon bar or
from the interval context menu.

☞ After setting your intervals to automatic, the enabled
possible baselines are listed in the GNSS > Inspector
> Enabled Suggested Baselines. If there is a coordin-
ate system attached to the project, automatically enabled
baselines are also visible in the graphical view (before
processing). The direction of the baseline is not always
known before processing, but it is determined once that
the automatic algorithm is started.

☞ The line colour of the automatically enabled baseline is
blue by default. Line width and line style of the automat-
ically enabled baselines are taken from the GNSS sugges-
ted baseline layer.
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☞ You can also enable a baseline by selecting it from the
graphical view (GNSS suggested baseline layer) and select-
ing Auto.

Manual processing and automatic processing can also be used together. In
such a setting, the manual processing has the priority to the automatic pro-
cessing in the baselines computation order. Moreover, results of manually
selected baselines can be used to feed the automatic processing.
For example, in the following setting, the baseline AVAL -> DIJO is computed
first. Therefore the coordinates of DIJO have been established and can be used
to solve the baselines DICO -> DOCX.
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A lonely interval set to reference (without rover), or a lonely interval set to
rover (without reference) is not combinable with an interval set to automatic.
In the setting below, no processing is performed.

Processing
To launch the processing, select the Process or Process & Analyse option in
the GNSS ribbon bar.

The processing options work as follows:
• Process:

Run the GNSS data processing and show in the results basic data qual-
ity information, such as satellite tracking, DOP, ambiguity statistics. Addi-
tional data analysis products (observations residuals, position residuals)
are not available in the results so to reduce the processing time.
Choose this option to process a large amount of data.

• Process & Analyse:
Run the GNSS data processing and output additional products to analyse
the results. By default, Infinity outputs observation residuals (for all kinds
of datasets) and position residual (for static dataset).
The behaviour of the option can be modified from the GNSS advanced
settings.
Select this option to make a complete and deep data analysis.

3.2.3 Create a Virtual Reference Station (VRS)

A Virtual Reference Station (VRS) is created nearby the rover position by
exploiting corrections, tropospheric and ionospheric modelling coming from a
network of physical reference stations.
Infinity creates VRS exploiting the HxGN SmartNet GNSS reference stations.
Rover data from short baselines can be processed resulting in an accurate final
VRS position.
Requirements:
• Valid subscription for HxGN SmartNet or X-pos.

Create a Virtual Ref-
erence Station (VRS)
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How to create a VRS:
 

1. From the GNSS interval view, select the intervals that you want to
post-process using a VRS.

2. Select Create VRS from the GNSS ribbon bar or from the context
menu.

3. Infinity connects to the SmartNet network to download the RINEX
file of the VRS.
The VRS data is directly imported into the project.
The additional interval is set to reference automatically.
☞ A VRS can only be set as reference. A VRS cannot be set

as rover or SPP.

When the VRS is created starting from one interval, one virtual reference
station is created in the location of the selected interval.
When the VRS is created starting from multiple intervals, Infinity creates one
VRS (in the average position) or multiple VRS (in the location of each selected
interval). This depends on the specified advanced settings for the VRS set in
Settings: Advanced.

See also:
 HxGN SmartNet
X-pos

3.2.4 GNSS Analysis Tools

The GNSS post-processing module offers tools to investigate the details of the
processing results.

To visualise the charts within the application:
1. Open the GNSS processing results from the Inspector > GNSS >

Results.

GNSS Analysis Tools
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2. Open the Results Analysis Viewer, by selecting the option situated
in the top right of the GNSS Inspector.

3. The GNSS > Inspector > Results, is split into two parts.
• Bottom part

Has the processing results.
• Top part

Has the charts with information about: Tracking (with used/
rejected satellites and used/rejected observations per epoch),
SV Position, Observations Statistics, Ambiguity and Observations
Residuals.

You can navigate within the charts by selecting the chart menu at
the top of the plots.

Position Residuals Charts
Position residuals come from the kinematic processing of static data.

Optional Modules 211



The charts are available by:
• Selecting the Process & Analyse option.
• Setting Process & Analyse Output to position residuals or observa-

tion and position residual in the GNSS advanced settings, see Settings: 
Advanced.

Position residuals are computed with respect to:
• Static Solution: The coordinates of the computed point (from the static

processing) are taken as reference to compute the residuals.
• First Epoch: The coordinates at the first epoch of the kinematic processing

are taken as reference to compute the residuals.
• Previous Epoch: The residuals at each epoch (t) are computed with respect

to the solution of the kinematic processing at the previous epoch (t-1).
• User Entered: The residuals at each epoch are computed with respect to

a point existing in the project. You can select the point through the edit
pencil.

In the Inspector > GNSS > Results > Static as Kinematic tab, the statistics
over the position residuals are available.

☞ The position residuals plot and statistics, can be used to evaluate
the internal reliability of the data set and of the static solution.
Residuals with a small dispersion around the zero, are indicator of
good reliability.
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☞ Position residuals can help to identify possible issues in the solution,
and at the same time could suggest a possible workaround. If you
realise that part of the residuals are particularly noisy, it is sugges-
ted to exclude that range of data from the processing, by applying
exclusion windows. In the following example (the chart represent
the position residuals from the previous epoch), it is suggested to
manually exclude from the processing the first and the last part of
the data set.
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☞ The positions residuals plot can also be used to identify displace-
ment of the antenna. The following picture, shows residuals of an
antenna subjected to vibration.

☞ By selecting Open in a new window from the Inspector > GNSS >
Results > Advanced, a different type of plot can be opened and
compared in a new window.
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3.2.5 RINEX Import

The standard and most common format to store and share GNSS raw data is
the Receiver Independent Exchange Format (RINEX). RINEX data can be easily
imported in Infinity from the import dialog or using drag and drop.

☞ Infinity also supports the import of the GNSS data in proprietary
format, such as Leica (.mdb), NovAtel (.gps and .dat) and u-blox
(.ubx).

Import dialog:
 

Import Settings

Merge intervals:
The merge intervals functionality is normally used when importing data from
permanent reference stations. If more than one GNSS interval is contained in
the data then this function merges any observation intervals that conform to
the following conditions:
• The gap between any two consecutive intervals is less than 30 minutes.
• The point ID are identical for consecutive intervals.
• The antenna type is identical for consecutive intervals.
• Coordinates are the same for consecutive intervals.

Connect intervals to mixed tracks:
This setting is used for consecutive measuring sessions of static and moving
GNSS raw data.
Check this box to create a unique GNSS interval, containing static and moving
data (Mixed Track).

Force to moving:
Check this box to import static data as moving data.
This checkbox helps to overcome storing issues happened on the field (for
example, you collected moving data, but the receiver stored the data as
static).

3.2.6 Settings: Data

Here you can select the settings that apply to the data used for GNSS post-
processing.

RINEX Import

Settings: Data
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Cut-off angle:
The system default is 10°.
Increase the cut-off angle to avoid the noisier low elevation satellites. This
would be used if there may be problems in solving of ambiguities to arrive at a
phase fixed solution.

Sampling Rate:
The system default is to use all recorded data.
Increase the sampling rate to use only sub-sets of all recorded data.
Decrease the sampling rate when using long observation times to reduce the
processing time.

Used Satellites:
The system default is to use all available satellites.

Select Manual selection and then on the  option to deselect unhealthy
satellites.

☞ Inactive satellites are disabled by default.

☞ To completely enable/disable entire constellations go to Info & Set-
tings > Data Processing > GNSS and select/deselect the satellite
systems in the data section.

Ephemeris Type:
The system default is to use broadcast ephemeris.
In order to use precise ephemeris, import the required NOAA/NGS *.sp3 to the
project.

See also:
GNSS Manager

☞ The date of the *.sp3 file must correspond to the date of the data to
be processed, else Infinity switches back to broadcast automatically.

☞ Download the required *.sp3 file, see Precise Ephemeries.

Antenna Calibration Set:
The system default is Leica relative.
Additional calibration sets for non-Leica antennas are offered for selection
but can also be downloaded from http://www.ngs.noaa.gov/ANTCAL/. You can
do so through the GNSS manager.

See also:
GNSS Manager
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3.2.7 Settings: Strategy

Solution Type:

Set the solution type, the processing engine should output:

• The system default and recommended setting is phase fixed where pro-
cessing attempts to fix the ambiguities.

☞ The computed solution can also be a Widelane fixed solution,
which is the equivalent of the xRTK solution on Captivate/Smart-
Worx Viva RTK rovers and applies mainly with difficult data and on
typically short (<50 km) baselines.

☞ For baselines where the phase fixed solution is not reliable, the
solution type reverts to a float solution automatically.

• Select Float when you process long baselines and have long observa-
tion times. The system then does not try to solve the ambiguities.

☞ If in the data settings you have chosen to process a single fre-
quency solution then the system processes ‘L1 only’, ‘B1 only’ or
‘E1 only’ float solutions.

• Select Code in order to compute a code only solution when lower
accuracy results are sufficient.

Solution Optimisation:
Set how the processing engine considers the tropospheric and ionospheric
biases.

• The system default and recommended setting is automatic which allows
the processing engine to determine when to compute a linear combin-
ation and which makes it automatically use the best combination of
frequencies.

☞ The input data is evaluated during the processing and considers
the effects of the ionosphere. When the processing engine
determines the reliability of the solution is higher when using a
linear combination, then this is automatically considered for the
solution.

☞ For the GPS constellation, the system can compute an iono-free
solution over three frequencies (if L1, L2 and L5 are all available).
To change the frequencies to use, go to the advanced settings.

• Set to Iono Minimised to force the processing engine to attempt a
linear combination solution.

☞ For baselines longer than 15 km (system default, can be changed
in the advanced settings) or with a noisy ionosphere, the system
automatically computes a linear combination iono-free solution.

• Set to None when you do not want the processing to consider a linear
combination for the solution.

☞ When set to none the processing engine uses the selected Iono-
spheric model to apply during processing.

Tropospheric Model:
The system default and recommended setting is automatic, which uses the
VMF (Vienna Mapping Function) with GPT2 (Global Pressure and Temperature -
 2) for baselines whose duration is shorter than 90 minutes. If the data is
longer than 90 minutes, a computed tropospheric model gets applied.

Settings: Strategy

Optional Modules 217



Indeed, when enough observations are provided, the use of a computed tro-
pospheric model, can be more effective than an a-priori model (such as the
VMF, Hopfield or Saastamoinen, also available in Infinity), because it is based
on the current status of the troposphere. The longer the observation period,
the better the estimation of the troposphere is.

Iono Model:
The system default and recommended setting is automatic.

☞ If you have at least 45 minutes of static or rapid-static dual fre-
quency data collected on the reference station then the system
chooses computed. The computed model suits your observations
best. If less than 45 minutes of data are available, then it auto-
matically switches to none.

☞ Only choose none when you can be sure that ionospheric activity
is low.

☞ You can also use a global/regional model if available. Ionospheric
files can be imported through the GNSS manager. If you select this
option but no such file is available, then the system switches to
use none automatically.

3.2.8 Settings: Advanced

Advanced Processing Strategy

Frequency:
The system default is automatic.
All available frequencies are used, like if available Infinity makes use of triple
frequencies.

☞ The system uses the selected frequencies only for the constellations
enabled in the Info & Settings > Data Processing > GNSS, for
instance to use Galileo E5a E5b E5ab, Galileo must be manually acti-
vated. Select Galileo in the data section under satellite systems.

☞ If multi frequency is not available the system automatically processes
a single frequency solution. For users having the single frequency
processing option, only ‘L1/B1/E1” is used by default.

Frequency to use in Iono Minimized:
This setting is active only if you have set solution optimization to Iono Minim-
ized in the strategy settings.
The system default is automatic. Infinity finds the best combination of fre-
quencies to use in the iono-free computation.
To exclude L2/B2 (GPS, Glonass and Beidou) or L5 (GPS) from the iono-free
linear combination, select the corresponding options.

☞ For GPS, a triple frequency iono-free solution can be computed.

Min. Distance for Iono Minimized:
By default an iono minimized solution is only attempted for baselines longer
than 15km.
Adapt the value to force the system to compute an iono minimized solution
even for shorter baselines.

Settings: Advanced
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☞ If in the settings: Strategy Solution Optimization is set to Iono Min-
imized, then the processing engine always attempts a linear combin-
ation solution independent of the baseline length.

Possible Ambiguities Fix up to:
The system default is 300km.
Defines the maximum length of a baseline for which the system shall try to
resolve ambiguities. For baselines above the limit a float solution is computed.
If you want to ensure a higher accuracy and reliability you can enter a lower
value.

Min. Duration for Float Solution (static):
The system default is 5 min.
Defines the time below which the computation of a float solution for static
intervals shall not be allowed, because for short observation intervals a float
solution may not be accurate enough. In case ambiguities cannot be resolved
the processing engine computes a code-only solution for intervals below the
limit.

Allow Widelane fix:
By default this setting is active.
It allows for the computed solution possibly being a Widelane fixed solution,
which is the equivalent of the xRTK solution on Captivate/SmartWorx Viva RTK
rovers and applies mainly with difficult data and on typically short (<50km)
baselines.

Analysis Tool

Process & Analyse Output:
Establish the type of output for the process & analyse mode. The analysis
products are shown in the GNSS results analysis viewer.
Observation residuals can be used to analyse the noise of the solution on the
observations domain.
Position residuals help to analyse the noise of the static solution on the
positions domain. The position residuals are derived by processing static data
in kinematic mode.
Select None to remove the analysis mode option from the GNSS processing
ribbon bar.
Select Observation & Position Residuals to make a complete and deep data
analysis.

Virtual RINEX Download

From multiple points:
This setting is applicable when the user creates a VRS (Virtual Reference Sta-
tion) from multiple intervals having different positions.
Select Create one VRS in the middle when working with raw data collected
in a small area (hundred meters). Infinity creates one VRS, whose location is
the average of the points.
Select Create one VRS for each point when working with raw data collected
in a large area (kilometres). Infinity creates a VRS close to each point.
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Name:
Define the name to assign the interval for the VRS.

Sampling Rate:
Define the sampling rate for the observation of the VRS.
By default automatically, Infinity uses the sampling rate of the GNSS intervals
from where the VRS is generated.

3.2.9 Settings: Automatic Processing

The automatic processing settings define the logic Infinity uses to:
1. Identify the possible baselines and draw it in the graphical view prior to

processing, through the GNSS suggested baselines layer.
2. Fix the rules to decide which baselines should be processed and in which

order.

Suggested Baseline Strategy
These parameters are considered to identify the possible baselines. If the
GNSS suggested baselines layer is on, the possible baselines are automatically
shown in the graphical view after importing raw data.

Function Description

Min. Baseline Duration This sets the minimum amount of time over
which simultaneous measurements must be
taken at two stations before Infinity try to
show the preview and process the baseline
between those two stations.

Max. Baseline Length Sets the maximum length of baselines up
to which Infinity shows the baselines in the
preview and process.

Re-Compute already com-
puted Baselines

If this option is checked, baselines that have
been calculated and stored previously are
proposed again as suggested baselines and
sent to the processing.

Compute Baselines
between Control Points

If this option is checked, baselines between
control points role are also processed. This
may be interesting if the control points are
not kept absolutely fixed in a subsequent
adjustment.

Settings: Automatic
processing
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Auto Processing Strategy

Function Description

Baseline Processing All: Infinity processes all possible combina-
tions of baselines that conform to the auto-
matic processing parameters.
Independent sets: Infinity only processes
a set of independent baselines. Between n
points which are measured at the same time
only n-1 independent baselines exist.

Priority to Baseline with Shorter Slope Distance: The shortest
baseline from the first reference point is
computed first. Infinity then decides which
is the next shortest baseline. This may be
from the first point or from the point that
was last computed. This line is processed
next and then the process is repeated. This
is also dependent on the other automatic
processing parameters.
Longer Duration: The baseline with the
longest common observation time is com-
puted first. Similarly, to the distance method,
Infinity then decides which point has the
next longest common observation time and
processes that line. The process continues
like that. This is also dependent on the other
automatic processing parameters.

Session by Session If this option is checked, Infinity computes all
possible baselines from the reference that
has been identified according to the selected
seeding strategy before proceeding with the
next reference. The point with the longest
interval is selected as the first reference.

Allow to use Float solution
as Reference

Allow points whose solution is float to be
used as reference points for further pro-
cessing.

General

Function Description

Set Intervals to Auto at
Import

If this option is checked, Infinity sets all the
intervals to automatic immediately after data
import.
This setting is suggested in case the user
measured a GNSS network with many ses-
sions of reference and rover, and the user
wants to process all the possible baselines
in one go. If this option is checked, the user
should only import all the data and select
Process.
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3.2.10 GNSS Inspector

3.2.10.1 Overview

The GNSS inspector is place where you can visualise and work with all the
GNSS data.

 

No. Name Description

1. All GNSS Observa-
tions

Lists of all the baselines (RTK or Post-pro-
cessed) existing in your project.

2. GNSS Observations
by Station Source

Lists all the baselines (RTK or Post-pro-
cessed) organised by reference station.

3. Point Measured by 
Precise Point Posi-
tioning

List of PPP points measured from Captivate
in the field using Smartlink correction ser-
vice.

4. GNSS Tracks Shows the tracks, derived from post-pro-
cessing of moving intervals.

5. GNSS Intervals Shows graphical representation of the raw
data to use for post-processing.

6. GNSS Processing 
Results

Visualise, analyse and store your processing
results.

3.2.10.2 GNSS Tracks

The GNSS tracks  tab lists all tracks in the project. A track is created using
post-processing and storing moving intervals.
When processing kinematic data from two or more reference stations, a
reduced kinematic track is computed. Drill in  into a track to inspect details
and visualise the contributors to the tracks.

GNSS Inspector

GNSS Tracks

222 Optional Modules



To extract discrete points from a GNSS track:
 

1. Go to GNSS Tracks.

2. Select the track (entire track or its contributors).

3. Select Copy to points from the context menu or from the Navig-
ator/Library.

☞ The reduced track, its contributors and the copy to point functional-
ity are also available in the navigator library, for quick access and
management of the tracks.

3.2.10.3 GNSS Intervals

GNSS intervals are a graphical representation of the raw data imported into
Infinity. They allow you to evaluate the quality of the input data (for example,
data completeness and continuity) and to perform some actions on the data
set itself (for example, exclude part of the data or download reference station
data for data post-processing).

To open or close the interval view:
 

1. Go to GNSS Intervals.

2. Select the  option next to the search field.

To set the Interval as a Reference , Rover , SPP or Auto:

3. Select the Interval and choose the function from the ribbon bar or
the context menu.

To view the details of the Intervals:

GNSS Intervals
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4. Click the arrow  to open details on each satellite in the
satellite view.
If you do not see the arrow, zoom over the interval, or expand the
interval if you are working with a mixed track.
☞ The default view shows satellites grouped by constellation

type and includes display of cycle slips.
Select the , to display the SNR values: Red or Orange data is poor
data.
Select , to view the elevation of the satellite.

To download data from a Reference Station or VRS:

5. Select Download Reference Data or Create VRS from the context
menu.
☞ Data to be downloaded matches the date/time of the

intervals from permanent reference stations.

See also:
Reference Stations
Create a Virtual Reference Station (VRS)

Exclusion Window
Normally, the whole observation period of an interval is used for processing
and Infinity automatically rejects parts of the data which are not beneficial to
the results. However, you may want to manually exclude part of the data.

To create an exclusion window:
 

1. Press ‘Shift’ + ‘left mouse button’ and drag the mouse over the
Intervals from left to right.
☞ An exclusion window is created and is not used in the

data processing.

2. You can manually edit the start and end time of the exclusion win-
dow by selecting Edit Exclusion Window from the exclusion win-
dow context menu.

3. You can remove the exclusion window by selecting the interval and
choosing Clear Window from the GNSS ribbon bar.
☞ You can remove the exclusion window also working with

the mouse, moving it in the opposite direction (from right
to left) like what is described in step 1.
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4. You can create an exclusion window also for single satellites, by
using the same functionality described previously.

Inclusion Window
You may want to create an inclusion window, because you only want to work
with part of the data you collected.

To create an inclusion window:
 

1. Press ‘Shift’ + ‘left mouse button’ and drag the mouse over the
Intervals from right to left.
☞ An inclusion window is created, and the rest of the data is

excluded.

2. You can manually edit the start and end time of the inclusion win-
dow by selecting Edit Inclusion Window from the inclusion window
context menu.

3. You can remove the Inclusion windows by selecting the interval and
choosing Clear Window from the GNSS ribbon bar.
☞ You can also create an inclusion window without working

with the mouse, but by directly selecting Edit Inclusion
Window from the context menu of the intervals. Enter
start and end time of the inclusion window and select OK.

See also:
Reference Stations
How to Post-Process GNSS Data?
GNSS Manager

3.2.10.4 GNSS Processing Results

Drill into a result  and select the  option (next to the search field), to see a
graphical representation of the results, for single baselines.

GNSS Processing Res-
ults
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See also:
How to Post-Process GNSS Data?

3.2.10.5 Point Measured by Precise Point Positioning

The Precise Point Positioning (PPP) Points tab lists all the points measured
in the field with Captivate, using the PPP technology, based on the Smartlink
correction service.
Smartlink is a correction service where GNSS correction data, is transmitted by
augmentation satellites (no reference station needed). Measuring a point with
this technique, is an alternative to the RTK survey in a situation where a local
reference network is not available or not accessible.
Using Smartlink, once the augmentation satellites are tracked, the process
takes around 10-30 minutes for the coordinate quality to converge to few
centimetres in position.

According to the converging process status, the measured point role
can be:
• PPP Converged (higher quality).
• PPP Converging (lower quality).

 

3.2.11 GNSS Manager

3.2.11.1 Overview

The GNSS Manager holds all GNSS-related information such as antenna calib-
ration sets, precise ephemeris and iono models. It also contains reference
station download and satellite availability prediction tools.

Point Measured by
Precise Point Posi-
tioning

GNSS Manager
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To start the GNSS Manager select  from the GNSS Processing ribbon bar
or in the Infinity title bar.

3.2.11.2 Antennas/Calibration Sets

Here all the antennas considered in the project are listed, grouped by calibra-
tion set.
By default, Leica, Geo ++ and NGS calibration set come with the installation
package. Leica and Geo++ consist of only Leica antennas; NGS consists of
Leica and third parties antennas. The antenna manager allows you to get
information about the properties of the antennas.
Select the antenna and open the Info fly-out to display the antenna PCV and
offset parameters.

 

Import antennas (ANTEX format)/calibration sets:
These files are available from various agencies including the International GNSS
Service (IGS) or National Geodetic Survey (NGS) and have a list of antenna
types by manufacturer with their respective offsets and eccentricities.

☞ When processing baselines with third-party GNSS sensors it is sug-
gested to use the NGS calibration set. If the antenna is not in the
selected calibration set, then a NullAntenna is used for both receivers
of that baseline.

☞ Antennas can be copied to the Antenna Management through the
Copy to Global option.

Add a new antenna:
1. Enter the antenna details in the Add Antenna property grid.

You can manually enter the antenna offsets and eccentricities when
needed.

2. Select Create.

The new antenna is added to the calibration set that you have selected in the
properties and marked as  user-defined.

Create a new calibration set:
Allows you to create user-defined calibration sets, to combine antennas of
different agencies into one list and use them for processing.

Antennas/Calibration
Sets
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All antennas must be absolute or of a relative type.
1. In the Antennas/Calibration Sets tab, select at least one antenna to

make the option become active.

2. Select the New Calibration Set option or right-click into the selec-
tion and select Add to Calibration Set, then New Calibration Set
from the context menu.

3. Enter the details in the New Calibration Set property grid.

4. Select Create.

The new calibration set is added and marked as  user-defined.

Add to calibration set:
1. In the Antennas/Calibration Sets tab, select at least one antenna to

make the option become active.

2. Select the Add To Calibration Set option or right-click into the
selection and select Add To from the context menu.
☞ You can only add antennas to  user-defined calibration

sets.
You cannot add more than one antenna with the same
name (but with different calibration values) to the same
user-defined calibration set.

☞ An antenna from an absolute calibration set cannot be
added to a relative calibration set and vice versa.

The antenna is added to the selected calibration set and marked as  user-
defined.

Delete antennas/calibration sets:

☞ Only  user-defined or  imported antennas/calibration sets can be
deleted.

See also:
Antennas
The tutorial "How to Manage an Antenna Calibration Set" https://leica-
geosystems.com/-/media/a633447d1f3f4afc8c7abf4a1685be6a.ashx

☞ The tutorial data can be downloaded in the Localisation Tool.

3.2.11.3 Reference Stations

Download GNSS reference station data

See also:
The tutorial "How to download reference data" https://leica-geosys-
tems.com/-/media/817c1f0ca2634823b2da45a5359cefec.ashx

☞ Tutorial data can be downloaded in the Localisation Tool.

Use the Internet download function to download and import static GNSS data
from continuously operating reference stations.
Stations made available by the following providers are found automatically.

Reference Stations
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• SOPAC:
http://garner.ucsd.edu/pub/rinex/

• NGS (NAFTA list of CORS stations):
https://geodesy.noaa.gov/corsdata/rinex/

• UNAVCO:
https://data.unavco.org/archive/gnss/rinex/obs/

• RGP:
ftp://rgpdata.ign.fr/pub/data/

• AG
https://data.gnss.ga.gov.au/

SmartNet Stations are found when you are logged in to the SmartNet Service.

See also:
 HxGN SmartNet

All available stations are shown in a map view:
 

The list is filtered with the radius of the circle:
Click onto the border of the circle and drag it to shrink or enlarge its radius
and find more or less stations.
Click into the circle and shift it to find stations in another region.

☞ By default, the circle is located with a radius of 300 km around your
project data.
If the project is empty the circle is by default located with a radius of
300 km around Heerbrugg, Switzerland.
If you have selected sites as favourites, the circle is by default loc-
ated with a radius of 300 km around your favourites.

Download reference station data from the Internet:
1. Select the stations you want to use and select Data > Download in

the ribbon bar.
Alternatively, right-click onto a station and select Download from
the context menu.
Next to the Property Grid a Download tab opens up.
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2. Enter a specific date and time for which you want to download data.
By default, the files suggested for download are within the time
frame of your project data.
☞ If one or more intervals are selected in the GNSS

Inspector, the download takes the date/time based on
your selection.
Else the date/time is taken based on all available data.

3. Choose another download directory if you want.
By default, the download directory is your download directory or the
project folder if available.

4. Choose whether you want to download Precise Ephemeris and Nav-
igation File simultaneously.

5. Select the Start option at the bottom of the tab to start the down-
load.

6. Follow the download progress in the Status section.

7. In case of errors, check the availability of the files to be down-
loaded.
Availability can comfortably be checked by clicking the hyperlink on
the file name.

8. When download is complete, the data is automatically imported to
your project.

Intervals are automatically merged on import.

See also:
RINEX Import
Precise Ephemeris are added to the list in the Precise Ephemeris tab.

☞ Infinity offers a shortcut to access Internet Download.
You can also select the Download option in the GNSS Processing
ribbon bar or select one or more intervals in the GNSS Inspector and
choose Download from the context menu. In both cases, the GNSS
Manager opens in the Reference Stations tab.

Update reference stations:
To update the list of reference stations, select Data > Update in the ribbon
bar.
New reference station:
1. To add a new reference station, select Reference Stations > New

in the ribbon bar.

2. In the Property Grid enter the Station Info and the WGS84 Position
of the station.

3. To define the Connection, select the Edit option .
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4. In the Edit URL flyout enter the FTP address.
For example: ftp://rgpdata.ensg.ign.fr/pub/data/%yyyy/%ddd/
data_30/amb2%ddd0.%yyd.Z with %yyyy being the placeholder for
a 4-digit year and %ddd being the placeholder for a day of the year.

☞ The URL preview always refers to the current day of the
year, but it is just for illustration to show you that you
entered path and file name correctly.

☞ When typing the address, beware of case sensitivity.

5. Confirm the address by selecting OK.

6. Back in the Property Grid, enter your User Name and Password if
necessary to establish a connection.

7. Select Create to create the new, manually entered reference sta-
tion.

Add to favourites:
To mark a selection of reference stations as favourites, select Reference
Stations > Add to Favourites in the ribbon bar. In the Inspector view, the
stations are marked with an asterisk .

Alternatively, right-click on a station and select Add to Favourites from the
context menu.

3.2.11.4 Satellite Availability

Satellite availability allows you to plan your GNSS field work. It provides you
with graphical and numerical information on the satellite constellation for any
location (site) at a given time.
You can create site-specific obstructions, to simulate real acquisition condi-
tions to predict the satellites availability for single sites or for a combination
of sites. For example, reference and rover receiver at the same time.
To open the satellite availability from inside a project:

Satellite Availability
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1. Select the Processing tab.

2. Select GNSS Manager from the Processing ribbon bar.

3. Select the Satellite Availability tab from inside the GNSS Manager.

To predict satellite availability for a site:
 

1. Right-click in the map view where you want to create a site and
select New Site from the context menu.
☞ The new site Property Grid opens up next to the regular

Property Grid. The coordinates are derived from the map.
You can also select New Site from the ribbon bar, enter the
coordinates in the Property Grid and select Create, to create the
site.

2. Give the site a Name and select Create in the Property Grid.
☞ The site is added to the map view and to the list of sites

in the Navigator.

3. Select the site and select New Prediction, either from the context
menu or from the Satellite Availability tab.
☞ The new prediction Property Grid opens up next to the

regular Property Grid.

4. In Settings, select a Start Date and an End Date for the prediction.
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5. In Almanac, select Automatic to automatically download and
import an almanac file.
☞ You can also import an almanac manually and select it

from the drop-down list.

☞ Supported almanac file formats are *.mdb, *.yum and
*.alm.

6. In Obstructions, select the obstructions you want to consider in
the prediction.
☞ Only available, if you have already created obstructions

for the specific site. See To create new obstructions 
for a site:.

7. Select Create at the bottom of the Property Grid.
Details of the new prediction are shown underneath the map view.
You get a skyplot plus information on:
• The satellite vehicles count.
• The satellite vehicles visibility.
• The DOP.
• The elevation values.
• The azimuths.
• The skyplot with the obstructions used in the computation.

To create new obstructions for a site:
 

1. Select the site, then select New Obstruction, either from the con-
text menu or from the Satellite Availability tab.
☞ A new window opens to allow you to draw the obstruc-

tions.

2. Enter a Name for the obstruction.

3. Design your obstructions by drag and drop of the yellow points in
the obstructions plot.

4. As an alternative, you can also import an obstruction file, by select-
ing Import in the Property Grid.

5. Select Create at the bottom of the Property Grid.
☞ The obstruction is added in the Navigator, under the site.

☞ Multiple obstructions can be created for a site. Repeat the steps to
create new obstructions.

☞ To use one or more obstructions in the prediction computation,
enable the related checkbox, as explained in step 6 of To predict 
satellite availability for a site:.
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Predicting satellite availability on multiple sites
To compute the baseline between a reference and a rover receiver, only the
common satellites at both sites are considered. In this respect, especially for
long baselines, it is useful to have a tool which predicts the satellite availability
at multiple sites.
To make a new prediction considering multiple sites:

 

1. Create the sites and the obstructions you want to consider.

2. Highlight all the sites you want to consider in the prediction.

3. Select New Prediction from the context menu.

4. In the Property Grid, select the sites where you want to compute the
prediction. Go through the settings and obstructions to use for all
the sites.

5. Select Create at the bottom of the Property Grid.
☞ The results are added in the Navigator.

See also:
The tutorial "How to predict Satellite Availability for a site" https://leica-
geosystems.com/-/media/599ca3a5148d41bb8821e3d02d1a674a.ashx

☞ The tutorial can be downloaded in the Localisation Tool.

3.2.11.5 Precise Ephemeries

Manage Precise Ephemeris

Import Precise Ephemeris:

Precise ephemeris files must be in the following format:
• NGS/NOAA SP3-P (Position) format.

The SP3-P format is an internationally accepted standard ASCII format for
precise ephemeris.

There are several services that provide precise ephemeris data, like for
example:
• IGN Global Data Center.
• IGS International GPS Service for Geodynamics.

Precise Ephemeries
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Download Precise Ephemeris from the Internet:
Alternatively, you can make use of the Internet download function to down-
load and import precise ephemeris data. Downloaded data is imported auto-
matically.
1. Go to the Precise Ephemeris tab.

2. In the ribbon select the Download option.
Next to the Property Grid a Download tab opens up.

3. Select the date and time that fits your data.

4. Choose another download directory if you want.
By default, the download directory is your Downloads directory or
the project folder if available.

5. Select the Start option at the bottom of the tab to initiate the
download.

6. Follow the download progress in the Status section.

7. In case of errors check the availability of the files to be downloaded.
Availability can comfortably be checked by clicking the hyperlink on
the file name.

8. When the download is complete the data is automatically imported
and listed in the Precise Ephemeris tab.

☞ Infinity offers a shortcut to access Internet downloads.
You can also select the Download option in the GNSS Processing
ribbon bar. The GNSS Manager opens in the Reference Stations tab.

3.2.11.6 Ionospheric Model

Manage Ionospheric Models

Import Ionospheric Models:
Ionospheric model files must be in the *.ion format.

There are several services that provide ionospheric models, like fo
example:
• AIUB (Astronomical Institute University of Bern).
• IGS International GPS Service for Geodynamics.

Download Ionospheric Models from the Internet:
The daily ionospheric files from the University of Bern can be downloaded
from: http://ftp.aiub.unibe.ch/CODE/.

To download and import the files automatically proceed as follows:
1. Add a new reference station with URL: http://ftp.aiub.unibe.ch/

CODE/%yyyy/COD%wwww%d.ION.Z with %wwww being the place-
holder for a 4-digit GPS week and %d being the placeholder for the
day of the week (Sunday = 0, Monday = 1 for example).
On how to add a new reference station see Reference Stations.

2. Once defined select the station and select Data > Download in the
ribbon bar any time you need ionospheric files for a specific day.

Ionospheric Model
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3. In the Download tab define the period for which you want to down-
load data and select the Start option at the bottom of the tab to
initiate the download.

4. When download is complete the data is automatically imported to
your project.
The ionospheric models are added to the list in the Ionospheric
Models tab.

3.3 Level-Processing

3.3.1 Overview

Level-processing is a purchased option. With this functionality, you can edit
and process the level lines but also perform 1D network adjustments in sup-
port of level networks.

 

Adjust Level Line opens the level line processing dialog to
adjust the heights for the line.

Join allows you to connect two or more level lines to a single
level line. The lines are added in order of selection.

Split allows you to divide a level line into two individual lines.
This is important when considering level loops are not parti-
cipating in a least squares adjustment.

Height Observation is used to enter observed height differ-
ence between two points.

Add Turning Points (TP) to Library is used for adding turning
points to be used for other project data.

Remove Adjustment resets the heights of the level line

Editing Level Lines
The height of a level line start or end target can be edited.

See also:
The tutorial "How to process level data" https://leica-geosys-
tems.com/-/media/e1114ca40fda4640a2afc19292063ea8.ashx
The tutorial "Working with level lines" https://leica-geosys-
tems.com/-/media/0e8524beb85c40ab926eec63b1ecc226.ashx

☞ Tutorial data can be downloaded in the Localisation Tool.

3.3.2 Split Level Line

In some cases its required to split a level line. When considering the data for
network adjustments, a level line which starts and ends on the same point
must be split to be at least two lines.

Level-Processing

Split Level Line
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To split a level line, select the turning point from the booking sheet or
the level line profile view:
1. From the ribbon bar select the Split option.

2. From the right-click context menu select Split.

3.3.3 Join Level Line

In some cases its required to join level lines.
To join a level line, select the lines to be joined.
1. From the ribbon bar select the Join option.

2. From the right-click context menu select Join.

Multiple lines can be joined at the same time. The lines are joined by order of
selection, with the second and subsequent lines added in selected order.
Remember, when considering the height observations for network adjust-
ments, a level line which starts and ends on the same point must be split
to be at least two lines.

3.3.4 Height Observation

You can manually enter a level height difference observation in the Pro-
cessing ribbon bar > Level > Height Observation.
The entered height observation is displayed from the source under the manu-
ally entered node.
The height difference together with its absolute standard deviation and relat-
ive standard deviation can be used for network adjustments.

3.3.5 Remove Adjustment

For any level line that has been processed, it is possible to remove the height
adjustment that was applied to the turning points.
Select the level line and with context menu or ribbon bar select Remove
Adjustment.

3.3.6 Level Line Data

3.3.6.1 Overview

You have the ability to import level data, edit the starting height and create
reports in a booking sheet format.

Importing Level Data
The Infinity projects support levelled heights data, which can be imported from
GSI, LEV or HeXML data formats.
All level jobs imported to a project are listed from source in the navigator.
Each job indicates the level line data or level measurements that was imported
by that job. Each job can hold many level lines or measurements.

Level Lines
If the level data includes position and height information, then the level line is
displayed in the graphical view.

Join Level Line

Height Observation

Remove Adjustment

Level Line Data
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From the Level tab/Level lines subtab of the Inspector, you find all data from
level group. From the level group, you can view the list of all level line data.
Each level line can be drilled in to, which displays the level data in a booking
sheet format.

Level Measurements
From the Level tab/Measurements subtab of the Inspector, youl find all meas-
urements. Measurements are listed by imported jobs. Drill into display meas-
urement booking sheet.

Level Data in a Project

Symbol Description

Unprocessed level line.

Processed level line.

User entered start point - Indicates the starting height of
the level line as entered on a level.

Control Point start point - Indicates the user selected a fixed
control point as the height to start the level line.

Level measured - These are the turning points of the level
line or level measurements. By default, these points are not
displayed in the points list. To convert a turning point or
measurements to be available in the project, you need to
convert that point to a library point.

3.3.6.2 Level Lines

Level data can be imported to a project. Its possible for you to edit the name
of a level line, as well as the starting height.
Reports in a booking sheet format can be made for the level lines.

Level Line List

Level Line Variable Description

Level Line ID Identification of the lines contained in a job.

Method Observation method used with a line.
The available methods are:
BF: BS-FS
BFFB: BS-FS-FS-BS
BBFF: BS-BS-FS-FS
BFBF: BS-FS-BS-FS
aBF: alternating BS-FS
aBFFB: alternating BS-FS-FS-BS
aBBFF: alternating BS-BS-FS-FS
aBFBF: alternating BS-FS-BS-FS

Staff One/Two ID Identification of the two staffs that have been used
for measuring the level line.

Start Point The point ID for the first measured point of the level
line.

End Point The point ID for the last measured point of the level
line.

Level Lines
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Level Line Variable Description

Stations Number of stations used in the level line.

Observations Total number of observations used in the level line.

Delta Height The height difference between start and end height.

Length The length of the level line.

ProcessingMethod When the line has been processed, which error dis-
tribution method was used.

Misclosure The calculated height misclosure.

Height Error/Point The height misclosure devided by the number of sta-
tions.

Total Dist Balance Total distance balance considering all stations.

Total Station Diff Indicates the sum of all station differences as com-
puted at each station in the level line.

3.3.6.3 Level Line Details

The level lines are shown from the inspector in a booking sheet format.

Level Line Details

Level Line Details Description

Point ID The measured point ID.

Type The type indicates what sort of data the booking
sheet line refers to - Backsight, intermediate or
foresight measurements.

BS The Backsight Staff (BS) reading. Depending on the
observation method you have one or two backsights
for one instrument setup.
The starting BS measurement for a level line is
always a library point and can be edited.

IS Intermediate Staff (IS) readings. These are the
points not part of the level line where a height value
should be measured. Intermediate points are staff
setups which are not part of the line but included in
the line processing.
The IS measurements are always library points and
can be renamed.

FS Intermediate staff readings. These are the points
not part of the level line where a height value should
be measured. Intermediate points are staff setups
which are not part of the line but included in the line
processing.
The IS measurements are always library points and
can be renamed.

Rise When the BS - FS is positive.

Fall When the BS - FS is negative.

Hz Dist Distance between the level instrument and staff 1/
2. Ideally the distances should be the same to cancel
errors due to curvature and refraction.

Level Line Details
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Level Line Details Description

Azimuth For some XML imported level data there can exist
preliminary coordinates and azimuth directions from
the level stations to the BS-FS.

Easting If the Easting has been recorded it can be displayed
in the booking sheet.

Northing If the Northing has been recorded it can be dis-
played in the booking sheet.

Height The height of a point as calculated in relation to the
start height. Control heights are fixed, while meas-
ured heights are updated when a level line is pro-
cessed.

SD This column shows the Standard Deviation (SD) of
an observation recorded in repeat single, mean,
mean+s or median measure mode. To edit one or
more SD highlight one or more staff reading and
select Edit Standard Deviations from the context
menu.

Mean SD The Mean Standard Deviation (Mean SD) is the mean
of all the standard deviations calculated in the level
line up to that point. It can be used for finding the
average variation in the measurements, rather than
the variation for each observation.

Measurements Is the number of measurements taken by the instru-
ment for that observation. This is displayed for
measurement modes repeat single, mean, mean+s
and median.

Spread The spread is the difference between the highest
and lowest observations in repeat single, mean,
mean+s or median measure modes.

Mode The measure mode indicates how the observations
were taken. Most levels have single, repeat single,
mean, mean+s and median measure modes.

Diff BS1-BS2 For BF sequence measurements the difference
between the first and second backsights is recorded.
Ideally the difference should be 0.

Diff FS1-FS2 For BF sequence measurements the difference
between the first and second foresights is recorded.
Ideally the difference should be 0.

Station Diff The Station Difference (Station Diff) is used for BFFB
(and aBFFB) sequence measurements. It is the sum
of the differences in the backsights and foresights.

Total Station Diff The Total Station Difference (Total Station Diff) is
a running total of the station differences for every
station in the level line up until that point.

Dist Balance The distance balance is the difference between the
distance to the backsight point and the foresight
point.
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Level Line Details Description

Total Dist Balance The total station difference is a running total of the
station differences for every station in the level line
up until that point.

Earth Curv Corr Indicates whether the Earth Curvature Correction
(Earth Curv Corr) has been applied to the observa-
tions.

Expansion Coeffe-
cient

The expansion coefficient is the a value used when
applying staff corrections during line processing. This
value varies depending on the type of staff used.

Calibration Temper-
ature

This is the temperature that the staff was calibrated.

Temperature The temperature during measurement is the T
value in the formula. Enter the actual temperature
determined while you were observing the level line
to be processed.

3.3.6.4 Level Line Graph View

The level line view is a graphical representation of the data given in the
booking sheet. The profile of the selected level line is visualised, for instance
the rises and falls resulting from calculated point heights. Since the distances
between the instrument setups and the staff setups are known a proportion-
ally correct overview on the line structure may be provided.
From within the inspector the level lines list has by default the graph view.

To view the graph view of a level line when drilled into a line, use the
level line graph toggle at the top right view:

 

Navigating
You can zoom in/out and pan in the graph view. The mouse uses the same
settings as when working in the main graphical display.

Selecting and viewing heights
Using the mouse you can hover and or select a turning point from the display.

Level Line Graph View
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3.3.6.5 Level Measurements

Level measurements that are not part of the level lines are imported to the
level tab/measurements subtab of the inspector. Level measurements belong
to the imported job and you can drill into see the booking sheet.
To view and post-process the attributes of the imported data, go to the level
tab/measurements subtab of the inspector.

Measurement
details

Description

Point ID The measured point ID.

Type For the level measurements the type is always
measure only.

IS Intermediate staff readings.

HZ Dist Distance between the level instrument and staff.

3.3.6.6 Using Turning Points

By default all turning points imported with the level lines are visible in the
project data but they are not listed from the library points. In most cases the
level lines are very long and in the case you need to use turning points for
other project data, you can convert these points to become library points.
The start, end and all Intermediate Sideshots (IS) are by default library points.

Create Library Point

For any turning point that you want to use in the project, such as for
the height of a TPS station, do the following:
1. Locate and select the point to view the data in the Property Grid.

2. Select the Create library point option in the Point ID field.

3. Select Apply.

Now you can see the point ID and it can be edited - If necessary, you can
rename the point to use with other project data.

☞ When converting a turning point to a library point and you edit the
point ID to be an existing point in the project, this level measured
becomes part of the point averaging of the point.

Level Measurements

Using Turning Points
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3.3.6.7 Edit Level Standard Deviations

With each level staff reading a standard deviation is stored and can be
displayed in the booking sheet. Editing the standard deviation modifies the
standard deviation of the levelled point height and the standard deviation of
the height difference observation of the total level line.

To modify the standard deviation of level staff readings:
Highlight one or more lines in the booking sheet indicating level height read-
ings and select Edit Standard Deviations from the context menu. Enter the
value that shall be applied to the selected staff readings and select OK.
The standard deviations for the point height and for the total level line are
updated.

3.3.7 Adjust Level Line

3.3.7.1 Overview

The calculation of level lines is done in a process level line window, that lets
you set and verify the results before storing to the project.

To open the process level line wizard select Adjust Level Line:
1. From the ribbon bar Processing tab.

2. Right-click from the mouse context menu.

3. Select the  option from the level line properties.

3.3.7.2 Process Level Line Settings

This page shows you the basic line information including a profile view.

The first step to process a level line is to:
1. Set the process method for how the height misclosure is distributed

to the turning points.

Edit Level Standard
Deviations

Adjust Level Lines

Process Level Line
Settings
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2. Set if its needed to use Staff Corrections.

3. Define the line tolerances you want to flag the data for the quality
control.

3.3.7.3 Process Level Line Calculate Information

This page shows the entire line in a booking sheet format.

The second step to process a level line is to:
1. Define the start and/or end heights by selecting the point ID from

the project data.

2. Select the  option from the level line starting point ID to choose
the starting height.

3. Select the  option from the level line ending point ID to choose
the ending height, if necessary. Scroll to the bottom of the line to
do it.

When using an ending height, then the level line misclosure and height error/
point are shown on this page.
Select Next to continue to view and verify the results.

3.3.7.4 Process Level Line Results

This page shows you the detail level line information including a list of the
new computed heights that are stored when finishing the processing.
The last step to process a level line is to confirm the results are within expect-
ations and review the data before storing.

3.4 Surfaces

3.4.1 Overview

Surfaces that have been created on the instrument can be imported into
Infinity together with the measured raw data. Surfaces can be managed in the
surfaces tab.

The surface tab allows you to:
• Create new surfaces by triangulation.
• Calculate volumes on the basis of existing surfaces.

In Infinity, the surfaces computation is performed using the 3DReshaper kernel
licensed to Leica Geosystems AG by Technodigit SARL, 69400 Gleize, France.
For detailed information, see https://www.3dreshaper.com.

Process Level Line
Calculate Information

Process Level Line
Results

Surfaces
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Creating new surfaces:
1. Select the entities from which you want to create a surface either

graphically or from inside the Inspector or the Navigator.
Surfaces can be created from  Points or  Point Clouds or 
Point Cloud Groups.
☞ There are two ways how you can select entities graphic-

ally. Either press Shift and drag a rectangle with your
mouse to enclose a selection of entities or press Ctrl and
draw a polygon (polygon selection). You cannot pick dis-
connected elements.

☞ In the case of the graphical view selection, only the
highest point role is added. TPS or GNSS setup points, as
well as deleted points are not added.

2.
Select  New Surface from the Surfaces ribbon bar.
The surface type created is indicated in the ribbon icon.

☞ You can also create an empty surface and add points or point clouds
to it later on.

The new surface is created and added to:
• The  Surfaces section in the Library of the Navigator. If the Surfaces

subsection does not yet exist, it is created.
• The  Surfaces section in the Surfaces subtab of the Inspector.

☞ Surfaces are always created with a default name. To change the
name, click onto a surface in the Navigator or in the Inspector and
adapt its name in the Property Grid.

☞ To see only the surfaces triangles in the graphical View, you can
switch off the underlying point cloud groups through the eye in the
Navigator.

To add or remove points or point clouds to or from a surface:
1. In the Inspector, go to the  Features tab and select the points or

the point clouds or point cloud groups to be added to or removed
from a surface.
In the Navigator, points can be selected from the Library section.
Point clouds can be selected from inside the Source section or from
the Library section if they belong to a point cloud group.
Alternatively, you can also select points or point clouds in the graph-
ical view.
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2.
Select  Add to from the Surfaces ribbon bar and select a sur-

face from the drop-down menu or select  Add to Surface...
from the context menu.
or:

Alternatively, go to the Surfaces tab and select  Remove
from from the ribbon bar to select a surface from the drop-down
menu or select  Remove from... from the context menu.

☞ Points can also be removed from inside the  Surfaces subtab of
the Inspector. Drill down  into the surface from which one or more
points shall be removed and further down  into points. Select the
points to be removed.

☞ Only points identified by point ID (so-called Library points) can be
selected to be added or removed from a surface. Cloud points are by
default not identified by any point ID and can thus only be selected
to be added or removed from a surface individually if either library
point have been  created from them before or when they belong
to a line or area. You can select a subset of cloud points, though,
graphically and add or remove it to or from a surface.

Adding and removing lines/areas to or from a surface:
In Infinity you can add lines as breaklines and areas as exclusion areas or to
an existing surface. A single area can also be added as a boundary, with the
effect that the border of the area becomes the new boundary of the surface.
Any line/area in your project, for example a line defining the sideline of a road
or the top of a ridge or an area defining the contours of a building, can be
added to a surface as a breakline, exclusion area or boundary.
This forces the triangulation of your terrain model to be rebuilt by taking
the line/area into account. The line/border lines of an area become triangle
edges. As a result, there is not any incorrect interpolation across the resulting
breakline, exclusion area or boundary.

To add a line/area to a surface:
1. Right-click onto the line/area to be added to the surface either in

the graphical view or in the Navigator or in the Inspector.

2. For lines, select  Add to Surface as Breakline from the context
menu.
For areas, select either  Add to Surface as Exclusion or  Add
to Surface as Boundary from the context menu.
If more than one surface exists in your project, select the surface to
which the line/area shall be added.

Alternatively, go to the Surfaces tab and select  Add to from
the ribbon bar to select a surface from the drop-down menu. For
areas, decide whether to add the area as Exclusion or Boundary.

☞ It is possible to add only one outer boundary to an existing surface.

☞ It is not possible to add different objects at the same time to a
surface.
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To remove a line/area from a surface:
1. Right-click onto the line/area to be removed from the surface either

in the graphical view or in the Navigator or in the Inspector.

2. Select  Remove from... from the context menu. If the line/area
has been added to more than one surface, select the surfaces from
which the line/area shall be removed.

Alternatively, go to the Surfaces tab and select  Remove
from from the ribbon bar to select a surface from the drop-down
menu.

3.4.2 Surface Types

In Infinity you can create surfaces from point sources. Working with point
cloud data, the results of surfaces are directly effected by the properties of
the point cloud data - Point density and the location from where scan meas-
urements are made from can result in holes and effects where the surface
routine cannot determine the above or below surface of the triangles to be
computed. To manage the situation of cloud point properties in the best way,
Infinity offers four triangulation methods to better determine which method
provides the best results.

The three surface types are:
• Refined.
• Regular.
• Interpolated.
• 2.5D.

The surfaces methods are based on the 3DReshaper engine. There are many
parameters that are already considered and defined with the three methods
that Infinity uses.

Refined

Use this method:
• For clean point cloud data that is consistent in density.
• Uses the meshing parameters and then refines the mesh to generate the

most details.

This surface method is created with following steps:

Determine initial mesh:
• Minimum triangle size (regular sampling) example used 0.08 m.

• Consider that if set to zero, all points are used.
• Maximum triangle size (hole detection) example used 3.0 m.

• Sets the size for which the maximum triangle is created to fill gaps.
• A hole remains when the points are not geometrically consistent (for

example, the surface does not know which direction it should follow,
change of direction is high).

Hole filling:
• Not adding new points, or curvature filling.

Surface Types
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Refine the mesh:
• Takes the points of the cloud and compares to existing mesh.
• Fit the mesh adding triangles where the deviation is greater than 0.01 m.
• Remove points that are too far from the mesh.

Remove spikes:

Regular

Use this method:
• For clean scan data but where point density is less consistent, like for

long distance between near and far cloud points.
• Uses the meshing parameters min/max triangle size, and appears most

evenly.
• This surface can be edited in the Properties - Change the min/max values

and apply.

This surface method is created with following steps:

Determine initial mesh:
• Minimum triangle size (regular sampling) example used 0.08 m.

• Consider that if set to zero, all points are used.
• Maximum triangle size (hole detection) example used 3.0 m.

• Sets the size for which the maximum triangle is created to fill gaps.
• A hole remains when the points are not geometrically consistent (for

example, the surface does not know which direction it should follow,
change of direction is high).

Hole filling:
• Not adding new points, or curvature filling.

Remove spikes:

Interpolated

Use this method:
• For scan data that is noisy and not consistent.

This surface method automatically calculates the meshing parameters to inter-
polate a best surface.

2.5D

Use this method:
• For points that are distributed on the ground and not representing a 3D

object.
• Ensure that every point is used as a vertex of the surface.

This surface is created with the following steps:
• If point cloud points are part of the selection: Use the minimum triangle

size from the surface parameters in order to reduce the point cloud to
respect a minimum distance between points of this value. A value of 0
would result in all point cloud points to be included in the surface.

• Create a 2.5D surface with all library points and, if applicable, with all the
remaining points left over from the previous step.
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☞ The same method used in Infinity v1.1. Projects with surfaces from
the previous versions can be used in Infinity v1.2. It is also possible to
generate the same surface as previously possible.

3.4.3 Surface Properties

In surface properties you can:
• Change the name (ID) of the selected surface.
• Assign the surface to a different layer.
• Change the styling independent of the overall layer style.

In the details section you are informed about:
• The total number of triangles, triangulation points and triangle edges.
• The total number of breaklines and exclusion areas that have been added

to the selected surface.
• The height of the topmost triangulation point (Max. Height) and the

height of the lowest triangulation point (Min. Height).
• The sum of all triangle areas (Area).
• The area covered by a surface projected to the ground plane (Area 2D).
• The perimeter as defined by the outer boundary of the selected surface

(Perimeter).
• The perimeter as projected to the ground plane (Perimeter 2D).

3.4.4 Surface Contours

It is possible to create contours for a selected surface.
• Select a surface.
• From the ribbon bar, select Contour.
• From the Create Contour window, edit the settings to define the contour

display.

Create Contour

When creating a set of contours for a surface the following settings
must be considered:

Surface
• Displays the selected surface including the height details.

Contours

Set the values to determine the drawing of the contour:
• Minor Interval, defines the distance between minor contours that are

drawn.
• Major Frequency, defines when the major contour is drawn. Usually this

setting would be set at 5 or 10.

With a minor interval of 10 and a major frequency of 5, the contours are draw
every 10 metres but at every 50 metres a major contour line is drawn.
• Min. Length, defines the minimum contour line length to be displayed.

Any shorter lines are not displayed.
• Smoothing, allows the contour lines to be smoothed with different

intensity values.

Surface Properties

Surface Contours
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Contour Styling
• Define the line style and colour settings.

Contour Labels
To display the labels, you must switch them on in the Layer Manager.

Exporting Contours
Contours can be exported to DXF/DWG and to XML.
Set the export flag in Layer Manager to determine if the contours are written
to the DXF/DWG file.

 

3.4.5 Volume Calculations

For calculating volumes a reference surface, a ground surface and, depending
on the selected calculation method, an intersecting plane must be defined.

Reference surfaces:
A reference surface is the surface of the stockpile/cavity for which a volume
shall be calculated. Cavities are negative stockpiles.

☞ If you have selected a surface before in the Inspector or from inside
the Library section of the Navigator then the selected surface is
automatically taken as the reference surface for which you want to
calculate the volume.

Ground surfaces:
A ground surface for simple stockpile computations is the surface at the
bottom of the selected stockpile which is created with triangulation among
the points which define the outer boundary of the stockpile. For cavities the
ground surface is the surface covering the cavity. It is computed in the same
way as for stockpiles. If you choose to compute a Surface to Surface volume
then the ground surface is the second selected surface (for example, the
surface that you select under To Surface in the Surface to Surface method, for
further information on this method read the following).

Intersecting planes:
To define an intersecting plane for a volume calculation choose a point from
your current project or define a height through which a horizontal plane shall
be calculated for intersecting the surface. Volumes are calculated above and
below the intersecting plane.

Volume Calculations
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Stockpile:
1.

Select the  Stockpile option in the Surfaces ribbon bar. A
window opens called Volumes: Stockpile.

2. In the Input section select the  option to select the Reference
Surface for the calculation.

3. Select the Calculate option at the bottom of the Volumes: Stockpile
window to compute the Stockpile Volume. The result is shown to
you in a Results section.

To Point:
1.

Select the  To Point option in the Surfaces ribbon bar. A
window opens called Volumes: Surface to Point.

2. In the Input section select the  option to select the Reference
Surface for the calculation.

3. In the From Point section select a point in your project that shall
serve as the reference point for calculating the intersecting hori-
zontal plane.

4. Select the Calculate option at the bottom of the Volumes: Surface
to Point window to compute the volume above and below the height
of the selected reference point. The result is shown to you in a
Results section.

To Height:
1.

Select the  To Height option in the Surfaces ribbon bar. A
window opens called Volumes: Surface to Height.

2. In the Input section select the  option to select the Reference
Surface for the calculation.

3. In the Height section enter a height that shall serve as the refer-
ence height for calculating the intersecting horizontal plane.

4. Select the Calculate option at the bottom of the Volumes: Surface
to Height window to compute the volume above and below the
selected height. The result is shown to you in a Results section.

Surface to Surface:
1.

Select the  Surface to Surface option in the Surfaces ribbon
bar. A window opens called Volumes: Surface to Surface.

2. In the Input section select the  option to select the Reference
Surface for the calculation.

3. In the To Surface section select the  option to select a surface
from your current project that shall serve as the ground surface for
the calculation.
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4. Select the Calculate option at the bottom of the Volumes: Surface
to Surface window to compute the volume between the selected
surfaces. The result is shown to you in a Results section.

For all four methods you can:
Select a different Input data and run another volume calculation within the
same Volumes window. The result is added on top of the results computed
before. Each Results section can be collapsed or closed individually.
Select the Report option at the bottom of the Volumes window to generate a
report on the Results.

3.4.6 Comparison Maps

Comparison maps is a surfaces function that allows the comparison of a refer-
ence feature with a measured feature. The differences are displayed in the
graphical view, as well as in the property grid of the calculated comparison
map.

Reference features can be:
• A surface.
• One point cloud.

☞ Measured type must be point cloud/group as well.

• A point cloud group.

☞ Measured type must be point cloud/group as well.

• A plane:
- Horizontal.
- Vertical.
- Free.

• One or more Industry Foundation Classes (IFC) objects (solids).
• An area.
• A closed line.

Measured features can be:
• A surface.
• One or more point clouds.
• A point cloud group.
• One or more library points.

Differences can be calculated along the height axis or in 3D, perpendicular to
the reference object.
The differences are then colour-coded and shown in a so called comparison
map. The comparison map is saved to the database as a Infinity object. By
default, it shows in blue volumes, distances and areas that are above the
reference feature. Volumes, distances and areas that are below, are indicated
in red.

☞ The settings can be changed any time before and after the creation
of the map in the Styling settings.

How to calculate a comparison map:
1. Go to the Surface tab and select Comparison Map from the Sur-

faces ribbon bar.
The Create New Comparison Map window opens up next to the
regular property grid.

Comparison Maps
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2. Select the Reference Type you want to compare against
(design). Once set, you can choose the feature itself.
☞ Not every feature allows a multiple selection.

☞ The selection can be done using a pencil flyout or
by selecting the Add current selection option. In
order to use it, select the required features from
the Navigator, Inspector or graphical view, before
selecting the option.

 

3. Select the Measured Type that represents the captured data. After-
wards, choose the required measured features in the same way as
the required reference features.
☞ The order of adding the data is not relevant.

☞ For library points, it is also possible to select multiple
points within the pencil flyout. Deselecting points can be
done by keeping the Ctrl key pressed and a left-click of
the mouse.

4. Under Settings, you can choose to compute only differences or
check your data against tolerances.
If you select tolerances, specify the upper and lower tolerance val-
ues and define a minimum segment distance. Through the segment
distance value, you can simplify the tolerance lines.
☞ Tolerance lines indicate the areas in the map where

material has to be added or removed. These lines can be
exported for stakeout, but if they are too detailed the
controller might not be able to handle them.

5. Also under the Settings, you can specify the inspection direction -
If you want to calculate distances along the height axis or perpen-
dicular to the reference feature. Then the direction is variable and
depends on the shape of the reference feature.

6. If the data set you are comparing has large extends, you can limit
the range by activating the ignore distances larger than option.
Define the maximum distance between the reference and the meas-
ured feature.
☞ You can also limit point clouds by clipping data or per-

forming a manual selection in the graphical view.

7. Under Styling, define which colours shall be used for indicating
above/below values.
☞ Default values for Settings and Styling can be defined in

the surfaces Parameters option.
Select Parameters from the Surfaces ribbon bar to open.
☞ These settings are shared with the cut fill map.
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8. Select the Create option to create the new comparison map.
A new comparison map object is created and visible in the graphical
view, as well as the Navigator, Inspector and Property Grid.

 

Comparison map tolerance mode results including tolerance lines at 0
difference (cyan lines) and -2m difference (orange line):
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Using Point Cloud as Reference
One reference point cloud or group can only be compared to other point
clouds or groups. Comparing the same point cloud with itself or a part of it is
not allowed.
Inspection Direction set to Along Height Axis: Infinity displays values below
(negative) and above (positive) the reference point cloud/group.

☞ The comparison map might have a low point density, when the refer-
ence or measured point cloud is dense in some areas and sparse in
other areas. In this case, the result can be improved, if the measured
point cloud is windowed in the graphical view.

Inspection Direction set to Perpendicular: Infinity displays absolute distances
between the two-point clouds/groups. All distances are positive, independent
of being above or below the reference.

Using Planes as Reference Features

There are different methods of creating a plane:
• Horizontal: Select a height of a point or enter a height yourself. The

inspection direction is fixed along the height axis.
• Vertical: Select two points to define the vertical plane. The inspection

direction is fixed to the perpendicular.
• Free: Select three points to define a 3D plane.

Points can be chosen from the flyout or directly from the graphical view. The
plane is created only once all required points are selected. It is possible to edit
the plane as often as you like, until you select the create option.
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☞ The inspection direction can be inverted with the checkbox. You can
define which values shall be positive or negative.

After the creation of the comparison map, the plane also appears in the
graphical view and navigator. You can turn it off by using the visibility eye
or switching off the comparison map reference planes layer from the layer
manager.

Inspecting the Comparison Results
Depending on the measured feature selected, you see the distances in the
graphical view in the shape of a surface, point cloud or lines (library points).

In the Property Grid select the  option to see a histogram of the calculation
results.
To generate a report, on one or multiple comparison maps, select the maps in
the Navigator or the Inspector and either select: Reports > Comparison Map
Report from the Home ribbon bar or right-click and select Comparison Map
Report.
For best viewing in the graphical view, it is recommended to turn off the
visibility of the measured and reference feature. This allows to focus on the
comparison map itself.

☞ If you choose a plane as a reference, then you can also turn off its
visibility from the navigator.

☞ In the Layer Manager, you can change the width of the lines for the
representation of distances between a reference feature and library
points.
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Measured Type = Library Points:
 

Measured Type = Point Cloud:
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3.4.7 Cut Fill Maps

Cut fill maps is a surfaces function that allows you to compare a measured
surface to a design surface, called reference surface in Infinity. Height differ-
ences are colour-coded and shown in a so-called cut fill map. The cut fill
map is saved to the database as an Infinity object. By default, it shows in
blue volumes that need to be cut to reach the level of the reference surface.
Volumes that need to be filled are indicated in red.

Sample of a road design:
 

Cut Fill Maps
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How to calculate a cut fill map:
1. Go to the Surfaces tab and

select Cut Fill Map from the
Surfaces ribbon bar.
The Create New Cut Fill Map win-
dow opens up next to the regu-
lar property grid.

2. Select  a Reference Surface
(design) and a Measured Sur-
face as input to the cut/fill cal-
culation.
☞ You can also first

select a Reference
Surface (design) and
a Measured Surface
in the Navigator or
the Features Inspector
and then select New
Cut Fill Map from the
context menu. In this
case the property grid
opens up and refer-
ence and design sur-
face is already selec-
ted. The surface you
select first is identi-
fied as the reference
surface. The second
surface you select is
automatically identified
as the measured sur-
face.

3. Under Settings select whether
you want to compute only height
differences or height differences
with respect to given tolerance
values.
If you select Tolerance, specify
the upper and lower tolerance
values, too and define a Min.
Segment Distance. Through the
Min. Segment Distance value you
can simplify the tolerance lines.
☞ The tolerance lines

indicate the areas in
the map where mater-
ial has to be cut or
filled. These lines can
be exported for stake-
out, but if they are too
detailed the controller
might not be able to
handle them.
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4. Under Styling define which colours shall be used for indicating cut/fill
areas.
By default, blue is used for volumes that need to be cut and red is
used for volumes that need to be filled.
☞ Default values for Settings and Styling can be defined in

the surfaces Parameters option.
Select Parameters from the Surfaces ribbon bar to open.

☞ To reset Settings and Styling to the factory defaults go to
the File tab > Info & Settings > Surfaces & Contours
and select the Defaults option.

5. Under Material Factors you can enter factors by which the cut/fill
volumes shall be multiplied. The material factors are used to better
estimate the volume of material to move.

6. Select Create at the bottom of the property grid to create the new
cut fill map.

Cut Fill Results and Tolerance Results
If tolerances have been used for the calculation, they are added as properties
of the cut fill map to the Property Grid and the Features Inspector.

Inspecting cut fill results:

• In the Property Grid select the  option to see a histogram of the
calculation results.

• In order to generate a report on one or more cut fill maps, select the
maps in the Navigator or the Inspector and either select Reports > Cut
Fill Map Report from the Home ribbon bar or right-click and select Cut
Fill Map Report from the context menu.

• In order to focus the graphical view on just showing the cut fill map
make other objects invisible by selecting the  option in the Navigator.
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• In the Layer Manager you can select different colours for the so-called
Tolerance Lines Upper and Tolerance Lines Lower to enhance their visib-
ility in the graphical view. You can also adapt the line width or change
the line style. If you switch off  the Cut Fill Map itself, you can focus
on the tolerance lines in the graphical view.

Workflow

A typical workflow making use of cut fill maps would be:
1. Measure, for example, a road that is being built based on a given

design.

2. Import the measured data and the design surface from CAD to Infin-
ity.

3. Calculate the surface resulting from the measurements.

4. Compare the surface to the design by calculating a cut fill map. Here
you can make use of tolerances by entering the values. The cut
fill map only shows areas and volumes to be cut or filled that are
beyond the entered tolerance values.
The areas where material needs to be moved are indicated by con-
tour lines called Tolerance Lines Lower and Tolerance Lines Upper.
These contour lines can be exported to DXF.

5. Use the exported upper and lower tolerance lines for stake-out of
the out-of-tolerance areas in the field.
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Illustration showing the tolerance lines upper and lower where material
still needs to be moved to reach the design surface:

 

 

The styling of the tolerance lines has been modified in the Layer Manager to
enhance their visibility against the cut fill map itself.
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To use the lines for stake-out in the field make use of the Min. Seg-
ment Distance to simplify the lines:

 

3.4.8 Trim Triangles

It is possible to remove the triangles at the outer border of a surface.

☞ Removing the triangles does not create holes.

How to trim triangles:
 

1. Select at least one triangle at the outer border of a surface.
☞ All existing selection shortcuts are available.

2. Select Trim Triangles, either from the ribbon bar or from the con-
text menu.

See also:
Graphical View

3.4.9 Remove Vertices

It is possible to remove vertices from a surface when spikes or areas of
triangles have been created but not wanted.

☞ Removing the vertices does not create holes.

Trim Triangles

Remove Vertices
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How to remove vertices:
 

1. Select all triangles that contribute to a vertex.

2. Remove vertices either from the ribbon bar or from the context
menu.
☞ The triangles are locally reorganised.

3.4.10 Fill Holes

It is possible to fill holes in the surfaces when the holes in the surface are
created but the surface should be continuous.

☞ Fill holes fills the closed shape holes.

How to select the surface for the fill holes tool:
1. Select the surface from the graphical view, the inspector or the

navigator.

2. Select Fill Holes from the surface ribbon bar.

☞ The selected surface is automatically used in the fill holes tool.

Alternatively:
1. Select the surface and right-click to open the context menu from

the graphical view, the inspector or the navigator.

2. From the context menu, select Fill Holes.

☞ The selected surface is automatically used in the fill holes tool.

Alternatively:
1. Select Fill Holes from the surface ribbon bar.

2. Select the pencil icon and then the surface from the list or select
the surface in graphical view and select the Add current selection
icon.

Fill Holes
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How to fill the holes:
 

1. Select the surface and launch the fill holes tool as explained previ-
ously.

2. Select highlighted holes edge which should be filled.

3. Select the Fill Interpolation parameter.

4. Select Apply.

☞ Multiple holes can be selected in one hole filling event. The hole is
filled in the same fill interpolation parameter within the same fill holes
event.

Fill Interpolation Parameter
This setting defines how holes in the surface are filled. The level of interpola-
tion considers the surrounding surface geometry to determine how to fill the
holes and how well to fit to the surrounding surface. With no interpolation,
straight triangles between hole vertices are created, with no interpolated ver-
tices. When applying levels of interpolation results in more vertices within the
holes to be filled.

3.5 Point Clouds

3.5.1 Overview

When a job contains point cloud data, that is imported into Infinity, this special
kind of data can be managed in the Point Clouds tab.
If you scanned buildings, industrial plants or other huge objects you probably
had to take your point clouds on several stations all around the object and
it becomes necessary to group the single point clouds as belonging together,
defining one object. Especially, when you scanned more than one object in a
job and when you had to scan from several stations around each object, it
becomes necessary to group the scan data. The grouped data also gives you a
solid basis for future surface calculations.

Creating new point cloud groups

To group point clouds into a point cloud group:
1. In the Inspector, go to the  Features tab and open the  Point

Clouds section.

Point Clouds
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2.
Select the point clouds to be grouped and select  New from
the Point Clouds ribbon bar.

The new point cloud group is created and added to:
• The  Point Cloud Groups section in the Library of the Navigator. If the

Point Cloud Groups subsection does not yet exist, it is created.
For each point cloud group, the single scans belonging to it are listed.

•
The  Point Cloud Groups section in the Features tab of the
Inspector.

☞ Point cloud groups are always created with a default name. To
change the name, click onto a point cloud group in the Navigator
or in the Inspector and adapt its name in the Property Grid.

☞ You can also create an empty point cloud group and add single point
clouds to it later on.

Adding and removing point clouds from a point cloud group

To add point clouds to a point cloud group:
1. In the Inspector, go to the  Features tab and open the  Point

Clouds section.

2. Select the point cloud to be added to a point cloud group and

select  Add to from the Point Clouds ribbon bar.

or:
1. In the Source section of the Navigator, go to the station setup

containing the point cloud to be added.

2.
Select the point cloud and select  Add to from the Point
Clouds ribbon bar.

☞ If there is more than one point cloud group available in your project,
select one from the drop-down list.

To remove point clouds from a point cloud group:
1. In the Inspector, go to the  Features tab and open the  Point

Clouds section.

2. Click on the arrow  next to Point Cloud Groups to open the cat-
egory.

3. Click on the arrow  next to the point cloud group from which one
or more point clouds shall be removed.

4.
Select the point clouds to be removed and select  Remove
from from the Point Clouds ribbon bar.

or:
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1. In the Library section of the Navigator, go to  Point Cloud
Groups and expand the tree for the point cloud group from which
one or more point clouds shall be removed.

2.
Select the point clouds to be removed and select  Remove
from from the Point Clouds ribbon bar.

Cleaning points
If your point clouds contain random points, like points that have accidentally
been taken while scanning a main object, then these random points can be
identified by Infinity and cleaned from the point cloud data in your project.
As a consequence, you only see the relevant point cloud data in the graphical
view.

To clean points:
1. Select a point cloud or a point cloud group either in the Inspector

or in the Navigator.

2.
Select  Clean Points from the ribbon bar to clean accidentally
taken points from your point cloud data.

In the Property Grid of the point cloud and/or the point cloud group, you see
that the total number of points decreases to just count the relevant points.

Deleting points

To delete point clouds:

Select  Delete to delete the selected point clouds.

In the graphical view, select the point clouds to be deleted.

Colouring Modes

Select between:
• RGB colouring (natural colours).
• Intensity.
• SNR (Signal-to-Noise Ratio).
• Single Color.

For Intensity and SNR you can select a Color Scale from the drop down list.
By default, MultiHue is set.
For Single Color representations you can select whether the representation
shall be By Layer (default) or by a user-selected colour.
For all Colouring Modes the last used settings are remembered when you open
another project. Select the same option to use the same settings again. The
icon indicates which settings have last been used. By default, the project data
is displayed in RGB mode.
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Filtering points

To reduce the point density in the graphical view:

Select  Filter from the ribbon bar and select a percentage to which the
point density shall be reduced from the drop-down menu.
The last used setting are remembered when you open another project. Select
the option again to filter the points using the same percentage. The icon
indicates which percentage has last been used. By default, the project data is
displayed with 100%.

3.5.2 Point Cloud Properties

In the point cloud properties you can:

• Edit the Point Cloud ID and enter a description.
• Select a Colouring Mode from the drop-down list:

For Intensity and SNR choose a colour palette, for Single Colour choose
a colour or decide on the layer colour.

• Select  to select a different Position Source.
• Select  to select a Panorama image to be assigned to the point

cloud.
☞ You can only assign panoramas that have been taken on the same

station as the point cloud.

You are informed about:
• The panorama assigned to the point cloud.
• The station on which the point cloud has been taken.
• The settings (point cloud method and mode, resolution, min. and max.

distance).
• The station coordinates.

3.5.3 Reduce Point Clouds

General
The reduce point clouds tool allows you to reduce the number of points within
selected point clouds. There are three different methods to choose from. They
work differently, but result in a point cloud with less than the original number
of points.

☞ In order to run this feature, at least one point cloud or point cloud
group must be selected.

☞ When applied to multiple point clouds, each point cloud is treated
individually. When applied to a point cloud group, the group as a
whole is reduced to the specified value.

Point Cloud Proper-
ties

Reduce Point Clouds

268 Optional Modules



Short description of each method:

Method Description

By Percentage
By Count

The user can decide what percentage or number
(count) of points to keep after the reduction. Use
one of these methods when the number of remain-
ing points should be under control.
The operation automatically tries to remove points
in more dense areas first. There is no equal spacing
between points after the reduction.

By Distance An average distance between points is entered. That
defines the size of an octree that is projected onto
the point cloud. Within each of the cells, the point
closest to the centre of gravity is kept.
The result is a dense point cloud that is grid-like
with an approximate spacing of the average distance
setting.
☞ It does not create an exact grid out of the

point cloud.

☞ Unlike the other methods, there is no con-
trol over the remaining number of points.

3.5.4 Clipping

Clipping allows the user to hide the cloud points with defined clipping objects
like plane, slice or box. Clipping does not delete the points. Multiple clips are
permitted. Use zooming, rotating and panning when creating a clip for better
data visualisation in 2D or 3D.
Once a clip has been created, you can remove the clipping and restore the
visibility of all point cloud data by selecting Reset Clips from the ribbon bar.

Plane
Plane hides points beyond a single plane.
A single plane can be created along a specified axis or defined by three points.

To hide points by plane:
1. Select Clip from the ribbon bar and then Plane from the drop-down

menu.
An additional window opens called Clip.

2. Select the Single point, Two points or Three points method to
create the plane.
For the Single point method define the Easting, Northing or Height
axis for the plane orientation.

3. To create the plane with the Single point method, a temporary plane
representing the clip appears in the graphical view and follow the
cursor.
Click once to position the plane. Points on one side of the plane are
hidden from the view.
Use Invert view to change the points visibility between plane sides.

Clipping
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4. To create the plane with the Two points or Three points method,
select two or three points in the graphical view to define and orient-
ate the plane.
Points on one side of the plane are hidden from view.
Use Invert view to change the points visibility between plane sides.

5. You can move the plane along the current axis by selecting the red
indicator and holding the left mouse button.

6. Select Create to save the current clip.

Slice
Slice hides points outside of two parallel planes.
Two parallel planes can be created along a specified axis or defined by three
points plane and slice width.

To hide points outside of a slice:
1. Select Clip from the ribbon bar and then Slice from the drop-down

menu.
An additional window opens called Clip.

2. Select the Single point, Two points or Three points method to
create the Slice.
For the Single point method define the Easting, Northing or Height
axis for the slice orientation.

3. To create the slice with the Single point method, a temporary plane
representing the clip appears in the graphical view and follow the
cursor.
Click once to position the first plane.
Now the second temporary plane follows the cursor.
Click again to position the second plane.
Points outside of the slice are hidden from view.

4. To create the slice with the Two points or Three points method,
select two or three points in the graphical view to define the first
plane.
Now the second temporary plane follows the cursor.
Click again to position the second plane.
Points outside of the slice are hidden from view.

5. You can resize the slice by selecting the red indicator and holding
the left mouse button or change the slice width in the Clip window.
To move the slice, hold down the Ctrl-key and left-click the mouse
at the same time.

6. Select Create to save the current clip.

Box
Box hides points outside a 3D box.

To hide points outside of a box:
1. Select Clip from the ribbon bar and then Box from the drop-down

menu.
An additional window opens called Clip.
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2. Select a method:
Fixed on ground
The first box face is defined by three points at the height of the first
selected point. The height of the box is defined by a fourth point.
Free
The first box face is defined by three points. The height of the box is
defined by a fourth point.
Easting
The first box face is defined three points around the Easting axis.
The height of the box is defined by a fourth point.
Northing
The first box face is defined by three points around the Northing
axis. The height of the box is defined by a fourth point.
Height
The first box face is defined by three points around the height axis.
The width of the box is defined by a fourth point.

3. Select a point in the graphical view to represent the first corner of
the desired 3D limit box.
A temporary line is attached to the cursor.

4. Select a second point representing the opposite corner of the
desired limit box.
The resulting rectangle is projected onto the work plane.

5. Select a third point to determine the last box dimension.
Points outside the boundaries of the box are hidden from the view.

6. You can resize the box by selecting the red indicators and holding
the left mouse button or by changing dimensions in the Clip win-
dow.
To move the box, hold down the Ctrl-key and left-click the mouse at
the same time.
You can rotate the box by selecting the purple indicators and left-
click the mouse.

7. Select Create to save the current clip.

☞ If all points are hidden after applying the box clip, it is likely that the
limit box is defined in an incorrect position. In this case, use Cancel
and try again.

3.6 Point Cloud Registration

3.6.1 Overview

The point cloud registration module allows for the import of BLK360, RTC360
and RTC360 LT data into Infinity. Individual scan setups can then be registered
together, optimised and stored to create a Unified Point Cloud (UPC). Scanning
objects in Infinity are accessible from the navigator, inspector, graphical view,
property grid and the register tool.
Infinity currently supports registration through visual alignment and by the
matching of targets. Targets can be matched to Infinity points (for example,
TPS or GNSS observations) to translate the UPC onto a coordinate system.
If necessary, the UPC can be exported from Infinity using various formats for
work in third-party applications.
Requirements:

Point Cloud Registra-
tion
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The following modules are required to utilise point cloud registration function-
ality in Infinity:
• Point Cloud Registration.

Module Features
• Up to 100 setups per Infinity project.
• Import BLK360 data.
• Import RTC360 data.
• Visual alignment.
• Match targets.
• Apply control.
• Optimise.
• Store and create UPC.

☞ The BLK data manager application is required when importing BLK360
data.

☞ To ensure the best performance, it is recommended that you install
the latest graphics card drivers from the website of the manufac-
turer.

3.6.2 Point Cloud Registration Settings

The point cloud registration settings are configured through the Infinity File >
Info & Settings > Registration, the import window and in the register tool
itself.

Registration Settings

The following settings can be configured:
 

Point Cloud Registra-
tion Settings
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Cloud-to-Cloud
• Max. Iterations: The maximum number of times the algorithm tries to fit

the point clouds together.
• Search Radius: The radius in which the application searches for common

matched surfaces.
• Max. Point Density: The number defines how many points in the cloud

are used for cloud-to-cloud registration.
• Normal Threshold: This value controls the threshold for how valid the

surfaces are in the cloud-to-cloud registration.

Targets
• Max. Target Error: Maximum allowed error between targets to be

included in the registration.
• Prioritise Targets: The targets receive a higher weight than the cloud-to-

cloud constraint during the link creation process.

Unified Point Cloud
• Max. Point Number: The maximum number of points which are created

for the unified point cloud.

Registration tolerances
• Scan Group: Overall Scan Group error for all links in the Scan Group.
• Loop: The loop error shows how much the links have to move to be

globally optimised. After the scan group optimisation, the loop error is
0.000 as it is contained within the globally optimised error.

• Global: The value that the setups have to be moved when included in a
loop. A high global error value may indicate a problem with a link or scan
group.

• ΔEasting: The difference between the Easting coordinate of the control
point and the assigned target.

• ΔNorthing: The difference between the Northing coordinate of the con-
trol point and the assigned target.

• ΔHeight: The difference between the height coordinate of the control
point and the assigned target.

• Δ3D: The difference between 3D coordinates of the control point and the
assigned target.

• Cloud-to-Cloud: The error in the cloud-to-cloud constraint between the
setups.

• Overlap: The percentage overlap between the two setups forming the
link.

• Target to Target: The average distance or error between matching tar-
gets in a link or scan group.

• Link: The overall error for the link which can be composed of cloud-to-
cloud error, target to target error and overlap.
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Import Window

The following settings can be configured in the import window when
BLK360 (.blk) files or RTC360 (project.rtc360) files are selected:
• Auto Cloud: The auto cloud routine is performed on the selected setups

at import. This process attempts to align the setups and join them
together using cloud-to-cloud.

• Auto Black & White Target: Black and white targets are extracted at
import. The match targets routine then attempts to join setups with
matching targets.

Register Tool

The following settings can be configured in the links subtab of the
register tool tab:
• Lock Links: The lock check box locks the link so that the link does not

move during global optimisation. You may choose to lock a link when the
global error of the link is too high. Locking the link prevents the link from
being affected (moved) by global optimisation.

Property Grid

The following setting can be configured in the scan group property grid
(error measurements flyout):
• Lock Links.

The following setting can be configured in the targets property grid:
• Target ID: The Target ID can be renamed or matched to an existing tar-

get.
• Assigned Point: The target can be assigned to an existing Infinity point

(for example, TPS or GNSS point).

3.6.3 Register Tool Workflow

The register tool has several different elements to facilitate the registration
workflow.

 

Register Tool Work-
flow
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No. Name Description

1. Registration Tool
Navigator

View all the imported scan setups organised
in scan groups or available setups.

2. Register Tool Bot-
tom Menu

View links, targets and control points.

3. Site Map View View and organise scan data in 2D top down
view.

4. Visual Alignment Display two selected setups and create link
between them.

5. Scan Setup View View scan setup from scanner position to
view the data and create targets.

6. Match Targets Create link based on targets.

7. Scan Group View View scan group in 3D view.

8. Georeference the
Scan Group

Auto assign control and apply control.

9. Optimise Optimise the scan group.

10. Store UPC Store Unified Point Cloud (UPC) in the Infinity
project.

Register Tool Navigator
This window allows you to select the setups and align them to build the scan
group.

The data can be organised in:
• Scan Groups: The scan groups show all scan groups in the current Infinity

project.
• Available Setups: The available setups shows all setups that are not part

of a scan group.

Register Tool Bottom Menu

This window displays all the information about the scan group:
• Links Subtab: Shows all links in the current Infinity project.
• Targets Subtab: Shows all targets in the current register view.
• Controls Subtab: Shows all controls in the current register view.

Site Map View
The Site Map view is a 2D-only view to select and move setups to organise
and make it easier to register.

The following controls are available:
• Shift Setup or Scan Group: Left-click mouse on a setup to shift a setup

or scan group.
• Rotate Setup or Scan Group: Left-click mouse + Shift key on a setup to

rotate a setup or scan group.
• Multi-Object Selection: Left-click mouse + Ctrl key.
• Fence Selection: Left-click mouse + Shift key on the open space.
• Context Menu: Right-click mouse on an object for the context menu

options.
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Visual Alignment View
The visual alignment view displays two selected setups to perform a cloud-to-
cloud registration.

The following controls are available in top view:
• Shift Setup: Left-click mouse to shift the active setup.
• Rotate Setup: Left-click mouse + Shift key to rotate the active setup.

The following controls are available in front/back/left/right views:
• Shift Setup Along Z-axis: Left-click mouse on a setup to shift the active

setup along the Z-axis.
• Tilt Setup About View Axis: Left-click mouse + Shift key to tilt the active

setup about the view axis.

Setup View
The setup view displays the setup cloud of the selected setup.

The setup view can be used to:
• View and inspect the setup cloud using existing Infinity view controls.
• Mark user targets.

Match Targets
Match targets creates the link between two or more scan setups based on a
minimum of three matching targets.
Where matching target labels exist, the match targets algorithm attempts to
align the setups based on the labels.
Where no matching labels exist, the match targets routine attempts to align
the setups by target geometry.

Scan Group View
The scan group view displays the scan group cloud of the selected scan
group. The scan group view can be used to interrogate the scan group cloud
using existing Infinity view controls.

Georeferencing the Scan Group
Use the controls assigned to targets to bring the scan group to project
coordinate system.
• Auto Assign Control Points: Match target and control point with the

same point ID if not manually matched.
• Apply Control Points: Assign the control points to the scan group to

transform it to the project coordinate system.

Optimise
Final optimisation of the scan group, updating all links and scan setup posi-
tions before storing the UPC.

Store Unified Point Cloud
Store the UPC to be used in the Infinity project.
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Register Strip
The register strip is at the bottom of the register tool view and provides
access to the functions provided by the registration module.

3.6.4 Registration Using Visual Alignment

 

No. Name Description

1. Visual Alignment
View

Display two scan setup point clouds which
are used in the visual alignment.

2. Visual Alignment Open the visual alignment mode.

3. Top View Switch the visual alignment graphical view to
top view.

4. Side View Switch the visual alignment graphical view to
side view.

5. Setup Selector Switch between two setups opened in visual
alignment. Active one can be moved.

6. Join Create the link between two setups opened
in visual alignment.

The visual alignment view displays two selected setups in different colours to
align and join.

The following controls are available in the top view:
• Shift Setup: Left-click mouse to shift the active setup.
• Rotate Setup: Left-click mouse + Shift key to rotate the active setup.

The following controls are available in the front/back/left/right views:
• Shift Setup Along Z-axis: Left-click mouse on a setup to shift the active

setup along the Z-axis.
• Tilt Setup About View Axis: Left-click mouse + Shift key to tilt the active

setup about the view axis.

The active setup can be toggled by selecting the setup name from the register
strip.

Registration Using
Visual Alignment
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Once the setups are visually correct they can be joined:
• Join: Uses the overlapping points between setups to join them together

through cloud-to-cloud. A global optimisation is then performed on the
scan group. If it detects setups that can also be joined, you are notified
and asked to or not to proceed with this additional step.

☞ In the case when between setups, there is not enough overlap to
create a valid link and optimise it, the user-defined link is created.

☞ The user-defined link has a lock state as default.

3.6.5 Registration Using Targets

This article covers the process of registration using targets in Infinity.

Target Creation

Targets can be created in Infinity in a number of ways:
• Black & White Target Extraction: Ensure that the Auto Black & White

Targets checkbox is ticked in the import window. This option also
attempts to align and join scans with matching targets as part of the
process.

• User Target Creation: When in the setup view, select Create User Tar-
gets from the register strip. You can then mark user targets on the setup
cloud by a left-click of the mouse.

☞ Any part of the setup cloud can be used to mark a user target,
facilitating the ability to join setup clouds using objects that are not
necessarily the targets.

User target creation:
 

1. Open the scan Setup View.

2. Select Create User Target.

3. Mark the User Target.
☞ The tool follows the same logic as create new point. It is

possible to relabel the target during target creation. The
next created target takes the name after the previous one
and follows the numbering.

4. After all the targets are created, select Create.

Registration Using
Targets
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Target Labelling

Targets can be labelled in Infinity in a number of ways:
• By entering a defined text string in the Target ID field of the targets

Property Grid.
• By selecting a matching target from another setup using the pencil icon in

the Target ID field of the targets Property Grid.

☞ See Applying Control for further information on applying control to
targets.

Matching Targets

To join setups with a minimum of three matching targets:
• Select two or more setups from the register tool navigator or register

tool.
• Select Match Targets from the register strip.

Where matching target labels exist, the match targets algorithm
attempts to align the setups in the following order:
• By label.
• By Target geometry.

Where no matching labels exist, the match targets routine attempts to align
the setups by target geometry.

☞ Once the setups have been aligned using targets they are joined
using cloud-to-cloud.

Targets State:
1.  - Not used: Target is not part of the link. Target does not constrain

with any targets on other setups.
2.  - Used: Target is part of the link. Target constrains with targets on

other setups.

3.6.6 Applying Control

Black & white targets extracted at import and user targets created after
import, can be assigned to Infinity points for translating the scan group on
to a coordinate system.

Assign Control to Target

Infinity points can be assigned to targets by:
• Selecting an Infinity point using the pencil icon in the Assigned To field of

the targets Property Grid.
• When the Target ID Matches the Infinity Point ID: Selecting Assign Con-

trol from the register strip.

Applying Control
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1. Select the target from the target subtab or the graphical view.

2. Select the pencil icon in the Property Grid to open the flyout with
Control Points from an Infinity Project.

3. Select from the flyout the control point which should be assigned to
the target.

4. Select Apply.

Apply Control to Scan Group
With a minimum of three targets with assigned Infinity points in a scan group,
select Apply Control from the register strip. The transformation is computed
and relevant error information for each assigned point is reported in the con-
trols subtab of the register tool.

☞ GNSS points must have a local position to be assignable.

☞ No scale factor is applied in the apply control process.

3.6.7 Optimise Scan Group, Store and Create Unified Point Cloud

Once the required links between setups have been created the scan group can
be optimised. Following this, the scan group can be stored and a Unified Point
Cloud (UPC) can be created for working with in the Infinity graphical view.

Optimise Scan Group

To perform a global optimisation of a scan group:
• Select the scan group to be optimised from the library, inspector or the

register tool side tab.
• Select Optimise from the register strip.

Store Scan Group and Create Unified Point Cloud

To store the optimised scan group and create the UPC:
• Select the scan group to be optimised from the library, inspector or the

register tool navigator.
• Select Store UPC from the bottom right corner of the register tool.

The scan group state changes to stored and the UPC is visible in the graphical
view.

☞ The number of points contained within the UPC is controlled by the
file tab setting Max. Number Points.

Optimise Scan Group,
Store and Create Uni-
fied Point Cloud
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☞ All setups in the Infinity project must be part of the scan group for
the Store UPC option to be active.

☞ The scan group must be optimised for the Store UPC option to be
active.

☞ Unstoring a scan group removes the UPC from the Infinity project.

3.6.8 Reports & Exports

The data source report and the scan registration report are available for
BLK360 and RTC360 data. The stored Unified Point Cloud (UPC) can be expor-
ted to the existing point cloud formats supported by Infinity.

Data Source Report

To create the data source report for BLK360 or RTC360 data:
• Select the required source from the source pane in the navigator.
• Select the file/reports/data source report.

Scan Registration Report

To create the scan registration report for a stored scan group:
• Select the stored scan group from the library, the inspector or the register

tool.
• Select the file/reports/scan registration report.

UPC Export

To export the UPC to a supported point cloud format:
• Select the UPC from the library or the inspector.
• Select File, then Export.
• Select Point Clouds from the Export window.
• Select the desired point cloud format from the Export side menu.
• Select Export.

3.6.9 Importing BLK360 and RTC360 Data

Import Settings

Scanning related import settings shown in the import window include:
• Auto Cloud: The auto cloud routine is performed on the selected setups

at import. This process attempts to align the setups and join them
together using cloud-to-cloud.

• Auto Black & White Target: Black and white targets are extracted at
import. The match targets routine then attempts to join setups with
matching targets by geometry.

☞ Previously applied settings are used and also applied when importing
data using the following drag and drop methods.

Importing BLK360 data
Infinity is able to import BLK360 data from the .blk files created using the BLK
data manager application.

Reports & Exports

Importing BLK360 and
RTC360 Data
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To import BLK360 data:
• Download and install the BLK data manager.
• Create the necessary .blk files for each setup in the BLK data manager.
• Import the necessary .blk files through:

• The import window (selecting Home, then Import and then the scan
data).

• Drag and drop the necessary .blk files to the source pane.

Importing RTC360 data

Infinity is able to import RTC360 data using several methods:
• The Import window (selecting Home, then Import and then the scan data)

using the project.rtc360 file.
• Drag and drop the necessary folder to the source pane.

☞ Field360 links and VIS links are imported as part of this process.

3.7 Imaging

3.7.1 Overview

Images are a useful way to add context to your project data. Infinity supports
working with images in a project for documentation, along with computing
points from images where measured data may have been overlooked during
field collection. In Reality Capture, images can be used for generating dense
point clouds, providing a detailed 3D perspective to a project area and allow-
ing you to extract or create 3D features and data deliverables.
Infinity supports the import of images from SmartWorx and Captivate field
jobs, Aibot UAV, other fixed and rotary wing drones and general JPG images.
It is also possible to import georeferenced images to display as background
maps.

In imaging you get access to:
 

No. Group Name Description

1. Images Base licence needed:
• Import, export and view images.
• Link or unlink images, to or from points,

lines or areas.
• View computed image points.
• Georeference images.

Imaging
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No. Group Name Description

2. Image Group Imaging option needed:
• Create image groups that allow you to

work with related images easier.
• Compute points from the grouped

images.

3. Image Point Compu-
tation

Imaging option needed:
• Image Group Viewer - View images and

points computed from images (image
points), or compute points from a selec-
ted image group.

• New Image Point - Calculate new points
from images.

4. Image Processing Point clouds from images option needed:
• Dense point clouds.
• Digital surface models.
• Orthophotos.

See also:
The video "Leica Infinity - Imaging Module - How to work with GS18 I
data" https://www.youtube.com/watch?v=1TwomI2lxw0
The video "Leica Infinity - Imaging Module - Points from Images" https://
www.youtube.com/watch?v=PDR4ROLrKbA
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs
The video "Leica Infinity - UAV Processing Part 1 - Import and orientate
Aibot data" https://www.youtube.com/watch?v=F8OdA9sy6q4
The video "Leica Infinity - UAV Processing Part 2 - Add GCPs and update
orientation" https://www.youtube.com/watch?v=Y8hLA0RObFA
The video "Leica Infinity - UAV Processing Part 3 - Create Dense
Point Cloud, DSM and Orthophoto" https://www.youtube.com/watch?
v=XPpLS1cxZIk

3.7.2 Images

3.7.2.1 Overview

Within images, you get access to the basic functionality of imaging.
Requirements:
• Basic option.

Images
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Here you can do the following:
 

No. Name Description

1. Import Images Import image data.

2. Imaging Inspector Explore imaging-specific project content
grouped thematically for detailed investiga-
tion.

3. Image Properties View the properties of the selected image.

4. Image Viewer View the selected image in the image viewer.

5. Link Images Link selected image to point/line/area.

6. Unlink Images Unlink selected image from point/line/area.

7. Delete Images Delete selected images.

8. Georeference Images Georeference selected images.

See also:
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

3.7.2.2 Import Images

Images can be imported through the Import dialog or by drag and drop option.
Currently, JPG, PNG, TIFF and PDF file types are supported for images. JPG, PNG
and TIFF file types are supported for georeferenced images.

Import dialog:
 

Import Images
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1. Check or uncheck the desired Import Settings.

2. Select Import to start the import.

☞ For images imported by drag and drop, the default Import Settings
are applied.

Import Settings
When the Create Image Group box is checked, an image group is created
directly after closing the import dialog. In order to be processed, images must
be added to an image group. If no image group is created on import, one
can be created after the import and images can be added to it. For further
information, see Image Group.

☞ At least two images must be selected for this option to become
available.

☞ By default, this setting is checked. However, if unchecked, Infinity
remembers the selection at the following import.

When the Import Images box is checked the images are copied to the project.
If this option is unchecked, the images are not copied into the project but
linked to it through the path specified in the import dialog. If, after importing,
the images are deleted or moved to a different path, no processing is allowed.
A warning message is displayed if the images cannot be found at the expected
location.

☞ When moving the project to another computer for further processing,
the link is no longer valid and no further processing is possible.

☞ By default, this setting is checked. However, if unchecked, Infinity
remembers the selection at the following import.

3.7.2.3 Imaging Inspector

From the inspector imaging tab, there are several groups to help you work
with images.

 

No. Name Description

1. All images View all images in a project.

2. Image Groups View images by their grouping.

3. Linked/Not Linked Sort images by point, line, area feature
which images are linked to.

4. Panoramas Using TPS imaging sensors, all imported field
acquired panorama images are sorted here.

Imaging Inspector
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No. Name Description

5. Georeferenced List of all the images that have been recti-
fied, either by import, using clip base map
or from the DSM & Orthophoto processing
step.

6. TPS Setups View all images that are linked to a total sta-
tion setup.

7. Imaging Results Access imaging results. The view is split in
two panes, the results pane and the task
pane.

8. Image Viewer You can view the selected image in a res-
izable image viewer that is part of the
inspector or in separate window.

9. Show Thumbnails Switch between a detailed list or a thumbnail
strip of images.

3.7.2.4 Image Properties

Image properties can be seen in the property grid as well as in the imaging
inspector.

 

Name Description

Image ID The name of the image.

Event State This is the GNSS solution type (for example phase fixed RTK
or navigated RTK) associated to Leica and DJI UAV images.
It indicates the quality of the image position.

Description Any optionally entered description.

Date/Time The date and time of when the image was taken.

Source The name of the image source data.

Acquisition The acquisition type informs whether the images are from
an aerial or from a ground perspective.
Could be:
• Aerial
• Terrestrial
• Unknown

Image
Group

The ID of the image group which the image belongs to.

Image Properties
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Name Description

Oriented Is indicating if the image has its orientation computed with
photogrammetric techniques.

Station The ID of the station on which the image was taken.
☞ Station is shown only for TPS images.

Linked to The ID of the object which the image is linked to.
☞ Linked to is shown only when the image has a link

to an object.

Width Image width in pixels.

Height Image height in pixels.

Image The image itself is displayed as a thumbnail.
☞ The image can be opened in a separate image

viewer using the icon.

Camera The details of the camera that the image was taken with.

☞ Images are also displayed in the property grid of the objects they
are linked to. If you select an object to which one or more images
are linked, then the thumbnails of these images are displayed in the
properties.

3.7.2.5 Image Viewer

You can view the selected image in a resizable image viewer that is part of the
inspector or in separate window.

To open/close the image viewer:
 

1. Select an image in the content view.

2. Select Open Image Viewer to see the image in a window.
☞ The image fits to the window size.

3. To close the image viewer, select Close Image Viewer.

4. Alternatively you can open the image viewer in a separate window
by selecting the icon in the Property Grid.

☞ You can shift the separator between the content view and the image
viewer to change the size of the display.

Image Viewer
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3.7.2.6 Link Images

Images can manually be linked to points or lines or areas. They cannot be
manually linked to point clouds.

To link images to an object:
 

1. Select the image you want to link, either from the Inspector, Navig-
ator or the graphical view.

2. Select Link from the Images ribbon bar.
Alternatively select Link from the context menu.

3. In the Link Image window, select the object to which you want to
link the images.
☞ You can also search for an object.

4. Select Link to link the image.

5. Select OK.

☞ An image can be linked to more than one object and an object can
have more than one image linked to it.

3.7.2.7 Unlink Images

Images can manually be unlinked from points or lines or areas. They cannot
manually be unlinked from point clouds.

To unlink an image from an object:
 

1. Select the linked image, either from the Inspector, Navigator or the
graphical view.

Link Images

Unlink Images
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2. Select Unlink from the Images ribbon bar.
Alternatively select Unlink from the context menu.

3.7.2.8 Delete Images

To delete images:
 

1. Select the images you want to delete, either from the Inspector, the
Navigator or the graphical view.

2. Right-click into the selection and select Delete from the context
menu or select the Delete option in the top left corner of the main
window.

3.7.2.9 Georeference Images

3.7.2.9.1 Overview

Infinity supports the display and the creation of georeferenced images. Using
these images is a nice way to help visualise, reference and relate your project
data.
Georeferenced images are shown as objects in the library and can be set to
visible or not visible. It is possible to use many georeferenced images. An
existing georeferenced image can be edited and updated with a new trans-
formation.
Georeferenced images are global objects. You can find them under File >
Tools > Georeferenced Images ( ).

Here you can do the following:

No. Name Description

1. Import Import georeference images.

2. Export Export georeference images.

3. Georeference Tool Select points and match points to georefer-
ence images.

See also:
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

3.7.2.9.2 Import

Delete Images

Georeference Images
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Images can be imported from PNG, JPG and TIFF format.
Georeferenced images must have a world file, which is a PNW for PNG images,
JPW for JPG images, TFW for TIFF images.
Otherwise it is possible to reference these images using the georeference
image wizard inside the project or from File > Tools > Georeferenced
Images ( ).

1. Locate the images to import.

2. Define the Import Settings unit for the files.

3. Select Import.

See also:
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

3.7.2.9.3 Export

Georeferenced images can be exported in PNG, JPG, TIFF and geoTIFF format.

☞ Georeferenced images from a project can be exported to be used in
other projects.

From the properties, select the  Export to Global option.

1. Select the image to export.

2. Select Georeference Image.

3. Edit the suggested file name.

4. Define the world file units.

5. Navigate to the desired export location.

6. Select Export.

☞ All georeferenced images can be viewed in 3D. Enable the 3D terrain
from the graphical view tool bar. The default DEM uses a resolution
of approximately one arcsecond.

See also:
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

3.7.2.9.4 Georeference Tool

Georeference Image: Select Points

To open the georeference image wizard, select an image and:
• Select  from the georeference image context menu.
• From the ribbon bar, select Georeference Image.

To georeference an image, ground control points are required. These points
must be in an Infinity project.

☞ Only points with local grid coordinate values are shown as available.

The first step of georeferencing an image is to select the ground control
points to be used to mark the image.

Import

Export

Georeference Tool
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1. Select the project and then the image control points.

2. Select the points to move to the Ground Control Points list by
selecting  or  to select all points.

3. Select Next to continue to Match Points.

Georeference Image: Match Points
Next step is to match points from the list to the image.

There are two ways to define the picture pixel and the ground control
point:

Method 1

Selecting the points manually from the list:
1. Select the point from the Points list.

2. With the mouse, navigate to the location in the image and left-click
to define this point position.

3. Select a second point from the list.

4. With the mouse, navigate to the location in the image and left-click
to define this point position.

5. Repeat until you have computed the residuals and you accept the
results.

Method 2
Place the mouse over the pixel of the image and right-click to select from the
list the point to mark at this position.
1. With the mouse, navigate to the location in the image to where the

point should be marked.

2. Right-click with the mouse and from the context menu select the
point that defines the pixel.

3. Repeat until you have computed the residuals and you accept the
results.

Select Finish to complete the georeference wizard.
The image is stored in the Inspector and in the Navigator.

See also:
The video "Leica Infinity - Home Module - Georeferencing Images" https://
www.youtube.com/watch?v=m-U29-ipJgs

3.7.3 Image Group

3.7.3.1 Overview

To generate data from images, you work with an image group. Image groups
are project objects that can be created in Infinity and imported from Captivate.
Requirements:
• Imaging option.

Image Group
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Here you can do the following:
 

No. Name Description

1. Image Group Proper-
ties

Check the properties of an image group.

2. New Image Group • New Image Group - Create a new image
group.

• Add to Image Group - Add images to an
image group.

• Remove from Image Group - Remove
images from an image group.

• Merge to Image Group - Merge image
groups.

☞ It is important to know, that data computed from image groups are
bounded to that image group. If the image group is deleted, any data
generated from the image group is also deleted.

See also:
Optional Modules
The video "Leica Infinity - Imaging Module - How to work with GS18 I
data" https://www.youtube.com/watch?v=1TwomI2lxw0
The video "Leica Infinity - Imaging Module - Points from Images" https://
www.youtube.com/watch?v=PDR4ROLrKbA

3.7.3.2 Image Group Properties

Image group properties can be seen in the property grid, as well as in the
imaging inspector.

Image Group Proper-
ties
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Name Description

Image Group ID The name of the image group.

Description Any optionally entered description.

Date/Time The date and time of when the image group was
created.

Source The name of the image source data.

Acquisition The acquisition type informs whether the image
groups are from an aerial or from a ground per-
spective.
Could be:
• Aerial.
• Terrestrial.
• Unknown.

Images Number of images in the image group.

Oriented Images Number of oriented images in the image group.

Total Image Size Overall size of all images contained in the image
group.

Points Number of points computed from images.

3.7.3.3 Managing Image Groups

3.7.3.3.1 New Image Group

To create a new image group:
 

New Image Group
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1. Select New from the Imaging tab.
Alternatively select images from the Inspector, Library or the graph-
ical view to be grouped and select New from the Imaging tab.

2. Define the Image Group ID and optionally the Description.

3. Select Apply.

The new image group is created and added to:
• The image groups section in the library of the navigator. If the image

groups subsection does not yet exist, it is created.
• The image groups section in the imaging tab of the inspector.

3.7.3.3.2 Add to Image Group

To add images to an image group:
 

1. Select the Images to be added either from the Library or the
Inspector or the graphical view.

2. Select Add from the Imaging tab or from the context menu.

☞ Images are added to a new image group only if they do not belong
to any other image group. Only images acquired from TPS devices can
belong to multiple image groups.

3.7.3.3.3 Remove from Image Group

To remove images from an image group:
 

1. Select the images to be removed either from the Library or the
Inspector or the graphical view.

Add to Image Group

Remove from Image
Group
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2. Select Remove from the Imaging tab or from the context menu.

3.7.3.3.4 Merge to Image Group

It is possible to merge multiple image groups by using the merge to image
group function.

To merge to image groups:
 

1. From the Navigator or the Inspector, select the Image Groups that
should be combined into another Image Group.

2. Select Merge to Image Groups from the context menu.

3. Select the Image Group to which it should be merged.

☞ It is only possible to merge image groups when the images have the
same camera properties and the same acquisition type.

3.7.4 Image Point Computation

3.7.4.1 Overview

To generate data from images, an image group must be used. Image groups
are project objects and can be created in Infinity and imported from Captivate.
There are several sources of images that can be used to generate points from.

Points can be computed when:
1. Images are taken from TPS image stations with either panorama images or

overview images and these images cover the same object.
2. Images with GNSS geotags are acquired from the same camera such as

GS18 I or a UAV, and the images have a good overlap.

Using the image group viewer and selecting a common target from the image,
the forward intersection from each image position arrives at a 3D intersection
point. These points have the point role computed.

Merge to Image Group

Image Point Computa-
tion
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3.7.4.2 Image Group Viewer

To open the image group viewer:
 

1. From the Library or the Inspector, select the Image Group and from
the context menu select Open Viewer.

2. The Image Group Viewer opens in a new window.

In the image group viewer you have the following options:
 

No. Name Description

1. Display Windows Set the number of working windows.

2. Filter Filter images to display.

3. Magnifier Switch magnifier On/Off to help select fea-
ture of interest.

4. Point Table Show or hide point table. Any points that
were computed in the field or in the office
are listed in the point table of the open
image group.

5. Search Search for image name.

6. Image Strip Show or hide image strip.
• For images measured from TPS, each

image view allows selecting the TPS sta-
tion and lists the images that were
taken from that station setup.

• For images measured with GNSS, the
GS18 I or UAV, you can select which
image to view from the image group.

Image Group Viewer
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See also:
The video "Leica Infinity - Imaging Module - How to work with GS18 I
data" https://www.youtube.com/watch?v=1TwomI2lxw0

3.7.4.3 New Image Point

Points can be computed when:
1. Images are taken from TPS image stations with either panorama images or

overview images and these images cover the same object.
2. Images with GNSS geotags are acquired from the same camera such as

GS18 I or a UAV, and the images have a good overlap.

Using the image group viewer and selecting a common target feature from
the image, the forward intersection from each image position arrives at a 3D
intersection point. These points from images are stored to the points and
have the point role computed.

To create new points from images:
 

1. Select New Point either from the ribbon bar or the context menu.

2. Mark the target point in the first image.

3. Mark the target in the second image.

4. Once the target has been selected in two or more images the pro-
jected point is shown.

5. Add thematic data if needed.

6. Select Create to store the point to the project.

When working with GS18 I images, the default mode for point creation is the
automatic target selection mode. With this method, a single click defines the
point. For other cases, the intersection mode is automatically set to manual,
and the point can be created after being marked on two or more images.

New Image Point
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Image Point Settings
The computation of image points is following the same principle as with point
averaging. You set a tolerance threshold for which the computed 3D point
quality is acceptable and when the results are within this tolerance a position
is computed. When the 3D accuracy is outside of that tolerance, then no point
is computed.
Set the image point accuracy in the Points & Angles options page.

See also:
The video "Leica Infinity - Imaging Module - How to work with GS18 I
data" https://www.youtube.com/watch?v=1TwomI2lxw0
The video "Leica Infinity - Imaging Module - Points from Images" https://
www.youtube.com/watch?v=PDR4ROLrKbA

3.7.5 Image Processing

3.7.5.1 Overview

Images can be processed to create quality 2D and 3D data deliverables, such
as Dense Point Clouds (DPC), Digital Surface Models (DSM) and Orthophotos.
Requirements:
• Point Clouds from Images option.

Here you can do the following:
 

Image Processing
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No. Name Description

1. Image Processing 
Settings

Adjust the Image processing settings for
achieving best possible results.

2. Image Processing 
Workflow

• Orientation of the Images - Calculate
the exterior and interior orientation of
images.

• Marking of Control Points - Mark Ground
Control Points (GCP) or Check Points
(CP), before or after running the orient-
ation.

• Optimisation of the Orientation - Update
the exterior and/or interior orientation
of images, after changing either the
control points (adding, removing or
adjusting them) or the camera calibra-
tion settings.

• Generation of the Dense Point Cloud -
Create the DPC. If images are not ori-
ented, an orientation is computed first.

• Filtering of the Dense Point Cloud -
Update the DPC after changing the DPC
settings, to create a filtered improved
version.

• Generation of the DSM & Orthophoto -
Create the DSM and the orthophoto. If
the orientation and DPC are not stored,
they are computed first.

3. Image Processing 
Report

Explore the details.

4. Task Manager View the progress of the processing tasks
for all the created projects.

5. Export Image Pro-
cessing Results

Export deliverables in various format files.

6. Processing Consider-
ations

Helps with understanding which component
has an impact on processing.

The processing procedure includes three core steps:
1. Orientation of the Images

2. Generation of the Dense Point Cloud

3. Generation of the DSM & Orthophoto

☞ Some further processes can be carried out if necessary.

There are two approaches to process image data:
Step-by-Step - Process each task manually, step-by-step, and store it. This
allows a better control on the results. Once stored, the output of each step
(sparse point cloud, dense point cloud, DSM & Orthophoto) is available in the
view and the numerical results in the inspector.
Onestep - Choose the end data result, such as DPC or DSM & Orthophoto,
and all individual tasks are computed automatically.
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Imaging Inspector
From the Inspector > Imaging tab, you can access Imaging Results. The view
is split into two panes, the results pane and the Task pane:

 

See also:
The video "Leica Infinity - Imaging Module - How to work with GS18 I
data" https://www.youtube.com/watch?v=1TwomI2lxw0
The video "Leica Infinity - UAV Processing Part 1 - Import and orientate
Aibot data" https://www.youtube.com/watch?v=F8OdA9sy6q4
The video "Leica Infinity - UAV Processing Part 2 - Add GCPs and update
orientation" https://www.youtube.com/watch?v=Y8hLA0RObFA
The video "Leica Infinity - UAV Processing Part 3 - Create Dense
Point Cloud, DSM and Orthophoto" https://www.youtube.com/watch?
v=XPpLS1cxZIk

In order to get a good quality result, it is of main importance to acquire the
data set to be processed correctly. A poor quality data set may lead to poor
results or even to failed processes.

The following guidelines are recommended for a good outcome:
• Use digital cameras with a fixed lens, or keep it fixed throughout the

acquiring phase.
• Use focal lengths between 20 mm and 80 mm (in 35 mm equivalent).
• Use 70%-80% forward overlap and 65%-80% side overlap.
• Avoid blurry images.
• Avoid low textured, moving or reflective objects.
• Avoid regions with shadows.
• Do not manipulate original images, for example crop or rotate them.
• Use control points to improve the orientation.
• Use check points to assess results accuracy.

☞ Fisheye, ultra-wide and macro lenses as well as hyperspectral images
are currently not supported.

☞ Corrections for the rolling shutter effect are currently not supported.

3.7.5.2 Image Processing Settings

Default settings are intended to be the most suitable solution in the more
common cases. Nevertheless, for achieving a better final accuracy or for deal-
ing with specific acquisitions, they have to be often tuned accordingly.

Image Acquisition
Suggestions

Image Processing Set-
tings
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The following settings are available for the image processing:
 

Store results immediately after computing
The results are stored without any manual intervention.

Processing Resolution
The processing resolution is the image resolution, that is used for all the
processing steps.
• Full, resolution uses the original image size for the processing.
• Half, resolution uses the images downscaled from the original size by a

factor of 4.
• Quarter, resolution uses the images downscaled from the original size by

a factor of 16.
• Eighth, resolution uses the images downscaled from the original size by a

factor of 64.

This setting has to be chosen as a trade-off between the final desired quality
and the processing time, considering the original image resolution as well.
A full resolution process produces more accurate results, exploiting all the
information contained in the acquired images, although requiring more time
for generating the results

Orientation Mode
The orientation mode allows the choice between two orientation processing
options, precise and fast.
Select Precise, if the orientation processing computes the co-variance mat-
rix considering the camera pose accuracy of each image within the selected
image group.
The precise option provides an improved accuracy of the orientation including
the resulting dense point cloud. Consider precise mode when the geometry

General

Orientation
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reconstruction and data accuracy are the important factors of processing res-
ults.
Select Fast, if the orientation is processed without computing the co-vari-
ance matrix. The advantage to the fast option is a quicker orientation result.
Consider fast option when accuracy is not the most important factor of pro-
cessing, such as working with stockpile volume computations or general earth
work surfaces.

☞ The precise option requires more hardware RAM during the orienta-
tion processing.

☞ When using the Fast orientation mode, there is the option to enable
CUDA acceleration from File > Preferences > Imaging. This is avail-
able for machines using graphic cards with CUDA capabilities (such as
NVIDIA GeForce). The benefit is shorter processing times.

Camera Pose Accuracy
This parameter is used to weight properly the GNSS information of the
acquired images during the orientation step. It is related to the accuracy of
the position of each image and not to the accuracy of the attitude of the UAS
itself:
• Use a higher value when the UAS has a low-end GNSS receiver, no accur-

ate RTK position or no raw data collection for post-processing.
• Use a smaller value when the UAS has an accurate RTK GNSS sensor or

when collecting raw data for post-processing.

This setting strongly affects the orientation results and all the following steps.
Pay attention with the choice of it.
Poor results (noise in the sparse point cloud) might be due to the current
camera accuracy, either bigger or smaller than the one set. For example, when
dealing with a low quality RTK position (because of interruption of the con-
nection with the reference station or because of the acquisition environment),
poor results can be generated due to a camera pose accuracy lower than
expected. In this case, a bigger value is of advantage for a better result.

2D Control Point Accuracy/1D Control Point Accuracy

The use of control points is recommended for:
• Accurate georeferencing of the images and the deliverables that depend

on them.
• Calibrating a camera or for improving the existing calibration.

These parameters are used to weight the control point horizontal position
(2D) and height (1D) during the orientation step. They should reflect the real
accuracy of the measured points.
These settings strongly affect the orientation results and so all the following
steps. Pay attention with the choice of it.
These settings are used only for control points that do not have a coordinate
quality (CQ 2D or CQ 1D respectively), so when using a point that already has
CQ 2D or CQ 1D, the respective setting is ignored for that point.

Control Point Marking Accuracy
This parameter refers to how accurately a control point can be marked on the
image. It is used to formulate the weight of the image observations of the
control points in the orientation step. If for any reason control points cannot
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be marked on the images with a subpixel accuracy, for example blurry images,
this value must be increased to make it more realistic.

Camera Calibration Computation
This parameter is connected to the interior orientation of the camera.
• Automatic: Default setting. When Ground Control Points (GCP) are used,

the parameters of the interior orientation (focal length, principal point
and distortion parameters) are estimated. If GCP are not marked on the
images (both cases when Control Points (CP) only are used, or when
no points at all are marked on the images) the camera calibration is
not estimated. For images with interior orientation values stored in the
metadata, those values are read and used as initial values: they are kept
fixed if the GCP are not marked, estimated if the GCP are marked on the
images, as described previously. When interior orientation values are not
available, the interior orientation is always computed using the default
distortion model.

• User-Defined: Using the User-Defined option, focal length, principal point
and distortion parameters can be set, and the interior orientation para-
meters are estimated accordingly.

Focal Length
The focal length of the camera is read from the image metadata information
(EXIF data). The more accurate the initial parameter is, the better the orienta-
tion of the images and the more accurate the scale of the reconstruction is.
This value can be optimised during camera calibration and is then replaced
with either one or two camera constants. These constants are the adjusted
focal length equivalents.
• Compute Two: The use of two camera constants compensates for the

non-squareness of the pixels.
• Compute One: In the other cases, the Compute One option can be used.
• Do not compute: Select Do not compute if the camera is already calib-

rated and the existing values are reliable enough.

A scale issue in the object reconstruction might depend on a wrong used
value. Either perform a calibration of the camera or carry out the auto-calibra-
tion during the orientation step, to get a more reliable focal length value and a
better result in the reconstruction.

Principal Point
By default, the principal point it is placed to the centre of each image.
• Compute: Select Compute to improve the existing value for the principal

point.
• Do not compute: Select Do not compute if the camera is already calib-

rated and you want to keep the existing values.

Distortion Parameters
This parameter controls the distortion of the lenses used to acquire images.
The default distortion model works well for most of the frame cameras.
However, for cases when additional information about the lens distortion
model is available, further models are available:
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• Distortion Model 1 (K1, K2, P1, P2).
• Distortion Model 2 (K1, K2, K3, P1, P2). (Default).
• Distortion Model 3 (K1, K2, K3, K4, P1, P2, S).
• Distortion Model 4 (K1, K2, K3, Kd1, Kd2, Kd3, P1, P2).
• Distortion Model 5 (K1, K2, K3, K4, K5, K6, Kd1, Kd2, Kd3, P1, P2,

P3, P4, P5, P6, S1, T1).
• Do not compute.
• None - Undistorted Images.

Parameter Description

Kx Radial distortion parameters.

Px Tangential distortion parameters.

S Skew parameter when using Distortion Model 3.

S1, T1 Shear and skew parameter when using Distortion Model 5.

☞ The focal length, principal point and distortion parameter options
are only selectable if the camera calibration computation is set to
User-Defined.

Ignore Imported Rotation Values
When this box is checked, the rotation values stored in the metadata of the
images are not used in the orientation process.
Use this setting if imported values are wrong, as in, if the images appear
incorrectly rotated or upside down in the graphical view. In all the other cases
do not use this setting, since it deteriorates the solution.

Along with control points, Infinity supports the use of check points.
In order to have an independent measure for assessing the accuracy of the
image orientation, a tolerance for each of the Root Mean Square Error (RMSE)
on control points has to be set. The 3D position of the check points is not
used during the orientation, yet the computed 3D position of each check point
is compared to its current position. The differences are used to evaluate the
overall accuracy of the orientation.

The following criteria, derived from ASPRS guidelines, are used to
determine when the analysed check point should be considered as out-
of-tolerance:
• If the computed RMSE values for Easting, Northing, horizontal or height

exceed the ones entered.
• If the absolute value of the mean of Easting, Northing or height exceeds

the 25% of the respective RMSE value entered.
• If the absolute value of ΔEasting, ΔNorthing or ΔHeight for a check point

exceeds three times the respective RMSE value entered. In this case, the
results are marked in bold red text.

In the generated dense point cloud there can be some outliers, due to blurry
images or poor overlap. A filter can be used to remove them and generate a
more accurate dense point cloud.

Noise Reduction
Used to remove inconsistent points above or in front of a reconstructed sur-
face.

Check Point Toler-
ances

Dense Point Cloud
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Local Filtering
Best used with data sets with high image overlap. Used to remove points that
are below or behind a visible surface and to create sharper edges.

Max. Sigma Threshold
The max. sigma threshold is the maximum value of the uncertainty (sigma)
that a point can have in order not to be filtered out.
• Increasing this value may lead to a more complete but noisier point cloud.
• A smaller value guarantees more accurate points, although reducing the

density of the dense point cloud. If a too noisy dense point cloud is
generated, a smaller value can be of advantage.

Min. Images per Point
This parameter defines the minimum number of images that a point must be
seen in to be considered valid.
• Increasing this value reduces the noise, although a lower number of points

in the point cloud might be computed. If a too noisy dense point cloud is
generated, a bigger value can be of advantage.

DSM & Orthophoto Mode
Digital Surface Model (DSM) & Orthophoto mode allows the choice between
two computation methods, Precise and Fast.
With Precise, a 3D DSM is generated that can better model the dense point
cloud. This 3D DSM is used for generating the orthophoto. This method
provides the best quality orthophoto output, but can take longer to process.
With Fast, a 2.5D DSM is generated that approximates the model of the
dense point cloud. This 2.5D DSM is used for generating the orthophoto. This
method has three options for defining the density of the DSM. Each option
affects the output of the orthophoto.

Triangle Size
When using the Fast DSM & Orthophoto mode, triangle size can be chosen
according to the size of the details to be reconstructed. Use large triangles
for the quickest processing time and when fine details are not of interest. Use
medium or small triangles to add more detail to the DSM and improve the
output of the orthophoto.

Orthophoto Resolution
This parameter controls the detail level of the orthophoto. Generally, this
value can never be smaller than the ground sample distance computed for the
image group being processed.
• Decreasing the parameter, increases the resolution of the orthophoto, but

also the computation time for its generation.
• Increasing the parameter, decreases the resolution of the orthophoto and

reduces the computation time. The orthophoto is smaller in size.

3.7.5.3 Image Processing Workflow

3.7.5.3.1 Orientation of the Images

After the import and the image group creation, the images can be orientated.

DSM & Orthophoto

Orientation of the
Images
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To orientate the images, do the following:
1. Set a master coordinate system in the project. See Working with 

Coordinate Systems.

2. Select the image group from the Navigator or the Inspector.

3. Select Orientate from the Imaging ribbon bar or from the context
menu.

☞ Images can be oriented only if they are geotagged and have (at
least a rough) camera calibration.

☞ If the previously mentioned requirements for images and coordinate
system are fulfilled, images camera poses should be shown in the
view. If not, check that the coordinate system used is the appropri-
ate one for the area considered.

☞ Infinity reads information for camera focal length and computes the
principal point position based on the information stored in the EXIF
data.

If the camera calibration parameters are provided, for example in the case of a
factory calibration, they can be manually entered.

To enter the camera calibration parameters, do the following:
1. Select all the images of the image group from the Inspector or from

the Navigator.

2. Use the context menu option Edit Camera Calibration.
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3. According to the selected distortion model, the calibration values
can then be entered.

4. As described in Images, once the orientation is triggered, the pro-
cessing task appears in the Task pane of the Imaging tab in the
Inspector, and in the Task Manager.

5. When the orientation is computed, you can drill in the orientation
result to view details about:
• The exterior orientation.
• The interior orientation.
• The control and the check points, if any have been used. For

further information, see Marking of Control Points.

6. To store the orientation result, highlight it and select Store from
the Imaging ribbon bar or from the context menu. The sparse point
cloud appears in the View.

☞ Together with the orientation of the images, Infinity computes the
3D position of the common features that were matched and used
for orientation, also called tie points. These points form a sparse
point cloud. This point cloud shows a rough representation of the
area, that is reconstructed during the dense point cloud computa-
tion.

☞ After the orientation, the images along with the updated position in
the EXIF data can be exported.

If you realise that the used settings are not compliant with the desired out-
come, you can remove the orientation result in order to run a new orientation.
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To run a new orientation, do the following:
1. Highlight the orientation result and select Remove from the Imaging

ribbon bar or from the context menu.

2. You can also select the image group and then Remove the stored
orientation.

☞ Every time you remove an orientation from an image group, the
position and the attitude of each image rollback to the values they
had after import.

To see the number of Oriented Images, select the Image Group and view
the Property Grid. This information is also available in the Imaging tab of the
Inspector > Image Group.

 

☞ The oriented image groups have a special icon.

3.7.5.3.2 Marking of Control Points

Infinity supports the use of control points and check points. You can mark
them either before running an orientation task or after storing it.
To mark control points, select the image group and select Add Control Points
from the Imaging ribbon bar or from the context menu.

Marking of Control
Points
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This action starts the Mark Control Points wizard:
 

Select Points
In this window, you select the points that you would like to mark on the
images. Any point from your project (imported or calculated) can be added as
control point, as long as it has a 3D position.
1. Select the points you want from the Available Points list, move them

to the Control Points list.

2. Select Next to proceed to the second page of the wizard.

Match Points
Infinity offers two ways to mark and match control points:
• Basic Marking Mode: Used to mark multiple control points on one image. It

is the default mode when there is no orientation result stored.
• Extended Marking Mode: Used to speed up the marking of a selected

control point on multiple images. It is the default mode when there is an
orientation result stored.

General Description

The main components of both marking modes are:

No. Group Name Description

1. Point List The place to select which point to
mark.

2. Map View Shows the images and the control
points that have been added in the
list. It helps checking the distribution
of marked points. You can use the
map view option to hide or show the
images. If the image group is already
oriented, you can also restrict the
images that are shown to those
that the selected point can be repro-
jected on. Once a point has been
marked, it is displayed in the map
view with one of the following icons:

 If it is used as a control point.
 If it is used as a check point.
 If it is not used at all.
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No. Group Name Description

3. Marking Pane Where the points are marked on the
images. The two marking modes use
this pane in a different way, refer to
the following.

4. Wizard Navigator Shows details about:
• The total number of orient-

ated images/the total number of
images in the image group.

• The total number of control
points.

• The total number of check
points.

• Which points have not been
marked.

• Which points are not used.

Basic marking mode layout: Extended marking mode layout:

The Warning section provides information on possible weaknesses of the
marking procedure, such as points marked on one image only or if not enough
control points are used.
The points that have been added in the point list can be used as control
points or check points. This option is available in the Use as column/property
in both marking modes.

The basic marking mode:
Apart from the common components that were described above, the page
also comprises a thumbnail list of the images that belong to the selected
image group.
The marking window shows the image that is active for control point marking.
The list of control points includes all the points that can be marked.

To mark a control point:
1. Select the control point from the list or the map view.

2. Select the image you want to mark this control point on from the
image thumbnail list or the map view.
The selected image appears in the marking window.

3. Mark the point on the image.

If another point is found on the selected image and must be marked, navigate
to the position on the image and use the context menu to select the point.
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If there are images that have been linked to the control points, they
are available in the flyout:

 

To speed up the point marking phase, Infinity can sort the image thumbnail
list by the incrementing 2D distance of each image to the selected point. This
increases the probability that the selected point appears in the first images
of the list. To activate this sorting, select Sort Images by the Distance to
Point. The same option is available in the Extended Marking Mode.

To activate this sorting, select Sort Images by the
Distance to Point.
To sort the images by name, select the same option
again.

The extended marking mode:
In this point-based view, multiple images with marking suggestions are dis-
played for a selected point.

To mark a control point:
1. Select the control point from the list or the map view.

2. Mark the point on the image.

If there are images that have been linked to the control points, they are
displayed at the bottom of the pane.

The marking pane includes a set of options to:
• Show only images a selected point can be reprojected on (valid only if an

orientation has already been stored for the selected image group).
• Sort images by distance to point or by name (the same option is available

in the basic marking mode).
• Sort images by ascending/descending reprojection error (valid only if an

orientation has already been stored for the selected image group).
• Zoom in/out in all images using the same zoom factor (can be acti-

vated/deactivated).
• Show images in small, medium or large size.
• Search for a specific image.
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☞ The context menu that is available in the marking image offers short-
cuts that can speed up the marking process.
If a point is already marked on an image, place the mouse over the
point marking and use the context menu to: remove, use as check/
control point or do not use the specific point.
If an orientation is already stored, the control points and the check
points that have at least one out-of-tolerance value are indicated

with the  icon.
You can switch between the basic and the extended marking mode
at any time: the markings and the settings are saved when switching
from one mode to the other.

To close the wizard and store the markings, select Finish.

If you want to change the control points, for example:
• Add or remove control points.
• Improve markings.
• Disable control points.
• Change control points to check points.

You can start the wizard at any time.

☞ If the images are already oriented, the selected point is automatically
detected on the selected image. But this marking is not used for
updating the image orientation, unless it is confirmed. The suggested
marking is displayed with .

☞ When possible, the use of control points acquired at different heights
is recommended in order to improve the orientation step.

3.7.5.3.3 Optimisation of the Orientation

Optimisation is the process of updating the exterior and/or interior orientation
of images, by making changes to the control points or to the camera calibra-
tion values.

The initial stored orientation can be optimised so that:
• Any wrong point marking is manually removed.
• Any control point with wrong 3D position is disabled.
• The camera calibration is fine-tuned to fit the specific image capture.

Since most cameras that are used do not retain a constant internal geometry,
the camera optimisation can improve the accuracy of the interior and exterior
orientation and its deliverables.
The orientation of an image group may take a considerable amount of time.
However, the optimisation only triggers a final bundle adjustment, without
recomputing the orientation from the beginning.

The optimisation of the orientation can be triggered:
• By the control points wizard.
• By highlighting the oriented image group and selecting Optimise from the

Imaging ribbon bar or use the context menu.

Optimisation of the
Orientation
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Optimisation using the control points wizard:
1. After making a change in the control point wizard for an oriented

image group, on the second page there is now an additional check
box.

2. Activate the Update orientation on finish option to optimise the
orientation.

3. Select Finish in the wizard to start a new processing task. The
orientation is updated and optimised with the changes you made in
the control point wizard.

Optimisation of the camera parameters:

To fine-tune the interior orientation of the images, do the following:
1. Open the Settings from the Imaging ribbon bar and make the

changes you want to the Camera Calibration Optimisation section.

2. Highlight the oriented image group and select Optimise from the
Imaging ribbon bar or the context menu.

3.7.5.3.4 Generation of the Dense Point Cloud

To create a dense point cloud from an image group, do the following:
1. Highlight the image group.

2. Select Dense Point Cloud from the Imaging ribbon bar or use the
context menu.

3. Once the dense point cloud process is triggered, the processing task
appears in the Task pane of the Imaging tab in the Inspector and in
the Task Manager. See Images.

4. To store the result, highlight the result and select Store from the
Imaging ribbon bar or from the context menu. The dense point cloud
appears in the View.

The dense point cloud can be filtered according to the settings described in
the Image Processing Settings.

To remove a stored dense point cloud result, do the following:
1. Highlight the dense point cloud result.

2. Select Remove from the Imaging ribbon bar or from the context
menu.

To create a report for the dense point cloud, do the following:
1. Highlight the dense point cloud result.

2. Select Reports and then Dense Point Cloud Report from the Ima-
ging ribbon bar or from the context menu.

☞ If the images are not oriented at the specified processing resolution
or the orientation is computed but not stored. An orientation is com-
puted first and then a dense point cloud is created, based on the
computed orientation.

Generation of the
Dense Point Cloud
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The Dense Point Cloud (DPC) can be also used to:
• Create surfaces, contours and compute volumes.
• Draw features, like lines and areas.
• Measure distances between objects.

3.7.5.3.5 Filtering of the Dense Point Cloud

The DPC can be filtered according to the settings described in the Image 
Processing Settings.

To filter the stored DPC, do the following:
 

1. Highlight the image group object from which you created the DPC.

2. Select Filter Dense Point Cloud from the context menu or the
ribbon bar.

3. To store the filtered DPC result and see it in the View:
Highlight it and select Store from the Imaging ribbon bar or the
context menu.

☞ The Filter DPC functionality is active only when a DPC task is already
stored.

3.7.5.3.6 Generation of the DSM & Orthophoto

To create a Digital Surface Model (DSM) and an orthophoto from an
image group, do the following:
1. Highlight the image group.

2. Select DSM & Orthophoto from the Imaging ribbon bar or use the
context menu.

3. To store the DSM & orthophoto result, highlight the result and
select Store from the Imaging ribbon bar or use the context menu.

To remove a stored DSM & orthophoto result, do the following:
1. Highlight the DSM & orthophoto result.

2. Select Remove from the Imaging ribbon bar or from the context
menu.

To create a report for the DSM & orthophoto, do the following:
1. Highlight the DSM & orthophoto result.

Filtering of the Dense
Point Cloud

Generation of the
DSM & Orthophoto
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2. Select Reports, then DSM & Orthophoto Report from the Imaging
ribbon bar or from the context menu.

☞ If the images are not oriented at the specified processing resolution
or the previous step is computed but not stored. An orientation is
computed first, then a dense point cloud is created, based on the
computed orientation. Finally a DSM & orthophoto is created, based
on the computed orientation and the dense point cloud. It is equival-
ent to running a onestep process. For further information, see Image 
Processing.

☞ The DSM is used to create orthophotos but can also be used to
compare between different models.
Orthophotos can be used as background maps in Infinity. They can
also be exported to onboard software, to Leica ConX, as well as to
third party software.

3.7.5.4 Image Processing Report

To create a report for the orientation, select the orientation result and select
Reports > Image Orientation Report from the Imaging ribbon bar or the
context menu.

Project Details
This section includes information about the project, such as the project name,
the customer details and the master coordinate system.

Image Group Information
This section includes information about the selected image group:
• The ID.
• The total number of images and their resolution.
• The sensor and the camera model.
• The EXIF focal length.
• The total size of the images in Gpx.

Orientation Settings
This section includes information on the settings that were used to compute
the orientation of the images. The settings are described in detail in Image 
Processing Settings.
The check point tolerances are the manually entered values used to assess the
quality of the check points.

Interior Orientation
This section includes information on the parameters of the interior orienta-
tion.

Calibration Source:
• Pre-Calibrated: The initial values for the parameters are imported to the

project, for example from Leica Aibot.
• User Entered: The initial values for the parameters are manually edited.
• Unknown: The initial values for the parameters were computed using

information from the EXIF image metadata.
• Computed: The initial values for the parameters were computed in a

previous step by self-calibration.

Image Processing
Report
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The initial value, the calibrated value and their differences are shown for each
parameter of the camera and the lens of the Image group. Normally, the
differences are expected to be small, but there is no limitation. Yet, a large
difference may indicate instability of the self-calibration or the orientation. In
most cases, this issue can be addressed by adding control points as explained
in Marking of Control Points.

Exterior Orientation
This section includes information about the exterior orientation of the images.
If control points have been used, the information shown here reflects the
absolute position of the images. Otherwise, the information is shown with
respect to the relative position of the images.

General Information
General statistics for the exterior orientation are shown in this subsection.
• Check the Minimum Number of Tie Points Per Image: If this value is

zero, there is at least one image that has not been orientated, due to
a not optimal acquisition. For example blurry images, not optimal camera
network or flight height.

Absolute Camera Pose Standard Deviations
This table shows the mean and the standard deviation of the mean, for the
standard deviations of the camera poses. Depending on the initial orientation
estimates, these values are more or less close to zero. A value that is bigger
from the rest or from zero, indicates a possible bias of this parameter. In most
cases, this can be fixed by adding control points to the orientation.

Control Points
This table shows the residuals in each direction, the mean reprojection errors
and the total number of images each control point has been marked on.
The mean reprojection errors are checked with the nMAD (normalised Median
Absolute Deviation) criteria. Possible outliers are marked as out-of-tolerance.
• If there are flagged values, review the markings of the specific control

points.

The mean and the standard deviation are computed for each column. These
values are more or less close to zero. A value that is bigger from the rest or
from zero, indicates a possible bias.

In this case:
• Check that the control points that are used have a good distribution.
• Check that the control points have been correctly marked on at least four

images.
• Check that there is no typing error in the coordinates of the control

points.

More information on control points can be found in Image Processing Settings.

Check Points
This table shows the residuals in each direction, the mean reprojection errors
and the total number of images each check point has been marked on. The
mean reprojection errors are checked with the nMAD criteria. The Δ values,
the mean and the computed RMSE are checked against the tolerances defined
in the image processing settings. Possible outliers are marked as out-of-toler-
ance.
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• If there are flagged values, review the markings and the coordinates of
the specific check points.

More information on control points can be found in Image Processing Settings.

3.7.5.5 Task Manager

The task manager is launched from the quick access bar. Here you can see
all processed tasks, in progress or to be processed when using a worker host
machine.

 

Once you start processing a task, it runs in the background. You can continue
working with Infinity or even change projects and submit another task to
the queue that starts as soon as the previous task ends. You can view the
progress of each task in the Task Manager. If the task is finished in the
meantime, the result is moved to the results pane, for you to store.

☞ Processing tasks create an asset directory on the computer where
the processing takes place. The default directory is: C:\Users\[USER]
\AppData\Local\Leica Geosystems\Infinity\mvs\assets\. The default
directory can be modified, as described in Imaging.

3.7.5.6 Export Image Processing Results

Infinity can export:
• The oriented images with the updated position in the EXIF data.
• The dense point cloud, in the standard formats used for point clouds.
• The DSM and orthophotos, as georeferenced images.
• For more information on exporting, see Data Export.

3.7.5.7 Processing Considerations

The number of images that can be processed with Infinity depends on
several factors:
• RAM: The image group size or Gpx size is related to the amount of system

RAM. It is important to consider the size of data sets to be processed to
ensure the platform has enough system RAM. Processing times can also
be reduced when enabling XMP profiles offering increased RAM speed.

• CPU: The processing is directly affected by the speed of the CPU. Consider
a high clock speed CPU (greater than 3 GHz) with a high boost speed
(greater than 4.5 GHz). A CPU with high core count improves processing
times, currently the biggest impact of cores is with the Dence Point Cloud
(DPC) step.

• GPU: Using NVIDIA GPU is recommended with CUDA capabilities and
speeds up the processing steps of the orientation and DPC.

Task Manager

Export Image Pro-
cessing Results

Processing Considera-
tions
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Processing at half resolution is suggested as the best balance between density
and completeness of data and time to process. For high-resolution images
> 36 MP, quarter resolution is also providing a good balance of data to pro-
cess time.
When working with large data sets, creating several smaller image groups
helps with the processing time.
Considering a 20 megapixel image, 16 GB of RAM is recommended to process
100-120 images at full resolution. The processing limits depend on the total
pixel count of all images being processed.
It is possible to process images on the local machine or to use a dedicated
worker host machine. When working with larger data sets its recommended to
use a dedicated worker host.

Compon-
ents

Minimum Recommended Recommended
Worker Host

Windows
Operating
System

Windows 8, 10
(64 bit)

Windows 10
(64 bit)

Windows 10,
Server 2016 or
newer (64 bit)

Processor
Intel or
AMD

Multi-Core base
2.5 GHz or greater

Multi-Core base
3 GHz or greater

Multi-Core base
4 GHz or greater

Memory 32 GB DDR4 RAM 128 GB DDR4 RAM
XMP enabled

128 GB or greater
DDR4 RAM XMP
enabled

Storage 512 GB SSD 1 TB or greater
SSD

1 TB or greater,
multiple drives for
storage

Graphics 2 GB NVIDIA 8 GB NVIDIA CUDA
capable

8 GB or greater
NVIDIA CUDA cap-
able

The image processing tasks can be sent to a different computer (host)
for processing, as long as the following requirements are met:
• Both computers have an Infinity licence with the point clouds from images

option.
• Both computers have the same version of Infinity.
• The Infinity image processing worker host is already running on the com-

puter that to be used for processing.
• Infinity is running on the computer that sends the processing task.
• The computers are working within the same network.

By default, the host for image processing tasks is the local computer, that is
the computer where the project is already running.

Suggested System
Requirements

Setup Worker Host

318 Optional Modules



To define the host, do the following:
 

1. Select File and then Preferences.

2. Select the Imaging tab.

3. Enter the necessary information regarding the Host Name, the Port,
the User Name and the Password.

3.8 Infrastructure

3.8.1 Overview

The infrastructure module allows you to create basic road designs as well as
convert data from external files that already have a design.
When a design is imported from an external file, the object is created directly.
However, you can still edit the information that has been imported with the
result of an updated design.
Once a road design is ready, Infinity can export it to a format suitable for field
use.

See also:
Export to Leica ConX
The tutorial "How to manually create a road and use it
for volume calculations" https://leica-geosystems.com/-/media/2b014fed-
0b854491b295bac4ee1df766.ashx
The tutorial "How to prepare a Road job from data
defined by cross sections" https://leica-geosystems.com/-/media/
7508f29835254de1be874acac79736ef.ashx
The tutorial "How to create a Road design from polylines in
a CAD file" https://leica-geosystems.com/-/media/45f1d1d913764be29b-
c2b8d9cc13b325.ashx

☞ The tutorial can be downloaded in the Localisation Tool.

Alignments:
An alignment, is a line object used to denote the path of a road, railway,
tunnel, and so on. A full design requires a 3D alignment in order to serve as
centreline and to calculate the rest of the infrastructure elements.

Infrastructure
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See also:
Alignment Objects

Road Objects:
A road object, consists of a group of stringlines. The stringlines can be defined
with a centreline and cross sections or imported from a design file. If imported
from a design file it is possible to set one of the stringlines as centreline,
which creates an alignment object in the background.

See also:
Road Objects

Cross Sections:
A cross section, is a slice or a cut at a certain chainage of the road. In a
vertical view, it indicates the position of a roads material layers.
Stringlines result from interconnecting the nodes of subsequent cross sec-
tions.

See also:
Cross Sections

Infrastructure Manager:
The infrastructure manager, is the tool that allows for the input and the edit-
ing of the different components that lead to a full 3D alignment object and,
based on an existing alignment acting as centreline, for the creation, editing
and viewing of the rest of elements that lead to a finished road design object.
If any potential conflicts are found, Infinity notifies you.

See also:
Infrastructure Manager

Material Layers:
Within Infinity, the material layers represent the different layers of a road and
group sets of stringlines that belong to the same level, material or phase of
construction and are, therefore, thematically interconnected.

See also:
Material Layers

3.8.2 Alignment Objects

Each road object needs at least one alignment object which serves as the
centreline of the road.
The centreline is the main line in a road model. It is the reference axis that
determines the distance along the road (chainage) and across it (offsets).
All alignments available in a project are grouped and listed in the navigator
and the inspector.
By default they are imported or written to the alignments layer.

Alignment Objects
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To create a new alignment:
1. Select Alignment from the Infrastructure ribbon bar.

Next to the Property Grid the Create New Alignment tab opens up.

2. Enter the alignment properties and select Create.

3. The Infrastructure Manager opens up next to the Inspector.

4. In the Infrastructure Manager builds up the alignment by defining its
horizontal (mandatory) and vertical (optional) elements.
For both the POB/VPOB (Point of Beginning/Vertical Point of Begin-
ning) are already predefined assuming the Start Station as defined in
the Alignment Properties.

5. In the Inspector view right-click on the POB and select Add below
from the context menu.
Alternatively, select Add below in the Infrastructure > Road
Design ribbon bar.
By default an element of type Straight is added. Optionally choose a
different Type and Method and edit the elements as required.

6. Continue adding new elements below or in between (above).

To edit existing alignments:
1. Right-click on the Alignment object in the Navigator or the Inspector

and select  Edit from the context menu.

2. Edit the elements of the alignment in the Infrastructure Manager.

To use an alignment as centreline in a road:
1. In the Navigator or in the Inspector select the Road object.

2. In its Property Grid go to Details and select  Edit next to
Centreline.

3. Choose a different alignment from the list and confirm your selec-
tion with OK.

4. Select Apply in the Property Grid to update the Road object.

3.8.3 Road Objects

Road objects can be cross section based or stringline based.

Cross section based road objects:

Cross section based road objects consist of:

• A 3D alignment that has been created or chosen to serve as its
centreline.

 ☞ Any of the alignments available within the project can be
chosen as centreline.

• Cross section templates assigned to chainage values along the
centreline.

 ☞ Cross section templates remain in the project even if assign-
ments are deleted.

Road Objects
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• Several material layers containing stringlines of the same level, material
or phase of construction.

 ☞ Daylight stringlines require a target surface to exist in the
road object.

Example:
 

Optionally a target surface can be assigned to the road object to visualise cut
or fill slopes. It must be available within the project as a surface, before it can
be chosen as target surface.

322 Optional Modules



Example:
 

☞ If the target surface is removed from the road object, the so-called
daylight stringlines which indicate the intersection of the road design
with the terrain model also disappear.

Stringline based road objects:
Road objects imported from external files often come in in the form of a list of
stringlines.
In this case the stringlines define the road object, which has typically been
calculated in a 3rd party software and sent to Infinity for its preparation and
conversion to a field-compatible format.
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Example:
 

Any of the stringlines available within the road object can be set as
centreline:
Right-click on the stringline and select Set as Centreline from the context
menu.

To create a new road object:
1. Select Road from the Infrastructure ribbon bar.

Next to the Property Grid the New Road tab opens up.

2. Enter the road properties.
Go to Details and select  Edit next to Centreline to optionally
select a centreline. All alignments available in the project are avail-
able for selection.
Select  Edit next to Target Surface to optionally select a target
surface. All surfaces available in the project are available for selec-
tion.
Having a target helps when you intend to assign cross sections to
the road.

3. Select Create.

The new road object is added to the list in the navigator and the inspector.
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To edit a road object:
1. To edit a road right-click on the Road object and select  Edit from

the context menu.
The Infrastructure Manager opens up next to the Inspector.

2. To assign cross section templates go to the Cross Sections tab.
Each assigned cross section is added under Cross Section Assign-
ments in the Inspector and the Navigator.

3. Optionally add Material Layers.
To add a new layer select Road Design > Material Layer in the
Infrastructure ribbon bar.

☞ When you assign cross sections to a stringline based road the nodes
have to be assigned to material layers of their own.
Simple stringlines cannot share a material layer with stringlines res-
ulting from cross section assignments.

3.8.4 Cross Sections

Within Infinity cross sections can be imported or manually created. Manually
created cross sections are always stored as a template and are as such avail-
able for roads.
Imported cross sections are not stored as a template automatically, but you
can copy them to a new cross section template.

See also:
Cross Section Assignments
If available as a template, a cross section can be selected to be assigned to a
road from the list in the Cross Sections tab of the Infrastructure Manager.
Assigned cross sections can be edited and if available as a template your
changes can be updated to the template for further use.

☞ Assignments using a modified template are not updated automatic-
ally. Reassign the updated template if necessary.

To manually create a cross section choose to create a cross section
template:
1. Select Cross Section from the Infrastructure ribbon bar.

2. Enter the template properties.
Go to Details and select the Pencil icon next to material layers to
select the layers that shall be available to define elements upon.
☞ If not, all elements are written to a default material layer.

☞ Available for selection are all the layers of the road object.
New layers can be added any time.

3. Select Create.

See also:
Material Layers
The new template becomes available for selection in Infrastructure, under
the New Cross Section Template tab.

Cross Sections
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On how to extract a new cross section by interpolation between existing cross
section assignments, see Cross Section Assignments.

3.8.5 Material Layers

Within Infinity the material layers represent the different layers of a road and
are used to group sets of stringlines that belong to the same level, material or
phase of construction.

☞ It is not possible to combine imported stringlines and cross section
nodes in the same material layer.

Layers defined for infrastructure or road objects are imported and stored to
the road object as material layers. Material surfaces that are created from
material layers can have their own code or style attributes.
Stringlines imported or created from cross sections are stored to the layer
stringlines and can have their own code and style attributes.

See also:
Layer Manager

To create a new material layer:
1. Select the Road to which you want to add a new Material Layer.

2. Select Road Design > Material Layer in the Infrastructure ribbon
bar.
Next to the Property Grid the New Material Layer tab opens up.

3. Give the new Material Layer a name.

4. Optionally, select  Edit next to Centreline to select a centreline.

5. Select Create.

All material layers are visible from the navigator. When used with a cross
section based-road, the material layers are also visible in the Infrastructure
Manager > Cross Sections tab.
A material layer applies to all cross sections.
With stringline-based roads, the new material layer can be used to add
stringlines to it. Which can be either existing stringlines on other layers or
library lines (for example, imported from DBX or created in Infinity).
1. Select the stringlines or library lines that shall be assigned to

another or a new Material Layer.

2. Right-click and select Add to Material Layer from the context
menu or select Add to in the Infrastructure > Road Design ribbon
bar.
Choose the target Material Layer from the list.

☞ Reassigning a stringline to a different material layer does only work
for stringline-based roads.

3.8.6 Material Surface

A material surface can be created for an existing material layer in a project.

☞ The 2.5D meshing method is used to create the material surface.

Material Layers

Material Surface
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To create a material surface:
1. Select a material layer from the Navigator or the Inspector.

2. Select Material Surface from ribbon bar.

Alternatively:
1. Select a material layer.

2. Right-click to open the context menu and select Material Surface.

Material surface method:
It is possible to select one out of three pre-defined methods for material
surface generation.
The method can be selected in the Info & Settings > Infrastructure tab.
Each method adjusts the deflection angle parameters used to reproduce the
material surface with respect to stringline shapes and angles between neigh-
bouring stringlines. Use this setting to improve the quality of the material
surface output.

Settings:
• Method 1
• Method 2
• Method 3

3.8.7 Inspect Check Road and Stake Road Application Results

To check and document stakeout results import the stake road job and/or the
check road job into Infinity.
The objective is to check the stakeout results.

The differences between design coordinates and stakeout results can
be:
• Seen in the graphical view.
• Checked in the Inspector > Features tab or in the Infrastructure tab

under Checks and Stakes.
• Saved in a report.

See also:
Staked Points in Infinity
Reports

3.8.8 Infrastructure Manager

3.8.8.1 Overview

The infrastructure manager is the dedicated tool to view, create and edit the
individual components of an alignment or a road object.
It opens up automatically when you create a new alignment or when you
choose to add a new cross section template.
To edit existing elements it can also be invoked from the navigator or the
inspector by selecting  Edit from the context menu.

Inspect Check Road
and Stake Road
Application Results

Infrastructure Man-
ager
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By default the infrastructure manager opens up as a new tab next to the
inspector.

 

The chainage bar represents the whole horizontal alignment from its start to
the end. The bars show you where cross sections are assigned.
• When the numbering of nodes is different between cross sections, then

these areas of the alignment are transition areas and marked as such in
the chainage bar.

• When cross section assignments are missing or there are gaps in the road,
then these areas are without any marking.

You can shift the slider to any position in the road or enter a chainage value
to make the slider jump. Both Alignment views (horizontal and vertical) as well
as the cross section view follow your movements.
On the bars the cross section view show you the details of assigned cross
sections.

3.8.8.2 Alignments

Alignments are defined in the horizontal and/or the vertical profile tabs of the
infrastructure manager.
In the horizontal tab, you can also define station equations.

How to define a horizontal alignment?
Each horizontal alignment starts at the Point Of Beginning (POB) and is
defined with a sequence of geometry elements.
Existing elements can be edited. New elements can be added above or below.
1. Select an element and select Add Above/Below in the Road Design

ribbon bar or select Add Above/Below from the context menu.
By default straight elements are added.

2. Edit the element properties. Infinity guides you through which defini-
tions are mandatory response or optional.
The graphical view follows your changes.

3. Select Apply to save your changes to the alignment.

To enter station equations switch to the equations tab.

Alignments
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1. Select Add Below in the Road Design ribbon bar and enter the Back
and Ahead values in the Inspector view.

2. Select Apply.

In the graphical view purple lines (perpendicular to the alignment) indicate in
which places along the alignment station equations are defined.
For each cross section assignment, its modified station value is listed in the
inspector and in the property grid.

How to define a vertical alignment?
Each vertical alignment starts at the Vertical Point Of Beginning (VPOB) and is
defined with a sequence of geometry elements.
The procedure of adding elements is the same as for horizontal alignments
(see previous information).

3.8.8.3 Cross Section Assignments

In the cross sections tab of the infrastructure manager, you can switch

between  editing cross sections and  editing connections.

Edit cross section view:
 

Edit connections view:
 

Each cross section is shown as a vertical cut through the road layers at a
specific station/chainage.
The inspector view has as many tabs as material layers are defined. The layer
of the active tab is colour indicated in the graphical representation of the
cross section.

Cross Section Assign-
ments
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Each of the nodes that constitute a cross section is defined with offsets to
the left and the right of the centreline. The centreline is available on all layers.

To create a new cross section assignment:
1. Shift the slider to the position in the chainage bar where a cross

section shall be assigned to or enter the chainage value.

2. Select  New Template to create a new cross section template or

select  Add to and select a template from the list.

3. Select Apply in the Infrastructure Manager.

The template is assigned as a cross section to the selected chainage and
assume as its ID the current chainage value. Existing cross sections in the
position are overwritten.
In the navigator and the road inspector the cross section assignment is added
to the list.

☞ Assignments can be deleted. The template remains.
Changes you have made to an assigned cross section are lost when
the template has not been updated before.

To edit an assigned cross section:
1. Shift the slider upon a cross section in the chainage bar or enter its

chainage value.

2. Edit the offsets and/or side slopes of single nodes or add new
nodes in the Inspector view. The graphical view follows your
changes.
To add new nodes right-click and select Add Above or Add Below
from the context menu.
☞ If you design a cross section from scratch and you know

that left and right side shall be identical, then you can
create the right or the left side and press the  Mirror
button to automatically create the nodes on the other
side.
It only works when one side is empty.

3. If a template has been used, optionally  update your changes to
the template for further use.
☞ Assignments that have come in with your road data on

import do not have underlying templates.
Copy them to a new template when you want to save your
changes.

☞ Assignments using a modified template are not automatic-
ally updated.
Reassign the updated template when necessary.

4. Select Apply.

To create a copy of an assigned cross section:
1. Shift the slider upon the cross section that shall be copied or enter

its chainage value.
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2. Select  Copy to New Cross Section Template.
Next to the Property Grid the New Cross Section Template tab opens
up.

3. Shift the slider to the position in the chainage bar where the cross
section shall be copied to or enter the chainage value.

4. Select Create in the New Cross Section Template tab.
The template ID can be modified.

5. Select Apply in the Infrastructure Manager.

The copy of the previously selected assignment is created and assigned to the
selected chainage. Existing cross sections in the position are overwritten.
The template is available for future use.

To extract a cross section to a new cross section template:
Cross sections can be extracted from a transition area by interpolating all its
nodes from the stringlines between the two existing cross sections.
1. Shift the slider to the position in the chainage bar where the new

cross section shall be interpolated or enter the chainage value.

2. Select  Extract to New Cross Section Template.
Next to the Property Grid the New Cross Section Template tab opens
up.

3. Select Create in the New Cross Section Template tab.
The new cross section is interpolated at the selected chainage.

4. Select Apply in the Infrastructure Manager to assign the new cross
section.
The template is available for future use.

How to edit connections?

To fix problems found within road design data using cross sections:
1. Switch to the Edit Connections view.

2. Shift the slider in the chainage bar to the cross section for which
you want to edit connections.
The graphical view shows the selected cross section and the follow-
ing one.
The Inspector splits to show the details of both cross sections.

3. In the Inspector select the elements to be connected in both cross
section profiles and then  Link from the context menu or from
the Infrastructure > Road Design ribbon bar.
To disconnect elements select them both and then  Unlink.

The stringline is recalculated and redrawn in the graphical view.

3.9 Adjustments

3.9.1 Overview

From the observations you have made in the field, the next step is to compute
an end result, the coordinates. When redundant observations are available, as
should be the case, choose a strategy to get a unique and optimal solution. In
geodesy, this strategy is usually a least squares adjustment, which is based on

Adjustments
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the following criterion: The sum of the squares of the observational residuals
must be minimised. After carrying out a least squares adjustment, you know
that based on the available observations, you have achieved the best possible
solution.
But after you have found the best possible solution, it is further important to
be able to assess the quality of this solution to verify whether your network
meets the requirements. The quality of a network can be assessed in terms
of precision and reliability, which can be quantified by setting the adjustment
parameters.
Finally, quality control has to include statistical testing to clear the result of
possible outliers. The effectiveness of testing depends on the reliability of
the network. The more reliable a network is, the higher the probability that
outliers are detected by the testing.

To summarise the relationship between least squares adjustment, pre-
cision and reliability and statistical testing we can say that:
• Based on the available data, the least squares adjustment produces the

best possible result.
• Statistical tests check the result to make it error-free.

See also:
Statistical Testing

• The precision and reliability settings quantify the quality of the result.
See also:
General Adjustment Settings

In Infinity, the adjustment computation is performed using the MOVE3 adjust-
ment kernel, licensed to Leica Geosystems AG by Grontmij Geo Informatie, bv,
Rosendaal, The Netherlands. For detailed information, see https://move3soft-
ware.com/.

See also:
The tutorial "How to adjust a GNSS+Level network" https://leica-geosys-
tems.com/-/media/94056ba161ce4993b46bd2848ad58902.ashx
The tutorial "Advanced Network Adjustment" https://leica-geosys-
tems.com/-/media/02614143f73640338df088b7f7123ef0.ashx
The tutorial "Advanced Adjustment Concepts" https://leica-geosys-
tems.com/-/media/80026c2d4e22481fb05a0df1fd2224f8.ashx

☞ The tutorial data can be downloaded in the  Localisation Tool.

Prepare the data for adjustment:

In Infinity there are four basic steps to performing an adjustment:
1. Define the control points - Fixed in 3D, 2D, 1D or not fixed.

2. Select the observations to be considered in the adjustment - TPS,
GNSS and level observations.

3. Run the adjustment and evaluate the results, even comparing sev-
eral adjustment runs.

4. Store the results that satisfy the adjustment criteria.
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Run full adjustment:

To run a network adjustment:

Select the  option in the Adjustments ribbon bar to run an adjustment.

Select from the drop-down menu whether you want to adjust 3D (position
and height), 2D (position only) or 1D (height only).

☞ The last selected method is remembered.

Depending on the chosen dimension, the following types of data is
adjusted:

 TPS GNSS Level

3D Direction, Zenith
Angle and Slope
Dist.

DX, DY, DZ ---

2D Direction and
Horizontal Dist.

DX, DY, DZ ---

1D Trig. Height Diff. --- Height Diff.

Adjustment
Method

Description

3D Data is adjusted in all available dimensions.
If only 2D or 1D data is available the 2D and 1D observa-
tions are adjusted instead.

2D If your network has GNSS baselines these are always adjus-
ted in 3D even if the dimension is set to 2D.
TPS slope distances and zenith angles are reduced to hori-
zontal distances.
Slope distances without zenith angles are ignored.
This adjustment is stored with the adjusted least squares 2D
point role.

1D If you choose 1D the GNSS baselines are excluded from the
adjustment.
TPS slope distances and zenith angles are reduced to trigo-
nometric height differences. TPS directions are ignored.
This adjustment is stored with the adjusted least squares 1D
point role.

The adjustment result is available in the  Adjustment Results view of the

Inspector and can be  stored if it meets your needs for accuracy.

The results of all adjustment runs are kept in the list until you select them and
delete them. To delete a result from the list select it and select the  Delete
option in the top left corner of the main Infinity window.

Network Reports
For each result in the Inspector, you can create a report to compare individual
adjustment runs.
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Select the  Reports option in the ribbon bar and select Network
Adjustment Report from the drop-down menu.
The report opens in a separate window and can be saved as a PDF or HTML
file. Both types of file are added to the Archive section of the Navigator under
Reports and can be opened from there again.

Store Result

In the  General Adjustment Settings, you can choose to automatically
store a result after the network computation is finished. If you have deselec-
ted this setting, you can store the result manually. A reason for doing that,
can be to first inspect a result before storing it.

See also:
General Adjustment Settings
Inspecting Adjustments
1.

Go to the  Adjustment Results view of the Inspector and
select the result which you want to store from the list.

2.
Select the  Store Result option in the ribbon bar to store the
adjustment result manually.

After saving a result, the point role  adjusted least squares are assigned
to all adjusted points. You can select this point role for each point in the
Navigator and inspect the properties in the Property Grid.

☞ Only one result can be selected to be stored. You cannot store mul-
tiple Results.

When you want to store another result, select it from the list and select the
Store Result option again.
When you want to remove the adjusted least squares point roles from the
project, select the Remove Adjustment option in the ribbon bar.

What is stored to the project:
A useful feature of Infinity is allowing you to run several adjustments to com-
pare results and in general decide which adjustment satisfies the adjustment
criteria.

☞ It is important to recognise the adjustment results are stored to the
project and merged with the existing data.
The adjusted coordinate values are merged to the library points and
the point role reflects the value that was stored.
It is also possible to merge the coordinate values from two adjust-
ment runs and to combine the 2D and 1D runs.

Adjusted least squares point roles:
After storing an adjustment result, the following table explains the point role
that is stored to the points project data:
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Point Role Storing Adjustment Dimension

Adjusted
Least
Squares 3D

Storing 3D creates a point role that indicates all three
coordinate values are from the adjustment.
If an existing adjusted point role exists, then it is replaced
with the adjustment values of the most recent store.

Adjusted
Least
Squares 2D

Storing 2D creates a point role that indicates the position
coordinate values are from the adjustment.
If an existing adjusted point role exists, then this store
replaces the position coordinate values.
The height value is not replaced.

Adjusted
Least
Squares 1D

Storing 1D creates a point role that indicates the height
values are from the adjustment.
If an existing adjusted point role exists, then this store
replaces the height coordinate value only.
The position coordinate values are not replaced.

Adjusted
Least
Squares 2D +
1D

When storing a 2D and then a 1D adjustment the height
coordinate value is merged with the position coordinate val-
ues to provide a 2D + 1D adjusted coordinate.
Run and store a 2D adjustment, the adjusted least squares
2D point role is available.
Run and store a 1D adjustment, the adjustment respects the
2D value and updates the height value.

Adjusted
Least
Squares 1D +
2D

When first storing a 1D and then a 2D adjustment the pos-
ition coordinate values are merged with the height coordin-
ate value to provide a 1D + 2D adjusted coordinate.
Run and store a 1D adjustment, the adjusted least squares
1D point role is available.
Run and store a 2D adjustment, the adjustment respects the
1D value and updates only the position value.

Remove Adjustment:

To remove a stored adjustment and with it the adjusted point roles:

Select the  Remove Adjustment option from the ribbon bar to remove
the stored result.
The status of the stored adjustment run is set back to not stored and the
point roles  adjusted least squares are removed from all adjusted points.

But the adjustments run itself is kept in the  Adjustment Results section
of the Inspector for future reference and could be saved again if necessary.
To delete an adjustment result from the list, select the result and select the

 Delete option in the top left corner of the main Infinity window.

3.9.2 Free and Constrained Adjustments

The adjustment of a network is usually subdivided into two separate
steps or phases:
1. Computation of a free network adjustment.
2. Computation of a constrained adjustment.

Free and Constrained
Adjustments
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This approach is intended to separate the statistical testing of observations
and known stations.

See also:
Statistical Testing

Free adjustments:
A free network is a network in which the geometrical layout is determined by
the observations only. The position, scale and orientation of the network are
fixed by a minimum number of constraints. The control coordinates of known
stations do not impose any extra constraints on the adjustment solution, yet.
In a free network adjustment the emphasis is on the quality control of the
observations rather than on the computation of coordinates. Selecting other
stations to fix the position, scale and orientation changes the coordinates but
not the results of statistical testing.

Constrained adjustments:
Having eliminated possible outliers in the observations by running a free
adjustment, the network can be connected to the known stations. This does
impose extra constraints on the solution. Now the emphasis is on the analysis
of the known stations and on the computation of the final coordinates.

There are two types of constrained adjustments:
• Absolutely constrained.
• Weighted constrained.

The difference between these two types lies in the way coordinates are
computed:
• In an absolutely constrained adjustment the coordinates of the known

stations are kept at their original value, that is, they do not get a least
squares correction. An absolutely constrained adjustment is sometimes
called a pseudo least squares adjustment.

• In a weighted constrained adjustment however, the known stations do get
corrections.

Your decision whether to compute the adjustment absolutely or weighted
constrained leaves the testing results unchanged.

3.9.3 Adjustment Settings

3.9.3.1 General Adjustment Settings

☞ The parameters for adjustment computations can either be set in the
File tab under Info & Settings or from inside the Adjustments ribbon
bar.
Changes are stored with the project and applied to all future adjust-
ment runs.

To set the adjustment parameters back to the default values:

Go to the File tab and select the Defaults option in the  Adjustment
Parameters section under Info & Settings.

General Adjustment
Settings
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Computation

Store results immediately after computing:
Decide whether you want to store the results of an adjustment immediately
and automatically after computing, or whether you want to store the results
manually later on.

By default the option  Store results immediately after computing is active.
When you change this setting, it has an immediate effect and also applies to
projects which are already open.
When you de-activate this setting, you can store the results manually by

selecting  Store Results from the Adjustments ribbon bar.

Controls

Select how  control coordinates shall be introduced into the adjustment
computation.
• Constrained

Two or more control points are kept fixed.
• Weighted

Control points are kept relatively fixed and are allowed to move according
to their standard deviations.

Iterations

Max. Iterations
Set the maximum number of iterations or computation runs to perform to try
and reach the iteration criteria (see the following). The maximum number of
iterations defines an upper limit and prevents the computation from running
into an endless loop if there are problematic observations taking part in the
adjustment which prevents the iteration criteria from ever being met. With
GNSS observations, one iteration is normally sufficient to meet the iteration
criteria. In this case, the adjustment automatically stops the computation even
if maximum three iterations have been set.

Iteration Criteria
The iteration criteria is the maximum allowed size of corrections to the adjus-
ted coordinates which must be reached before the iteration stops. The itera-
tion criterium is subject to the maximum number of iterations.

Visualisation Exaggeration Factors

Absolute and Relative Error Ellipses/Reliability
Set factors in order to enlarge the visualisation of error ellipses and reliability
boxes such that the error ellipses and reliability boxes can properly be seen in
the graphical view.

Threshold
Set a threshold value above which error ellipses and reliability boxes shall be
shown in the graphical view. Errors or reliability values below are not displayed
independent of the given exaggeration factor.
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Confidence Levels
Here you can set the confidence levels (that is the standard deviations) for
Heights - 1D and absolute and relative Error Ellipses - 2D. The given values are
stored in the adjustment results and shown in the adjustment report. In the
graphical view absolute and relative error ellipses are shown.
The axes of the absolute and relative error ellipses are multiplied by a scale
factor that is derived from the confidence levels as set by you for the stored
adjustment result. If you use other than the standard confidence levels then
confidence ellipses/ellipsoids are shown instead of error ellipses/ellipsoids.
The standard deviation for heights is treated in the same way.

The system default values are the standard one-sigma values, that are:
• For Heights - 1D: 68.3%.
• For Error Ellipses - 2D: 39.4%.

☞ Changing the confidence levels does not have any effect on the stat-
istical tests.

Here you can define the standard deviations and the centering and height
errors to be taken into account for the adjustment of TPS data. Altogether the
values defined here are used to define an overall accuracy information to be
fed into the adjustment.

Standard Deviations
Here you can define the default standard deviations that shall be applied to all
TPS observations when computing an adjustment.

Source for Standard Deviations
• Select Individual to make the adjustment apply the accuracies which are

stored with the observations. These are normally the standard deviations
pre-defined for all measurements on the instrument.

• Select Use Defaults to make the adjustment apply the default settings
to be defined below for all observations. A ppm value can be entered to
account for the relative length (the distance) of an observation.

Centering/Height Errors
Here you can define the default accuracy that shall be applied to the two end
points (setup and target) of a measurement.
The centring error defines the predicted error that could have been made
when centring the instrument/target on a point. The height error defines the
predicted error when measuring the instrument/target height above a point.

Source for Centering/Height Errors

• Select Individual to make the adjustment apply the accuracies which are
assigned to the two end points (setup and target) individually.

• Select Use Defaults to make the adjustment apply the default settings to
be defined below for setup and target.

Here you can define the standard deviations, the centering and height errors
and the sigma a priori to be taken into account for the adjustment of GNSS

TPS Accuracy Inform-
ation

GNSS Accuracy
Information
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data. Altogether the values defined here are used to define an overall accuracy
information to be fed into the adjustment.

Standard Deviations
Here you can define the default standard deviations that shall be applied to all
GNSS observations when computing an adjustment.

Source for Standard Deviations
• Select Individual to make the adjustment apply the accuracies which are

stored with the observations.
• Select Use Defaults to make the adjustment apply the default settings

to be defined below for all observations. A ppm value can be entered to
account for the relative length of a baseline.

Centering/Height Errors
Here you can define the default accuracy that shall be applied to the two end
points (reference and rover) of a measurement.
The Centring error defines the predicted error that could have been made
when centring the reference/rover on a point. The height error defines the
predicted error when measuring the reference/rover height above a point.

Source for Centering/Height Errors
• Select Individual to make the adjustment apply the accuracies which are

assigned to the two end points (reference and rover) individually.
• Select Use Defaults to make the adjustment apply the default settings to

be defined below for reference and rover.

Sigma a Priori
Here you can enter a value to compensate for too optimistic GNSS observa-
tions. Often, observations coming from GNSS post-processing programs are
too optimistic in their accuracy information. This in itself does not matter
when adjusting pure GNSS observations but it becomes important when com-
bining GNSS and TPS observations.

Here you can define the standard deviations to be taken into account for the
adjustment of level data. Altogether the values defined here are used to define
an overall accuracy information to be fed into the adjustment.

Source for Standard Deviations
• Select Individual to make the adjustment apply the accuracies which are

stored with the observations. These are normally the standard deviations
pre-defined for all measurements on the instrument.

• Select Use Defaults to make the adjustment apply the default settings
to be defined below for all observations. A ppm value can be entered to
account for the relative length (the distance) of an observation.

3.9.3.2 Test Criteria

☞ The parameters for adjustment computations can either be set in the
File tab under Info & Settings or from inside the Adjustments ribbon
bar.
Changes are stored with the project and applied to all future adjust-
ment runs.

Level Accuracy
Information

Test Criteria
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To set the adjustment parameters back to the default values:

Go to the File tab and select the Defaults option in the  Adjustment
Parameters section under Info & Settings.

Level of Significance (α0)
The Alpha0 criterium determines the probability of rejecting a good observa-
tion. By default the level of significance is set to 5% as this is regarded as
a good compromise. Setting the Alpha0 value too low may result in a bad
observation being accepted.

Power of Test (1 - β)
The 1-Beta criterium determines the power of the test, that is, the probability
of accepting a bad observation. By default the power of testing is set to 80%
as this is regarded as a good compromise. Setting the Beta value too high may
result in good observations being rejected.

☞ The Alpha0 and Beta settings are subjective and should be determ-
ined by an experienced surveyor who carried out the field work. If
you feel unsure about what Alpha0 and Beta should be set to, accept
the suggested default values. For a theoretical background and fur-
ther information on both these values read the topic on the W-Test.

Sigma a posteriori
This is a global setting that compensates for the uncertainty of the a priori
value. It affects the estimated precision of the adjusted coordinates. You can,
if required, only apply the sigma a posteriori if the adjusted coordinates fail
the so-called F-Test. The F-Test is a test that is applied to the sigma a priori
and the sigma a posteriori. If both are statistically different the result of
the F-Test indicates that the stochastic values awarded to the observations
a priori are incorrect (assuming outliers have been removed!). Applying the
sigma a posteriori then compensates for this problem.

See also:
W-Test
F-Test

3.9.3.3 Advanced Terrestrial Parameters

☞ The parameters for adjustment computations can either be set in the
File tab under Info & Settings or from inside the Adjustments ribbon
bar.
Changes are stored with the project and applied to all future adjust-
ment runs.

To set the adjustment parameters back to the default values:

Go to the File tab and select the Defaults option in the  Adjustment
Parameters section under Info & Settings.

Use reduced observations:
When calculating a network adjustment by default all active observations are
used. Select  this option, if you want to only use the reduced observations

Advanced Terrestrial
Parameters
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for all sets of angles applications stored in a project. The single observations
contained in the sets of angles are then not taken into account.
The standard deviations for the reduced observations are taken from the sets
of angles calculation, that is, the mean error of the averaged observations.

Use vertical refraction coefficient:
• Select Ignore, if you want to apply a vertical refraction coefficient to

zenith angles individually before feeding the data into the adjustment.
• Select Compute, if you want to estimate the vertical refraction coeffi-

cient. This is used in projects which have many zenith angle measure-
ments and thus a good estimate can be obtained.

• Select Use, if you want to apply the above set default value to all zenith
angles.

☞ As the vertical refraction coefficient is applied to all vertical angle
measurements in the network, it should only be used in networks
that cover relatively small areas.

Vertical Refraction Coefficient
The vertical refraction coefficient accounts for the influence of refraction on
zenith angles. The default is set to a typical value of 0.13.

Use scale factor correction:
• Select Ignore, if you want to apply a scale factor to distances individually

before feeding the data into the adjustment.
• Select Compute, if you want to estimate the scale factor. This is used

in projects which have many distance measurements and thus a good
estimate can be obtained.

• Select Use, if you want to apply the above set default value to all dis-
tances.

Scale Factor Correction
Here you can define the scale factor, that shall be applied to distance meas-
urements as an extra factor used to compensate for atmospheric conditions.

3.9.3.4 Coordinate System Settings

☞ The parameters for adjustment computations can either be set in
the File tab under Info and Settings or from inside the Adjustment
ribbon bar.
Changes are stored with the project and applied to all future adjust-
ment runs.
To set the adjustment parameters back to the default values:

Go to the File tab and select the Defaults option in the 
Adjustment Parameters section under Info & Settings.

Coordinate System
• Select WGS84 if you want to adjust your observations in the WGS84

system.
• Select Local Geodetic if you have a local coordinate system attached to

your project and you want to adjust the observations in the local system
of your Control points.

Coordinate System
Settings
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☞ The transformation used with your local coordinate system has to be
either a Classic 3D or None for this option to become active.
Read more in the topic "Status Bar" on how to attach a local coordin-
ate system to a project.

• Select Local Grid if you want to adjust pure TPS observations in a local
grid system. In this case, no information on the local ellipsoid is neces-
sary.

☞ If your project has GNSS and TPS observations and you select this
option then only the TPS observations are adjusted. GNSS observa-
tions are ignored. Select Local Geodetic if you want to compute a
combined adjustment.

Height Mode
Depending on the selected height mode, the adjusted coordinates have ellips-
oidal or orthometric heights:
• Select Ellipsoidal if you want to adjust your observations with ellipsoidal

heights.
• Select Orthometric if you want to adjust your observations with ortho-

metric heights.

If for your Control points orthometric heights are available and a geoid model
is included in the coordinate system to be used with the project then:
Run the adjustment with setting the height mode to ellipsoidal.
After the adjustment, the geoid separations are applied again to get the
orthometric heights of the adjusted coordinates.

Parameters
In order transform observations four parameters are required: three rota-
tions about each axis and a scale factor. These parameters can either be pre-
defined and used as such in the adjustment or you can make the adjustment
compute the parameters.
• Select Compute if you want the adjustment to compute the parameters

independent of the parameters given by the attached coordinate system.
• Select Use if you want your observations to be adjusted using the para-

meters as defined here. This does not have any influence on the paramet-
ers given by the attached coordinate system.

☞ In order to compute transformation parameters you should keep
at least three of your points fixed. Otherwise the network computa-
tion creates error messages. It is also important to note that the
computed transformation parameters are only valid for transforming
observations - they cannot be used for transforming coordinates.

3.9.4 Inspecting Adjustments

3.9.4.1 Overview

With Infinity you are flexible to run adjustments under various pre-conditions
and keep the results next to each other. You can inspect and select control
points to be fixed, observations not to be used, adapt the settings and com-
pare and judge afterwards which result fits your needs best before you finally
save one solution to your project.

To inspect adjustments:

Go to the Inspector and open the  Adjustment tab.

Inspecting Adjust-
ments
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 Define coordinate constraints:

The Define Coordinate Constraints view, lists all control points in your
project. Control points are needed when you want to adjust a constrained
or weighted constrained network.

If you want a control point to take part in the adjustment:

Select the  Fix 2D checkbox, if you want its position coordinates to take
part in the adjustment.

Select the  Fix 1D checkbox, if you want only the height coordinate to take
part.

Select  both checkboxes, if you want all coordinate components to take
part.

The role of all control points selected here, changes to  Control Fixed 3D (or
2D or 1D) to indicate that these points are considered for taking part in the
adjustment.

See also:
Objects, Point Roles and Symbols
If you want to compute a weighted constrained network standard deviations
have to be available for each  control point taking part in the adjustment.

☞ Before you start the adjustment, the control coordinates can be
edited in the property grid if necessary.

☞ You can import control coordinates, for example, from an ASCII file,
or you can enter them manually by selecting a point and selecting 
Create Control point next to the existing point role in the Feature
section of the Property Grid.

 Select Observations

The select observations view lists all observations in your project. By default all
observations are selected to be used in the adjustment computation.

If you want to exclude observations:
• De-select the Use checkbox for a single observation.

Or
• Multi-select a set of observations, right-click into the selection and select

Adjustment >  Don't Use from the context menu.

A reason for excluding an observation could be that it has been identified as
an outlier in a previous adjustment run.

See also:
W-Test
Possible reasons for outliers could be mistakes in elements like the target
height or type, offsets or the atmospheric or geometric corrections.
All these elements as well as the coding information can be edited in the
property grid before you start an adjustment run.
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See also:
Observation Properties

 Computed Loops Results

The computed loops results view lists all loop computation results. To inspect
the results open the computed loops report.

For detailed information, see:
Loops Computation

 Pre-Analysis Results

The pre-analysis results view lists all pre-analysis results. To inspect the res-
ults open the pre-analysis report.

See also:
Pre-Analysis

 Adjustment Results

The adjustment results view lists all adjustments that have been computed
within the current project.

On the top level for each adjustment run you can see:
• The Adjustment Type, that has been computed, that is, inner constrained,

constrained or weighted constrained.
• The Dimension, that is, the position only or position and height or height

only.
• The Confidence Levels, that have been defined for heights and error

ellipses.
• The Degrees of Freedom.
• The Critical Value for the F-Test, as computed on the basis of the cur-

rently given level of significance plus the F-Test result.

To inspect the resulting adjusted coordinates and observations:
Drill into a result by selecting the arrow  next to it.

Under coordinates you can inspect the adjusted coordinates together
with:
• The values by which they have been corrected in their components.
• The resulting standard deviations for all points that have not been kept

fixed or only weighted fixed.
• The values defining the error ellipses.
• The external reliability in each coordinate direction.

Under observations you can inspect the adjusted observations separ-
ately for TPS and GNSS together with:
• The residuals that have been amended in each observation component.
• The resulting standard deviations for each observation component.
• The W-Test results for each observation component.
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To manually save the result that meets the demanded accuracy best:

Select it and select  Store result from the ribbon bar to save it.

☞ On how to remove a stored result from the database and on how
to remove an adjustment run from the list of results, refer to the
overview topic in adjustments.

3.9.4.2 Error Ellipses/Ellipsoids

A surveying network can be checked in terms of both, accuracy and precision.
The most common approach to check a network precision is the calculation of
the absolute and relative error ellipses.
Infinity can display both kinds of ellipses/ellipsoids in the graphical view as
well as show the respective information in the inspector and the network
adjustment report.

To show the error ellipses/ellipsoids in the graphical view:
1. Run a network adjustment in 2D or 3D.

2. Store the result.

3. Activate (switch on: ) the Absolute Error Ellipses and Relative
Error Ellipses layers in the Layer Manager.

4. Switch the graphical view to display objects as Shaded or Shaded
with Edges.

For further information on how to run adjustments and store results, see
Adjustments.

☞ If the graphical view is in 3D mode, then error ellipsoids are shown
(instead of 2D error ellipses).
On how to switch between standard views, see Graphical View.

☞ Error ellipses/ellipsoids are only shown if you run the adjustment
using standard confidence levels, that is 68.3% for heights - 1D and
39.4% for absolute and relative error ellipses - 2D.
If you choose other confidence levels, then the graphical view shows
confidence ellipses/ellipsoids instead.

Error Ellipses/Ellips-
oids

Optional Modules 345



Illustration:
 

☞ If errors are too small, go to Settings > General and enlarge the
Visualisation Exaggeration Factors. Else you might not be able to
see the reliability boxes.
If errors are below the given threshold value they are not shown. Set
the threshold to a value smaller than the errors.

See also:
General Adjustment Settings

3.9.4.3 Reliability Boxes

External reliability can be expressed in terms of reliability boxes. For each
station in a project a reliability box is computed as a means to express the
influence of a possible error in the observations or of known coordinates on
the adjusted coordinates. In constrained adjustments the selection of control
points that shall remain fixed during adjustment has a direct influence on the
reliability boxes. The box represents the area that the adjusted station is in
(with a probability of 80%) if all observations and known coordinates of the
network are accepted by the statistical tests. Depending on the possible error
or known coordinate with the largest influence on the adjusted coordinate,
the size of the box is computed according to the size of the minimum detect-
able bias.

To show the reliability boxes in the graphical view:
1. Run a network adjustment in 2D or 3D.

2. Store the result.

3. Activate (switch on: ) the Reliability layers in the Layer Manager.

4. Switch the graphical view to display objects as Shaded or Shaded
with Edges.

Reliability Boxes
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For further information on how to run adjustments and store results, see
Adjustments.

☞ If the graphical view is in 2D mode, then squares are shown (instead
of 3D boxes).
On how to switch between standard views, see Graphical View.

Illustration:
 

☞ If errors are too small, go to Settings > General and enlarge the
Visualisation Exaggeration Factors. Else you might not be able to
see the reliability boxes.
If errors are below the given threshold value they are not be shown.
Set the threshold to a value smaller than the errors.

See also:
General Adjustment Settings

3.9.5 Tools

3.9.5.1 Loops Computation

The compute loops functionality is one of the pre-analysis tools included in
the adjustment module. It is used for automatic computation of network loops
and loop misclosures.
A loops computation is always applied to the unadjusted network as a means
of checking observations before running the adjustment. It detects all loops
with a minimum number of sides (triangles).

☞ Loops that could be formed by combining different types are not
considered.

As concerns loop type definitions, see the following:

Loop Types

Loop Type Description

GNSS Loops The three sums of all coordinate differences DX, DY
and DZ yield closing errors in X, Y and Z.

Loops Computation
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Loop Type Description

Direction and Dis-
tance Loops

The sum of the angles in the loop should be a mul-
tiple of 200 gon or 180 deg. The remainder is the
angular closing error. The closing errors in X (local
Easting) and Y (local Northing) are computed in a
local XY system, with the positive Y axis being paral-
lel to the first side of the loop, and the X axis being
perpendicular to it.
☞ If the two directions of one angle in a loop

are not from the same setup, then the
angular closing error cannot be computed.
The closing errors in X and Y however can
still be computed by starting at the point
with the missing angle. If two or more
angles are missing no closing errors can
be computed.

Zenith Angle and Dis-
tance Loops

The sum of the derived trigonometric height differ-
ences also yields a closing error in height.

Height Difference
Loops

The sum of all height differences equals the closing
error in height.

The calculated closing errors are tested using the W-Test.

☞ The routine does not use approximate and/or known coordinates,
and it does not necessarily take into account all observations.

☞ Instrument heights, scale factors and vertical refraction coefficients
are accounted for.

☞ The results do not point to a specific observation that could possibly
be a blunder.

Compute Loops

To run a loops computation:

Select  Compute Loops from the Adjustments tab.

☞ Select from the drop-down menu whether you want to compute 3D
(Position and height), 2D (position only) or 1D (height only) loops.
By default, loops are computed according to the main adjustment
settings.

☞ Only when set to 3D are all loop types considered in the computa-
tion.
2D only considers GNSS Baseline loops and Direction and Distance
loops.
1D only considers Zenith Angle and Distance loops and Height Differ-
ence loops.

Computation results are available under  Computed Loops Results in
the Adjustments tab of the Inspector.
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☞ The results of all loop computations are kept in the list until you
select them and delete them. To delete a result from the list right-
click upon it and select  Delete from the context menu.

Loops and Misclosures Reports
In order to inspect results in detail select a computation run and select Loops
and Misclosures Report from the context menu.

 

You can generate a report for each result listed in the Inspector in order to
inspect misclosure details. Loops and closing errors are listed by loop type as
described in Loops Computation.

☞ The inspector itself does not allow for any drilling-in to results of
loop computations.

To generate a loops and misclosures report:
1. Select a computation result in the Inspector.

2.
Select  Reports from the Adjustment ribbon bar and select
Loops and Misclosures Report from the drop-down menu.
Or:
Right-click and select Loops and Misclosures Report from the
context menu.

☞ The report opens up in a separate window and can be saved as a
PDF or HTML file. Both types of file are added to the navigator under
Archive > Reports and can be opened from there again.

Loops and Misclos-
ures Report
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3.9.5.2 Pre-Analysis

Pre-analysis is a tool that can be used:
• To detect possible weaknesses in a surveying network before adjustment.
• To detect unknowns which cannot be solved.
• To check input data.

To run a pre-analysis:

Select  Run Pre-Analysis from the Adjustments ribbon bar.

Select from the drop-down menu whether you want to compute 3D (position
and height), 2D (position only) or 1D (height only) loops. By default, loops are
computed according to the main adjustment settings.

Computation results are available under  Pre-Analysis Results subtab
under the Adjustments tab in the Inspector.

 

☞ The results of all pre-analysis computations are kept in the list until
you select them and delete them.

To delete a result from the list right-click upon it and select  Delete from
the context menu.

Pre-Analysis Reports
In order to inspect results in detail select a computation run and open the
Pre-Analysis Report from the context menu.

 

Pre-Analysis
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You can generate a report for each result listed in the inspector in order to
inspect details of a pre-analysis.

☞ The inspector itself does not allow for any drilling-in to results of a
pre-analysis.

To generate a pre-analysis report:
1. Select a computation result in the Inspector

2.
Select  Reports from the Adjustments ribbon bar and select
Pre-Analysis Report from the drop-down menu.
Or:
Right-click and open the Pre-Analysis Report from the context
menu.

☞ The report opens up in a separate window and can be saved as a
PDF or HTML file. Both types of file are added to the navigator under
Archive > Reports and can be opened from there again.

The pre-analysis report includes the following information:
• Configuration Defects:

This sections reports upon singularities that may come up when a network
is adjusted. It lists unknowns that cannot be solved, either because of the
network geometry or because of the type of observations or because of
the coordinate system that shall be used for the adjustment.

• Comparison of Identical Observations:
This section reports upon multiple observations to the same point that
differ by a certain amount and may, therefore, be suspect. If there is a
high probability that an error exists, the W-Test value is marked with bold
red text. Other possibly suspect observations are left to your discretion.

• Comparison of Observations and Approximate Coordinates:
This section reports upon observations checked against the pseudo-
observations, that are derived from approximate coordinates. Observa-
tions, for which a large difference is identified, are listed.

• Possibly Identical Observations:
This section reports upon observations which are suspected to be
identical. You may want to investigate if observations are really separate.

• Possibly Coinciding Stations:
This section reports upon stations which coincide with a distance of less
than 2 metres. Such stations are suspected to be identical, though they
have not been given the same point ID.

Depending on your data additional warning messages may appear after the
last section of a pre-analysis report.

3.9.6 Least Squares Adjustment

3.9.6.1 Mathematical Model

Usually in a survey, the observations themselves are not the quantities, which
we are aiming for. Instead, we use the observations to determine unknown
parameters, for example the coordinates of stations in a network. The obser-
vations are expressed as a function of the parameters in a so-called functional
or mathematical model.
In some cases, the model representing the relations between the observations
and the unknown parameters is simple. The relation, for example, in a one-

Pre-Analysis Report
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dimensional leveling problem between the observed height differences and
the unknown heights is linear:

More complicated is the case for a GPS network where the unknowns are
coordinates (X,Y,Z) to be determined in a reference system different from that
of the observed baselines ΔX:

With α,β,γ,μ = transformation parameters
As the least squares approach requires linear equations, the complex model
above must be linearised. Usually this means that a number of iterations are
needed to reach a solution. Moreover, approximate values for the coordinate
unknowns in the adjustment are required. Bad approximate values can lead to
an increasing number of iterations or, in the worst case, to no convergence at
all.

Nuisance parameters
Since coordinates are our main concern, other unknowns in the mathematical
model are not always useful for us. Unknowns such as the transformation
parameters mentioned above, are called additional or nuisance parameters.
Typical nuisance parameters are: transformation parameters, scale factors,
azimuth offsets, orientation unknowns and refraction coefficients. Some of
these parameters can be kept fixed at a certain value, which makes them
not be corrected in the adjustment. Whether or not to keep parameters fixed
is a question which cannot easily be answered. We must always be careful
to avoid over constraining as well as not to over parameterise. The introduc-
tion of refraction coefficients, for example, could result in the absorption
of systematic effects which are not caused by refraction. However, ignoring
the refraction, when in fact it does have an influence on the measurements,
causes an equally unfavourable effect. The success of what could be referred
to as tuning of the model depends largely on the expertise.
Another typical nuisance parameter is the scale factor which may be estim-
ated for distance measurements. The aim of introducing a free scale factor
in the adjustment is to overcome a possible bias in the internal scale of the
measurement equipment and, in more general terms, to prevent the over
constraining of the network in a free adjustment. A free scale factor shrinks
or blows up the network in order to make it fit to the known stations in con-
strained adjustments. As a result, in some situations a free scale factor may
obstruct the statistical testing of known stations: An outlier in the coordinates
of a known station could remain undetected when, due to the shrink or blow
up effect, the network is forced to fit to the known stations without any
rejections. The outlier is absorbed by the scale factor, which then has a value
distinctly different from 1.0. It is, therefore, recommended to examine the
value of the scale factor after the adjustment and, in case of doubt, to rerun
the adjustment with a fixed scale.

Singularity
An adjustment fails when the mathematical model, as represented by the
design matrix and normal matrix, is singular.
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Singularity is caused by:
• An ill-posed problem.
• An improperly formulated model.

A problem may be ill-posed because we expect too much from the observa-
tions, or because not enough observations are included. An example of an
ill-posed problem is the determination of the 2D coordinates of an unknown
station by a single horizontal direction from another station.
A model is improperly formulated, when too many parameters are included.
In general, an improperly formulated model does not correctly represent the
existing physical reality.
Additionally, the ill-conditioning of the normal matrix N could result in singu-
larity, a problem which occurs especially with computerised solutions to least
squares problems. An ill-conditioned matrix can become singular as a result
of the internal accuracy limits of the computer hardware. An example of an
ill-conditioned problem is the intersection of a station by two or more nearly
parallel directions.

Minimum number of constraints
Apart from the problems mentioned above, an adjustment of terrestrial obser-
vations cannot be solved unless the location, orientation and scale of the
network are established, that is, a datum must be defined. This is done by
imposing constraints on the solution. The minimum number of constraints
depends on the dimension of the network:
In a 3D network, there are three translations, three rotations and one scale
factor. The singularity is then eliminated by fixing at least seven coordinates of
three stations (Lat1, Lon1, h1, Lat2, Lon2, h2, h3).

3.9.6.2 Stochastic Model

A geodetic observation, such as a direction, distance or height difference, is
a random or stochastic variable. A stochastic variable cannot be described by
a single and exact value because there is an amount of uncertainty involved
in the measurement process. For example, repeatedly measuring the distance
between two stations results in a range of different values. This variation
is accounted for by a probability distribution. This means that in addition to
the mathematical model, it is necessary to formulate a second model which
describes the stochastic deviations of the observations; the stochastic model.
For geodetic observations a normal probability distribution is assumed (see
the following). The distribution is based on the mean μ and the standard
deviation σ.
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The mean μ represents the value of the mathematical expectation of the
observable. The standard deviation is a measure of the dispersion or spread
of the probability. The standard deviation characterises the precision of the
observation. The square of σ is called the variance. By definition there is
a 0.684 probability that normally distributed stochastic variables fall within
a window limited by -σ and +σ. For a window limited by -2σ and +2σ this
probability is 0.954. In general, the probability that a stochastic variable takes
a value between x1 and x2 is equal to the area enclosed by the curve, and the
x1 and x2 ordinates. This is the shaded area in the diagram above.

Correlation of observations
It is possible for two or more observations to be interdependent or correlated.
This means that a deviation in one observation influences the other. The
correlation between two observations x and y is mathematically expressed by
the covariance σxy. The covariance is also used in the correlation coefficient,
defined as:

 

The coefficient takes values between minus and plus one:
-1 ≤ ρ ≤ 1
If the observations are not interdependent it follows that ρ= 0. The vector
elements (DX,DY,DZ) of a GPS baseline are an example for correlated observa-
tions. To express this correlation a 3x3 matrix is used. This symmetric matrix is
a combination of standard deviations and correlation coefficients:
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Sigma a priori
In essence the stochastic model consists of a choice for the probability distri-
bution of the observations. Practically this means that for each observation a
standard deviation σ is chosen. The value for s is based on knowledge about
the measurement process (conditions in the field, type of instrument) and
experience. The standard deviation of most observation is supposed to consist
of an absolute part, and a relative part. In the relative part the dependence
on the distance between station and target, which characterises the precision
of most observations, is accounted for. The standard deviations are entered
in the variance-covariance matrix Σb. The precision of the unknowns in the
adjustment depends on the precision of the observations given in Σb, and on
the propagation of this precision by the mathematical model.

3.9.7 Statistical Testing

3.9.7.1 Overview

Both the mathematical and the stochastic models are based on a set of
assumptions. This set is called a statistical hypothesis. Different assumptions
result in different hypotheses. Statistical testing is used to verify the hypo-
theses. A special set of assumptions is referred to as the null-hypothesis H0.

This hypothesis implies that:
• Your observation does not have any gross errors (blunders).
• Your mathematical model delivers a correct description of the relations

between your observations and unknown parameters.
• The chosen stochastic model for your observations appropriately

describes the stochastic properties of the observations.

It is clear that there are two possible results for the testing of a hypothesis:
Acceptance or rejection. A specific cut-off point or critical value decides on
acceptance or rejection. The critical values establish a window of acceptance.
The further beyond this window a result is, the less certain the set of assump-
tions is satisfied. Critical values are determined with you choosing a level of
significance α. The probability that the critical value is exceeded, although the
set of assumptions is valid, is equal to α. In other words, α is the probability
of an incorrect rejection. Alternatively, the complementary level of confidence
1-α, is a measure of the confidence you can have in the decision.

While testing the null-hypothesis H0 there are two unfavourable situ-
ations that might occur:
• Rejection of H0 while in fact it is true. The probability of this situation

occurring is equal to the significance level α. This situation is called a Type
I error (see the following table).

• Acceptance of H0 while in fact it is false. The probability of this situation
occurring is 1-β, with b being the power of the test. This situation is called
a Type II error (see the following table).
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Situation Decision: accept H0 Decision: reject H0

H0 true correct decision:
probability = 1-α

Type I error:
probability = α

H0 false Type II error:
probability = 1-β

correct decision:
probability = β

See the following topics for further information on testing the null-
hypothesis and alternative hypotheses:
F-Test
W-Test
T-Test

3.9.7.2 F-Test

The F-Test is a commonly used multi-dimensional test for checking the null-
hypothesis H0. The F-Test is often called the overall model test, because it
tests the given mathematical and stochastic models in general.

The F-value is defined by the expression:

F = s2/α2

with

s2 = a-posteriori variance factor derived from the computed residuals and the
redundancy

α2 = a-priori variance factor.
The F-value is tested against a critical value of the F-distribution, which is a
function of the redundancy and the significance level α. But the information
provided by the F-Test, that is, the acceptance or rejection of the null-hypo-
thesis, is not specific. Therefore, if H0 is rejected it makes sense to ask for the
reasons why by tracing errors in observations or pre-assumptions.

F-Test
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There are three reasons for rejection:
• Gross errors

If you suspect that H0 is rejected because of a gross error in one of the
observations, then the so-called data snooping provides you with reveal-
ing information by applying the W-Test in order to seek for and find errors
in individual observations. The F-Test and the W-Test are interlinked by
a common value for the power of test β. The method is the called the
B-Method of testing.

• Incorrect mathematical model
If you suspect that H0 is rejected because of a mathematical model that is
incorrect or not refined enough, then check the adjustment settings. For
example, redefine and make the vertical refraction coefficient or the scale
factor correction be used to improve the mathematical model.
See also:
Advanced Terrestrial Parameters

• Incorrect stochastic model
If you suspect that H0 is rejected because of a stochastic model that is
incorrect or not refined enough, then check the adjustment settings . If
the a-priori variance-covariance matrix is too optimistic increase the input
standard deviations and/or centering/height errors of the observations to
improve the stochastic model.
See also:
TPS Accuracy Information

☞ When you optimise the mathematical or stochastic model always
bear in mind that the purpose of statistical testing is not to have
all observations accepted, but to detect outliers and model errors.

3.9.7.3 Chi-Square Test

Unlike the F-Test used in the B-Method of testing, the Chi-Square is a two-
tailed test, that is, it tests the Chi-Square value against both the upper and
the lower bound.
In practice, if the Chi-Square value is lower than the lower bound, this means
that the standard deviations are too pessimistic. On the other hand, if the
Chi-Square value is higher than the upper bound, this can be interpreted in the
same way as if the F-Test fails.

See also:
Interpreting Test Results

3.9.7.4 W-Test

A rejection of the F-Test does not directly indicate the reason for the rejection
itself. Thus, in case the null-hypothesis is rejected, other hypotheses must be
formulated if you want to describe a possible error or a combination of errors.
There is an infinite number of hypotheses which you could formulate as an
alternative for the null-hypothesis. But the more complex these hypotheses
become the more difficult they are to interpret. A simple but effective hypo-
thesis, though, is the so-called conventional alternative hypothesis, based on
the assumption that you have to suspect an outlier in only one observation
while all others are correct. The one-dimensional test associated with this
hypothesis is called W-Test.

Chi-Square Test

W-Test

Optional Modules 357



The assumption that just a single outlier corrupts your network is, indeed
realistic. A strong rejection of the F-Test can often be traced back to a gross
error in just one observation. The conventional alternative hypothesis for each
observation implies that each individual observation is tested. The process of
testing each observation in a network by a W-Test is called data snooping.
Often the size of the least squares correction alone is not precise enough
to indicate an outlier when you check the observations in your network.
A better test quantity, though only suited for uncorrelated observations, is
the least squares correction divided by its standard deviation. For correlated
observations, like for example the three coordinate elements of a baseline,
the complete weight matrix of the observations must be taken into account.
This condition is fulfilled with the test quantity W of the W-Test, which has
a standard normal distribution and is most sensitive to errors in one of the
observations.
The critical value Wcrit depends on your choice of the significance level α0.
If the W-Test is rejected because of W>Wcrit, there is a probability of 1-α0
that the corresponding observation indeed holds an outlier. On the other
hand, there is a probability of α0 that the observation does not hold an
outlier, which implies that the rejection was unjustified. In geodesy, values
for α0 between 0.001 and 0.05 are most commonly used. The following table
gives you an overview on the α0-values and their corresponding critical val-
ues. Which α0 you effectively choose depending on how strict and rigid you
intend to test your observations. A strict testing (with a small critical value),
leads to a larger α0 and therefore, to an increased probability to reject valid
observations. An α0 value of 0.001 implies one false rejection in every 1000
observations. This has proven to be a realistic choice.

significance level α0 0.001 0.010 0.050

critical value W-Test 3.29 2.58 1.96

Essential for a successful testing by the B-Method is that an outlier is detec-
ted with the same probability by both the F-Test and the W-Test. To achieve
this, the test power β is by default fixed on a level of usually 0.80 for both
tests. You can adapt β by 10% up or down in the settings for the test criteria.
The W-Test level of significance α0 is selected, to which leaves the F-Test
level of significance α to be determined. With α0 and β being fixed, α strongly
depends on the redundancy in the network and increases for large networks
with many observations and a considerable amount of redundancy. In such
networks, it becomes difficult for the F-Test to react on a single outlier. The
F-Test, being an overall model test, is not sensitive enough to achieve this
task. Thus, it is common practice to do data snooping, no matter what the
result of the F-Test might be.

See also:
Test Criteria

3.9.7.5 T-Test

As discussed in the topic on the W-Test, the W-Test is a 1-dimensional
test which checks the conventional alternative hypothesis. This hypothesis
assumes that there is just one erroneous observation at a time. This so-called
data snooping works very well for single observations, for example for direc-
tions, distances, zenith angles, azimuths or height differences. However, for
some observations such as GPS baselines, it is not enough to test the DX-,
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DY-, DZ-components of each vector separately. It is imperative to test the
baseline as a whole as well.
For this purpose we introduce the T-Test. Depending on the dimension of
the quantity to be tested, the T-Test is a 3- or 2-dimensional test. As with
the W-Test, the T-Test is also interlinked with the F-Test by the B-Method of
testing. The T-Test has the same power as both other tests, but has its own
levels of significance and its own critical values (see tables below).

Significance level/critical value for 2-dimensional T-Test, based on α0 of
the W-Test:

significance level α0 0.001 0.010 0.050

significance level α (2-dim) 0.003 0.022 0.089

critical value T-Test 5.91 3.81 2.42

Significance level/critical value for 3-dimensional T-Test, based on a0 of
the W-Test:

significance level α0 0.001 0.010 0.050

significance level α (3-dim) 0.005 0.037 0.129

critical value T-Test 4.24 2.83 1.89

The T-Test is equally useful when you want to test for slight deformations
on known stations. The data snooping successfully finds an outlier that might
have occurred, for example, due to a typing error in either the Easting or
the Northing or the height component causing a gross error in one of the
coordinate components. But the deformation of a whole station might stay
undetected by the data snooping when the shifts caused by the deforma-
tion in each coordinate component are relatively small. For testing a possible
deformation influencing the whole coordinate triplet, like with the Easting and
the Northing and the height, a different alternative hypothesis is needed. The
3-dimensional T-Test on the complete coordinate triplet is better equipped to
trace the deformation, although its not able to trace the exact direction into
which the station has moved.

☞ A situation in which the W-Test is accepted but the associated T-Test
of the observation is rejected, which is not unlikely in practice, does
not necessarily imply a contradiction. It is simply a matter of having
tested different hypotheses.

3.9.7.6 Interpreting Test Results

When dealing with test results we always have to keep in mind that a certain
amount of probability is involved in the process, and that there is no absolute
truth. Statistics in general should be used with discretion, together with com-
mon sense, practical experience and external independent evidence.

As discussed in the topic on the F-Test a rejection of the F-Test, mean-
ing a rejection of H0, may happen because of:
• Gross errors or blunders.
• An incorrect mathematical model.
• An incorrect stochastic model.

Needless to say, a combination of these reasons for a rejection is also pos-
sible, which makes it difficult to define strict rules for drawing conclusions

Interpreting Test Res-
ults
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from the F-Test results. In general, a rejected F-Test in combination with a
pattern of rejected W-Tests points to a model error. An incidental W-Test
rejection points to one or more gross errors or blunders.

Since F-Test, W-Test and T-Test are interlinked, it is best to interpret
all tests in combination:
• A rejected F-Test in combination with a limited number of rejected W-

Tests (T-Tests) usually points to one or more gross errors.
• If the F-Test is rejected and all observations of a specific type (for

example all zenith angles) are rejected as well, the problem probably
lies within the mathematical model which needs correction or refinement
then. For instance, if all W-Tests for the zenith angles are rejected, it
could be helpful to include refraction coefficients.

• If the F-Test is rejected together with most of the W-Test results (without
extremes), the problem probably lies within the stochastic model and you
can suspect that the input standard deviations are too optimistic. On
the other hand, if the F-Test result is well below the critical value and
the W-Test (T-Test) results are all close to zero, then the input standard
deviations are possibly too pessimistic.

Example:
Suppose that the data snooping on the observations in your network results
in a (limited) number of rejections. Further assume that the rejections are not
caused by mathematical model errors and that obvious errors such as typing
mistakes have been fixed.

Then this leaves you with a number of options:
• Remove the corresponding observations

This is a valid but rather abrupt way of handling rejections. Remember
that the removal of observations decreases the redundancy and, there-
fore, influences precision and reliability.

• Remeasure the corresponding observations
Remeasuring observations is an obvious but often expensive way to elim-
inate rejections, especially when the fieldwork is already completed. Thus,
it is recommended to process and cross-check as much of the data as
possible on site.

• Increase the standard deviation of the corresponding observations
Increasing the standard deviation of an observation always works,
because it always results in decreasing the F-, W-, T-Test values. Keep
in mind, though, that the goal is not to get all tests accepted, but rather
to detect blunders or model errors!

• Ignore the rejections
This option is obviously very risky and should only be applied if the W-
Test results just exceed the critical value. Have a look at the estimated
error coming with the rejection and see whether it is acceptable or not,
because we also have to keep in mind that, depending on the level of
significance, it may always happen that a valid observation is rejected.

☞ Unless there is clear evidence of the reason for an error, for example
a typing error, never edit observations just to make it better fit into
your network!
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